Contents

Preface.................................................................................................................................................................13
  Documentation Conventions............................................................................................................................14
  Related Publications............................................................................................................................................15
  Customer Support................................................................................................................................................15
  Information You Should Have..........................................................................................................................15
  User Feedback..................................................................................................................................................16
  Information Builders Consulting and Training...............................................................................................16

1. Performance Management Framework Overview..........................................................................................19
  Introduction to PMF............................................................................................................................................20
  Working With PMF...........................................................................................................................................20
  WebFOCUS Components Used by PMF........................................................................................................21
  Finding It: Authors............................................................................................................................................22
  Finding It: Administrators...............................................................................................................................22
  Shared Roles for Authors and Administrators...............................................................................................23
  Finding It: Analysts..........................................................................................................................................23
  Finding It: Consumers....................................................................................................................................23
  Finding It: Developers....................................................................................................................................24
  Finding It: Installers.........................................................................................................................................24
  Milestones in the Performance Management Process....................................................................................25

2. Performance Management Framework User..................................................................................................27
  PMF Overview..................................................................................................................................................28
    Changing Dashboard Gadgets and Preferences........................................................................................29
  Accessing Views................................................................................................................................................33
  Working With PMF Views................................................................................................................................33
    Universal Drill-Down Menus..........................................................................................................................35
    Drill-Down Options.......................................................................................................................................39
  Working With the Analytics Tab.....................................................................................................................41
    Drilling to Atomic Measures.......................................................................................................................42
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strategy Map .....................................................................................42</td>
</tr>
<tr>
<td>Interactive Highlighting on the Strategy Map ................................45</td>
</tr>
<tr>
<td>Cause and Effect Drills ..................................................................46</td>
</tr>
<tr>
<td>Previous vs. Current and Prior vs. Current ......................................46</td>
</tr>
<tr>
<td>Rolling 5 Periods ................................................................................47</td>
</tr>
<tr>
<td>Executive Booklet ................................................................................49</td>
</tr>
<tr>
<td>Executive Briefing Booklet - PDF ..................................................50</td>
</tr>
<tr>
<td>Executive Briefing Booklet - PowerPoint .......................................50</td>
</tr>
<tr>
<td>Strategy Relationships .......................................................................51</td>
</tr>
<tr>
<td>Objectives Summary ............................................................................52</td>
</tr>
<tr>
<td>Objectives Performance ....................................................................53</td>
</tr>
<tr>
<td>Projects ..............................................................................................54</td>
</tr>
<tr>
<td>Processes ............................................................................................55</td>
</tr>
<tr>
<td>Correlation .........................................................................................55</td>
</tr>
<tr>
<td>Scorecard Views ..................................................................................62</td>
</tr>
<tr>
<td>Scorecard Matrix ............................................................................62</td>
</tr>
<tr>
<td>Scorecard Quadrants ......................................................................63</td>
</tr>
<tr>
<td>Scorecard Dimensional Breakout ....................................................64</td>
</tr>
<tr>
<td>Scorecards Overview .....................................................................65</td>
</tr>
<tr>
<td>Objective Views ..................................................................................66</td>
</tr>
<tr>
<td>Objectives - Previous vs. Current .................................................66</td>
</tr>
<tr>
<td>Show Objectives (Curr vs. Prev) .....................................................67</td>
</tr>
<tr>
<td>Causes &amp; Effects ...............................................................................67</td>
</tr>
<tr>
<td>Understanding Compound Objectives and Consequences .......................68</td>
</tr>
<tr>
<td>Understanding Risks ..........................................................................70</td>
</tr>
<tr>
<td>Predictive Analysis Views ..................................................................70</td>
</tr>
<tr>
<td>Performance Trend (Predictive) .......................................................71</td>
</tr>
<tr>
<td>Histogram (Predictive) ....................................................................71</td>
</tr>
<tr>
<td>Measure Views ...................................................................................72</td>
</tr>
<tr>
<td>Show Measures ...............................................................................73</td>
</tr>
<tr>
<td>Measure Details .............................................................................74</td>
</tr>
<tr>
<td>Measure Breakout ...........................................................................75</td>
</tr>
<tr>
<td>Operational Report ............................................................................76</td>
</tr>
<tr>
<td>Project Views .....................................................................................77</td>
</tr>
</tbody>
</table>
Projects - Objectives

Project Impact

Project Detail

Aligned Projects

Process Views

Scorecard Aligned Processes by Objective

Processes - Objectives

Performance Views

Percent Reached Histogram

Performance Trend

Actual vs. Target Relationship

Properties Views

Measure Properties

Objective Properties

Perspective Properties

Project Properties

Process Properties

Related Properties

Using the Analysis Designer

Running the Metrics Across Dimension View

Running the Metrics Vertical Sort View

Running the Metrics Crosstab View

Creating Active Technologies Reports

Automatic Trend Dates

Hi-Mid-Low Raw Counts and Percents of Total

Variance by Value and Percent Reached

Ranking Metrics and Objectives

Categorizing a Saved Report

Saving a View

Running a Saved View

Editing a Saved View

Today Tab

Feedback Blogging

Scheduling Reports and Views
3. Performance Management Framework Author......................................................169

Implementing PMF.................................................................170
PMF Prerequisites...............................................................170
Getting Started as a PMF Author...........................................171
What You Should Know......................................................171
Authoring in PMF.................................................................171
   Scorecard Building Methodology....................................172
   Schemas...........................................................................173
Navigating PMF: Adding, Changing, and Deleting Items...............173
Scorecarding......................................................................174
Navigating the Author Tab...................................................175
   Navigating the Scorecard Tree........................................176
   Editing, Deleting, and Creating Scorecards......................178
Creating a New Scorecard....................................................180
   Scorecard Cascading.......................................................184
Creating Strategy and Risk Objects.......................................186

Managing Project Tasks.................................................................................................................................108
Managing Alerts..............................................................................................................................................112
   Viewing and Modifying Alerts.............................................113
   Creating a New Alert..........................................................115
Working With Measure Tasks...................................................121
Inputting User-Entered Measures.............................................125
Inputting User-Entered Sources..............................................127
Working with Dashboards........................................................128
   Dashboard Designer...........................................................129
   Personalizing Gadgets.......................................................142
   Resizing and Displaying Gadgets.......................................143
   Working with Gadget Tracking Menus...............................144
What is Broadcast?..............................................................147
Styling the Dashboard............................................................152
Using PMF Content on your Mobile Device.................................167
   Using the Ginsu Slicer.........................................................167
   Zooming in Mobile.............................................................168
Creating or Editing a Perspective.................................................................187
Creating or Editing an Objective.................................................................190
Creating or Editing a Compound Objective...............................................193
Creating or Editing a Risk............................................................................196
Creating or Editing a Consequence..............................................................199
Deleting a Strategy or Risk Object...............................................................203

Drawing a Strategy Map..................................................................................203
Adding Themes to a Strategy Map.................................................................208
Linking Projects and Processes to Objectives in the Strategy Map....................211
Understanding Measures.............................................................................213
  Adding and Editing Measures....................................................................213
Indicator Concepts.......................................................................................228
Weighting Measures Across Objectives.......................................................233
Weighting Objectives Across a Strategy.......................................................235
Automatic Equal Weighting.........................................................................237
Setting a Basis for Descending Measures...................................................239
Overriding Measures at the Measure Level................................................240
Documenting Your Work..............................................................................240
Scorecard-Specific Data Access Security....................................................241
Author Scorecard Options...........................................................................242
  Scorecard Perspectives..............................................................................243
  Objectives.................................................................................................244
  Risks.........................................................................................................246
  Scorecard Themes....................................................................................250
  Projects....................................................................................................251
  Processes.................................................................................................265

PMF Tabs - Quick Reference for Authors.....................................................267
  Author Tab...............................................................................................267
  Strategy Subtab.......................................................................................268

4. Performance Management Framework Administrator..........................271
  Getting Started as a PMF Administrator................................................272
    Functions of a PMF Administrator........................................................272
    Managing Metadata.................................................................................273
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thinking About Users and Security</td>
<td>274</td>
</tr>
<tr>
<td>Adding, Changing, Deleting, and Importing Users (Owners)</td>
<td>275</td>
</tr>
<tr>
<td>Importing Users (Owners)</td>
<td>278</td>
</tr>
<tr>
<td>Understanding Functional and Access Roles</td>
<td>280</td>
</tr>
<tr>
<td>Planning Considerations for Functional Roles</td>
<td>280</td>
</tr>
<tr>
<td>Working With Functional Roles</td>
<td>281</td>
</tr>
<tr>
<td>Working With Access Roles</td>
<td>289</td>
</tr>
<tr>
<td>Working With Scorecard Security</td>
<td>291</td>
</tr>
<tr>
<td>Scorecard Functional Access</td>
<td>292</td>
</tr>
<tr>
<td>Working With the New Data Model</td>
<td>295</td>
</tr>
<tr>
<td>The Core Paradigm</td>
<td>296</td>
</tr>
<tr>
<td>Migrating to the New Architecture</td>
<td>297</td>
</tr>
<tr>
<td>Data Lineage</td>
<td>300</td>
</tr>
<tr>
<td>Load, Recalculate, and Copy (LRC) Loads</td>
<td>302</td>
</tr>
<tr>
<td>What Are Sources?</td>
<td>305</td>
</tr>
<tr>
<td>Working With Loadable Sources</td>
<td>309</td>
</tr>
<tr>
<td>Working With User-Entered Sources</td>
<td>314</td>
</tr>
<tr>
<td>Working With Generated Sources</td>
<td>319</td>
</tr>
<tr>
<td>Load Now Panel</td>
<td>324</td>
</tr>
<tr>
<td>What Are Datapoints?</td>
<td>325</td>
</tr>
<tr>
<td>Derived Datapoints</td>
<td>327</td>
</tr>
<tr>
<td>Loadable Datapoints</td>
<td>334</td>
</tr>
<tr>
<td>Generated Datapoints</td>
<td>334</td>
</tr>
<tr>
<td>User Entered Datapoints</td>
<td>338</td>
</tr>
<tr>
<td>Scheduling Loads and Updates</td>
<td>338</td>
</tr>
<tr>
<td>Setting Measure Access for Users (Owners)</td>
<td>339</td>
</tr>
<tr>
<td>Specifying Dimensions and Measures</td>
<td>341</td>
</tr>
<tr>
<td>PMF Objectives</td>
<td>342</td>
</tr>
<tr>
<td>PMF Measures</td>
<td>343</td>
</tr>
<tr>
<td>PMF Dimensions</td>
<td>343</td>
</tr>
<tr>
<td>Creating Units of Measure Conversion Profiles</td>
<td>349</td>
</tr>
<tr>
<td>Planning Considerations for Loading Dimensions</td>
<td>351</td>
</tr>
<tr>
<td>Working With a Dimension Load</td>
<td>352</td>
</tr>
<tr>
<td>Designing Dimension Loads</td>
<td>352</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Working with Templates</td>
<td>438</td>
</tr>
<tr>
<td>Administration Views</td>
<td>440</td>
</tr>
<tr>
<td>Description of the Administration Views</td>
<td>442</td>
</tr>
<tr>
<td>Designing Gadgets</td>
<td>453</td>
</tr>
<tr>
<td>Designing a Gadget Procedure</td>
<td>453</td>
</tr>
<tr>
<td>Creating a Gadget</td>
<td>458</td>
</tr>
<tr>
<td>Creating Gadgets With WebFOCUS InfoAssist</td>
<td>459</td>
</tr>
<tr>
<td>Creating Gadgets Using an Analysis Designer Template</td>
<td>460</td>
</tr>
<tr>
<td>Saving Managed Reporting Content as a Gadget</td>
<td>461</td>
</tr>
<tr>
<td>Adding Various Content Types as Gadgets</td>
<td>462</td>
</tr>
<tr>
<td>Custom Parameters for Gadgets</td>
<td>464</td>
</tr>
<tr>
<td>Broadcast Capability for All Grid Gadgets</td>
<td>465</td>
</tr>
<tr>
<td>Turning a WebFOCUS Report Into a Gadget</td>
<td>467</td>
</tr>
<tr>
<td>Designing a Dashboard</td>
<td>478</td>
</tr>
<tr>
<td>Designing a Dashboard for Mobile Content</td>
<td>479</td>
</tr>
<tr>
<td>Manage Tab - Quick Reference</td>
<td>479</td>
</tr>
<tr>
<td>Manage Tab Components</td>
<td>480</td>
</tr>
<tr>
<td>Viewing and Editing Default Settings</td>
<td>495</td>
</tr>
<tr>
<td>Debugging Settings</td>
<td>496</td>
</tr>
<tr>
<td>Integration Settings</td>
<td>497</td>
</tr>
<tr>
<td>Load Settings</td>
<td>497</td>
</tr>
<tr>
<td>Look Settings</td>
<td>499</td>
</tr>
<tr>
<td>PMF Labs Settings</td>
<td>502</td>
</tr>
<tr>
<td>Project Settings</td>
<td>503</td>
</tr>
<tr>
<td>Security Settings</td>
<td>504</td>
</tr>
<tr>
<td>Summarization Settings</td>
<td>505</td>
</tr>
<tr>
<td>System Settings</td>
<td>508</td>
</tr>
<tr>
<td>UI Settings</td>
<td>511</td>
</tr>
<tr>
<td>Changing Language Display</td>
<td>513</td>
</tr>
<tr>
<td>A. Tips for Administrators and Authors</td>
<td>515</td>
</tr>
<tr>
<td>Displaying Static Tabs With Dynamic Dashboards</td>
<td>516</td>
</tr>
<tr>
<td>Administrators: Dashboard Design Tips</td>
<td>517</td>
</tr>
<tr>
<td>Administrators: Hiding Content From Users</td>
<td>518</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Analytics Tab</td>
<td>518</td>
</tr>
<tr>
<td>Administrators: Automated Upgrades</td>
<td>518</td>
</tr>
<tr>
<td>Administrators: Styling the Look and Feel of PMF</td>
<td>519</td>
</tr>
<tr>
<td>PMF Swatching System</td>
<td>521</td>
</tr>
<tr>
<td>Authors: Creating a Scorecard</td>
<td>523</td>
</tr>
<tr>
<td>Troubleshooting Measure Data Issues</td>
<td>523</td>
</tr>
<tr>
<td>Troubleshooting and Debugging Aids</td>
<td>524</td>
</tr>
<tr>
<td>Reader Comments</td>
<td>541</td>
</tr>
</tbody>
</table>
Preface

This manual describes how to install and use Performance Management Framework (PMF). It is divided into chapters designed for authors, administrators, and users.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Performance Management</td>
<td>Provides background information on PMF capabilities, components, and</td>
</tr>
<tr>
<td>Framework Overview</td>
<td>rollout process.</td>
</tr>
<tr>
<td>2 Performance Management</td>
<td>Describes logging on to the system, navigating PMF, viewing scorecard</td>
</tr>
<tr>
<td>Framework User</td>
<td>performance reports and associated drill downs, inputting user-entered</td>
</tr>
<tr>
<td></td>
<td>measures, entering feedback, utilizing gadgets, and scheduling alerts.</td>
</tr>
<tr>
<td>3 Performance Management</td>
<td>Describes how to design a strategy for a PMF application and support it</td>
</tr>
<tr>
<td>Framework Author</td>
<td>through a scorecard, create a Strategy Map that shows cause-and-effect</td>
</tr>
<tr>
<td></td>
<td>relationships, and work with perspectives, objectives, themes, projects,</td>
</tr>
<tr>
<td></td>
<td>processes, and measures.</td>
</tr>
<tr>
<td>4 Performance Management</td>
<td>Describes administrative capabilities of PMF, including setting up</td>
</tr>
<tr>
<td>Framework Administrator</td>
<td>users and their access rights, performing dimension and measure loads,</td>
</tr>
<tr>
<td></td>
<td>and establishing system default settings.</td>
</tr>
<tr>
<td>A Tips for Administrators and</td>
<td>Describes tips and troubleshooting techniques to aid Administrators and</td>
</tr>
<tr>
<td>Authors</td>
<td>Authors.</td>
</tr>
</tbody>
</table>

Performance Management Framework
# Documentation Conventions

The following table describes the documentation conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>THIS TYPEFACE</strong></td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td><em>this typeface</em></td>
<td></td>
</tr>
<tr>
<td><em>this typeface</em></td>
<td>Represents a placeholder (or variable) in syntax for a value that you or the system must supply.</td>
</tr>
<tr>
<td><em>underscore</em></td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td><em>this typeface</em></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td>{  }</td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td>[  ]</td>
<td>Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td>.</td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>
Related Publications

Visit our Technical Content Library at http://documentation.informationbuilders.com. You can also contact the Publications Order Department at (800) 969-4636.

Customer Support

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, http://www.informationbuilders.com. It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).
- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
Your server version and release. You can find this information using the Version option in the Web Console.

The stored procedure (preferably with line numbers) or SQL statements being used in server access.

The Master File and Access File.

The exact nature of the problem:

Are the results or the format incorrect? Are the text or calculations missing or misplaced?

Provide the error message and return code, if applicable.

Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. Please use the Reader Comments form at the end of this document to communicate your feedback to us or to suggest changes that will support improvements to our documentation. You can also contact us through our website http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.
For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
This chapter describes the capabilities, components, and rollout process of Performance Management Framework (PMF).

These topics are relevant for administrators, authors, developers, analysts, and consumers, including executives, managers, and workers.

Topics:

- Introduction to PMF
- Working With PMF
- WebFOCUS Components Used by PMF
- Finding It: Authors
- Finding It: Administrators
- Shared Roles for Authors and Administrators
- Finding It: Analysts
- Finding It: Consumers
- Finding It: Developers
- Finding It: Installers
- Milestones in the Performance Management Process
Introduction to PMF

PMF is a WebFOCUS application that allows your enterprise to store and track metrics and aggregate these metrics into scorecards to evaluate your enterprise goals. It also provides tools to help you keep the metrics updated with current data. PMF metrics are multi-dimensional, to let employees at all levels track their own progress and see how their work integrates with overall enterprise strategy.

PMF is a standard WebFOCUS application that runs on a WebFOCUS Reporting Server. It takes advantage of many of the capabilities of WebFOCUS, including tabular and financial reporting, user configuration, document distribution, and security.

Working With PMF

PMF utilizes standard tools, including tabs, trees, views, and forms, to provide advanced capabilities in three core areas:

- **Communication.** PMF provides you with multiple ways to summarize your metrics, communicate performance trends, distribute information to constituents, show important metrics, and track related projects and processes. You can also easily set up, distribute, and centrally manage customizable dashboards for each user.

- **Collaboration.** PMF includes many web 2.0 style collaboration capabilities that enable users to mesh their work with that of colleagues to discover, analyze, inform, document, and act.

- **Analysis.** PMF utilizes powerful analytic tools that enable you to trend, track, and discover the why behind the performance of your organization.

PMF delivers these communication, collaboration, and analysis capabilities through the following functionalities:

- **Fully Comment Capable.** Feedback blogging enables you to instantly enter feedback comments about measures and objectives to explain variances from targets. Each instance of feedback is stored and tracked by the user, and provides valuable data including Owner ID, the date and time the feedback was entered, percent of target achieved, and indicator color at the time of input. PMF also captures information on how metrics are calibrated, allowing full compliance with audit standards.

- **Planning, Budgeting, and Forecasting.** PMF has the capability to plug in standard budgeting and forecasting applications. These can be Information Builders produced, or an external budgeting or forecasting system. An open API allows you to integrate any forecasting application with PMF, to allow PMF data to be used in the forecasting tool, and to allow output of completed forecasts into PMF to create targets.
- **Customizability.** Every aspect of PMF is developer customizable. The scorecards, windows, forms, style sheets, and the underlying database are built with production WebFOCUS components. You can use WebFOCUS capabilities to change, revise, or extend any part of PMF.

- **User-friendly Scorecard Setup.** All work flow for adding, changing, and deleting scorecards and scorecard data, and input of strategies, perspectives, objectives, measures, and themes is done through user-friendly, web-based forms and wizards.

- **Powerful Analytics.** PMF has a full suite of views that allows analysis of your organization metrics both with and without a strategic component. In PMF, there are many ways you can slice and dice the multi-dimensional metrics. Structured ad hoc tools provide full ad hoc capability so you can design information presentations in millions of ways. PMF data is easy to integrate with the financial, process, and operational data for your enterprise.

- **Thin-client Strategy Map.** Unlike many other systems, PMF includes a built-in interactive Strategy Map. Based on industry-standard Scalable Vector Graphics (SVG), the Strategy Map has a live relationship to underlying scorecards and data and allows you to save your changes to the underlying scorecard, thus giving you an easy-to-use graphical method for updating the strategic flow of your organization.

- **Multi-Dimensional Data.** PMF has a built-in, cross-platform OLAP database that can be installed and used with any RDBMS. The database permits assigning measures to relationships with standard dimension types (for example, Location, Product, Customer, Time, Organization). In PMF, you can create up to 15 user-defined dimensions.

- **Loading Data.** PMF built-in dimension and measure loaders allow you to design your data loads and feeds for PMF using the flexible, powerful data extraction capabilities built into WebFOCUS. Scheduling your loads and feeds is an automated process.

- **Scorecard Inheritance.** PMF lets you cascade your scorecards so that you can create a top-level scorecard for high-level management, then let your scorecards for other levels of the organization hierarchy inherit one or more aspects of the management scorecard.

- **Standard Analysis Views.** PMF includes a pre-packaged set of financial, user, customer, location, time, and trend views that allows you to be instantly productive with the application as soon as it is deployed. You can also use the powerful ad hoc reporting capability of WebFOCUS to create any other views you need.

**Note:** You can access and use PMF from a standard web browser, including Mozilla Firefox® Version 2 and higher for any Consumer or Analyst role.

---

**WebFOCUS Components Used by PMF**

PMF incorporates nearly every product capability across the WebFOCUS product line. The WebFOCUS system components required for basic operation include the following:
WebFOCUS Reporting Server and WebFOCUS Client. Provides a standard reporting infrastructure including data access drivers, complex business rules, exports to Excel, HTML, and PDF, graphing capabilities, and drill downs.

WebFOCUS Managed Reporting. Provides user administration, a repository for storing components, and ad hoc and OLAP (online analytical processing) tools if you choose to expand the PMF application to include these.

WebFOCUS Business Intelligence Portal. Supports the selectable views needed for each distinct role in the PMF user base. Provides a customizable user interface.

WebFOCUS Maintain. Provides a platform for updating all data in the customer framework.

WebFOCUS ReportCaster. Delivers alerts and schedules metric loads. Also offers a library that allows tracking and history.

Optional components include:

- Adapters. For data and application access.
- ESRI. Allows GIS (Geographic Information System) operations to be performed in the field on a mobile device, on a desktop, and throughout the enterprise.
- Integrated Search (Magnify) Support. PMF supports full integration with WebFOCUS Magnify, which enables you to search for feedback, measure tasks, objectives, measures, and dimension-level values.
- Mapping/GIS Support. PMF allows you to place Google Maps™ or ESRI in a dashboard gadget and integrate Google Maps capabilities directly into the PMF dashboard.

Finding It: Authors

The role of author is one of the most important in the PMF design process. The main responsibility of an author is the overall metrics and strategic content of the PMF dashboard. This includes creating and maintaining strategies, scorecards, perspectives, objectives, and the Strategy Map. Authors also have input into the evaluative aspects of metrics.

For more information about the author's role, see Performance Management Framework Author on page 169.

Finding It: Administrators

Administrators are responsible for maintenance of the PMF system and its structures and controls. Administrators also typically perform the following tasks:

- Load dimensions and measures.
- Schedule and monitor regular loading to ensure that PMF data is current.
Set up owners and roles in PMF.

Create various other objects (such as unit of measure) used throughout PMF.

An administrator has access to all functionality in the PMF application, and administers all user access rights and permissions by assigning user roles. An administrator manages all components of the balanced scorecard.

The administrator also defines the source of the data for all the scorecard components for the initial loads and regular updates.

For more information about using PMF as an administrator, see Performance Management Framework Administrator on page 271. You may also want to consult the following documentation:

- WebFOCUS Security and Administration.
- ReportCaster Development and Administration.
- Data adapter documentation for your adapters.

Shared Roles for Authors and Administrators

PMF authors and administrators share the following functions:

- Review sources, datapoints, measures, and dimensions to ensure that the business requirements are met by the tasks being done by the administrators.
- Verify loads of strategies, measures, and dimensions.
- Verify the actual, target, and threshold amounts for each source, datapoint, and measure.

Finding It: Analysts

Analysts have access to all PMF views. They rigorously examine data at the deepest level using the PMF analytical capabilities and tools available to them. They can add comments to a scorecard that describe their analysis of the data.

For more information, see Performance Management Framework User on page 27.

Finding It: Consumers

Consumers display their own views, including the Strategy Map in read-only format, and provide comments on the results of a PMF scorecard.
Executives, managers, and workers are consumers. Executives and managers set targets (goals) for business objectives. They can, like all system users, add comments to a scorecard that help clarify variances from norms in measures, and provide additional contextual information about a scorecard.

For more information, see *Performance Management Framework User* on page 27.

**Finding It: Developers**

Developers customize PMF views and content. Typically, developers create new views against PMF data, transactional data sources, or warehouse data sources to enhance the PMF user experience. Since PMF is a fully customizable application framework, developers may also make minor modifications to PMF forms, trees, or other user interface or data components.

For more information about using PMF as a developer, see *Performance Management Framework Author* on page 169 and *Performance Management Framework Administrator* on page 271. You may also want to consult the following documentation:

- WebFOCUS Security and Administration
- WebFOCUS Managed Reporting Developer's Manual
- ReportCaster Development and Administration
- Describing Data With Graphical Tools
- Creating Reporting Applications With Developer Studio
- Developer Studio Application Development Getting Started
- PMF Developer Guide

**Finding It: Installers**

Installers install and configure PMF and integrate it with WebFOCUS components and any external security systems.

For more information about installing and configuring PMF, see the *Performance Management Framework Installation and Configuration Guide*. 

---

24 Information Builders
Milestones in the Performance Management Process

The PMF rollout process usually follows a straightforward pathway that looks like the following.

1. Performance Management Framework Overview
   - Installing System and Application Components
   - Configuring the Application
   - Configuring Security

Milestone I
Successful Installation

- Administrators
  - Acquire measures
  - Load dimensions and measures
  - Test loads
  - Interact with authors
  - Configure users and roles

- Authors
  - Create scorecards
  - Specify dimensions, measures, objectives, strategies, perspectives, projects, processes, and themes
  - Interact with Business Strategy Committee and Administrators

Milestone II
Scorecard Loaded

- Rollout to users
  - Each user has working applications that meet their business needs

Milestone III
User Satisfaction

- Production-Ready PMF

Milestone IV
Ongoing Administration and Authorship
This chapter provides instructions for working with Performance Management Framework (PMF) as a user.

**Topics:**
- PMF Overview
- Accessing Views
- Working With PMF Views
- Working With the Analytics Tab
- Strategy Map
- Previous vs. Current and Prior vs. Current
- Rolling 5 Periods
- Executive Booklet
- Correlation
- Scorecard Views
- Objective Views
- Understanding Compound Objectives and Consequences
- Understanding Risks
- Predictive Analysis Views
- Measure Views
- Project Views
- Process Views
- Performance Views
- Properties Views
- Using the Analysis Designer
- Today Tab
- Feedback Blogging
- Scheduling Reports and Views
- Managing Project Tasks
- Managing Alerts
- Working With Measure Tasks
- Inputting User-Entered Measures
- Inputting User-Entered Sources
- Working with Dashboards
- Using PMF Content on your Mobile Device
PMF Overview

In this section:
Changing Dashboard Gadgets and Preferences

How to:
Log On to PMF

PMF is a WebFOCUS application that allows your enterprise to track and store metrics, aggregate these metrics into scorecards to clearly evaluate your enterprise goals, and track projects and initiatives across your enterprise. It also provides tools to help you keep the metrics updated with current data. PMF metrics are multi-dimensional, to let you track your progress and see how your work integrates with overall enterprise strategy. PMF is a standard WebFOCUS application that runs on a WebFOCUS Reporting Server. It takes advantage of many of the capabilities of WebFOCUS.

PMF has a full suite of views that allows analysis of your organization metrics, with or without a strategic component. PMF metrics are multi-dimensional, giving you many ways to slice and dice your metrics. PMF also has structured ad hoc tools and full ad hoc capability to let you design information presentation in millions of ways. PMF data is easy to integrate with all financial, process, and operational data in your enterprise.

Procedure: How to Log On to PMF

Note: This procedure describes how to access the default PMF logon window. Depending on your configuration, your logon window or other means of accessing PMF might be different.

1. Navigate to the following URL to launch PMF

   http://server_name/

   where:

   server_name

   Is the name provided by your administrator.
A Performance Management Framework logon panel opens.

2. Type your user ID and password and click Logon.

When you first log on, the Today tab is the active tab. For details about the Today tab, see Today Tab on page 101. Another tab that is available is the Analytics tab. See Working With the Analytics Tab on page 41.

**Note:** Your login panel might be different, or your logon might be “single sign on”, which means you log on automatically.

**Changing Dashboard Gadgets and Preferences**

**How to:**

- Change the Display of Your Dashboard
- Change Your Personal Preferences
- Change Your Gadget Preferences

PMF displays gadgets and stores dashboards for each user. You can use either the Unlock the Dashboard button or the Preferences button in the upper-right corner of the Today tab to change the type of view displayed on your dashboard. You can also set up or modify personal information that applies to your PMF session.
For consumers and analysts, a separate Preferences button exists for each of the gadgets displayed on a dashboard. These gadgets display performance trend data that you can monitor daily. Each gadget has a Preferences button that enables you to change the values being used to display the data for that gadget. Each gadget has the following three icons you can select:

- Previous page icon. Goes back to the previous page.
- Preferences icon. Opens the change preferences panel.
- Refresh content icon. Refreshes to saved preferences.

Note: These three icons are removed from view when you click anywhere outside the action block.

Procedure: How to Change the Display of Your Dashboard

1. From your Today tab, click the Unlock the Dashboard icon located in the upper-right corner of the page.

   The Today Page drop-down menu appears to the left of the cluster of icons, as shown in the following image.

   ![Today Page drop-down menu](image)

   The Unlock the Dashboard icon is replaced by the following five icons:

   - Save your current Today Page preference icon
   - Add to Mobile Favorites icon
   - Create a new Today Page icon
   - Edit the current selected Today Page icon
   - Lock the Dashboard icon

   Note: Clicking the Save preferences or Lock the Dashboard icons replaces them with the unlock dashboard icon and hides the Today Page drop-down menu.

   The Edit Today page icon is only available if you have Administrator rights.

2. Select a different dashboard view from the Today Page drop-down menu.

   The previous view of your dashboard is replaced with the selected view.

3. Do one of the following:
To save the selected dashboard view, click the Save your current Today Page preference icon.

To create a new Today Page, click the Create a new Today page icon.

To edit the dashboard, click the Edit the current selected Today Page icon.

To keep the view, but not save it, click the Lock the Dashboard icon.

To restore the previous view, click the Refresh content icon.

Procedure: How to Change Your Personal Preferences

1. From your Today tab, click the Preferences icon.

   The following image shows the Change Preferences panel that opens, with sample values in the fields.

   ![Change Preferences Panel](image)

2. Review and modify the fields in the panel as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner Id</td>
<td>ID of the person currently logged on. You cannot change the value in this field.</td>
</tr>
<tr>
<td>First Name</td>
<td>First name of the person associated with the Owner Id.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name of the person associated with the Owner Id.</td>
</tr>
<tr>
<td>Your Email</td>
<td>Email address of the person associated with the Owner Id, used when Alerts are fired.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Today Page</td>
<td>Type of dashboard view displayed from the Today tab by default. You can change the view by selecting a different one from a catalog of personalized dashboards using the Today Page drop-down menu. You can click the Preview button to see what this view looks like. You can also change this option quickly by unlocking the Ribbon. See <em>How to Change the Display of Your Dashboard</em> on page 30.</td>
</tr>
<tr>
<td>Convert Units</td>
<td>If an administrator has created multiple conversion profiles, you can select a different profile (than the one assigned to you) using the Convert Units drop-down menu. Selecting a different profile converts and refreshes the metrics displayed in your views. Click the Change button to apply a selected conversion profile. <strong>Note:</strong> An administrator can also disable conversions.</td>
</tr>
</tbody>
</table>

3. After you make your changes, click **Save**.  
   **Note:** You can click **Change** to save your new preferences for the current session. The previous settings will be restored once the current session is over.

4. Click the **Refresh content** icon to make your changes effective.

*Procedure: How to Change Your Gadget Preferences*

1. Select any of the gadgets displayed on your dashboard, then click the **My Preferences for this Gadget** icon in the upper-right corner of the gadget.

The following image shows the Gadget Preferences panel that opens, with the current selection values in the drop-down menus.
2. To change values, use the drop-down menu next to the preference setting you want to change.

Depending on how the selected gadget was designed, you can change preferences using any of the available drop-down menus, which can include Groupings, Levels, and one or more Filters.

3. As you make changes, you can click Preview to redisplay the graph gadget.

Before you save your changes, you can click Revert to restore the previous settings or Close to exit the Preferences panel.

4. Click Save to retain your changes.

After saving your changes, the next time you refresh the page, or log out and log back in to PMF, the gadget you modified displays your changed preferences.

You can click the Refresh content icon in the upper-right corner of the graph gadget to view your changes now.

Accessing Views

If you are a consumer, you can access selected PMF views using the Today Page drop-down menu to select the view that appears on that page. For details, see Changing Dashboard Gadgets and Preferences on page 29.

If you are an analyst, you can access PMF views through the Analytics tab. For details, see Working With the Analytics Tab on page 41.

Working With PMF Views

Views in PMF are based on analysis of the metrics contained in PMF. They can also directly focus on any operational data used in PMF and/or related to PMF metrics.

Navigation in PMF views generally uses these components:

- **Forms.** Enable you to design presentations of PMF metrics data and interact with it in real time.
Metric Hierarchy Trees. Show the dimensional aspects of metrics, enabling you to select the level of aggregated metrics you are viewing.

Drill-down menus. Provide options throughout PMF views to navigate to other related data views or enter feedback by clicking hyperlinked measures, perspectives, objectives, projects, processes, dimensions, and data values.

Reference: Viewing a PMF Application

The PMF application uses icons in the panel of red/yellow/green stop lights, as well as gauges and charts, to show performance visually.

The following table lists and describes PMF default images and icons. These will vary depending on how you have configured the PMF indicator sets. For more information, see Look Settings on page 499.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Red Stop Light]</td>
<td>Red stop light</td>
<td>Measurement is below the desired threshold.</td>
</tr>
<tr>
<td>![Yellow Stop Light]</td>
<td>Yellow stop light</td>
<td>Measurement is in a satisfactory range.</td>
</tr>
<tr>
<td>![Green Stop Light]</td>
<td>Green stop light</td>
<td>Measurement is in a positive range.</td>
</tr>
<tr>
<td>![No Previous Data]</td>
<td>No previous data</td>
<td>No measure is present to draw an indicator.</td>
</tr>
<tr>
<td>![Up Arrow]</td>
<td>Up arrow</td>
<td>Measurement is closer to the target since the last update.</td>
</tr>
<tr>
<td>![Down Arrow]</td>
<td>Down arrow</td>
<td>Measurement is further from the target since the last update.</td>
</tr>
<tr>
<td>![Flat Arrow]</td>
<td>Flat arrow</td>
<td>There is no trending change.</td>
</tr>
<tr>
<td>![Red Metric Icon]</td>
<td>Red metric icon</td>
<td>Metrics below are lower than the desired threshold.</td>
</tr>
<tr>
<td>![Project Icon]</td>
<td>Project icon</td>
<td>Projects are aligned with the metric.</td>
</tr>
<tr>
<td>![Feedback Icon]</td>
<td>Feedback icon</td>
<td>Feedback has been recorded for the metric.</td>
</tr>
<tr>
<td>![Task Icon]</td>
<td>Task icon</td>
<td>Tasks are aligned to that metric.</td>
</tr>
</tbody>
</table>
An administrator can change the default indicator set (the stop lights) using the PMF Settings capability on the Manage tab. For more information, see *Performance Management Framework Administrator* on page 271.

**Universal Drill-Down Menus**

**In this section:**
Navigating the Drill System

The PMF Universal Drill system lets you drill the same way from charts, grids, and the Strategy Map, and combines all drills seamlessly.

You can right-click any data visualizer in a chart, and get a menu appropriate for that kind of data. The following image shows an example of metrics data.
If you click cells in a WebFOCUS Grid Gadget, the appropriate menu will also be displayed, as shown in the following image.
If you right-click an object in the Strategy Map, the Universal Drill will open and display the proper items for these objects, as shown in the following image.

Navigating the Drill System

The following are tips on how to navigate the drill system:

- The top item on the menu, your default Content for that object, always runs automatically when the menu displays.
- You can click other items on the menu to run them. The Drill window displays the Content and resizes itself to fit the Content you are displaying.
- You can click the Back button in the Drill menu, or your browser, to step yourself backwards along the path you took.

When drilling into data in a grid or chart, dimensional breadcrumbs display your drill path, making it easier for you to navigate backward through the drill hierarchy. The following image shows an example of a drill path.

- If the Content is larger than the available screen size, the browser scroll bars will engage, and let you scroll to see more of the Content. The Drill menu stays open while you do this.
To close the Drill menu system, click anywhere outside the menu. The menu closes automatically.

If you click a drill inside the Universal Drill window, the menus in the drill will follow your drill path, as shown in the following image.

For example, if you click 2010/04, the drill menus shown in the following image will display Dimensional choices, which are what the Measure Detail grid expect.

If you continue to click new drills, new menus as are appropriate, in turn, replace the menus that were there.
For information on how to control the content visible from a drill, see *Control Drill Menus for Measures* on page 390.

## Drill-Down Options

<table>
<thead>
<tr>
<th>Reference:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perspective Drill-Down Options</td>
</tr>
<tr>
<td>Objective Drill-Down Options</td>
</tr>
<tr>
<td>Default Measure Drill-Down Options</td>
</tr>
<tr>
<td>Project Drill-Down Options</td>
</tr>
<tr>
<td>Process Drill-Down Options</td>
</tr>
</tbody>
</table>

The drill-down options available for each hyperlinked item listed under a specific column heading are standardized. For example, all hyperlinked items in the Objective columns of PMF provide the same set of drill-down menu options. The same is true for the other columns. The following topics show the available drill-down options by column heading.

### Reference:  Perspective Drill-Down Options

The following drill-down options are available from the hyperlink menus in the Perspective column throughout the views in PMF.

- *Show Objectives (Curr vs. Prev).* For details, see *Show Objectives (Curr vs. Prev)* on page 67.
- *Causes & Effects.* For details, see *Causes & Effects* on page 67.
- *Graph: Performance Trend.* For details, see *Performance Trend* on page 83.
- *Related Properties.* For details, see *Related Properties* on page 88.
- *Perspective Properties.* For details, see *Perspective Properties* on page 86.

### Reference:  Objective Drill-Down Options

The following drill-down options are available from the hyperlink menus in the Objective column throughout the views in PMF. In some views, these drill-down options are also available in the Caused By and Affects columns.

- *Show Measures (Curr vs. Prev).* For details, see *Show Measures* on page 73.
- *Causes & Effects.* For details, see *Causes & Effects* on page 67.
- *Graph: Performance Trend.* For details, see *Performance Trend* on page 83.
Aligned Projects. For details, see Aligned Projects on page 79.

Aligned Processes. For details, see Scorecard Aligned Processes by Objective on page 80.

Operational Report. For details, see Operational Report on page 76.

Related Properties. For details, see Related Properties on page 88.

Objective Properties. For details, see Objective Properties on page 86.

**Reference:** Default Measure Drill-Down Options

The following drill-down options are available from the hyperlink menus in the Measure and Measure Series columns throughout the views in PMF.

**Note:** These are the default settings for drill-down options. These menus are configurable. For more information, see Control Drill Menus for Measures on page 390.

- Operational Report. For details, see Operational Report on page 76.
- Measure Breakout. For details, see Measure Breakout on page 75.
- Graph: Performance Trend. For details, see Performance Trend on page 83.
- Graph: Actual vs. Target Relationship. For details, see Actual vs. Target Relationship on page 84.
- Graph: % Reached Histogram. For details, see Percent Reached Histogram on page 82.
- Graph: Performance Trend (Predictive). For details, see Performance Trend (Predictive) on page 71.
- Graph: % Reached Histogram (Predictive). For details, see Histogram (Predictive) on page 71.
- Input Measure Values. This option opens the Data Entry panel and is available for user-entered measures only. For more information, see Inputting User-Entered Measures on page 125.
- Related Properties. For details, see Related Properties on page 88.
- Measures Properties. For details, see Measure Properties on page 85.

**Reference:** Project Drill-Down Options

The following drill-down options are available from the hyperlink menus in the Project columns throughout the views in PMF.

- Project Impact. For details, see Project Impact on page 78.
Project Properties. For details, see Project Properties on page 87.

Operational Report. For details, see Operational Report on page 76.

Project Detail. For details, see Project Detail on page 79.

Related Properties. For details, see Related Properties on page 88.

Reference: Process Drill-Down Options

The following drill-down options are available from the hyperlink menus in the Process columns throughout the views in PMF.

- Operational Report. For details, see Operational Report on page 76.
- Related Properties. For details, see Related Properties on page 88.
- Process Properties. For details, see Process Properties on page 88.

Working With the Analytics Tab

In this section:

Drilling to Atomic Measures

The Analytics tab is where you can perform analysis in PMF. This tab hosts the Strategy Map and Analysis Designer, as well as a set of standard dimension and perspective views.

To run the views on the Analytics tab, select a type of view from the Type drop-down menu and select a specific view from the View drop-down menu, then click Run to display the results. The following are just some of the available views:

- Strategy Map. For details, see Strategy Map on page 42.
- Previous vs. Current. For details, see Previous vs. Current and Prior vs. Current on page 46.
- Last 5 Periods. For details, see Rolling 5 Periods on page 47.
- Executive Booklet. For details, see Executive Booklet on page 49.
- Scorecard Matrix. For details, see Scorecard Views on page 62.
- Correlation. For details, see Correlation on page 55.

For more information about the Analysis Designer, including information about the Metrics Analysis and Metrics Grid views, see Using the Analysis Designer on page 89.
Drilling to Atomic Measures

You can drill down from any high-level measure in the Objective column of a PMF view to the next level in the dimension hierarchy, and continue moving down until you reach the lowest atomic measure for that objective. From the lowest atomic measure, dimensional cross-drills are built into the summary row titles.

The dimensional cross-drills follow the same logic used in PMF Analysis Designer views. For any metric, in any dimension, you can perform research by drilling up and down the dimension hierarchy to verify totals, extract information, and determine the root cause of any issue.

Strategy Map

A Strategy Map is a graphical representation of the objectives used in your strategy. It shows the cause and effect linkages between leading and lagging objectives, and places the objectives within the perspectives that are significant for your enterprise.

The PMF read-only Strategy Map displays indicators that show the performance of metrics linked to the objectives displayed. The layout of the Strategy Map shows the relationship between objectives for your operational area of the enterprise. The indicators show an aggregate overall performance of the metrics you own for each of your objectives. The links between objectives for your enterprise represent the strategy of your enterprise.

With the Strategy Map, you can view objective properties, drill down to underlying measures, drill out to operational views, and access the cascade of scorecards using intuitive links and menus.

To display the Strategy Map, select Analysis from the Type drop-down menu on the Analytics tab, then select Strategy Map from the View drop-down menu, and click Run.

Note: When you run PMF in Internet Explorer, you can use the Renesis or the SVG Map plug-ins as a way to increase the flexibility of PMF.
The following is an example of a PMF read-only Strategy Map.
Right-clicking an Objective on the Strategy Map displays additional options, as shown in the following image.

These options include:

- **Operational Report.** Runs the default view associated with the selected objective, set up by your administrator.

- **Show Measures (Current vs. Prev).** Runs the Show Measures view, in which the current measures for the objective are compared to previous measures.

- **Feedback.** Displays the Feedback panel, where you can view the existing comments on the objective or enter a comment of your own.

- **Graph: Performance Trend.** Runs the Objectives Performance view for the objective.

- **Aligned Projects.** Displays the projects aligned to the objective.

- **Aligned Processes.** Displays the processes aligned to the objective.

- **Aligned Tasks.** Displays the tasks aligned to the objective.

- **Objective Properties.** Displays the properties for the objective, such as the theme and date of creation.
Related Properties. Displays additional properties for the objective, such as the aligned measure series, projects, and processes.

For consumers and analysts, the Strategy Map is read-only. For authors, the Strategy Map can be read/write if it has been configured that way by the administrator. For more information about working with the Strategy Map as an author, see Performance Management Framework Author on page 169.

Interactive Highlighting on the Strategy Map

If you have created Themes for a Scorecard, the Strategy Map in PMF displays a legend that lists the Themes and indicates by color, which themes have been assigned.

Note: Themes are represented using a color halo around linked Objectives.

In the read/write Strategy map on the Strategy tab, you can drag and place the Theme legend anywhere you want on the surface of the Strategy Map. When you click Save, the position for the Themes legend is stored.

The Themes legend appears in:

- The read only Strategy Map.
- The read/write Strategy Map (for example, the Strategy tab).
The embedded Strategy Map graphic as placed in the Executive Briefing Booklet (PDF View).

**Cause and Effect Drills**

Cause and effect drills are now available in the Strategy Map. Clicking on any Objective, Compound, Risk, or Consequence on the Strategy Map shows the immediate causes and effects.

![Strategy Map Graphic](image)

**Note:** You can also see these drills by right-clicking any Objective, Compound, Risk, or Consequence and selecting *Cause and Effect*.

**Previous vs. Current and Prior vs. Current**

PMF provides both a Previous vs. Current view and a Prior vs. Current view. The Previous vs. Current view displays current and previous period achievement for all metrics to which you currently have access. The Prior vs. Current view displays current and prior period achievement for all metrics to which you currently have access. The prior period is one year before at the same time of year. The previous period depends on the time dimension being measured. If dealing with monthly data, the previous period is the previous month. For both views, metrics are automatically aggregated. These views roll across time, so that the two compared periods are always sensitive to the current date.

To run the Previous vs. Current view from the Analytics tab, select *Analysis or Measures Detail* in the Type drop-down menu, then select *Measures - Previous vs. Current* from the View drop-down menu and click *Run*.
The following is an example of the Previous vs. Current view, which displays the heading Metric - Previous vs. Current w/Trend.

To run the Prior vs. Current view, select Analysis or Measures Detail in the Type drop-down menu of the Analytics tab, then select Measures - Prior vs. Current from the View drop-down menu and click Run.

The following is an example of the Prior vs. Current view, which displays the heading Metric - Prior vs. Current.

For these views, the navigation tree on the left permits you to drill down and analyze measures at the lowest dimensional level. The view automatically reformats itself appropriately, depending on the dimensional level you select. For example, if you drill into the Time dimension and choose only the current period, the previous period is automatically omitted from the view.

The views also provide the ability to drill into the properties for any item in the Measure column to display additional views that show how the measure was loaded, what calculations were used to create it, and so on. To display additional data related to a measure, click a hyperlinked item in the Measure column and select the desired option. For a list of the available drill-down options, see Default Measure Drill-Down Options on page 40.

**Rolling 5 Periods**

The Rolling 5 Periods view displays the current period and four previous periods worth of achievement for all metrics to which you currently have access. Metrics are automatically aggregated. The view rolls across time, so the last five periods are always sensitive to the current date.
To run the Rolling 5 Periods view, select Analysis or Measures Detail in the Type drop-down menu of the Analytics tab, then select Measures - Rolling 5 Periods from the View drop-down menu and click Run.

The following is an example of the Rolling 5 Periods view, which displays the heading Metric - Rolling n Periods.

![Example of Rolling 5 Periods view](image)

The navigation tree on the left permits you to drill down and analyze measures at the lowest dimensional level. The view automatically reformats itself appropriately, depending on the level of dimensionality you select. For example, if you drill into the Time dimension and choose the current period, the previous periods are automatically omitted from the view. If you choose only the current year, only periods that fall into this year are displayed.

The view also provides the ability to drill into the properties for any item in the Measure column to display additional views that show how the measure was loaded, what calculations were used to create it, and so on. To display additional data related to a measure, click a hyperlinked item in the Measure column and select the desired option. For a list of the available drill-down options, see Default Measure Drill-Down Options on page 40.
Executive Booklet

In this section:
- Executive Briefing Booklet - PDF
- Executive Briefing Booklet - PowerPoint
- Strategy Relationships
- Objectives Summary
- Objectives Performance
- Projects
- Processes

The Executive Booklet provides summary views of the enterprise strategy, with critical details provided on breakout pages. These views enable you to examine relationships between all objectives, perspectives, projects, and processes, in one location.

The views in the Executive Booklet, represented by links in the left pane, are as follows:

- **Strategy.** Shows the relationships within a scorecard in the Strategy Relationships view. This is the default view in the Executive Booklet.

- **Objectives Summary.** Summarizes the achievement of overall scorecard goals in the Scorecard Objectives Summary.

- **Objectives Performance.** Graphically displays recent performance trends for all objectives in every perspective to highlight areas that need attention.

- **Projects.** Shows relationships between the projects and objectives within a scorecard in the Scorecard Projects view.

- **Processes.** Shows relationships between the processes and objectives within a scorecard in the Scorecard Processes view.

To run the Executive Booklet, select Analysis in the Type drop-down menu of the Analytics tab, then select Executive Booklet from the View drop-down menu.

You can also access the Executive Booklet in PDF or PowerPoint formats, which provide enterprise strategy views plus a view of the strategy map in one PDF or PowerPoint®. For details, see Executive Briefing Booklet - PDF on page 50 or Executive Briefing Booklet - PowerPoint on page 50.
Executive Briefing Booklet - PDF

The Executive Briefing Booklet in PDF format provides summary views of the enterprise strategy and a view of the strategy map formatted in a PDF report. This report includes a title page, and a table of contents that displays when the report opens. To access the Executive Briefing Booklet in PDF format, select Analysis in the Type drop-down menu of the Analytics tab, then select Executive Briefing Booklet - PDF from the View drop-down menu.

The views in the PDF version of the Executive Briefing Booklet are represented by the following links in the table of contents:

- **Strategy Map.** Shows a full-color graphical image of the Strategy Map.
- **Strategy.** Shows the cause-and-effect relationships within the selected scorecard.
- **Objectives Summary.** Shows a summary overview of all of the objectives in the selected scorecard including descriptions and comments.
- **Projects.** Shows a summary overview of all of the projects aligned to the selected scorecard including details and performance data for the aligned objectives.
- **Processes.** Shows a summary overview of all of the processes aligned to the selected scorecard including details and performance data for the aligned objectives.

There are no drill-down options available in the PDF version of the Executive Briefing Booklet.

Executive Briefing Booklet - PowerPoint

The Executive Briefing Booklet in PowerPoint format provides summary views of the enterprise strategy and a view of the strategy map formatted in a PowerPoint report. To access the Executive Briefing Booklet in PowerPoint format, select Analysis in the Type drop-down menu of the Analytics tab, then select Executive Briefing Booklet - PPT from the View drop-down menu.

The PowerPoint version of the Executive Briefing Booklet is presented as a slide show that you view by clicking the interface to see each of the following views:

- **Strategy Map.** Shows a full-color graphical image of the Strategy Map.
- **Strategy Relationships.** Shows the cause-and-effect relationships within the selected scorecard.
- **Objectives Summary.** Shows a summary overview of all of the objectives in the selected scorecard including descriptions and comments.
- **Projects - Objectives.** Shows a summary overview of all of the projects aligned to the selected scorecard including details and performance data for the aligned objectives.
- **Processes - Objectives.** Shows a summary overview of all of the processes aligned to the selected scorecard including details and performance data for the aligned objectives.
There are no drill-down options available in the PowerPoint version of the Executive Briefing Booklet.

**Strategy Relationships**

When you first run the Executive Booklet, the default view is Strategy Relationships. It shows the relationships between the measures and objectives for every perspective in a particular scorecard.

Strategy Relationships displays hyperlinked metrics in each of its columns. To display related data for a perspective, click a Perspective hyperlink and select the desired option. For a list of the available drill-down options, see *Perspective Drill-Down Options* on page 39. To probe deeper into the metrics listed in the Objective, Caused By, and Affects columns, click a hyperlink and select the desired option. For a list of the available drill-down options, see *Objective Drill-Down Options* on page 39.

You can also access Strategy Relationships by selecting Analysis in the Type drop-down menu of the Analytics tab, then selecting Strategy Relationships from the View drop-down menu.
Objectives Summary

If you click **Objectives Summary** in the left section of the Executive Booklet, the Scorecard Objectives Summary opens, as shown in the following image. It displays descriptions for each objective, within each perspective, for a scorecard.

The Objectives Summary displays hyperlinked metrics in the Perspective and Objective columns.

To display related data for a perspective, click a Perspective hyperlink and select the desired option. For a list of the available drill-down options, see *Perspective Drill-Down Options* on page 39.

To probe deeper into the metrics listed in the Objective column, click a hyperlink and select the desired option. For a list of the available drill-down options, see *Objective Drill-Down Options* on page 39.
Objectives Performance

If you click Objectives Performance in the left section of the Executive Booklet, the Objectives Performance view opens, as shown in the following image. It provides a graphical view of all the objectives for each and every perspective in a scorecard.

There are no drill-down options available from the Objectives Performance view.

You can also access Objectives Performance by selecting Analysis in the Type drop-down menu of the Analytics tab, then selecting Objectives Performance from the View drop-down menu.
Projects

If you click Projects in the left section of the Executive Booklet, the Projects - Objectives view opens, as shown in the following image. It provides a detailed description of each project and related objective, including the associated start and end dates.

The Projects - Objectives view displays hyperlinked metrics in the Project and Objective columns.

To display related data for a project, click a Project hyperlink and select the desired option. For a list of the available drill-down options, see Project Drill-Down Options on page 40.

To probe deeper into the metrics listed in the Objective column, click a hyperlink and select the desired option. To view the available drill-down options, see Objective Drill-Down Options on page 39.
Processes

If you click Processes in the left section of the Executive Booklet, the Processes - Objectives view opens, as shown in the following image. It provides a detailed description of each process and related objective.

The Scorecard Processes view displays hyperlinked metrics in the Process and Objective columns.

To display related data for a process, click a Process hyperlink and select the desired option. For a list of the available drill-down options, see Process Drill-Down Options on page 41.

To probe deeper into the metrics listed in the Objective column, click a hyperlink and select the desired option. For a list of the available drill-down options, see Objective Drill-Down Options on page 39.

Correlation

**How to:**

Run a Correlation View

You can view any two metrics, two objectives, or one metric and one objective, to determine their relationship, or correlation. For example, you can:

- Determine if there is a real cause-and-effect relationship between two measurements, and if so, determine if it is positive or negative.
Correlate the performance of a single metric in the different areas of your organization to see if the performance is part of a general trend, or is an outlier that is statistically unrelated to the rest of the data.

Use the correlation results to help you set targets for individual areas in your organization.

There are many ways to correlate data using various statistical methods. PMF uses the percent achieved of an objective or measure to determine how points of data are plotted on the Correlation scatter plot. Each plotted dot represents the intersection of a single point in time for two different metrics. The Correlation view displays a linear plot showing the relationship between all points of data.

The following is an example of the PMF Correlation view.

The Correlation view also displays the correlation coefficient equation, which indicates the correlation of the data. The following are the three possible types of Correlation:

- **Positive Correlation.** When the correlation coefficient is close to +1, there is a positive relationship between changes in the two measurements. This indicates that when one measurement improves, it causes the other measurement to improve in an equally positive manner.
Negative correlation. When the correlation coefficient is close to -1, there is a negative relationship between changes in the two measurements. This indicates that when one measurement improves, it causes the other measurement to decline in an equally negative manner. For example, if one measurement improved by 10 percent, the other measurement declined by 10 percent.

Zero correlation. When the correlation coefficient is close to zero, there is no linear relationship between changes in the two measurements. This indicates that there is a very low or non-existent level of correlation between the two measurements.

Procedure: How to Run a Correlation View

1. Select the Analytics tab.
2. Select Analysis, Objective, or Measures Detail from the Type drop-down menu and select Correlation from the View drop-down menu.
3. Select a value from the Time range drop-down menu. When you run the view, it will display data for the selected time range.
   Tip: Selecting the widest possible range of time that is appropriate for your needs utilizes the most data and produces the most accurate correlation results.
4. Specify the X-Axis options.
   - Select the Measure radio button to display a measure on the X-Axis, or select the Objective radio button to display an objective on the X-Axis.
   - Select the specific measure or objective from the drop-down menu beneath the radio buttons.
     If you selected Metric in the Synchronize Y to X axis on field, the Y-Axis metric will mirror the X-Axis metric that you choose here.
   - Select the dimension and its value from the drop-down menus, or select All to display information at the top level of that dimension.
     If you selected Dimension in the Synchronize Y to X axis on field, the Y-Axis dimension values will mirror the X-Axis dimension values that you choose here.
5. For the Synchronize Y to X axis on field:
   - Select Dimension to compare different measures or objectives on the X-Axis and Y-Axis, with the same dimension value on the X-Axis and Y-Axis. This option causes the Y-Axis dimension value to mirror the X-Axis dimension value.
   - Select Metric to compare the same measure or objectives on the X-Axis and Y-Axis, with different dimension values on the X-Axis and Y-Axis. This option causes the Y-Axis measure or objective value to mirror the X-Axis measure or objective value.

- Select the **Measure** radio button to display a measure on the Y-Axis, or select the **Objective** radio button to display an objective on the Y-Axis.
- Select the specific measure or objective from the drop-down menu beneath the radio buttons.
  
  If you selected Metric in the Synchronize Y to X axis on field, the metric chosen for the X-Axis automatically appears here.

- Select the dimension and its value from the drop-down menus, or select **All** to display information at the top level of that dimension.
  
  If you selected Dimension in the Synchronize Y to X axis on field, the dimension and its value chosen for the X-Axis automatically appears here.

7. Click **Correlate** when you have supplied the criteria.

  **Tip:** Depending on your browser security, you might be asked if you want to open or save the file. Click **Open**.

  PMF generates two views.

---

**Example:** Correlating Sales and Profit in Boston

As manager of the Boston sales office, you frequently research cause-and-effect relationships to find ways to improve the contribution of your office to the health of the company. The Boston sales office in your organization has shown strong sales. You would like to see how sales have affected profit. To correlate sales and profit in the Boston office:

1. Select the **Analytics** tab.

2. Select **Analysis**, **Objective**, or **Measures Detail** from the Type drop-down menu.

3. Select **Correlation** from the View drop-down menu.

4. For the Time range field, select **Current Period**.

5. For the X-Axis, select the **Measure** option.

   In the drop-down menu below the Measure and Objective options, select **Sales**. In the Dimension drop-down menu, select **Organization** and select **Boston** in the drop-down menu below that, under **Sales**, **US**, and **East Cost**.

   Notice that the value for the Dimension field **Organization** and the value for **Organization Boston** automatically appear in the Y-Axis specification.
6. In the Synchronize Y to X axis on field, select the Dimension option.

7. For the Y-Axis, select the Measure option.

8. In the drop-down menu below the Measure and Objective options, select Profit.

9. Click Correlate.
PMF displays a scatter plot, and correlation data in an Excel spreadsheet below, to compare sales and profit for the Boston office.

![Scatter plot and correlation data](image)

**Example: Correlating Profit in Boston and St. Louis**

The Boston stores in your company historically report a profit that reflects a national trend, while the St. Louis stores historically fall below that trend. You need to examine how St. Louis profit is doing compared to the national trend reflected by Boston profit. To correlate profit in the St. Louis stores with profit in the Boston stores:

1. Select the Analytics tab.
2. Select Analysis, Objective, or Measures Detail from the Type drop-down menu.
3. Select Correlation from the View drop-down menu.
4. For the Time range field, select Current Period.
5. In the Synchronize Y to X axis on field, select the Metric option.
6. For the X-Axis, select the Measure option.
7. In the drop-down menu below the Measure and Objective options for the X-Axis, select Profit.
Notice that the Profit measure automatically appears in the Y-Axis specification.

8. For the X-Axis, in the Dimension drop-down menu, select *Location*.
   In the drop-down menu below Dimension, select BOS (Boston).

9. For the Y-Axis, in the Dimension drop-down menu, select *Location*.
   In the drop-down menu below Dimension, select STL (St. Louis).

10. Click *Correlate*.
PMF displays two views comparing profit in Boston and St. Louis.

Scorecard Views

In this section:
Scorecard Matrix
Scorecard Quadrants
Scorecard Dimensional Breakout
Scorecards Overview

The following topics describe and show details of the scorecard-related views that are available in PMF.

Scorecard Matrix

The Scorecard Matrix is designed to support the actual practice of strategy determination at your site. It displays all perspectives you have prototyped in the PMF system, and the objectives for each perspective. It also shows the cross-scorecard weights for each objective. This helps you quickly display all your corporate or team objectives with their weighted importance, which will help your executive team approve your overall strategy.
To run the Scorecard Matrix, select *CPM/BPM Practice* in the Type drop-down menu of the Analytics tab and select *Scorecard Matrix* from the View drop-down menu.

The following is an example of the Scorecard Matrix.

![Scorecard Matrix example](image)

There are no drill downs available from the Scorecard Matrix.

**Scorecard Quadrants**

The Scorecard Quadrants view shows objectives and related measures for each perspective group within the scorecard.
The following image is an example of a Scorecard Quadrants view.

Note: This view only shows perspective quadrants when you are using a scorecard that utilizes four perspectives.

Scorecard Dimensional Breakout

The Scorecard Dimensional Breakout View displays current and previous period achievement for the selected scorecard for all strategic rollups to which you currently have access. Metrics are automatically aggregated. The view rolls across time, so that the two compared periods are always sensitive to the current date.
To run the Scorecard Dimensional Breakout View, select **CPM/BPM Practice**, **Objective**, or **Perspective** in the Type drop-down menu of the Analytics tab, then select **Scorecard Dimensional Breakout** from the View drop-down menu. The following is an example of a Scorecard Dimensional Breakout view.

### Scorecards Overview

The Scorecards Overview displays previous and current statistics for all scorecards. You can also drill down to any of the scorecards and associated perspectives. This view is particularly useful to executive level users as it summarizes achievement of all goals in a scorecard taking into account the individual weights for each objective and their related metrics. Note that the Scorecards Overview is the only view in PMF that works across scorecards.
Objective Views

The following topics describe some of the objective-related views that are available in PMF.

Objectives - Previous vs. Current

The Objectives - Previous vs. Current view displays current and previous period achievement and comparative weights for the primary objectives across all perspectives for the selected scorecard. This view displays a dimension tree to the left of the report that enables you to drill into the underlying metrics of any particular area of the scorecard. You can analyze the previous and current period performance of the objectives for any aspect of any dimension.

To run the Objectives - Previous vs. Current view, select Analysis, Objective, or Perspective in the Type drop-down menu of the Analytics tab, then select Objectives - Previous vs. Current from the View drop-down menu.

The following image is an example of the Objectives - Previous vs. Current view, which displays the heading Perspective - Objectives Summary Grid.

When using the tree to drill into a specific area of the scorecard, the view is refreshed and a summary of the type of objectives you are viewing appears at the bottom of the report.
For example, if you expand the Organization folder, drill into the Sales subfolder, and select US, the following summary information appears below the report data:

**Scorecard: CenturyCorp Card**
Division: Sales
Country: US
Time Range: Previous vs. Current

**Show Objectives (Curr vs. Prev)**

When you click a Perspective drill-down hyperlink, for example, in the Strategy view of the Executive Booklet, and select *Show Objectives (Curr vs. Prev)*, the drill down takes you to the Objectives view, as shown in the following image.

In this view, current metrics for an objective are compared to previous metrics for the selected objective, and the trend, scorecard weight, and perspective weight are displayed.

To display related data for an objective, click an Objective hyperlink and select the desired option. For a list of available drill-down options, see *Objective Drill-Down Options* on page 39.

**Causes & Effects**

When you click a drill-down hyperlink, for example, in the Stop Light view, and select *Causes & Effects*, the drill down takes you to the Causes & Effects view, which contains data showing strategy relationships. If you have a strategy set up in PMF, you can drill down to research strategic relationships for any metric.
Cause and effect relationships cascade automatically as you navigate drill-down hyperlinks for metrics in the *Caused By* and *Affects* columns to move up and down the strategic chain of events. The following is an example of the Causes & Effects view.

The Causes & Effects view displays hyperlinked metrics in the Perspective, Objective, Caused By, and Affects columns.

To display related data for the perspective, click the Perspective hyperlink and select the desired option. For a list of the available drill-down options, see *Perspective Drill-Down Options* on page 39.

To probe deeper into the metrics listed in the Objective, Caused By, and Affects columns, click a hyperlink and select the desired option. For a list of the available drill-down options, see *Objective Drill-Down Options* on page 39.

**Understanding Compound Objectives and Consequences**

A compound objective links multiple causative objectives into a grouping on a Strategy Map. When included on a dashboard, a view, or a Strategy Map, a compound objective displays the aggregate values of the contributing objectives.
The following image shows a sample compound objective on a Strategy Map. The compound objective is named Blended Profit Goal. In this example, the contributing objectives are Profit up 20 Pct and Margin up 10 Pct. Those objectives were assigned a weight (priority) by the author at your site.

A risk represents a specific problem or threat to your enterprise. A consequence links multiple causative risks into a grouping on a Strategy Map. A consequence displays the aggregate values of the contributing risks.

The following image shows a sample consequence on a Strategy Map. The consequence is named Delisting from Stock Market. In this example, the contributing risks are Internal Fraud and Programming errors in systems. Those risks were assigned a weight (priority) by the author at your site.

On a Strategy Map, you can click an object type on the legend to highlight that specific type. For example, you can click Risk on the legend to highlight only the risk objects on the Strategy Map. This capability supports a live discussion about the risk performance of your business strategy.
Understanding Risks

A risk describes an area that you are measuring that represents a specific problem, or threat, to your enterprise. Risks can be placed on the Strategy Map and different metrics can be linked to each risk.

The following image shows a sample risk, named Internal Fraud, on a Strategy Map.

On a Strategy Map, you can click an object type on the legend to highlight that specific type. For example, you can click Risk on the legend to highlight only the risk objects on the Strategy Map. This capability supports a live discussion about the risk performance of your business strategy.

Predictive Analysis Views

In this section:

- Performance Trend (Predictive)
- Histogram (Predictive)

PMF allows you to apply predictive analysis to your measures. You can design a view that shows historical metrics and predicts future results, using a wide range of patterns and sampling frequencies. PMF analyzes data using all available forecasting models, finds the one that best predicted past performance, and applies it to predict future performance.

Results are displayed in a side-by-side view that shows the patterns of change for the metrics. You can use these results as the basis for planning, or to demonstrate how an existing business strategy is most likely to succeed or fail.

To fully utilize the predictive analysis functionality of PMF, you should configure predictive processing for specific measures to make forecasting results available in related views and reports. When configuring predictive methods, a map of all available prediction methods and sampling frequencies is presented for you to determine which ones provide the best results. You can easily select and change the method and sampling frequency used for predictive analysis without having any forecasting or advanced mathematics knowledge. Configuring predictive processing is performed by authors and administrators from the Edit Measure Metadata panel. For more information, see How to Configure Predictive Data on page 406.
The following topics describe and show details of the views that use predictive analysis and forecasting to extend trends into the future. These views are available as drill-down options.

**Note:** To enable users to distinguish between standard and predictive actual and target data displayed in some views and reports, cells containing predictive data have a different background color.

**Performance Trend (Predictive)**

When you click a Measure drill-down hyperlink, for example, Margins, and select Graph: Performance Trend (Predictive), the drill down takes you to the Performance Trend view, as shown in the following image.

![Performance Trend](image)

The Performance Trend predictive view shows the performance achievement for both past and future time periods, displaying graphic performance indicators side-by-side to visually show patterns of change in the metrics.

There are no additional drill downs available from this view.

**Histogram (Predictive)**

When you click a Measure drill-down hyperlink, for example, Sales, and select Graph: % Reached Histogram (Predictive), the drill down takes you to the Performance Trend predictive histogram view. The method (algorithm) used to create the predictive data in the view varies. PMF analyzes all available methods, identifies the one that best predicted past achievement, and uses it to predict future achievement.
The following is an example of a Performance Trend predictive histogram view, in which the method used is moving average.

The preceding Performance Trend predictive histogram view shows the high, mid, and low moving averages for each time period, displayed in three separate colors, as indicated in the legend.

There are no additional drill downs available from this view.

**Measure Views**

The following topics describe and show details of the measure-related views that are available as drill-down options.

**Note:** In reports that show aggregated measures, measure data might be distinctly counted. This means that items, such as staff, tools, or machinery that moves from location to location are not counted twice when totaling at higher levels.
Show Measures

When you click an Objective drill-down hyperlink and select Show Measures (Curr vs. Prev), the drill down takes you to the Show Measures view, which displays the heading Measures - Compare to Previous. In this view, current measures (Percent Reached, Target, Actual) are compared to previous measures for the selected objective, as shown in the following image.

This view compares data for current and previous time periods which can be year over year, quarter over quarter, or month to previous month depending on the time window that is configured. PMF also provides measures for the previous year total, same quarter in previous year, and same month in previous year.

From the Show Measures view, you can select the Measure Details drill-down option in any of the columns displaying Current and Previous data. This option takes you to another view that provides statistical data at the lowest atomic measure level for the related metric. For details, see Measure Details on page 74.

The Show Measures view also enables you to drill into the properties for any item in the Measure column to display additional views that show how the measure was loaded, what calculations were used to create it, and so on. To display additional data related to a measure, click a hyperlinked item in the Measure column and select the desired option. For a list of the available drill-down options, see Default Measure Drill-Down Options on page 40.
Measure Details

When you click a measure drill-down hyperlink, for example, in the Show Measures view, and select Measure Details, the drill down takes you to Measure Detail Data. Clicking a measure in this views view provides statistical data at the lowest atomic measure level for the related metric, as shown in the following image.

From Measure Detail Data, you have access to different dimensional cross-drill data views by clicking a hyperlink in the first column and selecting from the drill-down options. The options vary, depending on how your own dimensions are set up.

In the preceding example, the options are:

- **Show by Month.** The view is reformatted to show data by month.
- **Show by Location.** The view is reformatted to show data by location.
- **Show by Product.** The view is reformatted to show data by product.
- **Show by Organization.** The view is reformatted to show data by organization.
Measure Breakout

When you click a measure drill-down hyperlink and select Measure Breakout, the drill down takes you to the Measure Breakout view. This view provides actual, target, and percent reached measure data with graphs displaying current period and year-to-date trends for actual, target, and prior year performance. You can also view additional measure properties in a pop-over panel by clicking the zoom button in the upper-right corner of the view. An example of the Measure Breakout view for the Sales measure is shown in the following image.

A Measure Breakout view is also available in PDF format for print output in the Analytics tab. To access it, select Analysis or Measures Detail from the Type drop-down menu, select Measure Breakout Booklet - PDF from the View drop-down menu.
Operational Report

When you click a drill-down hyperlink and select Operational Report, the drill down takes you to the view that was set up by your administrator, as shown in the following image.

For any project, process, objective, or measure, your administrator can set up a WebFOCUS report as your operational report. This enables you to link PMF to external reports.
The following topics describe and show details of the available project-related views. A project supports an objective, and has a start and end date. Project views measure the impact of projects on aligned objectives and identify the status of budgets and schedules.

Projects - Objectives

You can access a view that provides a summary of all projects related to your scorecard and displays objective performance for each project, as shown in the following image.

To access this view, select Projects & Processes in the Type drop-down menu in the Analytics tab, then select Projects - Objectives from the View drop-down menu.

The Projects - Objectives view provides hyperlinked metrics in the Project and Objective columns. To probe deeper into the metrics listed in the Project column, click a hyperlink and select the desired option. To display related data for an objective, click an Objective hyperlink and select the desired option.
Project Impact

To run a Project Impact view, select Projects & Processes from the Type drop-down menu and Project Impact from the View drop-down menu. Another way to run this view is to click a project drill-down hyperlink, for example, in the Project Summary or Scorecard Projects view, and select Project Impact. PMF takes you to the Impact of Projects on Objectives view, as shown in the following image. This view provides a way to measure the impact of projects on aligned objectives.

For all projects listed in the view, visual indicators show the percentages for project completed and budget spent to see if the project is actually supporting the related objective or not. Percentages are also shown for each objective for each time period in the view to indicate if the objective is accomplishing its goal or not.

The Project Impact view displays aligned and unaligned projects as entered in PMF against their aligned goals in a timeline view. The timeline displays the immediate or gradual impact of the project on its aligned goals. You can use this view to demonstrate:

- The effectiveness of the project and whether it is having its intended results.
- The Project Health metric, which is a blended metric that combines the project performance regarding schedule and budget. You can determine how well the project is running at a glance.

Project managers can also use this view to determine the disposition of a project.

The Project Impact view displays hyperlinked metrics in the Objective/Project column. To probe deeper into the metrics listed in the Objective/Project column, click a hyperlink and select the desired option. For a list of the available drill-down options, see Objective Drill-Down Options on page 39.
**Project Detail**

When you click a project drill-down hyperlink, for example, Optimizing Margins in the Project Summary or Scorecard Projects view, and you select *Project Detail*, the drill down takes you to Project Detail, as shown in the following image.

![Project Detail Example](image)

Project Detail shows the overall health of a project, listing budget targets versus actual spending, and schedule targets versus actual schedules. It combines the target budget versus actual budget, and target schedule versus actual schedule, to determine an overall Project Health metric. It draws an indicator for each time break to show the project schedule and budget health at various points in time.

It also shows any tasks that are assigned to that project, including task feedback, status, and due date.

The Project Detail report provides hyperlinked metrics in the Project and Task columns. To probe deeper into the metrics listed in these columns, click a hyperlink and select the desired option. Drilling down on a Task link will allow you to view task details, as well as edit the selected task.

**Aligned Projects**

When you click a drill-down hyperlink, for example, in the Strategy Relationships view, and select *Aligned Projects*, the drill down takes you to the Scorecard Aligned Projects by Objective view, as shown in the following image. This view shows the aligned projects for the selected objective.

![Aligned Projects Example](image)

The Aligned Projects view displays the status of a project and demonstrates its impact on the aligned objectives.
It provides hyperlinked metrics in the Objective and Project columns.

To display related data for an objective, click an Objective hyperlink and select the desired option. For a list of the available drill-down options, see Objective Drill-Down Options on page 39.

To probe deeper into the metrics listed in the Project column, click a hyperlink and select the desired option. For a list of the available drill-down options, see Project Drill-Down Options on page 40.

**Process Views**

**In this section:**
- Scorecard Aligned Processes by Objective
- Processes - Objectives

The following topics describe and show details of the available process-related views. A process supports an objective and is recurring (does not have start and end dates).

**Scorecard Aligned Processes by Objective**

When you click an objective drill-down hyperlink and select Aligned Processes, the drill down takes you to the Scorecard Aligned Processes by Objective view. This view shows the aligned process and a description of the process, for the selected objective.

To access this view for all of the objectives in a scorecard, select Projects & Processes in the Type drop-down menu in the Analytics tab, then select Process Summary from the View drop-down menu.

The Scorecard Aligned Processes by Objective view displays process status and demonstrates its alignment with business objectives. It provides hyperlinked metrics in the Objective and Process columns.

To display related data for an objective, click an Objective hyperlink and select the desired option. For a list of the available drill-down options, see Objective Drill-Down Options on page 39. To probe deeper into the metrics listed in the Process column, click a hyperlink and select the desired option. For a list of the available drill-down options, see Process Drill-Down Options on page 41.
Processes - Objectives

You can access a view that provides a summary of all business processes related to your scorecard and displays objective performance for each process.

To access this view, select Projects & Processes in the Type drop-down menu in the Analytics tab, then select Processes - Objectives from the View drop-down menu.

The Processes - Objectives view provides hyperlinked metrics in the Objective and Process columns. To display related data for an objective, click an Objective hyperlink and select the desired option. To probe deeper into the metrics listed in the Process column, click a hyperlink and select the desired option.

Performance Views

In this section:
- Percent Reached Histogram
- Performance Trend
- Actual vs. Target Relationship

The following topics describe and show details of the performance trending views available as drill-down options.
Percent Reached Histogram

When you click a drill-down hyperlink, for example, in the Show Measures view, and select Graph: % Reached Histogram, the drill down takes you to the Percent Reached Histogram, which contains graphical data for the associated objective and perspective, as shown in the following image. This view shows percentage reached performance trend data for the selected metric and associated time periods.

There are no additional drill downs available from this view.
Performance Trend

When you click a drill-down hyperlink for an objective, perspective, or measure, and select Graph: Performance Trend, the drill down takes you to the Performance Trend view, as shown in the following image. Depending on the metric, Performance Trend data is presented in one or more bar or line graphs.

![Performance Trend Graph]

There are no additional drill downs available from this view.

**Note:** For information on selecting trend dates for Performance Trend views using the Analysis Designer, see *Automatic Trend Dates* on page 95.
Actual vs. Target Relationship

When you click a Measure drill-down hyperlink, for example, in the Show Measures view, and select Graph: Actual vs. Target Relationship, the drill down takes you to the Actual vs. Target Relationship view, as shown in the following image.

![Graph: Actual vs. Target Relationship](image)

This view tracks actual performance compared to target performance. The lines in the graph assume that the percent achievement of the target is shown. The actual targets can vary from period to period, depending on how they have been set up by planners or managers.

There are no additional drill downs available from this view.
Properties Views

In this section:
- Measure Properties
- Objective Properties
- Perspective Properties
- Project Properties
- Process Properties
- Related Properties

The following topics describe and show details of the various properties views for objectives, perspectives, projects, processes, and measures that are available as drill-down options.

Measure Properties

When you click a drill-down hyperlink, for example, Margins in the Show Measures view, and you select Measure Properties, the drill down takes you to the Measure Properties view, as shown in the following image. It provides details about a selected metric including the formula for computing that metric, aggregation method, threshold direction, and more.

There are no additional drill downs available from this view.
Objective Properties

When you click a drill-down hyperlink and select *Objective Properties*, the drill down takes you to the Objective Properties view, as shown in the following image. It provides basic information about the selected metric including perspective, associated theme, and creation date.

There are no additional drill downs available from this view.

Perspective Properties

When you click a perspective drill-down hyperlink, for example, Financial in the Causes & Effects view, and you select *Perspective Properties*, the drill down takes you to the Perspective Properties view, as shown in the following image. It provides basic information about the selected perspective including the creation date and a description.

There are no additional drill downs available from this view.
**Project Properties**

When you click a project drill-down hyperlink, for example, Optimizing Margins in the Scorecard Projects view, and you select *Project Properties*, the drill down takes you to the Project Properties view, as shown in the following image. It provides basic information about the selected project including a description and the start, end, update, and creation dates.

![Project Properties View](image-url)
Process Properties

When you click a process drill-down hyperlink, for example, Drop ship for direct vendors in the Scorecard Processes view, and you select Process Properties, the drill down takes you to the Process Properties view, as shown in the following image. It provides basic information about the selected process including a description and the update and creation dates.

Related Properties

When you click a drill-down hyperlink and select Related Properties, the drill down takes you to the Related Properties view where additional drill-down hyperlink options are available in the Project and Process columns. The following image shows the drill-down options for the Project column.

All five PMF scorecard metrics are displayed in this view: Perspective, Objective, Measure, Project, and Process.

To display related data for the perspective, click the Perspective hyperlink and select the desired option. For a list of the available drill-down options, see Perspective Drill-Down Options on page 39.
To probe deeper into the metric listed in the Objective column, click the Objective hyperlink and select the desired option. For a list of the available drill-down options, see Objective Drill-Down Options on page 39.

To display additional data related to the measure, click the Measure hyperlink and select the desired option. For a list of the available drill-down options, see Default Measure Drill-Down Options on page 40.

To display related data for a project, click a Project hyperlink and select the desired option. For a list of available drill-down options, see Project Drill-Down Options on page 40.

To display related data for a process, click a Process hyperlink and select the desired option. For a list of available drill-down options, see Process Drill-Down Options on page 41.

Using the Analysis Designer

In this section:
- Running the Metrics Across Dimension View
- Running the Metrics Vertical Sort View
- Running the Metrics Crosstab View
- Creating Active Technologies Reports
- Automatic Trend Dates
- Hi-Mid-Low Raw Counts and Percents of Total
- Variance by Value and Percent Reached
- Ranking Metrics and Objectives
- Categorizing a Saved Report
- Saving a View
- Running a Saved View
- Editing a Saved View

The Analysis Designer option in the Analytics tab enables you to specify parameter options and run a view based on those options. The available parameter options are grouped into five sections: Layout, Groupings, Data, Filters, and Report.

In the Filters section of the Analysis Designer, you can filter the view by selecting any combination of specific values including time, product, scorecard, objective, perspective, theme, metrics, location, organization, and measure. If you want to select multiple measures, click the browse (...) button to the right of the Measure drop-down menu and the Multi-Measure Selector dialog box opens.
Note that you can force the report to always use the selected scorecard by selecting the check box next to Scorecard in the Analysis Designer. Leaving the check box clear allows an end user to pass the scorecard they wish to view at run time.

In the Layout, Groupings, and Data sections of the Analysis Designer, you can select a report template, sort criteria, and the type of data you want to show. There are nine different report templates that you can select: Metrics Vertical Sort, Metrics Across Dimension, Metrics Crosstab, Objectives Vertical Sort, Objectives Across Dimension, Objectives Crosstab, Themes Vertical Sort, Themes Across Dimension, and Themes Crosstab. You can select from primary and secondary vertical sort fields, and a horizontal sort field when you select the Metrics Across Dimension or Objectives Across Dimension report templates. Views can be sorted by perspective, objective, year, quarter, month, location, product, organization, supplier, or theme. You can control the output by selecting to show actual output data, multiple alternate targets plus indicators, or the percentage of goals achieved plus indicator information. For an example of displaying multiple alternate targets in a view, see Running the Metrics Vertical Sort View on page 92. Additionally, the Analysis Designer enables you to show any combination of value, percent reached, and indicator to compare up to four columns of data. This gives you the ability to create thousands of different views.

In the Report section of the Analysis Designer, you determine the output format by selecting to display the view in a browser, a PDF file, an Excel spreadsheet, or a WebFOCUS HTML active report which can be sent to end users for offline analysis. Enter a report name at the top of the Analysis Designer so it can be saved for future use.

**Running the Metrics Across Dimension View**

PMF provides the Metrics Across Dimension template, which you can use to create a view that displays metrics horizontally across your organization using the selected parameters. This view requires you to select an Across sort field.

To run the Metrics Across Dimension view, select Analysis in the Type drop-down menu of the Analytics tab and then select Analysis Designer from the View drop-down menu. The Analysis Designer opens where you select the desired report template and specify your parameter options.
Enter a report name in the field provided, for example, Product Analysis by Quarter. From the Layout drop-down menu, select Metrics Across Dimension and then select the desired parameters in the Groupings and Filters sections, as shown in the following image.
Click Run to execute and open the grid. The following image shows the Metrics Across Dimension view for the selected parameter values.

The Options button at the top-left of the view enables you to Print the view, Output (export) to an Excel file, Output to a PDF, add to Mobile favorites, or Schedule the run time and distribution of the view using the Report Wizard. You can also display alternate target data in the view by selecting Show Benchmark, Show Forecast, or Show Stretch Target.

**Running the Metrics Vertical Sort View**

PMF provides the Metrics Vertical Sort template, which you can use to create a view that displays metrics vertically using the selected parameters and vertical sort field.
To run the Metrics Analysis, first select Analysis from the Type drop-down menu of the Analytics tab and then select Analysis Designer from the View drop-down menu. The Analysis Designer opens where you select the desired report template and specify your parameter options.

Enter a name in the field provided, for example, Product Analysis by Month. From the Layout drop-down menu, select Metrics Vertical Sort, and select the desired parameters in the Groupings and Filters sections. In the Data section, in line 1, select Actual for Value, Indicator for Type, and Forecast for Target. In line 2, select Actual for Value, Indicator for Type, and Benchmark for Target. In line 3, select Actual for Value, Indicator + Value + Pct Reached for Type, and Target for Target. The following image shows the Analysis Designer with all selected values for this view.

![Analysis Designer screenshot](image-url)
Click *Run* to execute and open this view in a new window. The following image show the Metrics Vertical Sort view for the selected parameter values.

The Options button at the top-left of the view enables you to Print the view, Output (export) to an Excel file, Output to a PDF, add to Mobile favorites, or Schedule the run time and distribution of the view using the Report Wizard. You can also display alternate target data in the view by selecting Show Benchmark, Show Forecast, or Show Stretch Target.

**Running the Metrics Crosstab View**

PMF provides the Metrics Crosstab template, which you can use to create a view that displays metrics horizontally using the selected parameters. This view enables you to see dimensional breakouts across many measures. When you run the Metrics Crosstab report, you can visually analyze your measures on a point-to-point basis across the selected sorting levels.

To run the Metrics Analysis, first select *Analysis* from the Type drop-down menu of the Analytics tab and then select *Analysis Designer* from the View drop-down menu. The Analysis Designer opens where you select the desired report template and specify your parameter options. If you click the browse (...) button to the right of the Measure drop-down menu, you can select multiple measures to personalize the columns you want displayed in the output.
Enter a report name in the field provided. From the Layout drop-down menu, select Metrics Crosstab, select the desired parameters, and then click Run to execute and open this view in a new window. The following image shows an example of the Metrics Crosstab view.

![Metrics Crosstab View](image)

**Creating Active Technologies Reports**

You can use the Analysis Designer to create HTML active reports. The Analysis Designer enables you to design personalized PMF output that can be sent to end users along with embedded data and built-in browser-neutral analysis tools. To request your content to be delivered as an active report, select the Active option in the Format area of the Analysis Designer and click Run.

**Note:** The use of WebFOCUS HTML active reports requires a specific software license from Information Builders.

**Automatic Trend Dates**

To better facilitate generating performance trend views with the Analysis Designer, standard trending dates are available in the Time dimension drop-down menu in the Filters section of the Analysis Designer. You can quickly create a trend view that looks back from the current period to the start of the trend period selected.
For CenturyCorp Card, the default options available for the trend periods include Last 13 Months, Last 25 Months, Last 5 Quarters, and so on, as shown in the following image. The Current Period is the default Time selection.

If you create personalized trend periods using the Time Ranges capability of the Manage tab, those values will be available in the Filters section of the Analysis Designer. For more information, see *General Tab - Time Ranges* on page 490.

![Filter Options](image)

**Hi-Mid-Low Raw Counts and Percents of Total**

You can use the Analysis Designer to report both the total Hi-Mid-Low (Hi-Mid-Low or red/yellow/green) counts for a metric range, as well as the Hi-Mid-Low Percent of Total, which shows the share of each indicator of the total count of metric values in that metric range.
These options can be found in the Data Type drop-down menu of the Analysis Designer, as shown in the following image.

The display options are:

- **Hi-Mid-Low Raw Counts.** Displays a count of High, Mid, and Low (Green, Yellow, and Red) values. This is the count of rows for that metric and Dimensional intersection that are each High, Mid, and Low (Green, Yellow, and Red).

- **Hi-Mid-Low % of Totals.** Displays the share of total High, Mid, and Low (Green, Yellow, and Red) values. This is the percent share of total rows that are each Greens (Highs), Yellows (Mid), and Reds (Low).

**Variance by Value and Percent Reached**

You can use the Analysis Designer to report both the variance value from Target, as well as the percent variance from Target.
These options can be found in the Data Type drop-down menu of the Analysis Designer, as shown in the following image.

![Data Type Menu](image)

The display options are:

- **Variance (by Value).** Displays the difference between the actual value and the target value.

- **Variance (% Reached).** Displays the difference of percent reached. For example, if the percent reached is 75%, the actual variance from target is -25%. If the percent reached is 125%, the actual variance from target is 25%.

### Ranking Metrics and Objectives

Metrics and objectives for views and in gadgets can be displayed based on the ranking of their performance or value. The available options are *Rank Ascending* or *Rank Descending*. The default sorting setting is alphabetic.

To set up Ranking, first select *Analysis* from the Type drop-down menu of the Analytics tab, then select *Analysis Designer* from the View drop-down menu. The Analysis Designer opens where you select the desired report template and specify your parameter options. If you click to the left of the data field of the Value that you want to rank, a ranking button appears, as shown in the following image.

![Ranking Button](image)
If you click to the left of another field and the previous field has been ranked, it will transfer to the newly selected field.

**Note:** Only Vertical Sort styles of the Measure, Objective, and Theme templates can support ranking.

PMF ranking sorts the report information by the value or the percent reached. For example, if you chose a value for actual or target, PMF ranks based on the value of the field for the indicators. If you choose a percent reached field, or a combo indicator, PMF ranks based on the percent reached for the indicators.

If you choose a sort value from the Sorting options, PMF displays the rank within the outermost sort type indicated. For example, if sorting by one or more Dimensions, PMF performs the rank within the innermost dimension. If sorting by Perspective, PMF ranks the items within each perspective. The only exception to this is when sorting on the Time Dimension.

**Categorizing a Saved Report**

**In this section:**
- Categorizing and Publishing a New Analysis Designer Report
- Adding or Removing Categories from Saved Reports

PMF has several predefined categories that allows a user to categorize and share saved reports with other users, including Administration, Analysis, Audit, CPM/BPM Practice, History, Measures Detail, Objective, Perspective, Projects & Processes, Today, and Private. There are also ten additional user-defined categories available, which are set up in the Content panel by your Administrator.
Categorizing and Publishing a New Analysis Designer Report

If you create a new report in Analysis Designer, you can quickly add the report to any category while saving it. Click the Categories field and select the desired categories from the drop-down menu, as shown in the following image.

You can also type the category name in the field provided to quickly search through the list. Click OK to save the report.

Analysis Designer reports that have been user-categorized will appear in the View drop-down menu in the Analytics tab for the categories to which they have been assigned, as shown in the following image.

Other users can now see and run the report.

Adding or Removing Categories from Saved Reports

You can change the categories of any saved report. To add a category to, or remove a category from a saved report, first select Analysis from the Type drop-down menu of the Analytics tab and then select Analysis Designer from the View drop-down menu. Click Open and select the report from the Report Name drop-down menu. Click OK.
Click the Categories field and select the desired categories from the drop-down menu. To remove a category, click the X next to the category name. Click Save once you are done making changes. The report will now be listed in the View drop-down menu under the new categories selected.

**Saving a View**

After you run a view, you can save its parameters and run the view again later. To save a view created in the Analysis Designer, type a report name in the Report field provided at the top of the Analysis Designer and click Save.

**Running a Saved View**

To run a saved view, select Saved in the Type drop-down menu of the Analytics tab, select the name of the saved view from the View drop-down menu, and then click Run. The following image shows the drop-down menus used to retrieve a saved view.

![Image of drop-down menus](image)

**Editing a Saved View**

You can change the parameters of any saved view. To edit a saved view, select Saved in the Type drop-down menu of the Analytics tab, select the desired saved view from the View drop-down menu, then click Edit. The Report Options panel opens where you can change your parameter options. After you are done making changes, run the view to test the results of your changes. If you are satisfied with the results, click Save.

**Today Tab**

There are several views available for display on the Today tab. The administrator sets up the display you desire for your Today page.

You can also personalize the Today tab for your work in PMF by clicking the Preferences button, located in the upper-right corner of the page. The Change User Preferences panel opens. On this panel, you make choices, such as the type of view displayed or the metrics monitored in the Graph Gadget. For details on the Change User Preferences panel, see *Changing Dashboard Gadgets and Preferences* on page 29.

The Today tab is also known as a launch page. As an administrator, you can set up launch pages from the Manage tab.
Feedback Blogging

**How to:**
- Add Feedback
- Edit or Delete Feedback

Feedback blogging enables you to instantly enter feedback comments about a measure, and the associated objective, for which you have responsibility. Each instance of feedback is stored and tracked by user and provides valuable data including Owner ID, the date and time the feedback was entered, percent achieved, and indicator color at the time of input.

If feedback has been entered, a feedback icon appears on the reports and views associated with the measure, and on the Strategy Map above the associated objective. Hover the mouse over the feedback icon to display the most recent feedback. If you click the icon, you can add new feedback, view related feedback entered by others, and edit any existing feedback that you recently added.

The following is an example of viewing feedback by hovering over a feedback icon on a report.

![Feedback Icon Example](image)

The following is an example of viewing feedback by hovering over a feedback icon on the Strategy Map.

![Strategy Map Feedback Example](image)
**Procedure:  How to Add Feedback**

1. To add feedback for a measure on a report or view, click the measure and select *Feedback...* from the menu, as shown in the following image.

   ![Feedback Image 1](image1.png)

   To add feedback for an objective on the Strategy Map, right-click the objective and select *Feedback...* from the menu, as shown in the following image.

   ![Feedback Image 2](image2.png)

   The Feedback panel opens, displaying an input text area (and any feedback that exists).
2. Type feedback comments in the input text area.

3. To display additional feedback related to the selected measure, select Show related feedback.

4. To arrange the order in which existing feedback appears, select Input Date or Dimension from the Sort by drop-down menu.

5. To hide the input field and maximize the area to view existing feedback, select Hide Input Area and the input field for entering feedback is removed from the pane.

   To restore the input field, click Show Input Area.

6. When you are finished entering feedback, click Save.

   The saved feedback appears at the bottom of the panel.

   You can type up to 1024 characters to document the selected measure.

7. If you want to edit existing feedback that you recently added, click the hyperlinked feedback below the Feedback heading at the bottom of the panel. Make any edits in the dialog box that opens and click Save.
**Procedure: How to Edit or Delete Feedback**

1. To edit or delete feedback that you entered for a measure on a report or view, click the measure that displays the feedback icon, then select Feedback from the menu.

   To edit feedback that you entered for an objective on the Strategy Map, double-click the feedback icon or right-click the objective, then select Feedback from the menu.

   The Feedback panel opens, displaying existing feedback.

2. Click the desired comment hyperlink listed in the Feedback column below the input text area, as shown in the following image.

   ![Feedback Panel Image](image-url)

3. To save the edited feedback, click Save.

   To delete the feedback, click Delete, a confirmation dialog box appears, then click OK.

   **Note:** Feedback editing can only be performed for a period of time that is preset by your PMF Administrator, who can also disable the option to edit feedback.

**Scheduling Reports and Views**

**How to:**

Schedule Reports and Views

View, Update, or Cancel a Scheduled Report or View

You can instantly schedule any view to be sent to you exactly how it currently appears. The scheduling facility automatically captures the parameters of the report you are viewing. Views are scheduled and distributed using WebFOCUS ReportCaster. You can cancel or revise any existing scheduled view quickly and easily.
Procedure: **How to Schedule Reports and Views**

1. From any view, click the *Options* button and select *Schedule this* from the menu.

The Schedule this panel opens, as shown in the following image.

2. Select values for the following fields to schedule the report or view.

   **Note:** Your choice of the scheduling interval determines which additional fields appear in the Schedule this panel. The following table lists all of the possible fields.
### Field
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the days of the week to schedule the report or view. Click to select a day. Click twice to deselect. This field only appears when you select Weekly as the schedule interval.</td>
</tr>
<tr>
<td>Select the days of the month to schedule the report or view. Options include all numbered days of the month (1-31) and Last Day. Click to select a day. Click twice to deselect. This field only appears when you select Monthly as the schedule interval.</td>
</tr>
<tr>
<td>Date you want to start the schedule (in YYYYMMDD format).</td>
</tr>
<tr>
<td>Date you want to end the schedule (in YYYYMMDD format). This field does not appear when scheduled to run once.</td>
</tr>
<tr>
<td>Time you want to start the schedule (in HHMM, 24-hour format).</td>
</tr>
<tr>
<td>Time you want to end the schedule (in HHMM, 24-hour format). This field does not appear when scheduled to run once.</td>
</tr>
</tbody>
</table>

3. Click Save and close the Schedule this panel.

**Procedure:** How to View, Update, or Cancel a Scheduled Report or View

1. Select **Scheduled Reports** from the drop-down menu in the action block on the Today page.
PMF displays a list of reports and views you have scheduled.

2. Click the schedule you want to change.
   PMF displays a menu with the following options:
   - Change When Report Runs
   - Remove Report

3. To update when the report or view is scheduled to run, click Change When Report Runs. The Schedule this panel opens.
   Make the desired changes and click Save.

4. To cancel a scheduled report or view, click Remove Report.
   PMF deletes the schedule for that report or view.

Managing Project Tasks

How to:
- Edit a Task
- Add Feedback or Spending to a Task
- View Task Details

You can manage tasks assigned to you from the action block located on the dashboard. Since the action block is a portable component, it can be placed anywhere on the PMF dashboard by an administrator.
From the action block, you can work with tasks in the following ways:

- See the project tasks assigned to or assigned by the owner who is currently signed in.
- See the tasks for projects linked to the current scorecard.
- Edit any of the listed tasks.
- Create new tasks if you are the owner of the project.
- Add feedback comments to the selected task.
- Add budget entries (Expenditures) to the selected task.
- View all details for the selected task.

**Procedure: How to Edit a Task**

1. From the action block, select *Project Tasks*.

2. Click the task you want to edit.
Managing Project Tasks

3. Click **Project - Edit Task** to open the Edit Task panel, as shown in the following image.

4. Make any necessary changes, such as updating the task status, priority, or due date. For more information on the fields in this panel, see *Projects* on page 251.

5. Click **Save**.

6. Click the **Refresh** icon in the action block to see the changes.

**Procedure: How to Add Feedback or Spending to a Task**

1. From the action block, select **Project Tasks**.

2. Click the task for which you want to add feedback or spending.

   A menu opens.

3. Click **Project - Edit Task**.

   The Edit Task panel opens.

4. Click the **Feedback & Expenditures** tab.

5. For the Effective Date, click the box and select the date from the calendar that opens.
6. Type any expenditure and task feedback items in the boxes provided, as shown in the following image.

Note: An Owner can only edit or delete their own Effective Date, Feedback, or Expenditure entries.

7. Click Save.

The Info Tab in the Edit Task panel will display the aggregated Spend data in the Task Expenditure field.

Procedure: How to View Task Details

1. From the action block, select Project Tasks.

2. Click the task for which you want to view details.

The Task Detail report opens, as shown in the following image.
Managing Alerts

PMF implements WebFOCUS ReportCaster alerts through an easy-to-use action block. You can display fired alerts and scheduled alerts, modify or delete existing alerts, or add new alerts.

When you log on to PMF, you can access all alert functionality from the action block located on the dashboard. Since the action block is a portable component, it can be placed anywhere on the PMF dashboard by an administrator.

From the action block, you can work with alerts in the following ways:

- See a list of the current fired alerts and alerts scheduled to be fired.
- Display alert views from the ReportCaster Library.
- Reassign actions for an alert to another user.
- Document the actions taken to correct the condition that caused the alert to fire.
- Access the Alert Wizard, where you can change how the alert fires or create a new alert.

The action block allows you to choose to display Fired Alerts (alerts that have been sent because the alert condition was met), Scheduled Alerts (alerts that are being monitored and will be sent if the alert condition is met), Scheduled Reports, Measure Tasks (for collaborating), or Measures to Input (for user-entered measures).

When you choose Fired Alerts, for example, a list similar to the following displays.
The Fired Alerts list includes the date each alert was sent and a Done check box next to each alert to close the alert. Selecting the New Alert icon opens the Alert Wizard for creation of a new alert.

Above the New Alert icon are the following three icons:

- A go back to previous page icon.
- An action block preferences icon.
- A Refresh icon.

**Note**: These three icons are removed from the view when you click anywhere outside the action block.

### Viewing and Modifying Alerts

<table>
<thead>
<tr>
<th>How to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change When an Alert Fires</td>
</tr>
<tr>
<td>Add a Comment or Reassign an Alert</td>
</tr>
</tbody>
</table>

Each alert listed in the Fired Alerts is also a hyperlink to alert options. Click an alert hyperlink to access the following drill-down options:

- **View All Alerts.** Displays all alerts including alerts that have been closed, which appear at the bottom of the Alerts display panel.
- **Change When Alert Fires.** Opens the Alert Wizard where you can modify the alert settings that determine when the alert fires.
- **Add Comments or Reassign.** Opens the Edit Alert Status panel, which displays information about the alert including the condition that caused the alert to fire, the owner of the alert, the action being taken, the date the alert fired, and the date the alert was read. Check boxes are available to indicate when the alert was read and when action was taken. A text box is available to add comments or additional information about the alert and the course of action being taken.

Scheduled Alerts have the following hyperlink options:

- **View Fired Alerts.** Allows you to switch to the display of fired alerts.
- **Change When Alert Fires.** Opens the Alert Wizard where you can modify the alert settings that determine when the alert fires.
- **Remove Alert.** Deletes the scheduled alert.
Procedure: **How to Change When an Alert Fires**

1. Click the alert you want to modify and select *Change When Alert Fires*.

   The Alert Wizard (1 of 4) panel opens. This panel provides the settings that define the conditions under which the alert fires.

2. Change the necessary settings that define when the alert fires, and click *Next* until you are in the Alert Wizard (3 of 4) panel. See *Creating a New Alert* on page 115 for details on these settings.

3. Click *Finish*.

4. In the Alert Wizard (4 of 4) panel, click *Done*.

Procedure: **How to Add a Comment or Reassign an Alert**

1. Click the alert you want to work with and select *Add Comments or Reassign*.

   The following image shows the delete alert status panel that opens, with sample values in the fields.

![Edit Alert Status Panel](image)

2. To reassign the alert to another user, select that user from the Owner drop-down menu.

3. To add a comment or information about the necessary course of action for the alert, add appropriate text in the Action being taken text box.

4. When the alert has been read, select *The alert was read* check box.

5. When the appropriate action is taken for the alert, select the *Action was taken* check box.
6. Click Save.
   A message at the top of the panel informs you that the information was updated.

7. Close the panel.

Creating a New Alert

**How to:**

Create a New Alert
Create an Alert from a Measure, Objective, or Risk

The Alert Wizard is an easy-to-use tool that guides you through the step-by-step process of creating an alert for a potential condition that requires a course of action to be taken.

**Procedure: How to Create a New Alert**

1. Click the New Alert icon to the right of the action block drop-down menu.
   The Alert Wizard (1 of 4) panel opens, as shown in the following image. In this panel, you define the condition that triggers the alert.
2. Select values in the following fields to define the alert.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Select the appropriate scorecard associated with the alert.</td>
</tr>
<tr>
<td>Objective or Measure</td>
<td>The first drop-down menu determines if the alert is based on an objective or a measure. The second drop-down menu provides the specifics of the objective or measure.</td>
</tr>
<tr>
<td>turns (status indicator)</td>
<td>Status indicator of the objective or measure. Selections are Below Tgt (Red), Marginal (Yellow), On/+ Tgt (Green), Better (Up arrow), Worse (Down arrow).</td>
</tr>
<tr>
<td>Time Period</td>
<td>Time period of the objective or measure. Selections are Year, Quarter, Month.</td>
</tr>
<tr>
<td>Compare to (time period)</td>
<td>Time period for which you want to compare the objective or measure. Selections are previous or prior period (1 year ago).</td>
</tr>
</tbody>
</table>

3. Click Next.
The Alert Wizard (2 of 4) panel opens, as shown in the following image. Here you determine the email subject, the type of the alert to send, the selected view to send with the alert, and the User ID of the person to notify when the alert fires.
4. Select values for the following fields to format the alert.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Subject</td>
<td>Type a brief message that appears in the alert email.</td>
</tr>
<tr>
<td>Send (type of email)</td>
<td>Form of alert notification.</td>
</tr>
<tr>
<td>Simple alert message.</td>
<td>Send an email with the Alert email subject and view selected in the second list.</td>
</tr>
<tr>
<td>Content page.</td>
<td>Send an email with the Alert email subject, a content page, and the view selected in the second list.</td>
</tr>
<tr>
<td>Content to send</td>
<td>Select the appropriate PMF view to send with the alert message.</td>
</tr>
<tr>
<td>To (User ID to notify)</td>
<td>The User ID of the person you want to notify when the alert fires. Selections are the administrators and users of PMF.</td>
</tr>
</tbody>
</table>

5. Click Next.

The Alert Wizard (3 of 4) panel opens, as shown in the following image. This panel provides the parameters to schedule the alert.
6. Select values for the following fields to schedule the alert.

**Note:** Your choice of the scheduling interval determines which additional parameters appear in the panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule the alert to run</td>
<td>Desired schedule interval for testing the alert condition.</td>
</tr>
<tr>
<td></td>
<td>Selections are Once, Daily, Weekly, and Monthly.</td>
</tr>
<tr>
<td>Weekdays</td>
<td>Select the days of the week to run the alert. Click to select the day.</td>
</tr>
<tr>
<td></td>
<td>Click twice to deselect.</td>
</tr>
<tr>
<td></td>
<td>This field only appears when you select Weekly as the schedule interval.</td>
</tr>
<tr>
<td>Days of month</td>
<td>Days of the month you want to run the alert (1-31 or Last Day).</td>
</tr>
<tr>
<td></td>
<td>Click to select the day. Click twice to deselect.</td>
</tr>
<tr>
<td></td>
<td>This field only appears when you select Monthly as the schedule interval.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date you want to start the alert (in YYYYMMDD format).</td>
</tr>
<tr>
<td>End Date</td>
<td>Date you want to end the alert (in YYYYMMDD format).</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time you want to start the alert (in HHMM, 24-hour format).</td>
</tr>
<tr>
<td>End Time</td>
<td>Time you want to end the alert (in HHMM, 24-hour format).</td>
</tr>
</tbody>
</table>

7. Click Save.
The Alert Wizard (4 of 4) panel, as shown in the following image, shows that the alert was created followed by a summary description of the alert.

8. Click Done to exit the wizard.
   If you want to create another alert, click New to restart the Alert Wizard.

Procedure: How to Create an Alert from a Measure, Objective, or Risk

1. Click a Measure, Objective, or Risk from any report. A menu opens.
2. Select Alert when.
   The Alert Wizard opens.
3. Select values in the fields to define the alert. For more information on the Alert Wizard fields, see How to Create a New Alert on page 115.
Working With Measure Tasks

**How to:**
- Create a New Task
- Edit a Task
- Create a New Measure Task From a Measure
- View a Measure Task from a Measure, Objective, or Risk

To enhance your ability to collaborate in PMF, you can create a list of action items (tasks) for Measures. Measure tasks help facilitate common work-flow options and enable you to assign, update, change status of, and view tasks, whether you are the assigner of the task or the person currently responsible for performing the task.

To find your tasks, select *Measure Tasks* in the action block. A list similar to the following opens.

The Measure Tasks list includes the name of the task, the assigned owner, the due date, and the owner who assigned the task. Selecting the task name opens the Edit Task panel where you can edit the task to change the status, reassign it, change the due date, and more. Selecting the New Task icon opens the panel for creating a New Task. Above the New Task icon are the following three icons:

- A go back to previous page icon.
- An action block preferences icon.
- A Refresh icon.

*Note:* These three icons are removed from the view when you click anywhere outside the action block.
Procedure: How to Create a New Task

1. Select Measure Task in the action block.
   The Measure Tasks list displays in the action block.

2. Click the New Task icon to the right of Measure Tasks.
   The new task panel displays, as shown in the following image.

3. Complete the new task panel and select values for the fields that are listed and described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a name for the task.</td>
</tr>
<tr>
<td>Measure</td>
<td>Select the Measure to which the task is aligned.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description for the task including instructions and any other necessary information.</td>
</tr>
<tr>
<td>Performed by</td>
<td>Select the owner who will perform the task.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Type in the percent complete for the task.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Status       | Choose one of the following status values from the drop-down menu:  
  - **Assigned.** Task is assigned to an owner for action.  
  - **Complete.** Task was completed.  
  - **Deferred.** Task is on hold.  
  - **In Progress.** Task is currently being performed. |
| Priority     | Select a priority from Low to High.                                                                                                           |
| Type         | Choose one of the following task types from the drop-down menu:  
  - **PMF action required.**  
  - **Metric Follow-up.**  
  - **Technical work.**  
  - **Internal work.**  
  - **Work with customer.**  
  - **Other.**                                                                                      |
| Start Date   | Type a date or click the calendar control to select a start date for the task. By default, the task start date is today.                  |
| Currently due| Type a date or click the calendar control to select a due date for the task.                                                                     |
| Assigned by  | Select the owner who is assigning the task. By default, you are the owner assigning the task.                                               |
| Dimensions   | Select a value from the drop-down menu next to each of the dimensions displayed at the bottom of the new task panel. The selected value is used for linking the task. The available dimensions are Location, Organization, Product, and Supplier. |

4. Click Save when the new task panel is completely filled out.
5. Click Close to exit the new task panel.

**Procedure: How to Edit a Task**

1. To edit or delete an existing task, select Measure Task in the action block.
   The Measure Tasks list displays in the action block.

2. Click the task name in the action block.
   The Edit Task panel displays.

3. To delete the Measure task, click Delete, then click OK when the delete confirmation dialog box appears.

4. To edit the Measure task, change any of the previously entered information and selected values in the Edit Task panel as needed.

   **Note:** The Edit Task panel contains the same fields as the New Task panel. In addition, it displays the original due date (in the event the date is changed). For details about the fields in the New Task panel, see *How to Create a New Task* on page 122.

   **Tip:**
   - The Percent complete and Status fields provide a good indicator of how much progress is being made on the measure task.
   - To reassign a Measure task to another owner, you must be the owner in the Assigned by or Performed by fields, or an administrator.

5. Click Save when the New Task panel is completely filled out.

**Procedure: How to Create a New Measure Task From a Measure**

From a report, or gadget, that displays Measure data:

1. Click a data field. A menu opens, as shown in the following image.

The New Task panel opens.

3. Complete the New Task panel and select values for the fields that are listed. For more information on setting up Measured Tasks, see How to Create a New Task on page 122.

Procedure: How to View a Measure Task from a Measure, Objective, or Risk

A Measure Task icon indicates if there are Measure Tasks linked to the measure, objective, or risk you are viewing.

1. Click the measure that is linked to a Measure Task. A menu opens, as shown in the following image.

2. Select Aligned Tasks.

A report opens, as shown in the following image.

This report lists the linked measure tasks, their descriptions, and their current status.

Inputting User-Entered Measures

How to:
Input User-Entered Measures

Note: This will be depreciated in a future release.
User-entered measures enable users to type in actual or target data values for their measures. Before users can input user-entered measures, the measures must be created in the Author tab and access should be set in the Manage tab to allow users to input user-entered actual or target values.

When you log on to PMF, the Alerts panel appears by default in the upper-right corner of the Today tab. Since this panel is a portable component, it can be placed anywhere on the PMF dashboard by an administrator.

Note: Measure Entry allows you to activate Quick entry to make entering values easier for your users, especially if values repeat from row to row within Measures Entry. The Quick Entry capability works similarly to the Excel Auto-Fill feature. As users type and advance the cursor from line to line, the values from the line above are automatically brought down and fills in each cell. Users need to type only if their values differ from those copied down.

Procedure: How to Input User-Entered Measures

1. From the Today tab, select Measures to Input from the drop-down menu in the Action block.
   The user-entered measures that are available to you display below the drop-down menu.

2. Click the desired measure to input values.
   The Data Entry panel displays for the selected measure.

3. Enter values in any or all of the input fields available to you on the panel.
   As you enter values in each field, the data is automatically calculated, displayed on the panel, entered into the PMF data mart, and instantly available from all views. PMF keeps track of all input and allows you to pause from entering data now and resumes entering data later. All work is automatically saved for you.
Inputting User-Entered Sources

PMF includes a gadget, called Utility – UE Sources, which incorporates the User Entry user interface. You can include this gadget on a dashboard to allow end-user access for data entry.

This gadget allows users to select from the user-entered sources to which they have access, based on the measures linked to the current scorecard, as shown in the following image.

Click Save in the gadget to save the data you have entered into the datapoints. You can also:

- Sort the contents of the Enter data tab by clicking the column headings. The arrow next to the column heading tells you the direction of the sort.
- Highlight any row or column for closer examination with a click.
- Resize the columns of the Enter data tab by dragging the column borders in the headings.
Dashboards appear to PMF owners (users) the same as other Today pages. Dashboards can be designated for use by particular users by the PMF Administrator. This can be changed at any time by selecting a personalized dashboard as a Today page on the Today tab.

When an owner first selects a dashboard, it automatically populates itself with data appropriate to their access role or owner access (depending on how this is configured in PMF). Metrics are displayed using the default choices set up by the dashboard designer.

PMF users can personalize each gadget to display the metric information that is important to them. As a user, you can group, filter, and select the data points that are displayed in the gadgets on your dashboards. The available choices for each gadget depend on how the gadget was designed.

PMF includes a set of gadgets that use HTML5 technology with local intelligent caching. As you navigate through data, the intelligent caching agent determines if data is already in your browser. If it is, the data is instantly delivered to the HTML5 gadgets. If not, the agent requests the needed data.
Dashboard Designer

In this section:
- Controlling the Look of a Gadget
- Draggable Guidelines
- Target Screen Resolution Support
- Moving Gadgets Together
- Adding Gadgets From the Catalog
- Registering Gadgets From the Catalog
- Resetting Dashboard User Preferences

How to:
- Design a New Dashboard
- Edit an Existing Dashboard
- Search the Gadget Catalog
- Turn Snap Grid Control On or Off
- Change the Dashboard Owner

The Dashboard Designer is available to the user if the user was given Administrator rights to the dashboard.

To access the Dashboard Designer from the Today page, click the Unlock the Dashboard icon, followed by the Edit current selected Today page icon or click the Create a new Today Page icon.
The Dashboard Designer opens, as shown in the following image.

Dashboard Designer includes:

- A canvas, which is the surface on which you position and configure gadgets.
- Four chevrons on the right:
  - The Catalog chevron, which provides a list of the available gadgets currently registered with PMF. Each gadget is represented by a thumbnail preview image that lets you see how the gadget looks and works. A scroll bar directly to the right of the Catalog chevron enables you to view the entire list of available gadgets. From the list, you can drag and drop individual gadgets onto the canvas.
  - The Broadcast chevron, which opens Broadcast design mode. The chevron controls the properties for the Broadcast capability. With this chevron, you configure the gadgets that belong to a particular Broadcast group. For more information on Broadcast, see Setting Up Broadcast on a Dashboard on page 147.
  - The Look chevron, which you can use to change the overall look of your dashboard.
  - The Properties chevron, where you supply a name for the new dashboard and an optional description.
When you click a chevron, it slides out to the applicable interactive panel. Clicking an open chevron closes that chevron. If you click a second chevron while another chevron is open, the open chevron is closed and the second chevron is opened.

- The ribbon, a toolbar from which you can click:
  - *Card*, to select a scorecard.
  - *New*, to start a new dashboard design with a fresh canvas.
  - *Save*, to save the current dashboard, including the gadgets that you added to the dashboard and their position on the page. For a new dashboard, you are prompted for a name when you click *Save* for the first time. If this option can be changed, you can also indicate whether the dashboard is public or private. A public dashboard is accessible to all PMF users at the site. A private dashboard is accessible only to you.
  - *Save As*, to save the dashboard under a new name.
  - *Reset*, to restore all default values to the dashboard and the currently selected Scorecard.
  - *Live*, to preview the gadgets on the dashboard in run-time mode, with real interactive data, rather than use the supplied preview files.

**Procedure: How to Design a New Dashboard**

1. Unlock the Today page and click the *Create a new Today Page* icon. You can also click *New* from the Dashboard Designer.
2. Click the *Catalog* chevron to display a list of gadgets available for use in your design.
The following image shows part of a sample Catalog.

3. Use the scroll bar directly to the right of the Catalog chevron to display the entire list of available gadgets. You can also search for a specific gadget by typing its name in the Search field.

4. Drag the desired gadget or gadgets onto the design canvas.

    PMF retrieves the default size for each gadget that you add to the canvas.

5. Perform the following actions to achieve the desired result.
To re-position a gadget on the canvas, click anywhere inside the gadget to display its title bar. Move the cursor inside the title bar of the gadget to display the move symbol. Drag the gadget to the desired location. Dashboard Designer automatically aligns the top edges of gadgets that are in proximity.

To resize a gadget on the canvas, click the Resize button in the lower-right corner of the gadget, and drag the borders of the gadget to the desired height and width.

To delete a gadget from the dashboard, click the Remove Gadget button on the title bar of the gadget.

To change the values used to display the data for a gadget, click the My Preferences for this Gadget button on the title bar of the gadget. Make your selections from the drop-down menus. For details, see Changing Dashboard Gadgets and Preferences on page 29.

On the ribbon, click Live at any time to display the dashboard as it will appear at run time. From run-time mode, click Design to return to design-time mode.

6. Optionally, click the Broadcast chevron to implement simultaneous run-time changes across multiple gadgets.

For details on Broadcast, see Setting Up Broadcast on a Dashboard on page 147.

7. On the ribbon, click Save when you are satisfied with your design. When you are prompted, type a name for the new dashboard. If this option can be changed, indicate whether the dashboard is public or private.

The following image shows the Save As panel.
The following options are available:

- **Public Dashboard.** Visible to all owners in PMF. Administrator access is required to create a public dashboard.

- **Private Dashboard.** Visible only to the owner who created it. You can create a private dashboard with Edit or higher dashboard access.

**Procedure: How to Edit an Existing Dashboard**

1. In the Today tab in PMF, click the *Edit the current selected Today page* icon.
   The dashboard opens in the Dashboard Designer.

2. Edit the dashboard. On the ribbon, click Save when you are done.

**Controlling the Look of a Gadget**

You can make changes to a gadget when its title bar appears. To display the title bar, click anywhere inside the gadget.

The gadget controls include the following:

- **Moving.** You can position the anchor point of any gadget. To move a gadget, click inside the title bar and drag the gadget to the desired position.
  The following image shows the symbol that appears when you click a title bar to move a gadget.

- **Resize button.** You can interactively adjust the height and width of a gadget. A click-and-drag Resize button is located in the lower-right corner of the gadget. Click the button and drag the borders of the gadget to resize it as desired.

- **Remove Gadget button.** The Remove Gadget button removes the selected gadget from the canvas.

- **Preferences button.** A separate Preferences button exists for each gadget on a dashboard. The button opens a panel on which you can change the values used to display the data for that gadget. For more information on specifying preferences for a gadget, see *Changing Dashboard Gadgets and Preferences* on page 29.

- **Refresh button.** The Refresh button refreshes the gadget to the saved preferences.
Renaming the gadget. You can change the default title of a gadget and rename it by going to the Dashboard Designer and clicking the title bar of the gadget. Enter the new title, as shown in the following image.

To revert back to the default title, click the X in the field.

Procedure: How to Search the Gadget Catalog

There is a built-in search capability in the Gadget Catalog which makes it easier to find specific gadgets for your dashboard.

To search for a gadget or a category of gadgets:

1. Click the Catalog chevron in the Dashboard Designer.
2. In the Search field, enter the first few letters of the gadget type or category, as shown in the following image.

3. Select the desired gadget from the list that appears. You can either select the listed category to view all gadgets related to your search, or select a specific gadget.

To clear the search and show all available gadgets, click the Clear Search button.
Draggable Guidelines

**How to:**

- Add a Guideline to a Dashboard Design
- Move a Guideline
- Lock a Guideline
- Remove a Guideline

You can place draggable guidelines on your Dashboard designs that enable you to lay out your Dashboards more precisely. With the guidelines, you can set and lock vertical and horizontal positions along which gadgets can be placed.

Guidelines are only visible to the dashboard designer. A consumer will not be able to see the guidelines unless the consumer was given rights to use the Dashboard Designer.

Any dashboards that are saved either by using the Save or Save As functions are saved along with the guidelines in their exact positions and locked state. If you enter the Dashboard Designer at a later time, all guidelines display in their last known position and locked state.

**Procedure: How to Add a Guideline to a Dashboard Design**

Vertical and horizontal guidelines can be added to your dashboard at any time.

**Note:** Rulers must be displayed in order to add a guideline.

From the Dashboard Designer:

1. Move the pointer over the vertical or horizontal rule until the ruler line flashes and the pointer becomes a double-headed arrow, as shown in the following image.
2. Click the ruler line and drag the pointer to set the guideline. As you drag the guideline, a hover control appears that shows the exact pixel position of the guideline while it is being moved, as shown in the following image.

3. Once the guideline is positioned, release the pointer.
Guidelines can be locked on the dashboard or left floating. Unlocked guidelines can be moved at any time.

**Procedure: How to Move a Guideline**

Guidelines can only be moved if they are not locked.

1. Move the pointer over the guideline until the point becomes a double-headed arrow.
2. Click the guideline and drag it into its new position.
3. Release the pointer to set the guideline in place.

**Procedure: How to Lock a Guideline**

1. Move the pointer over the guideline until the hover control appears.
2. Click the lock button to lock the guideline.

**Note:** Locked guidelines cannot be moved but they can be removed.

**Procedure: How to Remove a Guideline**

1. Move the pointer over the guideline until the hover control appears.
2. Click the *Delete* button to remove the guideline, as shown in the following image.

The guideline disappears and has been removed.
Target Screen Resolution Support

How to:
Set Up Target Screen Resolution

Guidelines can be automatically placed on the Dashboard design based on the target screen size of the consumer. For example, if many of your users have a 1024 x 768 total screen resolution, your Dashboard designs can be targeted to display all onscreen with no scrollbars using this capability.

Procedure: How to Set Up Target Screen Resolution

In the Dashboard Designer:

1. Click the Properties chevron.

2. Select the desired target resolution from the Screen Resolution drop-down menu, as shown in the following image.
Moving Gadgets Together

How to: Move Gadget Groups

The Dashboard Designer allows you to perform multiple selection of gadgets, which enables you to move and position gadgets as a group.

**Procedure:** How to Move Gadget Groups

1. Select the first gadget you want to move.
2. Press CTRL while selecting each gadget you want to group together.
3. Move the group while continuing to press CTRL.

When you select gadgets to be moved as a group, the Dashboard Designer restricts the move by drawing a rectangle around all of the gadgets. This prevents you from dragging any portion of the group outside of the onscreen dimensions of the dashboard.

**Procedure:** How to Turn Snap Grid Control On or Off

The auto-snap feature in the Dashboard Designer can be turned off, which enables you to freely move gadgets on the dashboard with no constraints on positioning.

To turn snap grid control off:

1. Click the Properties chevron in the Dashboard Designer.
2. Clear the Snap Control check box.
3. Optionally, change the size of the snap grid by entering a different pixel value in the Snap Control field. The default snap grid size is 10 pixels.

**Note:** Saving the dashboard design will save with the state of the current snap control setting.

**Procedure:** How to Change the Dashboard Owner

You can change the dashboard owner directly from the Dashboard Designer:

1. Click the Properties chevron from the Dashboard Designer.
2. Select the new owner from the Owner drop-down menu, as shown in the following image.

3. Click Save.

Adding Gadgets From the Catalog

How to:
Add a New Gadget From Inside the Catalog

Gadgets can be added directly from the catalog in the Dashboard Designer. Gadgets that are added and configured from the catalog are immediately available to use in dashboard designs.

Procedure: How to Add a New Gadget From Inside the Catalog

From the Dashboard Designer:

1. Click the Catalog chevron.

2. Click the New Gadget button.
   The new gadget designer window opens.

3. Enter all values in their appropriate fields.
   
   Note: This capability is only available to users with administration rights to dashboards.
Registering Gadgets From the Catalog

**How to:**
Register a New Gadget From Inside the Catalog

Gadgets can be registered directly from the catalog in the Dashboard Designer. Gadgets that are added and configured from the catalog are immediately available to use in dashboard designs.

**Procedure:** How to Register a New Gadget From Inside the Catalog
From the Dashboard Designer:

1. Click the **Catalog** chevron.
2. Click the **Register** button.
   
   The Register window opens.

3. Enter all values in their appropriate fields. For more information, see Registering a Gadget on page 476.

   **Note:** This capability is only available to users with administration rights to dashboards.

Resetting Dashboard User Preferences

**How to:**
Reset Dashboard Preferences From the Dashboard Designer

Dashboard user preferences can be reset to the default preferences in the original dashboard design.

The dashboard preferences control settings a user sees, such as metrics and dimensional filters. Preferences are stored for each of the following:

- User
- Dashboard
- Scorecard in the system

Default preferences are stored for each dashboard in the system. These preferences are set during the dashboard design process in the Dashboard Designer.

Users can override preferences set for a dashboard by saving their changes in the Preference panel in the dashboard.
User preferences can be reset from many areas within PMF. Where the reset is performed determines the scope of where those preferences are overridden.

**Procedure: How to Reset Dashboard Preferences From the Dashboard Designer**

If a user has administrator rights in a dashboard, the user has the ability to clear user preferences for any of their dashboard designs.

Any preferences that are changed from within the Dashboard Designer changes the default preferences for that dashboard, as well as each scorecard that can be selected and configured.

From the Dashboard Designer:

1. Click the Reset button on the Dashboard Designer ribbon.

   The Reset window opens, as shown in the following image.

   ![Reset Window](image)

   2. Select *Auto-reset this Dashboard’s default preferences* to only clear the default preferences. Selecting *Clear all User Dashboard preferences* will delete any saved user preferences.

**Personalizing Gadgets**

PMF Owners, including consumers and analysts, can configure their gadgets to display the exact metrics they want to see from any of their scorecards. PMF enables owners to interactively view and personalize the metrics displayed on a dashboard, and PMF saves the preferences for each user.

The following three icons are available in the upper-right corner of each gadget:

- Previous page icon. Goes back to the previous page.
- Preferences icon. Opens the change preferences panel.
Refresh icon. Refreshes to saved preferences.

**Note:** These three icons are removed from the view when you click anywhere outside the gadget.

When you select the preferences icon, the gadget configuration panel appears, as shown in the following image.

![Gadget Configuration Panel](image)

You can select specific display options, depending on which groupings and filters are available in the dialog, and then click Preview to re-display the gadget with the new configuration. There are options to Save your personalizations, Revert back to your current saved preferences, or Close the dialog without further changes. If you save your preferences, the next time you refresh the page, or log out and log back in to PMF, the gadget displayed reflects your saved preferences. PMF permanently retains all preferences for every gadget for each user until it is changed. The menus available in the configuration panel vary depending on how the gadget was designed. For more information about designing gadgets, see *Designing Gadgets* on page 453.

### Resizing and Displaying Gadgets

The size of a PMF Gadget depends on the content it contains. PMF Gadgets can contain drill downs to many contexts including operational reports, detailed views, websites, mini-dashboards, and graphs. After you utilize a drill down, a Gadget automatically detects the area required to display the new content and resizes accordingly.

If a resized Gadget covers part of another Gadget, you can bring the covered Gadget back into full visibility by clicking any part of it. You can also click any space on the dashboard where no Gadgets exist to restore visibility to all of the Gadgets on the dashboard. Additionally, if you click the Back button on a Gadget, PMF automatically resizes the Gadget back to its default size.
The following is an example of how multiple gadgets may appear on your dashboard:

![Dashboard Example]

**Working with Gadget Tracking Menus**

PMF tracking captions with instant menus allow you to:

- Hover to see menus that allow you to quickly and effectively drill to other cached contexts.
- Exempt any gadget from the inter-gadget Broadcast.
- Use the one-click page flip capability.
As you interact and drill with chart gadgets on the PMF dashboard, the captions display the initial filter and grouping conditions for each gadget, as shown in the following image.

![Chart gadget example](image)

As you change the gadgets, the captions continue to track so you never lose context of the information you are viewing.

You can change the current applied filter for Object, Time Range, and Dimension by hovering over the top of the tracking menu. A drop-down menu appears with the filters, as shown in the following image.

![Filter drop-down menu](image)
To auto-activate the page flip, click the Flip button on the tracking menu. The gadget view will change, as shown in the following image.

![Trend 1]

To exclude the gadget from receiving any Broadcasts, click the Disable Broadcast button. This will lock the gadget in place, which allows more control over comparative analysis.

**Note:** The buttons and menus in a gadget automatically resize in Zoom mode, and are mobile friendly. You can use tap and gesture on touch sensitive devices, as well as use a mouse.
What is Broadcast?

In this section:
- Setting Up Broadcast on a Dashboard
- How to:
  - Change Multiple Gadgets in a Broadcast Group
  - Apply Time Animation

Broadcast enables changes you make to the parameters passed to a gadget to be shared among other gadgets on the dashboard. If an administrator has enabled Broadcast for your dashboards, it enables you to cascade simultaneous changes which you specify across multiple gadgets on the dashboard. As a result, you can quickly compare similarities and differences between multiple Dimension areas, or compare different Measures for the same Dimension areas. With Broadcast, changing the Dimension Preferences on any gadget can change the displayed Dimension data for all gadgets. It works as if you had changed the Dimension groupings or filters on all gadgets in the Broadcast group and then clicked Preview simultaneously. You can add a gadget or remove a gadget from a Broadcast group with a few clicks.

For all gadgets, (both HTML5 and other) if Broadcast is active, the Preferences box also controls the currently displayed filters. This actually controls all gadgets grouped for Broadcast on the dashboard, regardless of whether they are HTML5 or not.

If your administrator enabled time animation when setting up a Broadcast group on a dashboard, you can select the time range that you want to display in the group. PMF automatically refreshes the views in the Broadcast group so that they display the selected time range.

Setting Up Broadcast on a Dashboard

How to:
- Set Up Broadcast on a Dashboard

When you implement the Broadcast capability, run-time values specified by a user in the Preferences panel for a single gadget are applied to all the gadgets in a group. As a result, users can quickly compare similarities and differences among multiple dimensional areas, or compare different measures for the same dimensional areas.

You can also enable animation of the time range that appears in a Broadcast group.

To implement those capabilities for your users, use the Broadcast chevron in Dashboard Designer when creating a new dashboard or editing an existing dashboard.
For an example of a dashboard on which Broadcast has been applied, see *What is Broadcast?* on page 147.

**Procedure: How to Set Up Broadcast on a Dashboard**

This procedure assumes that you are in Dashboard Designer, that you have added gadgets from the Catalog to the dashboard, and that you have specified your preferences for each gadget.

1. Click the *Broadcast* chevron. When the Broadcast chevron is open, Dashboard Designer is in Broadcast design mode.

2. From the Broadcast drop-down menu, click the type of change that you want to share among the grouped gadgets. Possible values are:
   - Metrics only
   - Dimensions only
   - All (for both metrics and dimensions)

   The following image shows the Broadcast drop-down menu.

3. With the Broadcast chevron still open, click each gadget on the design canvas that you want to add to the Broadcast group.

   A gadget that you select on the design canvas is highlighted to indicate that it is in the group.
In the following image, the two gadgets in the group are highlighted.

**Tip:** To remove a highlighted gadget from a group, click the gadget.

4. Optionally, select the *Time Animation* check box to enable animation of the time range that the Broadcast gadgets display when the gadgets are run.

When you enable time animation, a user can apply it using the instructions in *How to Apply Time Animation* on page 151.

In the following image, the Time Animation check box is selected.

5. Click Set on the Broadcast chevron.

The Broadcast properties are saved to the dashboard, and the Broadcast chevron is closed.

When your user specifies run-time values in the Preferences panel for a gadget in the group, those values are applied to all the gadgets in the group.
Procedure: How to Change Multiple Gadgets in a Broadcast Group

1. Display the dashboard, for example, Metric Flex Mix - 01, as shown in the following image.

   ![Dashboard Image]

2. Click the heading of the top-left gadget on the dashboard, for example, Profit: Target over Actual by Quarter.
3. Click the *My Preferences for this Gadget* button. PMF displays the Preferences panel for the gadget, as shown in the following image.

![Preferences Panel Image]

4. In the Filters drop-down menu, select the one showing Time and change the Time Range selection from *Last 9 Quarters* to *Last 5 Quarters*, as shown in the following image.

![Filters Drop-down Menu Image]

5. Click *Preview*.

The gadget you selected updates to show the last 5 quarters. This change automatically propagates to all the gadgets in the Broadcast group so they are all showing data from the Last 5 Quarters.

**Procedure: How to Apply Time Animation**

1. On the Today tab, run the dashboard for which Broadcast and time animation have been enabled.

   Your administrator must set up those capabilities.
2. Click the *Explore Time* chevron, as shown in the following image.

3. From the drop-down menu, click the time range that you want to display in the Broadcast group.
   When you select a time range, the view of the data in the group changes to reflect your selection.

4. Optionally, you can:
   - Click the left arrow and right arrow buttons on the chevron to move forward and backward in time.
   - Use the slider to adjust the speed of the time animation.

**Styling the Dashboard**

**How to:**
Change the Look of a Dashboard

You can change the overall look of your Dashboard Designer from the Look chevron.

The following options are available:

- **Always show titles.** Select this option to always display gadget titles. If this option is not selected, the titles will display when you click the gadget.

- **Always show chrome.** Select this option to always display the titles, control buttons, and borders of a gadget.
- **Gadget style.** This drop-down menu allows you to pick from three different looks for the Dashboard Designer:
  - Flat Titles/Flat Border
  - 3D Titles/Shadow Border
  - Gradient Titles/Shadow Border

The following images show examples of gadget style combinations:

**Flat Titles/Flat Border with borders showing**

**3D Titles/Shadow Border with borders showing**
Gradient Titles without the borders showing

**Note:** The colors of the dashboard are separately controlled by the color styling system, as is the charting color. For more information, see *Look Settings* on page 499.

**Procedure:** How to Change the Look of a Dashboard

To change the look of a new or existing Dashboard, from the Today Page:

1. Click the *Create a new Today Page* icon or the *Edit the current selected Today Page* icon.
   - The Dashboard Designer opens.
2. Click the *Look* chevron.
3. Select your desired changes and click *Save*.

**Reference:** Catalog of Available Gadgets

The following table lists and describes the Gadgets that are available in the current release of PMF.

**Note:** As of Release 5.3.2, Flex gadgets have been deprecated. If you migrate an existing data mart to Release 8, any flex gadgets and dashboards you are using for defaults will still be in the system, and unused ones will be removed. More Gadgets will be made available in subsequent releases.
<table>
<thead>
<tr>
<th><strong>Gadget</strong></th>
<th><strong>Example</strong></th>
<th><strong>Description and Filters</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension Actual Circle-Pack</td>
<td>![Image](Dimension Actual Circle-Pack.png)</td>
<td>An animated visualization that shows proportionally-formatted Measure Actual data for any Dimensions you select, and broadcasts your selections to the entire Dashboard. Required filter is a measure. Optional filters are dimension name and a measure.</td>
</tr>
<tr>
<td>Dimension Percent Reached Circle-Pack</td>
<td>![Image](Dimension Percent Reached Circle-Pack.png)</td>
<td>A smoothly animated visualization that shows proportionally-formatted Measure Percent Reached data for any Dimensions you select, and broadcasts your selections to the entire Dashboard. Required filter is a measure. Optional filters are dimension name and a measure.</td>
</tr>
<tr>
<td>HTML5 - Metric Actual Target Prior Lines</td>
<td>![Image](HTML5 - Metric Actual Target Prior Lines.png)</td>
<td>Displays a line graph showing the variance of actual values against the variance of target values, along with prior actual values for year-over-year comparison. Required filter is measure name. No optional filters.</td>
</tr>
<tr>
<td>HTML5 - Metric Actual Target YTD &amp; Prior Bars</td>
<td>![Image](HTML5 - Metric Actual Target YTD &amp; Prior Bars.png)</td>
<td>Provides a visual analysis using bar charts to display Year-To-Date and current period performance for actual, target, and prior year values. Required filter is measure name. No optional filter.</td>
</tr>
</tbody>
</table>
### Working with Dashboards

<table>
<thead>
<tr>
<th>Gadget</th>
<th>Example</th>
<th>Description and Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML5 - Metric Actual v. Flattened Target Lines</td>
<td><img src="image" alt="Graph showing variance of actual over target values" /></td>
<td>Displays a line graph showing the variance of actual over target values, which is flattened to emphasize variances. Required filter is measure name. Optional filter is time range (defaults to Last Five Periods view if no time range is provided).</td>
</tr>
<tr>
<td>HTML5 - Metric Bubble Chart</td>
<td><img src="image" alt="Bubble Chart Example" /></td>
<td>Displays a placed distribution of performance values where the midpoint of each value falls along a horizontal Dimensional axis and Performance on the vertical axis. Size of the bubble indicates the actual value. Required filters are dimension name and measure name. Optional filter is Time Range used.</td>
</tr>
<tr>
<td>HTML5 - Metric Bubble Value Chart</td>
<td><img src="image" alt="Bubble Chart Example" /></td>
<td>Displays a placed distribution of Measure Actual values where the midpoint of each value falls along a horizontal Dimensional axis and Performance on the vertical axis. Size of the bubble indicates the actual value. Required filters are dimension name and measure name. Optional filter is Time Range used.</td>
</tr>
<tr>
<td>HTML5 - Metric Counts of Actual RYG Bars</td>
<td><img src="image" alt="Bar Chart Example" /></td>
<td>Displays the total Hi-Mid-Low (H-M-L) counts of a metric range. Also shows the H-M-L share of the total count of metric values in the metric range of each indicator.</td>
</tr>
<tr>
<td>Gadget</td>
<td>Example</td>
<td>Description and Filters</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HTML5 - Metric Dim Breakout Actual Bars</td>
<td><img src="chart1.png" alt="Sales chart" /></td>
<td>Displays actual value distribution for any Dimension and level. Displays a series of bars across a selected dimension using indicator colors for the current time period. Required filters are dimension name and measure name. Optional filter is dimension level to pre-drill.</td>
</tr>
<tr>
<td>HTML5 - Metric Dim. Breakout Donut</td>
<td><img src="chart2.png" alt="Donut chart" /></td>
<td>Displays a donut chart showing metric quantities distributed across a selected dimension and level value. Required filter is dimension name. Optional filter is the level value to begin the breakout for the dimension.</td>
</tr>
<tr>
<td>HTML5 - Metric Dim. Breakout Perf. Bars</td>
<td><img src="chart3.png" alt="Bar chart" /></td>
<td>Displays performance distribution for any dimension and level. Displays a series of bars across a selected dimension using indicator colors for the current time period. Required filters are dimension name and measure name. Optional filter is dimension level to pre-drill.</td>
</tr>
<tr>
<td>HTML5 - Metric Dim. Breakout Pie</td>
<td><img src="chart4.png" alt="Pie chart" /></td>
<td>Displays a pie chart showing metric quantities distributed across a selected dimension and level value. Required filter is dimension name. Optional filter is the level value to begin the breakout for the dimension.</td>
</tr>
<tr>
<td>Gadget</td>
<td>Example</td>
<td>Description and Filters</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HTML5 - Metric Dim. Pareto Distribution Chart</td>
<td><img src="image1.png" alt="Chart Example" /></td>
<td>Shows the proportion of Actual values for all measures for the selected Perspective for the current or any single-point Time Period. Differs by Scorecard. Required filter is one user-selected dimension.</td>
</tr>
<tr>
<td>HTML5 - Metric Pct Reached for Perspective</td>
<td><img src="image2.png" alt="Table Example" /></td>
<td>Shows the percent reached for all measures for the selected Perspective. Differs by Scorecard. Required filter is one user-selected perspective.</td>
</tr>
<tr>
<td>HTML5 - Metric Perf. Gauge</td>
<td><img src="image3.png" alt="Gauge Example" /></td>
<td>Displays the percent achieved for the selected measure, and illustrates the measure set tolerances in red/yellow/green. Required filter is measure selection. No optional filters.</td>
</tr>
<tr>
<td>HTML5 - Metric Perf. Trend Bars</td>
<td><img src="image4.png" alt="Bar Chart Example" /></td>
<td>Displays a time series of bars using indicator colors. Required filter is measure name. Optional filter is time range (defaults to Last Five Periods view if no time range is provided).</td>
</tr>
<tr>
<td>HTML5 - Metric Value Trend Bars</td>
<td><img src="image5.png" alt="Bar Chart Example" /></td>
<td>Displays a time series of bars using indicator colors. Required filter is measure name. Optional filter is time range (defaults to Last Five Periods view if no time range is provided).</td>
</tr>
<tr>
<td>Gadget</td>
<td>Example</td>
<td>Description and Filters</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>HTML5 - Metric Perf. Trend Lines &amp; Bars</td>
<td><img src="Image" alt="Graph" /></td>
<td>Displays a time series of bars using indicator colors with two lines drawn over the bars to show actual and target values. Required filter is measure name. Optional filter is time range.</td>
</tr>
<tr>
<td>HTML5 - Metric Value Trend Lines &amp; Bars</td>
<td><img src="Image" alt="Graph" /></td>
<td>Displays a time series of bars using indicator colors with two lines drawn over the bars to show actual and target values. Required filter is measure name. Optional filter is time range.</td>
</tr>
<tr>
<td>HTML5 - Metric Tree Map</td>
<td><img src="Image" alt="Tree Map" /></td>
<td>Displays a drillable tree map of shares of various contributors. Required filters are dimension name and measures to display in the map.</td>
</tr>
<tr>
<td>HTML5 - Metrics Actual Multiline</td>
<td><img src="Image" alt="Line Chart" /></td>
<td>Displays a line chart to show the actual value with a smooth line. For comparison, each line is a different measure. Required filter is measure multi-selection. Optional filters are dimension and time.</td>
</tr>
<tr>
<td>HTML5 - Metrics Pct-Rchd Multiline</td>
<td><img src="Image" alt="Line Chart" /></td>
<td>Displays a line chart to show the percent reached with a smooth line. For comparison, each line is a different measure. Required filter is measure multi-selection. Optional filters are dimension and time.</td>
</tr>
<tr>
<td><strong>Gadget</strong></td>
<td><strong>Example</strong></td>
<td><strong>Description and Filters</strong></td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>HTML5 - Metrics Strategic Pct-Rchd Multibars</td>
<td><img src="image1.png" alt="Multibars Example" /></td>
<td>Displays a multi-bar chart to show the percent reached for groups of Measures across a Dimensional breakout. For comparison, each color series of bar in each group represents a different measure, and groupings indicate the dimensional breakout. Required filter is measure multi-selection and Dimension and level for the breakout. Optional filter is time.</td>
</tr>
<tr>
<td>HTML5 - Metrics Actual Multibars</td>
<td><img src="image2.png" alt="Multibars Example" /></td>
<td>Displays a multi-bar chart to show the actual value for groups of Measures across a Dimensional breakout. For comparison, each color series of bar in each group represents a different measure, and groupings indicate the dimensional breakout. Required filter is measure multi-selection and Dimension and level for the breakout. Optional filter is time.</td>
</tr>
<tr>
<td>HTML5 - Perspective Compare Perf. - Horz Bars</td>
<td><img src="image3.png" alt="Horz Bars Example" /></td>
<td>Displays a horizontal grouping of performance trends for all objectives in a perspective. No required filters (defaults to the currently selected scorecard). Optional filters are perspective and time range (defaults to Last Five Periods view if no time range is provided).</td>
</tr>
<tr>
<td>HTML5 - Perspective Compare Perf. - Vert Bars</td>
<td><img src="image4.png" alt="Vert Bars Example" /></td>
<td>Displays a vertical grouping of performance trends for all objectives in a perspective. No required filters (defaults to currently selected scorecard). Optional filters are perspective and time range (defaults to the Last Five Periods view if no time range is provided).</td>
</tr>
<tr>
<td>Gadget</td>
<td>Example</td>
<td>Description and Filters</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HTML5 - Perspective Perf.</td>
<td><img src="image1.png" alt="Perspective Perf. Gauge" /></td>
<td>Displays the Percent Reached aggregate at the Perspective level for the selected Scorecard. Differs by Scorecard. Required filter is perspective name.</td>
</tr>
<tr>
<td>Perspective Perf. Gauge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTML5 - Project Gantt Chart</td>
<td><img src="image2.png" alt="Gantt Chart" /></td>
<td>Displays a graphical overview of project status. Required filter is a project.</td>
</tr>
<tr>
<td>Metric - Advanced Properties</td>
<td><img src="image3.png" alt="Advanced Properties" /></td>
<td>Allows end users with proper access to edit critical Measure properties directly from the Dashboard. Required filter is a measure.</td>
</tr>
<tr>
<td>Metric - Big Number</td>
<td><img src="image4.png" alt="Big Number" /></td>
<td>Displays a rotating value for Actual and Percent Reached for the Measure. Required filter is a measure.</td>
</tr>
<tr>
<td>Metric - Sparkline &amp; Bullet Chart Grid</td>
<td><img src="image5.png" alt="Sparkline &amp; Bullet Chart Grid" /></td>
<td>Displays actual, target, and variance data with an actual vs. target horizontal sparkline and bullet chart. No required filters.</td>
</tr>
</tbody>
</table>
### Metric - Counts of RYG Bars

Displays performance data using red, yellow, and green indicator color bars for the current time period.

No required filters.

### Metric - Performance Grid

Displays a grid of all metrics for the current scorecard and can show multiple measure selections if desired. Optional grouping can be done on the dimension name and level.

No required filters. Optional filter is perspective. If you apply filtering, it limits the grid to displaying only measures linked to that object.

### Metric - Values Grid

Displays a grid of all metrics for the current scorecard and can show multiple measure selections if desired. Optional grouping can be done on the dimension name and level.

No required filters. Optional filter is perspective. If you apply filtering, it limits the grid to displaying only measures linked to that object.
<table>
<thead>
<tr>
<th>Gadget</th>
<th>Example</th>
<th>Description and Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric - Dimensional Crosstab Across Measure Grid</td>
<td><img src="image" alt="Measure Grid Example" /></td>
<td>Displays a drillable grid view of multiple measure values distributed in a particular dimension and level for use as a quick comparison of metrics. Required filters are dimension name and measures to display in columns. Optional filter is dimension level to pre-drill.</td>
</tr>
<tr>
<td>Metric - Performance Trend Grid</td>
<td><img src="image" alt="Quarterly Trend Grid Example" /></td>
<td>Displays a drillable grid view of values distributed for single or multiple measures across a selectable time range to provide quick trending of one or more Measures. Required filter is time range for trending (default is 5 periods). Optional filter is single, multiple, or all measures.</td>
</tr>
<tr>
<td>Metric - Values Trend Grid</td>
<td><img src="image" alt="Quarterly Trend Grid Example" /></td>
<td>Displays a drillable grid view of values distributed for single or multiple measures across a selectable time range to provide quick trending of one or more Measures. Required filter is time range for trending (default is 5 periods). Optional filter is single, multiple, or all measures.</td>
</tr>
<tr>
<td>Perspective - Objectives Summary Grid</td>
<td><img src="image" alt="Objective Summary Grid Example" /></td>
<td>Displays a summary showing current and previous achievement percentages, trend, weight, and all corresponding indicators for the selected group of objectives. No required filters (defaults to currently selected scorecard). Optional filter is perspective.</td>
</tr>
<tr>
<td>Gadget</td>
<td>Example</td>
<td>Description and Filters</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Perspective - Compact Overview Grid</strong></td>
<td><img src="image" alt="94.6% Financial" /> <img src="image" alt="94.0% Customer" /> <img src="image" alt="97.8% Internal process" /></td>
<td>Displays a summary showing bars and indicators for the count of high, mid, and low objectives for each perspective included. No required filters (defaults to currently selected scorecard). Optional filter is perspective.</td>
</tr>
<tr>
<td><strong>Scorecard - Strategy Map</strong></td>
<td><img src="image" alt="Strategy Map" /></td>
<td>Displays a strategy map in the dashboard that is a peer in display.</td>
</tr>
<tr>
<td><strong>Utility - Administration - Measures</strong></td>
<td><img src="image" alt="Metadata Grid" /></td>
<td>Displays detailed information about scorecard metrics to a PMF Administrator and contains drill downs to view detailed properties for all measures.</td>
</tr>
<tr>
<td><strong>Utility - Google Search on Filter</strong></td>
<td><img src="image" alt="Google Search" /></td>
<td>Displays search results in Google for a selected Dimension level value. Does not differ by scorecard. Required filter is user-specified dimension and level value.</td>
</tr>
<tr>
<td>Gadget</td>
<td>Example</td>
<td>Description and Filters</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Utility - Legend                           | ![Legend](image) | Displays the color language used in all Graph gadgets on the dashboard. Since all legends on all charts would be the same, this saves space on your dashboard.  
There are no required filters. |
| Utility - Action Block                     | ![Actions](image) | Displays the PMF Action Block which enables owners to work with their fired alerts, create new alerts, manage scheduled alerts, manage Schedule This reports, and input user-entered measures for their scorecard.  
There are no required or optional filters. |
| Utility - Administration - DB Overview Grid| ![Stats](image) | Displays overview statistics for the PMF data mart to a PMF Administrator. This grid also fires the resynchronization function if the data mart is switched to point to a different data mart.  
There are no required or optional filters. |
<table>
<thead>
<tr>
<th>Gadget</th>
<th>Example</th>
<th>Description and Filters</th>
</tr>
</thead>
</table>
| Utility - Dimension Tree | ![Dimensions](image) | Displays all dimensions in a tree.  
There are no required or optional filters. |
|                        |         |                                                                                        |
| Utility - Scorecard Tree | ![Scorecard](image) | Displays all scorecards in a tree.  
There are no required or optional filters. |
|                        |         |                                                                                        |
| Utility - Analysis Designer | ![Analysis Designer](image) | Displays the PMF Analysis Designer, which enables you to specify parameter options and run a view based on those options. The available parameter options are grouped into five sections: Layout, Groupings, Data, Filter, and Report. |
### Using PMF Content on your Mobile Device

**In this section:**
- Using the Ginsu Slicer
- Zooming in Mobile

Using your PMF content on a mobile device is simple. Any PMF dashboard or other PMF-managed content can be turned into a WebFOCUS Mobile Favorite by clicking the **Add to Mobile Favorites** icon on the Today tab ribbon. You will receive a confirmation page that the content has been added to your Mobile Favorites.

You can navigate through any mobile dashboard using standard mobile device gestures on any iOS or Android™ device. Using the magnifying glass on the dashboard will zoom in on gadgets, allowing you to see enhanced detail and more easily interact with the gadget. Swiping the screen will allow you to navigate from gadget to gadget.

**Note:** Gadgets allow operation in the following browsers: Safari®, Android, Firefox®, and Google Chrome™. Microsoft Internet Explorer is not currently supported.

### Using the Ginsu Slicer

The Ginsu slicer allows you to use swiping and tapping gestures to set up dashboard parameters on any mobile device by touch. It can also be used if you are running Chrome, Firefox, or Safari from a PC.

<table>
<thead>
<tr>
<th>Gadget</th>
<th>Example</th>
<th>Description and Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utility - UE Sources</td>
<td><img src="image" alt="Utility - UE Sources" /></td>
<td>Allows end users to input data for groups of User Entered Source Datapoints they have access to. Also filterable by Dimensions as defined on each Source.</td>
</tr>
<tr>
<td>Utility - Feedback</td>
<td><img src="image" alt="Utility - Feedback" /></td>
<td>An easy-to-use accordion view that allows you to quickly view and respond to Feedback on any Measure for the current Dashboard.</td>
</tr>
<tr>
<td>Live with Update</td>
<td><img src="image" alt="Live with Update" /></td>
<td></td>
</tr>
</tbody>
</table>
To use the slicer:

If using a mobile device, drag your finger up from the bottom of the window to open the slicer. If using a PC browser, click the slicer to open it. The slicer opens, as shown in the following image.

Once you set up your desired parameters, the dashboard gadgets automatically refresh to show these changes.

**Zooming in Mobile**

On tablet-type devices, the PMF dashboard locks and zoom is not available during Broadcast. You can tap on chart and grid components to broadcast changes of a dimensional drill or object to the overall dashboard, without zooming.

Zoom is implemented using a separate button located on the bottom right of the dashboard. Tapping the Zoom button zooms the top-left gadget on the Dashboard to full-screen, and you can swipe between the different gadgets from Zoom view.
This chapter describes the authoring role and provides instructions for establishing the business strategies in a Performance Management Framework (PMF) application.

Topics:
- Implementing PMF
- PMF Prerequisites
- Getting Started as a PMF Author
- Authoring in PMF
- Navigating PMF: Adding, Changing, and Deleting Items
- Scorecarding
- Navigating the Author Tab
- Creating a New Scorecard
- Creating Strategy and Risk Objects
- Drawing a Strategy Map
- Adding Themes to a Strategy Map
- Linking Projects and Processes to Objectives in the Strategy Map
- Understanding Measures
- Indicator Concepts
- Weighting Measures Across Objectives
- Weighting Objectives Across a Strategy
- Automatic Equal Weighting
- Setting a Basis for Descending Measures
- Overriding Measures at the Measure Level
- Documenting Your Work
- Scorecard-Specific Data Access Security
- Author Scorecard Options
- PMF Tabs - Quick Reference for Authors
Implementing PMF

Designing a working scorecard or metrics dashboard with PMF requires not only the information and data to be presented, but also strategic information about your enterprise. The implementation process is usually straightforward. The work flow in the Performance Management practice starts with the installation by technical staff and ends with a production-ready PMF application being used by all identified users.

The basic steps for implementing PMF at a site are:

- Installing PMF components.
- Creating scorecards to group metrics based on business objectives for groups of users.
- Making scorecards available to users at all levels.
- Designing and loading dimensions and metrics (done by an administrator).
- Maintaining the scorecards and using them to chart corporate progress.
- Setting up access and functional security (done by an administrator).

PMF Prerequisites

Before you start entering objectives and metrics into the PMF metrics dashboard, you should have a basic understanding of strategy information for your enterprise. Even if your intention is not to begin with a full balanced scorecard view of your enterprise, you should be familiar with these aspects of organization performance.

Before you can author a PMF application, your enterprise must have:

- Successfully installed and configured the product based on the requirements in the Performance Management Framework Installation and Configuration Guide, and verified the sample Century Corp scorecard to meet the installation requirements.
- Designated staff responsible for strategy design if needed.
- Established a balanced scorecard or the goal to build the scorecard if needed.
- Assigned the duties of authors and administrators.
Getting Started as a PMF Author

In this section:
What You Should Know

The role of author is one of the most important in the PMF design process. The main responsibility of the author is the overall metrics and strategic content of PMF scorecards. The Author and Strategy subtabs contain most of the tools the author needs to perform these tasks.

What You Should Know

Authoring a PMF application can involve:

- Understanding the concepts of scorecards.
- Meeting with personnel who have knowledge of:
  - Organization strategies.
  - Organization measures and Key Performance Indicators (KPIs).
  - Current applications at the customer site that provide measures and KPI data.
- Acting as a liaison between the Business Strategy Committee and the administrators of the PMF application if needed.

Authoring in PMF

In this section:
Scorecard Building Methodology
Schemas

The role of the author is to capture and record strategies that serve as the basis for the Performance Management solution. An author serves both a business role and a technology role in the enterprise. The author outlines strategies as they evolve and then captures these in PMF as the basis of all scorecard views. The author also interacts with the PMF administrator to ensure that measures needed for the overall strategy are loaded, and checks the good sense and accuracy of these measures.

Note: When making any changes within the Author tab, it is recommended that you click the Refresh Contents icon to ensure that your changes take effect immediately.
Scorecard Building Methodology

To build a scorecard with a Business Strategy Committee, you must:

- Interact with the Business Strategy Committee (if you have one) to build strategic linkages.
- Determine indicators of success.
- Identify processes and projects.
- Build the scorecard process.

Determine the following:

- Key Performance Indicators (KPIs)
- Mission statement

Determine and specify the following:

- Dimensions
- Measures
- Objectives
- Risks
- Perspectives
- Projects
- Processes
- Themes

Determine the options for Today page content, which include:

- Explaining different versions and options.
- Identifying the roles of various users in the organization.
- Confirming content with the Business Strategy Committee after you successfully load your scorecards.

Interact with administrators who will:

- Acquire measures.
- Acquire dimensions, sources, datapoints, and measures.
- Set up feeds.
- Set up Dimensional security, if desired.
Test loads.

**Schemas**

The main schemas of PMF, and questions you should ask are:

- **Measures.** What do you want to measure? Where do measures originate? What units of measure are needed to support these? How should these be aggregated?

- **Sources.** What sources will provide data for your measures? Do you have all data on hand, or will you need to capture some from end users or other personnel?

- **Dimensions.** What business dimensions are required? Examples of dimensions to consider are Customer, Location, Product, Service, Organization, and additional Time dimensions.

- **Scorecard.** What overall business strategies are to be implemented? One strategy is supported per scorecard.

- **Objectives.** What specific, measurable goals are included in a strategy?

- **Risks.** What risks are present and need to be tracked? How can these be measured?

- **Projects.** What specific projects are linked to your objectives?

- **Processes.** What specific processes are linked to your objectives?

**Navigating PMF: Adding, Changing, and Deleting Items**

PMF gives you a tree-based means of navigating its hierarchy of contents. You can access any PMF scorecard, metric, or system object through hierarchy tree menus. After you have located the object you want to edit, click the object name in the tree. PMF displays an edit [object] panel to the right of the tree where you can make changes.

To create a new object or delete an existing object, you can access information in an edit [object] panel and then click the New or Delete button. You can also right-click a peer of the new object in the tree menu and select New from the pop-up menu that appears. PMF will display a new [object] panel.

To perform scorecard maintenance, click the scorecard tree to work with scorecard objects through the panels.
There are two methodologies for working with PMF. You can work from the top down by drawing a high-level strategy and creating measures. You can also work from the bottom up by creating a KPI Dashboard using loaded measures and adding the strategy elements at some point in the future.

<table>
<thead>
<tr>
<th>Top Down Process</th>
<th>Bottom Up Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you use the top down process, perform the following steps before you create any metrics.</td>
<td>If you use the bottom up process, perform the following steps before you create a scorecard.</td>
</tr>
<tr>
<td><strong>1.</strong> Create a new scorecard. Populate it with objectives, perspectives, themes, projects, and processes. For details, see <em>Creating a New Scorecard</em> on page 180.</td>
<td><strong>1.</strong> Set up metrics and load them into the PMF data mart. For details, see <em>Planning Considerations For Loading Sources</em> on page 380.</td>
</tr>
<tr>
<td><strong>2.</strong> Set up a few user-entered measures. For details, see <em>Adding and Editing Measures</em> on page 213.</td>
<td><strong>2.</strong> Immediately use the relaxed reports that provide KPI dashboard-like views of your metrics.</td>
</tr>
<tr>
<td><strong>3.</strong> Draw your Strategy Map and observe its flow through the views built into PMF. You can tweak your design until it best fits your organization strategy. For details, see <em>Drawing a Strategy Map</em> on page 203.</td>
<td><strong>3.</strong> Use the PMF Scorecard Wizard and Measures Wizard to create a scorecard, tie measures to a scorecard, and draw a strategy. The Wizards allow you to link your live metrics to a strategy in minutes. For details, see <em>Creating a New Scorecard</em> on page 180 and <em>Loading Production Measures</em> on page 222.</td>
</tr>
<tr>
<td><strong>4.</strong> When the time comes to hook up the scorecard to loaded metrics, you can easily switch over from manually entered metrics to multi-dimensional loaded metrics. For details, see <em>Planning Considerations For Loading Sources</em> on page 380.</td>
<td></td>
</tr>
</tbody>
</table>
Navigating the Author Tab

The panel buttons in the Author tab represent components that involve scorecards, measures, objectives, projects, and processes. Click a panel button to view its contents. The following is a summary of the subordinate levels for each component.

<table>
<thead>
<tr>
<th>Component</th>
<th>First Level</th>
<th>Second Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecards</td>
<td>Perspective and Themes</td>
<td>Objectives</td>
</tr>
<tr>
<td>Measures</td>
<td>Measures Source</td>
<td>Measure detail...</td>
</tr>
<tr>
<td>Perspectives</td>
<td>Measures Source</td>
<td></td>
</tr>
<tr>
<td>Objectives</td>
<td>Measures Source</td>
<td></td>
</tr>
<tr>
<td>Risks</td>
<td>Measures Source</td>
<td></td>
</tr>
<tr>
<td>Themes</td>
<td>Themes</td>
<td></td>
</tr>
<tr>
<td>Projects</td>
<td>Objectives</td>
<td>Measures Source</td>
</tr>
<tr>
<td>Processes</td>
<td>Objectives</td>
<td>Measures Source</td>
</tr>
</tbody>
</table>

If you are in demo mode (that is, you are accessing the pmf_manufacturing, or something similar, data mart), the first panel button in the Author tab, Scorecards, includes a sample scorecard you can use to learn how to navigate within PMF. For more information, see Navigating the Scorecard Tree on page 176. When the Scorecards panel button is selected, two buttons are displayed. The New button opens the New Scorecard panel to create a new scorecard. The Wizard button opens the New Scorecard Wizard to guide you through the process of creating a new scorecard. For more information about the Scorecard Wizard, see Creating a New Scorecard on page 180.
When the next panel button, Measures, is selected, two buttons are displayed. The New button opens the New Measure panel to create a new measure. The Wizard button opens the New Measure Wizard to guide you through the process of creating a new measure. For more information about the New Measure Wizard, see Adding and Editing Measures on page 213. For details about creating and editing measures, see Adding and Editing Measures on page 213. For details about manually entering measures, see Working with User-Entered Measures on page 214.

The Perspectives, Objectives, Risks, Themes, Projects, and Processes panel buttons provide you with options for viewing, creating, editing, and deleting objectives, risks, projects, and processes. To learn more about working with these Author tab options, see the following topics:

- Scorecard Perspectives on page 243.
- Objectives on page 244.
- Risks on page 246.
- Scorecard Themes on page 250.
- Projects on page 251.
- Processes on page 265.

You can also select the Show My Objects button at the bottom of the Author tab navigation panel to filter out any objects for which you are not the owner. If the Show all Objects button is displayed, then you are already viewing just the objects for which you are the owner. If you select Show all Objects, all objects for all owners are displayed. Note that the ability to edit objects is controlled by the Functional Role access of the owner. To set Show My Objects as the default, set the Object Display Type setting to U in the UI panel on the Settings menu. For more information, see Viewing and Editing Default Settings on page 495.

**Navigating the Scorecard Tree**

To view the contents of the sample scorecard, expand the Scorecard and CenturyCorp Card folders to display the main scorecard component, Perspectives, as shown in the following image.

![Scorecard Tree Image](image)

You can continue expanding folders to reveal additional scorecard elements and see a big picture view of the scorecard structure.
The Perspectives folder can be expanded to reveal subfolders. If you expand one of the Perspective subfolders, for example, Customer, the Objectives folder appears. Expanding any of the Objective folders reveals the Measures, Projects, and Processes folders, which are at the core of building a scorecard. For more information about working with perspectives, see *Scorecard Perspectives* on page 243.

The following image shows the expanded Measures folder for the objective, Shipping costs down 5 Pct, which are all integral parts of the Internal process perspective in the CenturyCorp Card.
The Themes folder can also be expanded to reveal objectives and measures elements, as shown in the following image.

For more information about working with themes, see *Scorecard Themes* on page 250.

**Editing, Deleting, and Creating Scorecards**

To perform detailed maintenance of a scorecard, expand the scorecard tree and select a perspective, theme, objective, measure, project, or process to display the associated Edit panel to the right of the scorecard tree where you can make any necessary changes.
The contents of the existing CenturyCorp Card scorecard are displayed to the right of the scorecard tree in the Edit Scorecard panel, as shown in the following image.

In the Edit Scorecard panel, you can edit the Scorecard Name, select the Scorecard Type, select a different Parent Scorecard, change the Owner, and add or edit a scorecard Mission Statement. You can also select the Object Shape that is used for displaying objectives in the Strategy Map. For more information about the modifiable fields of a scorecard, see *How to Create a New Scorecard by Cascading* on page 185.

There are two additional buttons that enable more functionality in the Edit Scorecard panel.

- If you click the *Adjust Objective Weights* button, the Objective Weights panel opens, where you can control the percentage that each objective represents as part of the overall scorecard strategy. For more information, see *Weighting Objectives Across a Strategy* on page 235.
Creating a New Scorecard

- If you click the Configure Functional Access button, the Edit Scorecard User Access panel opens, where you can configure Scorecard Functional Access. For more information, see Working With Scorecard Security on page 291.

When you select the Delete button in the Edit Scorecard panel, a dialog box appears asking you to confirm that you want to delete the scorecard.

**Note:** If you delete an existing scorecard, you will permanently remove the scorecard schema, including perspectives, Strategy Map, objectives, themes, and links to projects, processes, and metrics.

### Creating a New Scorecard

<table>
<thead>
<tr>
<th>In this section:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard Cascading</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>How to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a New Scorecard Using the Scorecard Wizard</td>
</tr>
</tbody>
</table>

You can create a new scorecard using the New Scorecard Wizard or by cascading from a parent scorecard. The New Scorecard Wizard quickly sets up all of the basic records you need to create a scorecard including the scorecard record, the four standard Kaplan/Norton perspectives, and the desired objectives.

**Procedure:** How to Create a New Scorecard Using the Scorecard Wizard

1. In the Author tab, click the Scorecards panel button in the left pane.
2. Click the Wizard button.
The scorecard wizard appears, as shown in the following image.

3. Complete the fields in the panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard Name</td>
<td>Type a name for your new Scorecard. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Scorecard Type</td>
<td>Select Performance or Risk.</td>
</tr>
<tr>
<td>Parent Scorecard</td>
<td>If the Scorecard should be cascaded from a parent, select the desired parent scorecard. All scorecards that you have access to are shown in the drop-down menu.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the user ID of the owner of the scorecard. By default, your owner ID is used.</td>
</tr>
<tr>
<td>Today Page</td>
<td>Select the default Today Page for the new scorecard.</td>
</tr>
<tr>
<td>Objectives</td>
<td>Select the shape to use for Objectives in the Strategy Map. Choose Oval, Rectangle, Rounded Rectangle, Wide Oval, Wide Rectangle, or Wide Rounded Rectangle.</td>
</tr>
</tbody>
</table>
Select the shape to use for Risks in the Strategy Map. Choose Oval, Rectangle, Rounded Rectangle, Wide Oval, Wide Rectangle, or Wide Rounded Rectangle.

Optionally, type text to describe the fundamental purpose of the new scorecard. This information is displayed in the Strategy Map and in some views.

4. Click Next.

The next page, used to add perspectives, is displayed in the new scorecard wizard.

**Note:** You can click Previous at any time before the Finish step to go back and make changes.

5. Select the *Use default Perspectives* check box or type a value in each of the four Perspective fields.

6. Click Next.

The next page, used to add objectives, is displayed in the new scorecard wizard, as shown in the following image.
7. For each new objective that you want to add, select an objective category from the drop-down menu (to the right of Objective 1), and double-click the desired item in the objective selection box, which is located below the objective category drop-down menu.

You can also do any of the following:

- Replace an objective that was already selected. Highlight an item in the objective selection box and click the left-pointing arrow to the right of the existing objective.

- Manually add an objective name. Click the Add Objective button and type the name of the desired objective in the blank objective field. Note that when you do this, you will have to also manually type a name for the associated measure.

- Remove the last objective. Click the Remove last Objective button.

8. Select the Create standard metrics check box to set up new standard measures for each objective as defined in the PMF standard metrics repository.

When Create standard metrics is not selected, the Scorecard Wizard creates objectives without creating new standard measures and bypasses the step, which means you will have to manually link each objective to an existing measure or a new measure that you will create.

9. Click Next to review all of the corresponding measures for the objectives you selected on the previous page.

   If the Create standard metrics check box was not selected, you will bypass this step.

10. If you have no further changes, click Finish, otherwise, click Previous.

    When you click Finish, a summary page is displayed for the new scorecard you just created. You can click Go to card to view the new scorecard or click Another new to create another new scorecard.

Your new scorecard is now set up and ready to use.

For information on editing a scorecard created by the Scorecard Wizard, see Editing, Deleting, and Creating Scorecards on page 178. For example, you can add a mission statement to the scorecard or select the shape for displaying objectives on the Strategy Map.
Scorecard Cascading

**How to:**
Create a New Scorecard by Cascading

You can organize scorecards in a hierarchical linkage called a cascade. Cascaded scorecards enable you to drill up and down through the various scorecards set up for your organization, which allows users to view scorecards both higher up and lower down in the hierarchy of the organization. There is almost an infinite number of ways to combine scorecard cascading with data security in PMF. You can customize cascading to permit individual users to view specific metrics from other organizational scorecards, in addition to their own scorecards.

Typically, you cascade scorecards along an organization org chart or company/departmental structure. For example, if your company is in manufacturing, you might create a scorecard cascade like this, in which the parent is the Corporate card, with children representing Support, Sales, Production, and other departments.

![Scorecard Cascade Diagram]

You can add, change, or delete the parent child relationship between any two scorecards by changing the properties from the child scorecard panel. After you set up a parent child relationship between two scorecards, you can begin to drill back and forth between them.

You can create a new child scorecard by making an exact copy of an existing (parent) scorecard and the two will be automatically cascaded. You can then modify the copied (child) scorecard, changing perspectives, objectives, themes, and metrics, without affecting the parent.

In both read-only and read or write Strategy Maps, if a scorecard has a parent and one or more child scorecards, you can use the Strategy Map to navigate to the parent using a link, and the child or children using a menu.
If a scorecard has a parent and one or more child scorecards, you can use the Card drop-down menu to navigate between the parent and children or between the children. This capability is available on the Today, Analytics, and Author tabs.

**Procedure: How to Create a New Scorecard by Cascading**

1. Click the Scorecards panel button and then click the New button.
2. Complete the fields in the New Scorecard panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard Name</td>
<td>Type a name for the new scorecard. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Scorecard Type</td>
<td>Choose from Performance or Risk.</td>
</tr>
<tr>
<td>Parent Scorecard</td>
<td>Select a parent scorecard from which the new scorecard will be cascaded. All scorecards appear in the drop-down menu. Scorecards to which you have access appear in the list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Owner</td>
<td>Select an owner from the drop-down menu. The default is the owner name of the login ID.</td>
</tr>
<tr>
<td>Today Page</td>
<td>Select the default Today Page for the new scorecard.</td>
</tr>
<tr>
<td>Objectives</td>
<td>Select the shape to use for Objectives in the Strategy Map. Choose Oval, Rectangle, Rounded Rectangle, Wide Oval, Wide Rectangle, or Wide Rounded Rectangle.</td>
</tr>
<tr>
<td>Risks</td>
<td>Select the shape to use for Risks in the Strategy Map. Choose Oval, Rectangle, Rounded Rectangle, Wide Oval, Wide Rectangle, or Wide Rounded Rectangle.</td>
</tr>
<tr>
<td>Mission Statement</td>
<td>Enter text that describes the focus or fundamental purpose of the new scorecard, if desired. This information is displayed in the PMF Strategy Map and on views.</td>
</tr>
</tbody>
</table>

3. After you have entered your data in the fields of the New Scorecard panel, click Save.

Creating Strategy and Risk Objects

In this section:
- Creating or Editing a Perspective
- Creating or Editing an Objective
- Creating or Editing a Compound Objective
- Creating or Editing a Risk
- Creating or Editing a Consequence
- Deleting a Strategy or Risk Object

PMF provides a strategy management system that allows you to arrange and organize metrics into business strategies. You can link and align metrics to various business goals, projects, and themes. You can also assign a weight to an individual metric (that is, set its priority compared to other metrics).
Once you perform the preceding tasks, you can present and interpret the objects through various perspectives and business views, as appropriate for different business roles inside an organization, or outside.

PMF supports several types of objects, including perspectives, objectives, compound objectives, risks, and consequences. On the legend on a Strategy Map, a user can click a type to highlight that specific type. For example, a user can click Risk on the legend to highlight only the risk objects on the Strategy Map. This capability supports a live discussion about the risk performance of a business strategy.

Creating or Editing a Perspective

How to:
Create a Perspective
Edit an Existing Perspective

A perspective indicates a high-level classification for types of objectives. It is a container that holds objectives. You can display a perspective for any scorecard, both on a scorecard view and in the Strategy Map.

To create a perspective, you will use the New Perspective panel on the Author tab. To edit a perspective, you will use the Edit Perspective panel.

Procedure: How to Create a Perspective

1. In the Author tab, click the Perspectives panel button in the left pane.
2. Click the New button.
The following image shows the New Perspective panel that opens, with sample values in the fields.

3. Complete the fields on the New Perspective panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perspective Name</td>
<td>Type a name for the new perspective. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description of the perspective. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Owner</td>
<td>From the drop-down menu, click the ID of the owner of the perspective. The default value is the ID of the owner that is logged on.</td>
</tr>
</tbody>
</table>

4. After you have supplied the values on the panel, click Save.

**Procedure:** How to Edit an Existing Perspective

1. In the Author tab in PMF, click the Perspectives panel button.
2. Click the name of the perspective that you want to edit.
3. On the Edit Perspective panel that opens, edit the perspective as desired. The fields are the same as those on the Create Perspective panel.
4. If you are not using automatic weighting, click the Adjust Objective Weights button to set the priority of individual objectives that are linked to the perspective.

The following image shows the Objective Weights panel, with sample values.

![Objective Weights Panel]

- **a.** In the panel, drag the sliders to re-assign the weights, or type the weighting percentage in the input field.

  **Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.

Notice that the weights are automatically balanced across all the objectives.

If you do not want to balance a particular objective as you drag the sliders or type percentages, click the Lock icon to the left of the objective to lock the weight of that objective.

The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.
b. At any time, optionally click *Re-balance weights* to assign an equal percentage to all objectives.

c. Click Save on the panel when you have adjusted the weights as desired.

d. Click *Perspective* to return to the Edit Perspective panel.

5. Click Save on the Edit Perspective panel when you have finished making changes.

Creating or Editing an Objective

**How to:**

Create an Objective

Edit an Existing Objective

An objective relates to a high-level goal for business action. An objective is designed to be specific, measurable, action-oriented, results-driven, and time-based (SMART).

To create an objective, you will use the New Objective panel on the Author tab. To edit an objective, you will use the Edit Objective panel.

**Procedure: How to Create an Objective**

1. In the Author tab in PMF, click the *Objectives* panel button.

2. Click *New*. 
The New Objective panel opens, as shown in the following image.

![New Objective Panel](image)

3. Complete the fields on the New Objective panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a name for the new objective. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Report</td>
<td>From the drop-down menu, click the type of view on which the objective appears.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Leave the default value, Objective.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description of the objective. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Subjective Comments</td>
<td>Type information about the objective that helps you use it in your authoring tasks. The maximum number of characters is 1024.</td>
</tr>
</tbody>
</table>
From the drop-down menu, click the ID of the owner of the objective. The default value is the ID of the owner that is logged on.

4. After you have supplied the values on the panel, click Save.

**Procedure: How to Edit an Existing Objective**

1. In the Author tab in PMF, click the Objectives panel button.

2. In the Objectives tree on the left, locate and click the name of the objective that you want to edit.

3. On the Edit Objective panel that opens, edit the objective as desired. The fields are the same as those on the Create Objective panel. The name of the associated scorecard, perspective, and theme is shown in the respective field, if applicable.

4. Optionally, click the Link/Unlink Measures button to modify the list of measures that are linked to the objective. The Link Measures to Objective panel opens.
   a. To link a measure to the objective, locate the measure in the Measures Available to be Linked section of the panel. Select the Link? check box.

      You can link more than one measure by selecting all the applicable check boxes.

   b. To unlink a measure associated with the objective, locate the measure under Measures Currently Linked. Select the Unlink? check box for the measure.

   c. Click Save to make the changes to the list of measures that are linked to the objective.

   d. Click Objective to return to the Edit Objective panel.

5. Optionally, click the Adjust Measure Weights button to set the priority of individual measures that are linked to the objective.

   **Tip:** You can also click this button on the Link Measures to Objective panel.

   If you are not using automatic weighting, it is strongly recommended that you adjust the weighting of measures if you change linking relationships, as described in step 4. If you do not adjust weighting, metric totals may be inaccurate.

   a. On the Measure Weights panel that opens, drag the sliders to re-assign the weights, or type the weighting percentage in the input field.
**Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.

Notice that the weights are automatically balanced across all the measures.

If you do not want to balance a particular measure as you drag the sliders or type percentages, click the Lock icon to the left of the measure to lock the weight of that measure.

The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.

**b.** At any time, optionally click Re-balance weights to assign an equal percentage to all measures.

**c.** Click Save on the panel when you have adjusted the weights as desired.

**d.** Click Objective to return to the Edit Objective panel.

6. Click Save on the Edit Objective panel when you have finished making changes.

**Creating or Editing a Compound Objective**

**How to:**

- Create a Compound Objective
- Edit an Existing Compound Objective
- Edit an Individual Objective That Is Linked to a Compound Objective

A compound objective enables you to link multiple causative objectives into a grouping that you can place on a Strategy Map. When included on a dashboard, a view, or a Strategy Map, a compound objective displays the aggregate values of the contributing objectives.

To create a compound objective, you will use the New Compound Objective panel on the Author tab. To edit a compound objective, you will use the Edit Compound Objective panel.

You can also edit an individual objective that is linked to a compound objective.

To link individual objectives to a compound objective, use the standard linking function on the Strategy Map.
The following image shows a compound objective, named Blended Profit Goal, on a Strategy Map. Two objectives are linked to the compound objective. They are Profit up 20 Pct and Margin up 10 Pct.

Procedure: How to Create a Compound Objective

1. In the Author tab in PMF, click the Objectives panel button.
2. Click Compound.

The following image shows the New Compound Objective panel that opens, with sample values in the fields.
3. Complete the fields on the New Compound Objective panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a name for the new compound objective. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Report</td>
<td>From the drop-down menu, click the type of view on which the compound objective appears.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Leave the default value, Objective.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description of the compound objective. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Subjective Comments</td>
<td>Type information about the compound objective that helps you use it in your authoring tasks. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Owner</td>
<td>From the drop-down menu, click the ID of the owner of the compound objective. The default value is the ID of the owner that is logged on.</td>
</tr>
</tbody>
</table>

4. After you have supplied the values on the panel, click Save.

**Procedure: How to Edit an Existing Compound Objective**

1. In the Author tab in PMF, click the Objectives panel button.
2. In the Compound Objectives tree on the left, locate and click the name of the compound objective that you want to edit.
3. On the Edit Compound Objective panel, edit the compound objective as desired.

   If you are not using automatic weighting, the Adjust Objective Weights button enables you to set the priority of individual objectives that are linked to the compound objective.

   - Click **Adjust Objective Weights** to open the Objective Weights panel for the compound objective.
   - Drag the sliders to re-assign the weights, or type the weighting percentage in the input field.

   **Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.
Notice that the weights are automatically balanced across all the contributing objectives.

If you do not want to balance a particular objective as you drag the sliders or type percentages, click the Lock icon to the left of the objective to lock the weight of that objective.

The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.

- Optionally, click *Re-balance weights* to assign an equal percentage to all objectives.
- Click Save on the panel when you have adjusted the weights as desired.
- Click *Compound* to return to the Edit Compound Objective panel.

4. Click Save on the Edit Compound Objective panel when you have finished making changes.

**Procedure:** How to Edit an Individual Objective That Is Linked to a Compound Objective

1. In the Author tab in PMF, click the *Objectives* panel button.
2. In the Compound Objectives tree on the left, expand the node for the compound objective to which the individual objectives are linked.
3. In the tree, locate and click the name of the individual objective that you want to edit.
4. On the Edit Objective panel that opens, edit the objective as desired.
5. Click Save on the panel when you have made your edits as desired.

**Creating or Editing a Risk**

**How to:**

Create a Risk
Edit an Existing Risk

A risk describes an area that you are measuring that represents a specific problem, or threat, to your enterprise. Risks can be placed on the Strategy Map and you have the ability to link different metrics to each risk.

To create a risk, you will use the New Risk panel on the Author tab. To edit a risk, you will use the Edit Risk panel.

To link individual risks to a consequence, use the standard linking function on the Strategy Map, as described in *Drawing a Strategy Map* on page 203.
Procedure: How to Create a Risk

1. In the Author tab in PMF, click the Risks panel button.

2. Click New.
   The New Risk panel opens, as shown in the following image.

![New Risk Panel](image)

3. Complete the fields on the New Risk panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a name for the new risk. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Report</td>
<td>From the drop-down menu, click the type of view on which the risk appears.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Leave the default value, Risk.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description of the risk. The maximum number of characters is 1024.</td>
</tr>
</tbody>
</table>
4. After you have supplied the values on the panel, click Save.

**Procedure: How to Edit an Existing Risk**

1. In the Author tab in PMF, click the Risks panel button.
2. In the Risks tree on the left, locate and click the name of the risk that you want to edit.
3. On the Edit Risk panel, edit the risk as desired. The fields are the same as those on the New Risk panel. The name of the associated scorecard, perspective, and theme is shown in the respective field, if applicable.
4. Optionally, click the Link/Unlink Measures button to modify the list of measures that are linked to the risk. The Link Measures to Risk panel opens.
   a. To link a measure to the risk, locate the measure in the Measures Available to be Linked section of the panel. Select the Link? check box.
      You can link more than one measure by selecting all the applicable check boxes.
   b. To unlink a measure associated with the risk, locate the measure under Measures Currently Linked. Select the Unlink? check box for the measure.
   c. Click Save to make the changes to the list of measures that are linked to the risk.
   d. Click Risk to return to the Edit Risk panel.
5. Optionally, click the Adjust Measure Weights button to set the priority of individual measures that are linked to the risk.

**Tip:** You can also press this button on the Link Measures to Risk panel.

If you are not using automatic weighting, it is strongly recommended that you adjust the weighting of measures if you change linking relationships, as described in step 4. If you do not adjust weighting, metric totals may be inaccurate.
On the Measure Weights panel that opens, drag the sliders to re-assign the weights, or type the weighting percentage in the input field.

**Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.

Notice that the weights are automatically balanced across all the measures.

If you do not want to balance a particular measure as you drag the sliders or type percentages, click the *Lock* icon to the left of the measure to lock the weight of that measure.

The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.

At any time, optionally click *Re-balance weights* to assign an equal percentage to all measures.

Click *Save* on the panel when you have adjusted the weights as desired.

Click *Risk* to return to the Edit Risk panel.

6. Click *Save* on the Edit Risk panel when you have finished making changes.

**Creating or Editing a Consequence**

**How to:**

Create a Consequence

Edit an Existing Consequence

A consequence enables you to link multiple causative risks into a grouping that you can place on a Strategy Map. When included on a dashboard, a view, or a Strategy Map, a consequence displays the aggregate values of the contributing risks.

To create a consequence, you will use the New Consequence panel on the Author tab. To edit a consequence, you will use the Edit Consequence panel.

To link individual risks to a consequence, use the standard linking function on the Strategy Map.
The following image shows a consequence, named Delisting from Stock Market, on a Strategy Map. Two risks are linked to the consequence. They are Internal Fraud and Programming errors in systems.

**Procedure:** How to Create a Consequence

1. In the Author tab in PMF, click the Risks panel button.
2. Click Consequence.
The following image shows the New Consequence panel that opens, with sample values in the fields.

3. Complete the fields on the New Consequence panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a name for the new consequence. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Report</td>
<td>From the drop-down menu, click the type of view on which the consequence appears.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Leave the default value, Risk.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description of the consequence. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Subjective Comments</td>
<td>Type information about the consequence that helps you use it in your authoring tasks. The maximum number of characters is 1024.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Owner | From the drop-down menu, click the ID of the owner of the consequence. The default value is the ID of the owner that is logged on.

4. After you have supplied the values on the panel, click Save.

**Procedure: How to Edit an Existing Consequence**

1. In the Author tab in PMF, click the *Risks* panel button.

2. In the Consequences tree on the left, locate and click the name of the consequence that you want to edit.

3. On the Edit Consequence panel, edit the consequence as desired.
   
   If you are not using automatic weighting, the Adjust Risk Weights button enables you to set the priority of individual risks that are linked to the consequence.
   
   - Click *Adjust Risk Weights* to open the Risk Weights panel for the consequence.
   
   - If you are not using automatic weighting, drag the sliders to re-assign the weights, or type the weighting percentage in the input field.

   **Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.
   
   Notice that the weights are automatically balanced across all the contributing risks.
   
   If you do not want to balance a particular risk as you drag the sliders or type percentages, click the *Lock* icon to the left of the risk to lock the weight of that risk.
   
   The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.
   
   - Optionally, click *Re-balance weights* to assign an equal percentage to all risks.
   
   - Click Save on the panel when you have adjusted the weights as desired.
   
   - Click *Consequence* to return to the Edit Consequence panel.

4. Click Save on the Edit Consequence panel when you have finished making changes.
Deleting a Strategy or Risk Object

How to:
Delete a Strategy or Risk Object

The procedure for deleting a strategy or risk object is the same for every type of object. To delete an object, you will use the Edit panel on the Author tab.

Procedure: How to Delete a Strategy or Risk Object

1. In the Author tab in PMF, click the panel button that opens the navigation tree for the strategy or risk object that you want to delete.
2. Locate and click the name of the object.
   The Edit panel for the object opens.
3. Click the Delete button on the Edit panel.
   After you click Delete, PMF prompts you to confirm the deletion of the object.
4. Click OK to proceed with the deletion.

Drawing a Strategy Map

How to:
Draw the Strategy Map

After you have set up a scorecard and have either user-entered or production measures in the system, you can immediately begin painting your strategy. To do this, use the PMF Strategy Map.

The Strategy Map is based on industry-standard technology including SVG (Scalable Vector Graphics), which prints at boardroom-quality resolution, and CSS (Cascading Style Sheets), which can be used to easily customize the appearance of the Strategy Map. This enables you to save the Strategy Map in SVG format for embedding in reports, and style the Strategy Map by adding or changing fonts, colors, and images, without modifying the underlying PMF code. You can also add a banner title to display the scorecard name and mission statement.

Procedure: How to Draw the Strategy Map

Note: The first 3 steps apply only to new scorecards.
1. Click the Strategy subtab to display the Strategy Map.
The following image shows the Strategy Map palette area located to the right of the Strategy Map tree. The palette area is blank when you first launch the Strategy Map.

2. To begin populating the Strategy Map, click Perspectives, then Financial. The Financial perspective is added to the palette area.

3. To continue populating the Strategy Map, click Customer, Internal Process, and then Learning and Growth, and these perspectives are also added to the palette area.

If you want to change the order of the perspectives, increase or decrease the vertical size of a perspective, or remove a perspective, right-click a perspective in the palette area, and select the desired option in the pop-up menu that opens.
The following image shows the perspectives added to the Strategy Map and the available options when you right-click a perspective.

The options available by right-clicking a perspective in the palette area include:

- Remove Perspective - Removes the perspective.
- Move Perspective Up - Moves the perspective up one level.
- Move Perspective Down - Moves the perspective down one level.
- Decrease Height - Decreases the height of the perspective area by 75 pixels. (Repeat as many times as needed).
- Increase Height - Increases the height of the perspective area by 75 pixels. (Repeat as many times as needed).

4. To add objectives to the Strategy Map, click the Objectives panel button, expand the Objectives folder, and then click the desired objective, for example, Customer claims down.

The selected objective is added to the palette area as a rectangle-shaped label.

**Note:** The default rectangle-shaped objective label can be changed using the Edit Scorecard panel. For more information, see *Editing, Deleting, and Creating Scorecards* on page 178.
5. Drag the objective to the desired perspective in the Strategy Map and drop it.

The objective is now anchored to the perspective, for example, Customer claims down is anchored to Customer, as shown in the following image.

![Strategy Map Diagram](image)

**Note:** If you were to save the Strategy Map now, then navigate to the Author tab and check under the Customer perspective, you would find that the objective, Customer claims down, is now a child of that perspective.

If you want to start a link or remove an objective from the Strategy Map, right-click an objective in the palette area, and select the desired option from the pop-up menu that opens.
The following image shows the available options when you right-click an objective label.

The options available by right-clicking an objective label include:

- **Start Link** - The first step in linking two objectives.
- **Remove Objective** - Removes the objective from the palette area.

6. On the Strategy Map, click the *Fewer overall defects* objective, and when it appears in the palette area, drag it into the Customer perspective to anchor it there.

7. Right-click *Fewer overall defects* and select *Start Link* from the pop-up menu.

8. Click *Customer claims down* to link the two objectives together, as shown in the following image.

9. Drag more objectives over and link them to finish creating your Strategy Map.
Each link you create between two objectives represents the cause and effect relationship between those objectives. The network of links between all of your objectives is called a strategy in PMF.

10. From the left pane of the window, click Save to save the Strategy Map.

**Adding Themes to a Strategy Map**

**How to:**
Add Themes to a Strategy Map

Themes indicate high-level attributes of your strategy. Many organizations initially build their strategies by stating their major themes (for example, consistently high market share or world-class customer service) and then creating objectives representative of their themes.

If you are using themes, they are displayed as color keys on the PMF Strategy Map. While you are editing a strategy in the Strategy Map, you can assign themes to objectives using paint-like actions. Themes are located as the bottom element in the scorecard tree.

**Procedure: How to Add Themes to a Strategy Map**

1. On the Author tab, click the Themes panel button to expand the list of themes.
2. Click a theme, for example, *Best Practices*, to see the Edit Theme panel.

You can also click New to create a new theme.

If you are creating a new theme, select the desired scorecard from the Scorecard drop-down menu. For existing themes, the Scorecard name cannot be edited.

3. In the Theme Name field, type a name for the theme.

4. In the Description field, type a description.

5. Under the Color field, select a color. The Color field displays the numbers representing the RGB (red, green, and blue) for the color you choose.

6. In the Owner field, select an owner from the drop-down menu.

7. Click the Save button near the top of the Edit Theme panel.

8. Click the Strategy subtab to go to the Strategy Map.

9. Click the Refresh Contents icon at the upper-right corner of the Strategy Map.
   The Strategy Map refreshes updating colors, trends, and active status indicators. You may notice some or all of the following:
- The background color for an objective is the same as the indicator color for that objective.

- Up and down arrows represent the trends.

- A Project icon indicates that projects are aligned with the objective below it. If you click the indicator, you can drill down to more project data including schedule and budget status, project impact data, and project-related reports.

- A red metric icon indicates that a measure below the objective is lower than the desired threshold, which is a sign of poor performance. If you click the icon, you can quickly drill to a view of the underachieving measure.

- A feedback icon indicates that feedback has been recorded for an objective or measure below it. If you hover the mouse over the icon, the most recent feedback is displayed. If you click the icon, you can drill down to a view where you can read and edit the feedback.

10. To see the themes and colors you selected, expand the Themes tree in the Strategy Map, which is shown in the following image. A new theme, Consistently high market share, was created for the purpose of this example.
11. Click the new theme, *Consistently high market share*. It appears in the upper-left corner of the Strategy Map.

Click an objective representative of the theme, such as *Customer returns down*. A halo of the applicable color appears around the objective.

12. Click **Save** to save the Strategy Map.

You can go back into the Strategy Map at any time and change the strategy. When you change your Strategy Map, the views change to reflect your changes. Your Strategy Map controls how everything in PMF is linked together.

**Linking Projects and Processes to Objectives in the Strategy Map**

**How to:**

Link Projects and Processes to Objectives in the Strategy Map

You can link projects and processes to objectives using the PMF Strategy Map, which displays all of the objectives for a selected scorecard. Since objectives represent goals, linking projects and processes to your goals is a valuable analytical process.
If a project is linked to an objective, the Strategy Map displays a Project icon above the objective.

**Procedure:** How to Link Projects and Processes to Objectives in the Strategy Map

1. On the Strategy subtab, to display all of the objectives for a scorecard in the right pane, select the desired scorecard using the drop-down menu above Perspectives.

2. Expand either the Projects or Processes tree.

3. Click a desired project or process. It appears in the upper-left corner of the Strategy Map.

4. Click the objective you want to link to the desired project or process. The halo around the objective changes to green to indicate the project or process.

The following image shows the Customer claims down objective linked to the Warehouse Reorganization project.
To unlink any objective already linked with a project or process, click that objective. The halo changes to the background color to indicate that the project or process is no longer linked.

5. Click Save to save the Strategy Map.
   Refresh the contents of the map to see the Project icon for the objective.

6. To display the objectives currently linked with your project or process, go to the Analytics tab, run the Executive Booklet, and click the Projects or Processes link. For more information, see Performance Management Framework User on page 27.

Understanding Measures

In this section:

Adding and Editing Measures

PMF gives you a lot of flexibility in dealing with measurements. It supports quick one-off measurements you might add when prototyping a new scorecard, and it also allows you to design deeply loaded measures that span multiple time periods.

PMF supports measure pooling, which enables you to create measures independent of specific scorecards. You can create a measure and link it to every scorecard in your organization, or unlink a measure and hold it for later use. Linked measures are controlled by data access security, which allows users to view only measures to which they have been granted access (for example, through an optional Organization dimension).

Adding and Editing Measures

In this section:

Working with User-Entered Measures
Loading Production Measures

You can manually add one or more measures to PMF and quickly connect them to objectives in your system. Each of these user-entered measures takes about a minute to add with the New Measure Wizard. For more information, see Working with User-Entered Measures on page 214.

If you set up your scorecard using the Scorecard Wizard, and you selected objectives from the list, PMF automatically created measures for you. You can use the Measures panel button to edit these measures or convert them to loadable measures. After you have loaded measures with the loader, use the Edit Measure panel to edit their properties.
Working with User-Entered Measures

How to:
Create a User-Entered Measure With the New Measure Wizard
Edit User-Entered Measures

Reference:
Entering Formulas for User-Entered Measures

Note: This feature is deprecated in PMF 8. Use captured sources instead.

User-entered measures enable users to manually input measures and their targets for any of the following reasons:

- Measure data cannot be loaded (no available data source).
- The measure will always be entered by a user or manager.
- There is no planning system to obtain metric targets.
- Loading metrics would require mass-adjustments to correct inaccurate data.

The benefits to creating user-entered measures include:

- Determines which groups of end users (by Role settings) entered actuals and data for targets.
- Provides an intrinsic data store for metrics components.
- A user-entry screen is accessible directly from a URL.
- Multi-part calculations are supported.
- Archives older measure values.

From the Author or Manage tab, select the Measures panel button. To create a new user-entered measure, select New. To view or edit an existing user-entered measure, select the desired measure in the User Entered Measures folder of the tree structure. After measures are created, they are immediately available on all linked scorecards.

If data for a user-entered measure becomes available at a later date for loading from a data source, you can change the measure to be loaded from external data. You can also change a measure currently loaded from external data to a user-entered measure. To do either, edit the Measure Type field in the Edit Measure Metadata panel.

Users can enter data for a user-entered measure by selecting Measures to Input from the drop-down menu near the upper-right corner of the Today tab. For more information, see Inputting User-Entered Measures on page 125.
Procedure: How to Create a User-Entered Measure With the New Measure Wizard

This will be deprecated in a future release.

1. In the Author tab, click the Measures panel button, then click the Wizard button.

   The New Measure Wizard panel opens, as shown in the following image.

2. Specify values for the fields in the panel.

   The following table lists and describes the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure Name</td>
<td>Name of the measure. Links to the SERIES field in each atomic measure record. A measure name is linked to a single measure or a pool of production measures. It is used in views that need a common measure name for the often disparately named measures in a particular linked series. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Scorecard to which the measure is linked. This value can be set to a scorecard or left blank if the measure is in the measures pool but not attached to a particular scorecard.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Objective</td>
<td>Objective to which the measure is linked. Choose an objective from the drop-down menu. This field is blank if the measure is unlinked (most typically an unlinked measure is used when creating a relaxed measure). If the scorecard field above is blank, this field should also be left blank.</td>
</tr>
<tr>
<td>Aggregation Method</td>
<td>Method you can use when aggregating this measure in views. Select Additive for measures that represent linear quantities (for example, Dollars, People, Hours, and so on).</td>
</tr>
<tr>
<td></td>
<td>Select Percentage if the measure represents a percentage, so that aggregation can correctly account for separating the numerator and denominator. This aggregates them and then divides the sum.</td>
</tr>
<tr>
<td></td>
<td>Select Change in Percentage when the stored values for the measure represent a change from one time period to another. For example, if sales were 10,000 in January and 11,000 in February, the change from January to February is 10%. For regular percentage-based measures, the system stores both a numerator and denominator to correctly sum the measures; for the given example, the stored values would be 1,000 and 10,000. However, unlike percentage-based measure series, Change in Percentage ignores the sign of the denominator. If the January value is -10,000 and the February value is -9,000, the stored values are 1,000 and -10,000; however, the change in percentage is still 10%. The actual calculation of subtracting the January data from the February data is done during the load phase.</td>
</tr>
<tr>
<td></td>
<td>Select Ratio to display decimals for measures. For example, a ratio measure displays as .89 where a percentage measure displays as 89%.</td>
</tr>
</tbody>
</table>

**Note:** Both Ratio and Percentage measure types allow you to use separate numerators and denominators for measure actuals and targets, thus ensuring proper aggregation at every dimensional level. These aggregation types are automatically supported in the measure loader and in all PMF views.

| Units               | Unit of measure used for this measure. Select a value from the drop-down menu. If you do not see the value you need, you can add it using the Units of Measures panel. |


<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>The one-character dimension identifier or identifiers to which the measure is linked. For example, the value TOP means that the measure is linked to the Time, Organization, and Product dimensions.</td>
</tr>
<tr>
<td>Threshold/Flex Type</td>
<td>Select the type of value used in the Threshold/Flex fields:</td>
</tr>
<tr>
<td></td>
<td>- Percent</td>
</tr>
<tr>
<td></td>
<td>- Units</td>
</tr>
<tr>
<td>Threshold/Flex Direction</td>
<td>Direction to be used to determine how thresholding is performed.</td>
</tr>
<tr>
<td></td>
<td>- Ascending - higher is better</td>
</tr>
<tr>
<td></td>
<td>- Descending - lower is better</td>
</tr>
<tr>
<td></td>
<td>- Range - should fall within range</td>
</tr>
<tr>
<td></td>
<td>For more information about these options, see <em>Indicator Concepts</em> on page 228.</td>
</tr>
<tr>
<td>Target</td>
<td>Select the type of target you desire.</td>
</tr>
<tr>
<td></td>
<td>- Load from field</td>
</tr>
<tr>
<td></td>
<td>- Use fixed value</td>
</tr>
<tr>
<td></td>
<td>- Aggregate fixed value</td>
</tr>
<tr>
<td></td>
<td>When you select Use fixed value or Aggregate fixed value, the Set Fixed Target Values button appears, which opens the Fixed Target pop-up dialog box where you can select the desired target types and enter a target value for each.</td>
</tr>
<tr>
<td>Threshold/Flex</td>
<td>The first field is the value to be used for the threshold, which determines when an indicator shows red. The second field is the value to be used to determine the inner edge of the yellow zone. Setting a flex of 0 indicates that the measure does not allow any deviation from the target.</td>
</tr>
<tr>
<td>Slider</td>
<td>Click the red/yellow/green icon to display a grid that enables you to graphically adjust the threshold and flex values.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Owner Id</td>
<td>The owner ID currently assigned to the measure. You can select another owner to reassign the measure to that owner ID.</td>
</tr>
<tr>
<td>Audit Measures (check box)</td>
<td>Select this check box to archive any changes made to the measure in the PMF measures history table, used for reporting purposes.</td>
</tr>
<tr>
<td>Display Format</td>
<td>A WebFOCUS numeric display format valid for the unit of measure. Valid format types are D (floating-point double-precision), F (floating-point single-precision), I (integer), and P (packed decimal). The formats are $I_n$, $D_n.o$, $F_n.o$, and $P_n.d$, where $n$ represents the maximum number of digits to display, and $.o$, which is optional, and $.d$, which is required, represent the decimal point and the number of digits to display after the decimal point. The maximum number you can code before and after the decimal point is 10 for I, 15 for D, 7 for F, and 31 for P. For more information about numeric display options, see the Describing Data With WebFOCUS Language manual.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the data loaded for this measure. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Measure Report</td>
<td>Select an operational or PMF measure view from the drop-down menu to enable users to automatically drill down that view from this measure.</td>
</tr>
</tbody>
</table>
Option to vary how measured data is aggregated over time.

Select Standard to aggregate using standard Time rules. All of the measure data shown at higher time levels adds up to the total of all data at the lowest loaded level (for linear aggregation) and includes all percent or ratio data over the entire time period (for percent, ratio, and change in percent aggregation). This option is the default.

Select Average to show an average value, which calculates a mean average of all the data loaded across the lower Time levels for the duration of the higher level period.

Select Most Recent to show the latest values. Only the most recently loaded value of all the data loaded across the lower Time levels for the duration of the higher level period will be shown.

**Note:** These options will only be available if the Alternate Time Summary setting in the Summarization settings is enabled.

3. After you verify the values specified for all of the fields on the panel, click Next.

The New Measure Wizard (2 of 3) panel opens displaying the Dimensions tab, as shown in the following image.

4. Specify values for the fields in the panel.
The following table lists and describes the fields on the Dimensions tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case sensitive compare (check box)</td>
<td>When this option is selected, which is the default, PMF requires the case of the dimension values to match the data source exactly. If there is a mismatch on the dimensionality, it will be flagged as an error. When this option is not selected, PMF uppercases everything before comparing the dimensionality.</td>
</tr>
<tr>
<td>Keep Audit (check box)</td>
<td>Select this check box to archive any changes made to the measure in the PMF measures history table, used for reporting purposes.</td>
</tr>
<tr>
<td>Aggregation at Level</td>
<td>Select the appropriate level of the dimension at which data will be aggregated.</td>
</tr>
</tbody>
</table>

5. After you verify the values specified for all of the fields on the Dimensions tab, click the Entry Formulas tab.
6. For each field that displays an Edit button, type a value or a formula to calculate a value in the field to the right of the button. If you have a long formula to enter, click the *Edit* button, enter the formula in the Field Map input area that opens at the top of the panel, and then click OK.

7. After you verify the values and formulas specified on the Entry Formulas tab, click Next. The New Measure Wizard (3 of 3) panel opens, as shown in the following image.

![New Measure Wizard](image)

The panel that displays enables you to test entering measure actual, benchmark, forecast, stretch, and target values if desired. You may want to input target values for a measure, since users typically input only actual values, or you might reserve this task for planners or managers at your site.

**Reference:** Entering Formulas for User-Entered Measures

This will be deprecated in a future release.

If you create formulas for the actual and target values of user-entered measures, users are presented with a multi-cell calculation screen when entering measures. PMF displays the results of the calculation for user verification.

When creating formulas, all fields must be within square brackets. Supported operators are +, -, *, and /, and you can use parentheses to separate operations to create complex formulas. You must use a semi-colon to terminate a formula. The following is an example of a formula:

```plaintext
([Total Calls] - [Dropped Calls]) / [Processed Calls]
```

You can specify which users have access to enter actuals or targets by setting access for their Functional Role from the Manage tab. For more information, see *How to Limit Functional Roles to Enter Only Actual or Target Values* on page 285.
Procedure: How to Edit User-Entered Measures

1. In the Author tab, click the Measures panel button.
2. Select a user-entered measure.

   The Edit Measure Entry panel opens where you can edit any of the settings.

   ![Edit Measure Entry Panel]

3. Click the Measure button to edit any of the fields in the Edit Measure panel.

   This panel contains the same fields available when the measure was created in the New Measure Wizard panel, plus additional functionality including buttons to Link/Unlink Objectives and Configure Prediction Processing.

   Tip: You can convert user-entered measures to loaded measures by changing the Measure Type from User Entered to Loaded.

4. To edit any of the target or actual formulas, select the Entry Formulas tab or click the Formula button.

5. To enter any target or actual values, click the Enter Measures button.

   Note: In each panel where you make changes, click Save before moving to another panel.

Loading Production Measures

How to:

Link Measures to More Objectives

This will be deprecated in a future release.
When you are ready to load production measures from operational data, you can review and edit the properties for specific measures before loading. You may want to adjust the Threshold, Flex, Alert Threshold, and Alert Flex settings to ensure that they reflect the data you are about to load. If you have any user-entered measures that can now be loaded from a data source, you may want to convert these measures to loaded measures.

To review, modify, delete, and add new production measures, there are several different ways you can access measures in PMF. You can:

- Select the **Scorecards** panel button in the Author tab and fully expand the resulting tree structure all the way down to the measure level.
- Select the **Objectives** panel button in the Author tab and fully expand the resulting tree structure down to the measure level.
- Select the **Measures** panel button in the Author tab, select a measure in the User Entered Measures folder, and then click the **Measure** button in the Measure Entry panel.
- Select the **Measures** panel button in the Manage tab and expand the tree structure to the measure level.

Selecting any of the individual measures opens the Edit Measure panel where you can view, edit, or delete measures. The following image shows the Edit Measure panel.
The following table lists and describes the fields in the Edit Measure panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure Name</td>
<td>The measure you are editing.</td>
</tr>
<tr>
<td>Units</td>
<td>The unit of measure used for this measure.</td>
</tr>
<tr>
<td>Link/Unlink Objectives...</td>
<td>Displays the Link Measures to Objectives panel, which enables you to link the measure to additional scorecards and objectives. For details on this panel, see How to Link Measures to More Objectives on page 227.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>The one-character dimension identifier or identifiers to which the measure is linked. For example, the value TOP means that the measure is linked to the Time, Organization, and Product dimensions.</td>
</tr>
<tr>
<td>Measure Loader</td>
<td>Available only when the selected measure is a production measure. Displays the Measure Loader panel, which enables you to design and complete a measure load.</td>
</tr>
<tr>
<td>Measure Type</td>
<td>Type of production measure.</td>
</tr>
<tr>
<td>Aggregation Method</td>
<td>Method you can use when aggregating this measure in views. For details, see the Aggregation Method table entry in How to Create a User-Entered Measure With the New Measure Wizard on page 215.</td>
</tr>
<tr>
<td>Threshold/Flex Type</td>
<td>The type of value used in the Threshold/Flex fields:</td>
</tr>
<tr>
<td></td>
<td>- Percent</td>
</tr>
<tr>
<td></td>
<td>- Units</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Threshold/Flex Direction</td>
<td>Direction to be used to determine how thresholding is performed.</td>
</tr>
<tr>
<td></td>
<td>- Ascending - higher is better</td>
</tr>
<tr>
<td></td>
<td>- Descending - lower is better</td>
</tr>
<tr>
<td></td>
<td>- Range - should fall within range</td>
</tr>
<tr>
<td></td>
<td>For more information about these options, see <em>Indicator Concepts</em> on page 228.</td>
</tr>
<tr>
<td>Threshold/Flex</td>
<td>In the first field, the value used for the threshold, which determines the outer range when an indicator shows red.</td>
</tr>
<tr>
<td></td>
<td>In the second field, the value used to determine the inner edge of the yellow zone. Setting a flex of 0 indicates that the measure does not allow any deviation from the target.</td>
</tr>
<tr>
<td>Threshold/Flex Slider</td>
<td>Displays a grid that enables you to graphically adjust the threshold and flex values.</td>
</tr>
<tr>
<td>Calculating % Reached</td>
<td>Basis used for calculating the percent (%) reached for the descending measure.</td>
</tr>
<tr>
<td></td>
<td>- Use Target Value</td>
</tr>
<tr>
<td></td>
<td>- Use Basis Value</td>
</tr>
<tr>
<td>Basis Value</td>
<td>Sets a basis value for calculating Pct Reached. This is especially useful if you have a target at, or near to, zero. The Basis determines the amount above your target at which Pct Reached = 0%. This prevents very large negative Pct Reached values from being displayed.</td>
</tr>
<tr>
<td></td>
<td>This option is only available for Descending Measures.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Target                | Select the type of target you desire.  
|                       | - Load from field  
|                       | - Use fixed value:  
|                       | - Aggregate fixed value:  
|                       | When you select Use fixed value or Aggregate fixed value, the Set Fixed Target Values button appears, which opens the Fixed Target pop-up dialog box where you can select the desired target types and enter a target value for each. |
| Owner Id              | The owner ID currently assigned to the measure. You can select another owner to reassign the measure to that owner ID.                                                                                               |
| Add Predictions...    | Displays the Configure Predictive Data panel, which enables you to select options for predictive data analysis.                                                                                                                                                       |
| (button)              |                                                                                                                                                                                                                                                                         |
| Audit Measures        | Select this check box to archive any changes made to the measure in the PMF measures history table, used for reporting purposes.                                                                                                                                       |
| (check box)           |                                                                                                                                                                                                                                                                         |
| Access Security       | When this check box is selected, data is filtered using access security at the security level of the user.                                                                                                                                                           |
| (check box)           |                                                                                                                                                                                                                                                                         |
| Display Format        | A WebFOCUS numeric display format valid for the unit of measure. Valid format types are D (floating-point double-precision), F (floating-point single-precision), I (integer), and P (packed decimal).  
|                       | The formats are In, Dn.o, Fn.o, and Pn.d, where n represents the maximum number of digits to display, and .o, which is optional, and .d, which is required, represent the decimal point and the number of digits to display after the decimal point. The maximum number you can code before and after the decimal point is 10 for I, 15 for D, 7 for F, and 31 for P.  
|                       | For more information about numeric display options, see the Describing Data With WebFOCUS Language manual.                                                                                                                                                       |
| Description           | Intuitive description of the data loaded into this measure.                                                                                                                                                                                                             |
| Measure Report        | From the drop-down menu, select an operational or PMF measure view to which users can automatically drill down.                                                                                               |
### Field | Description
--- | ---
**Measure Formula** | You can add a text description of the calculation method and source fields that you will use in the load procedure for this measure here. Reports use this field to prompt for actual values displayed for a measure. This field is useful to explain to constituents how a measure was calculated.

**Time Summary** | Option to vary how measured data is aggregated over time.
Select Standard to aggregate using standard Time rules. All of the measure data shown at higher time levels adds up to the total of all data at the lowest loaded level (for linear aggregation) and includes all percent or ratio data over the entire time period (for percent, ratio, and change in percent aggregation). This option is the default.
Select Average to show an average value, which calculates a mean average of all the data loaded across the lower Time levels for the duration of the higher level period.
Select Most Recent to show the latest values. Only the most recently loaded value of all the data loaded across the lower Time levels for the duration of the higher level period will be shown.

**Note:** These options will only be available if the Alternate Time Summary setting in the Summarization settings is enabled.

Loading measures tends to be an administrative function. For more information, see *Performance Management Framework Administrator* on page 271.

**Procedure: How to Link Measures to More Objectives**

1. Click the *Scorecards* panel button.
2. Expand the *Scorecard, Perspectives, and Objectives* folders. Select the objective you want to use.
   The Edit Objectives panel opens.
3. Click *Link/Unlink Measures*. 
The Link Measures to Objective panel opens, as shown in the following image.

4. In the Link? column in the Measures Available to be Linked section of the panel, select the checkbox across from the desired measure to link the measure to the objective.

5. Click the Adjust Measure Weights button to weight the measure across the selected objective. For details on the Weight Measures Across Objective panel, see Weighting Measures Across Objectives on page 233.

6. To remove a linked measure, click the Unlink? checkbox under the Measures Currently Linked section of the panel.

Indicator Concepts

PMF provides a rich model of mechanisms that control how metrics are evaluated against their targets and interact with each other. To give you a better understanding of how metrics are evaluated, this section provides a model of the indicators PMF works with to calculate the grading of measures:

- **Target.** The goal for the measure.
- **Actual.** The actual value for the measure.
- **Direction.** The direction to be used to determine how thresholding is performed for the measure. The direction can be ascending (higher is better), descending (lower is better), or you can select a range (actual value should fall within the specified range).

- **Threshold.** The outer range of when an indicator shows red (poor performance).

- **Flex.** The margin of error, or the inner edge of the yellow zone (meaning that you failed to meet the target goal but are reasonably close to the target goal). Setting a flex of 0 indicates that the measure does not allow any deviation from the target.

- **Weighting.** The priority of the measure. The higher the weight of the measure, the greater its significance when calculating measures across objectives or scorecards.

There are alternate ways of expressing how your metrics are performing. You can define new scales or grading systems for displaying indicators. For example, you can display scales such as 1-10 or A-J, alongside the standard red/yellow/green stop lights. You can also establish your own criteria for how these grading systems are defined. Grading systems can be based on scoring scales, indicators (colored dots, graphical, or character-based), or both. Grading systems are based on setting a varied number of breakpoints in a range of percent achieved. These breakpoints can then have tolerances set globally or dimensionally. Multiple grading systems can be applied at the same time, but only one grading system can control the indicators for all metrics.

**Note:** There is no user interface for establishing new grading systems. Setting up new grading systems requires direct manipulation of the PMF data mart and the assistance of a qualified PMF consultant.
Example: Designing an Ascending or Descending Indicator

The following image provides two samples of how designing an indicator works.

Sample 1

Profits

- Above target (very good)
- On target (good)
- Below target (warning)
- Below target (bad)

Target $200,000
Flex $197,000
Threshold $180,000

Good

Bad

In Sample 1, the target value for the measure (profits) is set to $200,000. The direction is ascending, the threshold is $10,000, and the flex is $3,000. If the actual profit is:

- Greater than $200,000, the indicator is light green, since you have exceeded the target value.
- Between $197,000 and $200,000, the indicator is dark green. Although you have not met the target value, you have come close enough to the target value to meet the flex criteria.
- Between $190,000 and $197,000, the indicator is yellow. You have not met the flex criteria, but you are still within the $10,000 threshold.
- Less than $190,000, the indicator is red, since your profits have fallen below what the acceptable threshold allows.

Sample 2

Defects

- Above target (bad)
- Above target (warning)
- On target (good)
- Below target (very good)

Threshold 110
Flex 105
Target 100

Good

Bad

In Sample 2, the target value for the measure (defects) is set to 100. The direction is descending, the threshold is 10, and the flex is 5. If the actual number of defects is:

- Less than 100, the indicator is light green, since there are less defects than the target value.
Between 100 and 105, the indicator is dark green. Although you have not met the target value, you have come close enough to the target value to meet the flex criteria.

Between 105 and 110, the indicator is yellow. You have not met the flex criteria, but you are still within the threshold of 10.

Greater than 110, the indicator is red, since you have more defects than what the acceptable threshold allows.

Clicking the Threshold/Flex button in the Edit Measures panel opens a pop-up dialog box where you can adjust the threshold and flex values for a measure by clicking and dragging the Threshold and Flex flags in either direction to change the values. The following image shows an example of the pop-up dialog box used for adjusting descending threshold and flex values.

This will be deprecated in a future release.

For more information about adjusting threshold and flex values, see How to Adjust the Threshold and Flex Values on page 405.
**Example: Designing an Indicator Range**

The following image shows how to design an indicator for the range direction.

In this example, the target value for the measure (customer visits per month) is set to 3.5. The threshold is 1.5 and the flex is .5, meaning that you should have at least 2, but not more than 5, customer visits per month. Ideally, you should have between 3 and 4 customer visits per month. If the actual number of customer visits per month is:

- Between 3 and 4, the indicator is dark green since you have met the flex criteria.
- Between 2 and 3, or between 4 and 5, the indicator is yellow. You have not met the flex criteria of between 3 and 4, but you are still within the acceptable 1.5 threshold.
- Less than 2 or greater than 5, the indicator is red since your customer visits per month have fallen below or above what the acceptable threshold allows.

Clicking the *Threshold/Flex* button in the Edit Measures panel opens a pop-up dialog box where you can adjust the threshold and flex values for a measure by clicking and dragging the Threshold and Flex flags in either direction to change the values. The following image shows an example of the pop-up dialog box used for adjusting a range of threshold and flex values.
This will be deprecated in a future release.

For more information about adjusting threshold and flex values, see *How to Adjust the Threshold and Flex Values* on page 405.

**Weighting Measures Across Objectives**

**How to:**

Weight Measures Across Objectives

An objective can be linked to no measures, one measure, or multiple measures. If an objective is linked to multiple measures, measure weighting controls the percentage that each measure represents as part of the objective to which it belongs. The weight for an individual measure can be set to any percentage, with no decimal places (integral weighting) or with 1 or 2 decimal places of precision. The sum of the weights for all the measures that make up an objective indicator will always be 100%.

The number of significant decimal places on the weighting panel is set by an administrator. For more information, see *Performance Management Framework Administrator* on page 271.
**Procedure:**  **How to Weight Measures Across Objectives**

To set the priority of measures across objectives, perform the following steps.

1. In the Author tab, click *Objectives* and expand the objectives folders.

2. Click an objective, for example, *Customer claims down*.

3. Click the *Adjust Measure Weights* button.

   The Measure Weights panel opens, as shown in the following image.

4. Click and drag the sliders to re-assign the weights, or type the weighting percentage in the input field.

   **Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.

   Note that the weights are automatically balanced across all the objectives. For example, if you change the Claims measure from 100.0% to 30.0%, the Employee Self Score measure will automatically change to 70.0%.

   The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.

5. Click *Re-balance weights* to assign an equal percentage to all measures.

   **Note:** If you do not want to re-balance a particular measure as you drag the sliders or type percentages, click the *Lock* button to the left of the measure to lock the weight of that measure.

6. Click *Save* to save your changes.

   If you try to save weights that do not add up to 100%, PMF automatically makes adjustments in proportional amounts so that the total adds up to 100%. It displays a message that gives you an opportunity to view the adjustments (by clicking Cancel) before saving them.
7. Click Objective to return to the Edit Objective panel.

**Weighting Objectives Across a Strategy**

**How to:**

Weight Objectives Across a Strategy

A scorecard, which represents a strategy, is composed of multiple perspectives, each of which is composed of multiple objectives. Objective weighting controls the percentage that each objective represents as part of the overall strategy. You can adjust the individual weights for any of the objectives, or you can let PMF automatically balance the weights to give each objective an equal share of the overall strategy.

The weighting percentage can have no decimal places (integral weighting) or 1 or 2 decimal places of precision. The number of significant decimal places on the weighting panel is set by an administrator. For more information, see *Performance Management Framework Administrator* on page 271.

**Procedure: How to Weight Objectives Across a Strategy**

To set the priority of objectives across a strategy, perform the following steps.

1. In the Author tab, click Scorecards.
2. Select a scorecard, for example, *CenturyCorp Card*.
3. In the Edit Scorecard panel, click the Adjust Objective Weights button.
The Objective Weights panel opens.

4. Click and drag the sliders to re-assign the weights, or type the weighting percentage in the input field.

   **Tip:** Typed percentages are recognized when you move the mouse off the input field and click it.

   Note that the weights are automatically balanced across all the objectives.

   The Total Weighting Percentage is displayed at the bottom of the weights column as a guideline when you make percentage adjustments.

   Click **Re-balance weights** to assign an equal percentage to all objectives.

   **Note:** If you do not want to re-balance a particular objective as you drag the sliders or type percentages, click the **Lock** button to the left of the objective to lock the weight of that objective.

5. Click Save to save your changes.
If you try to save weights that do not add up to 100%, PMF automatically adjusts the total weighting and displays the following message.

6. Click the Scorecard button to return to the Edit Scorecard panel.

**Automatic Equal Weighting**

**How to:**
Disable or Enable Equal Weighting

PMF automatically weights the relationships of lower-level to higher-level objects throughout the strategy linking system. This speeds up the creation of Strategy objects during modeling of a new strategy.

PMF automatically weighs these relationships, by default:

- Measures upward to Objectives or Risks.
- Objectives or Risks upward to Compound Objectives and Consequences.
- Objectives or Risks to Scorecards.

You can easily turn off automatic weighting and use preferential weighting by:

- Navigating to the Scorecard, Compound Objective/Consequence, Objective or Risk for which you want to switch to equal weighting.
- Deselecting the Use Equal Weighting checkbox in the panel.
- Changing the weights of the linked objects manually using the sliders or lock buttons.
Procedure: How to Disable or Enable Equal Weighting

You can enable or disable equal weighting for Scorecards, Compound Objectives/Consequences, Objectives, or Risks. You need to alter the weighting mode from the “linked-upwards” object.

1. In the Author tab, navigate to the object for which you want change the weighting mode (for example, Scorecard).

   The Edit Scorecard panel opens, as shown in the following image.

   ![Edit Scorecard Panel](image)

   2. Select or deselect the Use Equal Weighting checkbox.

   3. Click Save.

   Note:
If you check the Use Equal Weighting checkbox, the Adjust Objective Weights button is disabled, because the system will take over Weighting, and will always do it equally among all linked child objects.

If you uncheck the Use Equal Weighting checkbox, you will need to reset the weights across the Scorecard whenever you link or unlink an Objective, Risk, Compound Objective or Consequence to or from the Scorecard.

**Setting a Basis for Descending Measures**

**How to:**

Configure the Basis for a Descending Measure

You can specify how Percent Reached should be calculated for Descending Measures with targets that are very small or set at zero. This is also useful if you are viewing negative values for Percent Reached.

**Procedure: How to Configure the Basis for a Descending Measure**

1. From the Author or Manage tab, click the Measures panel button.
2. Select the measure you want to change.

   The Edit Measure panel opens, as shown in the following image.

   ![Edit Measure Panel](image)

3. Click the Controls tab.
4. Select *Use Basis Value* from the Calculating % Reached drop-down menu. The Basis Value field becomes available, allowing you to enter a Basis Value, as shown in the following image.

![Image of Calculating % Reached with Use Basis Value dropdown and Basis Value field]

**Tip:** The Basis Value can be set by analyzing the extent of your Actuals. For example, if your Target is set to zero, the median of your Actual values is 12, and the extent is 30, you can use 12 since it is the median value. You can also do a Pareto analysis and decide that 80% of your measures should have positive Percent Reached. If you never want to see a negative Percent Reached, you should set the Basis to the extent of your values. Any Actual values that are precisely at the Basis will show a zero Percent Reached.

5. Click Save to save your changes.

**Overriding Measures at the Measure Level**

You can edit the default actual, threshold, flex, and alert amounts by editing the measure source record. For your reference, these defaults are also displayed on every measure record. You can enter actual, threshold, flex, and alert override amounts for each atomic measure in the Edit Measure panel. Threshold and flex values are used by the graphical tools to indicate the red/yellow/green stop light indications.

Be sure to perform careful analysis before setting these visual indicators because some executives and managers may rely on the colors alone when making decisions based on what the colors represent. Alert thresholds are values that work in a manner similar to thresholds. However, they trigger alert information to appear on the Today tab.

Whether you are adding a new measure or editing an existing one, the same fields are available for creating or changing a measure. For more information, see *Adding and Editing Measures* on page 213.

**Documenting Your Work**

PMF provides you with the ability to document your work so that details about the process you use when scorecarding and designing metrics can be carried through to your end users, and to reporting you do for compliance purposes. PMF provides the following fields where you can document your measures:

- Comments field. Type information to describe what your measure is designed to do.
Formula field (measures only). Type information that describes where your measure is derived and which database is used.

Your comments field (Edit Feedback panel). Type any information to provide feedback for a specific measure series. For more information, see Performance Management Framework User on page 27.

**Scorecard-Specific Data Access Security**

**How to:**
Set Scorecard-Specific Data Access Security

For each scorecard in PMF, you can set scorecard-specific data access security by changing the default dimensional levels of measure data to which the scorecard has access. Granting users access to view a particular scorecard automatically allows them to view its measures dimensionally, as appropriate for that scorecard. Note that you can either define access to levels of dimensionality by owner or set scorecard-specific data access. Using one method overrides the other. For more information about owner-based data access, see Setting Measure Access for Users (Owners) on page 339.

Before you can set scorecard-specific data access security, you must change Access Security in the Security panel on the Settings menu to S (Scorecard) from the default of O (Off). Setting scorecard-specific data access provides each owner, who has read access or higher for a scorecard, access to all of the measure values at the dimensional levels that the scorecard is set to access.

**Note:** If a particular measure has row-level security turned off, it will not be filtered for scorecard-specific data access. For more information, see Excluding a Measure Series From Access Security on page 419.

Scorecard-specific data access security overrides global access security, which determines access to dimensional levels by owner instead of scorecard.

**Note:** Global (owner-based) data access security is set by changing Access Security to G (Global) in the Security panel on the Settings menu.

**Procedure:** How to Set Scorecard-Specific Data Access Security

Verify that the Access Security setting in the Security panel on the Settings menu is set to S (Scorecard).

1. In the Author tab, click the Scorecards panel button.
2. Select the Scorecard you want to change.
   The Edit Scorecard panel opens.
3. In the Access Security list, click Scorecard Limited.

4. Click Save.
   The Access Security button appears in the panel.

5. Click the Access Security button.
   The Edit Scorecard Access panel opens, as shown in the following image.

   ![Edit Scorecard Access panel](image)

6. Using each of the available dimensional drop-down menus, select the desired dimension limits for the scorecard.

7. Click Save to save the changes.

**Author Scorecard Options**

---

This section provides reference information about the scoreboard-related options you can access from the Author tab. If you want to view, edit, create, or delete:

- Perspectives, see *Scorecard Perspectives* on page 243.
- Themes, see *Scorecard Themes* on page 250.
- Objectives, see *Objectives* on page 244.
Scorecard Perspectives

Perspectives indicate high-level classification for types of objectives. A given perspective is, literally, a container that holds objectives. You can view perspectives for any scorecard both on scorecard views and in the Strategy Map.

To view and work with perspectives, click Scorecards and expand the tree structure under Perspectives, then click a perspective. You can also click the Perspectives panel button, expand the Perspectives folder, and click the desired perspective. The following image shows the Edit Perspective panel.

In the Edit Perspective panel, the same fields are required for adding a new or updating an existing perspective. The following table lists and describes the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Name of the scorecard that contains this perspective.</td>
</tr>
<tr>
<td>Perspective Name</td>
<td>Perspective name. The maximum number of characters is 50.</td>
</tr>
</tbody>
</table>
Objectives

Objectives relate to high-level goals for business action. Objectives are usually designed to be specific, measurable, action-oriented, results-driven, and time-based (SMART).

You can view and work with objectives in two ways:

- All objectives for a given scorecard are displayable regardless of whether they have been assigned to a perspective by clicking the Objectives panel button in the Author tab. By expanding its tree structure, you will see all the objectives in the scorecard and also any measures linked to the objectives.

- Objectives that have been linked to a perspective can be displayed by expanding the perspective under the Scorecards panel button.
To edit, delete, or create an objective, select the Objectives panel button, expand an Objectives folder, click a desired objective, and the Edit Objective panel opens, as shown in the following image.

If you expand a specific objective, one or more underlying measures are displayed. You can select the measure to open the Edit Measure panel where you can edit, delete, or create a measure. For details on the Edit Measure panel, see Performance Management Framework Administrator on page 271.

The same fields are required for adding a new or updating an existing objective. The following table lists and describes the fields in the Edit Objective panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Name of the associated scorecard.</td>
</tr>
<tr>
<td>Perspective</td>
<td>Name of the perspective associated with the objective in the scorecard tree, unless no perspective is associated yet.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the objective. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Theme</td>
<td>Name of the theme associated with the objective in the scorecard tree, unless no theme is associated yet.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>View on which this objective appears.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Shows whether the object is an Objective or a Risk.</td>
</tr>
<tr>
<td>Description</td>
<td>Text area used for providing a brief description of the objective. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Subjective Comments</td>
<td>Text area used for adding a lengthy text description. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Owner</td>
<td>Defaults to the owner ID that is logged on; or you can select another owner.</td>
</tr>
</tbody>
</table>

The following two buttons are also available in the Edit Objective panel:

- **Link/Unlink Measures.** Opens the Link/Unlink Measures panel, where you can modify the list of measures linked to the objective. For details, see *How to Link/Unlink Measures* on page 248.

- **If you are not using automatic weighting, adjust Measure Weights.** Opens the Weight Measures Across Objective panel, where you can allocate the weighting percentages for the measures tied to an objective. There must be more than one measure associated with an objective to adjust the weights. The total weighting of all measures is always equal to 100 percent. If only one measure is tied to an objective and you attempt to adjust the weights, a pop-up error message is displayed.

  For details on this capability, see *Weighting Measures Across Objectives* on page 233.

### Risks

A risk describes an area that you are measuring that represents a specific problem, or threat, to your enterprise. Risks can be placed on the Strategy Map and you have the ability to link different metrics to each risk.

All risks for a given scorecard are displayable regardless of whether they have been assigned to a perspective by clicking the Risks panel button in the Author tab. By expanding its tree structure, you will see all the risks in the scorecard and also any measures linked to the risks.
To edit, delete, or create a risk, select the Risks panel button, expand a Risks folder and click a desired risk. The Edit Risk panel opens, as shown in the following image.

If you expand a specific risk, one or more underlying measures are displayed. You can select the measure to open the Edit Measure panel where you can edit, delete, or create a measure. For details on the Edit Measure panel, see Performance Management Framework Administrator on page 271.

The same fields are required for adding a new or updating an existing risk. The following table lists and describes the fields in the Edit Risk panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Name of the associated scorecard.</td>
</tr>
<tr>
<td>Perspective</td>
<td>Name of the perspective associated with the risk in the scorecard tree, unless no perspective is associated yet.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the risk. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Theme</td>
<td>Name of the theme associated with the risk in the scorecard tree, unless no theme is associated yet.</td>
</tr>
<tr>
<td>Report</td>
<td>View on which this risk appears.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Object Type | Shows whether the object is an Objective or a Risk.
Description | Text area used for providing a brief description of the risk. The maximum number of characters is 1024.
Subjective Comments | Text area used for adding a lengthy text description. The maximum number of characters is 1024.
Owner | Defaults to the owner ID that is logged on; or you can select another owner.

The following two buttons are also available in the Edit Risk panel:

- Link/Unlink Measures. Opens the Link/Unlink Measures panel, where you can modify the list of measures linked to the risk. For details, see *How to Link/Unlink Measures* on page 248.

- If you are not using automatic weighting, adjust Measure Weights. Opens the Weight Measures Across Risk panel, where you can allocate the weighting percentages for the measures tied to a risk. There must be more than one measure associated with a risk to adjust the weights. The total weighting of all measures is always equal to 100 percent. If only one measure is tied to a risk and you attempt to adjust the weights, a pop-up error message is displayed.

  For details on this capability, see *Weighting Measures Across Objectives* on page 233.

**Procedure: How to Link/Unlink Measures**

To modify the list of measures linked to an objective, perform the following steps.

1. In the Edit Objective or Edit Risk panel, click the *Link/Unlink Measures* button.
The Link Measures to Objective or Link Measures to Risk panel opens, as shown in the following image.

2. To link a measure to the selected objective, find the desired measure in the Measures Available to be Linked section of the panel and select the Link? check box.

You can link more than one measure by selecting all of the applicable check boxes.

3. To unlink a measure associated with the selected objective, find the measure under Measures Currently Linked.

Select the Unlink? check box for the measure.

4. Click Save to make the changes to the list of measures linked to the objective.

Your changes are reflected under Measures Currently Linked.

5. Click the Adjust Measure Weights button to access the Weight Measures Across Objective panel to assign weighting percentages. For instructions, see Weighting Measures Across Objectives on page 233.

It is strongly recommended that you adjust the weighting of measures after changing linking relationships. If you do not adjust weighting, metric totals may be inaccurate.
6. On the Link/Unlink Measures panel, click Objective or Risk to display the Edit Objective or Edit Risk panel again.

**Scorecard Themes**

Themes usually relate to high-level corporate principles that drive overall enterprise strategy.

To view and work with themes, click the Themes panel button, expand the Themes folder, and click the desired theme. The following image shows the Edit Theme panel.

![Edit Theme Panel](image)

The same fields are available whether you are creating a new, or editing an existing theme. The following table lists and describes the fields in the Edit Theme panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Name of the scorecard that contains this theme.</td>
</tr>
<tr>
<td>Theme Name</td>
<td>Name of the theme. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Description</td>
<td>Text area to describe the intention of the theme. The maximum number of characters is 1024.</td>
</tr>
</tbody>
</table>
Projects

**In this section:**
- Control Drill Menus for Projects and Tasks

**How to:**
- Create a New Project
- Assign a Task
- Set Progress in a Task
- Add Feedback or Expenditure to a Task
- Complete a Task

The new PMF Project system allows you to not only measure projects, but gives you the ability to also manage them:

- You can create, assign, track, and update the status on project-level tasks.
- The Project panel incorporates a quick-entry task grid, as well as a fast Gantt chart that allows graphical overview of project status.
- Task management is available to Project managers, as well as those responsible for performing Project Tasks. Task management allows rapid multi-editing using the Tasks panel.
- End users can focus on individual tasks, single Projects, or quickly scan across all Projects, depending on their level of access.
- A robust suite of reports are available that allow side-by-side analytics of project performance against strategic objectives.

Projects no longer have separate budget and schedule metrics. Instead, project budget metrics are based on analyzing the task-level spend vs. the project-level budget. Project schedule metrics are based on analyzing the task schedules (start dates, completed dates, and Progress) of each task.

Classic PMF Project reports report summaries of the tasks of a project. The reports available are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Color you select from the color palette.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the owner from the list.</td>
</tr>
</tbody>
</table>
Objective/Project and Project/Objective: These reports show high-level summaries of metrics that are based on task-level data that has been input by the project participants.

Project Detail: This report shows the overall project progress. Its metrics are based on task-level data that has been input by the project participants.

Project Properties

Each migrated project will have a single task pre-determined. The task will be named after the project (similar to what happens when you created a new project and save it without altering it). Note that the start date of a migrated project, completed date, and total budget will reflect the data of the migrated project. Any project-level budget or schedule records will be deleted from the system.

To edit, create, or delete a project, click the Projects panel button in the Author tab, and select the desired project.

Alternatively, you can access projects in an existing scorecard from the scorecard tree. To do this, expand the desired Perspectives subfolder, expand the desired Objectives folder, and then expand the specific Objective folder for which you want to add or edit a project. Click Projects, and then click the specific project.
The following image shows the Edit Project panel.

For the fields that prompt you for a date (for example, Start Date of a Task), click the field and select the date from the calendar that opens.

The system creates any new measures needed - one budget measure and one schedule measure for each time period indicated in the start and end date fields.

Users enter the Finish Date, which causes the percent done measure target to be automatically generated for each time period over which the project spans. Changes can add or delete records, and adjust targets.
The same fields are required for adding a new or updating an existing project.

The following table lists the tabs and describes the fields in the Edit Project panel and their fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Info Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Project Name</td>
<td>The name of the project. The maximum number of characters is 50. Click the field to enter or edit the project name.</td>
</tr>
<tr>
<td>Project Owner</td>
<td>Select the owner from the list.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start date for this project.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This value is set in the Tasks tab.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date this project was completed.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This value is set in the Tasks tab.</td>
</tr>
<tr>
<td></td>
<td>If your End Date shows as Delayed, this means that the current date is later than the currently set planned end date for the task with the last end date on the project.</td>
</tr>
<tr>
<td>Current Budget</td>
<td>The current cost value of this project.</td>
</tr>
<tr>
<td>Original Budget</td>
<td>The original target cost value of this project.</td>
</tr>
<tr>
<td>Actual Spend</td>
<td>The actual cost value of this project.</td>
</tr>
<tr>
<td>Description</td>
<td>Text area to describe the project. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Project Report</td>
<td>Select from the Project Report drop-down menu to establish a link that drills out to an internal (WebFOCUS) or external (web-based) project, report, or other documentation source.</td>
</tr>
<tr>
<td></td>
<td>To view the selected Project Report, select the name of the project that you edited from any report in PMF and select <em>Operational Report</em> from the pop-up menu.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Budget Flex</td>
<td>Percent value to be used to determine the inner edge of the yellow indicator zone for the budget of the project. The scale represents the Pct used, not Pct reached. If you need to go below or above scale, you can enter the value in the text field and the slider will pin the value at the appropriate end.</td>
</tr>
<tr>
<td>Budget Threshold</td>
<td>Percent value to be used for the threshold, which determines when an indicator shows red for the budget of the project. The scale represents the Pct used, not Pct reached. If you need to go below or above scale, you can enter the value in the text field and the slider will pin the value at the appropriate end.</td>
</tr>
<tr>
<td>Schedule Flex</td>
<td>Percent value to be used to determine the inner edge of the yellow indicator zone for the schedule of the project. The scale represents the Pct used, not Pct reached. If you need to go below or above scale, you can enter the value in the text field and the slider will pin the value at the appropriate end.</td>
</tr>
<tr>
<td>Schedule Threshold</td>
<td>Percent value to be used for the threshold, which determines when an indicator shows red for the schedule of the project. The scale represents the Pct used, not Pct reached. If you need to go below or above scale, you can enter the value in the text field and the slider will pin the value at the appropriate end.</td>
</tr>
</tbody>
</table>

**Tasks Tab**

<p>| Task Name | The name of the task. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The current status of the task. The following options are available:</td>
</tr>
<tr>
<td></td>
<td>- <strong>New.</strong> Only requires a task name.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Assigned.</strong> Requires an assignee and due date.</td>
</tr>
<tr>
<td></td>
<td>- <strong>In progress.</strong> Requires an assignee, start date, and due date.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Deferred.</strong> Requires an assignee, start date, and due date. This status shows the task is in progress, but suspended.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed.</strong> Requires an assignee, start date, due date, and completed date. By default, the current date is the completed date.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Milestone.</strong> Requires a due date only. This option represents a point in time that a project phase ends, and the next one starts.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the status is set to <em>In Progress</em>, a slider appears to the right of this field. This shows a percent value to be used to show how much of the task has been completed.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user this task is assigned to for completion.</td>
</tr>
<tr>
<td>Start</td>
<td>The date this task was started.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you move the start date forward in time for an existing project and you cross a time period boundary, PMF deletes all existing measures created prior to the new start date. If you move the start date back in time and cross a time period boundary, PMF creates new measure entries for time periods prior to the previous start date. In both situations you can enter a revised total budget. Also, PMF will adjust the percentage reached figures.</td>
</tr>
<tr>
<td>Currently Due</td>
<td>The current due date for this task.</td>
</tr>
<tr>
<td>Completed On</td>
<td>The date the task was completed. This date is automatically set when the Status of the task is set to <em>Completed</em>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Tasks will be ordered by this date.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Feedback & Expenditure Tab | Allows you to add feedback or expenditure for a task. **Note:** This tab is only available when you select a task to view from the Tasks tab.

### Content Tab

Allows you to control the content available when selecting a project.

### Gantt Tab

This tab shows a Gantt chart, which is a time analysis of tasks and the milestones associated with them.

**Procedure: How to Create a New Project**

To create a new project, perform the following steps:

1. In the Author tab, click the *Projects* panel button.
2. Click *New*.
   
   The New Project panel opens.
3. Enter a name for the project.
4. Click *Save*.
   
   **Note:** If you choose *Save* now, one Task will be automatically created in New mode. Every project must have at least one Task assigned to it. The name of the Task will be the name of the project.
5. You can enter a Description or Budget, or set tolerances at any time.
6. Click the Tasks tab, as shown in the following image.

You can enter tasks at will, or use the Tab key to move to the next row.

7. Click Save.

**Procedure: How to Assign a Task**

*Note:* You can drill into any individual Task from the Tasks panel in Projects, or the end-user Tasks gadget.

From the Tasks tab:

1. Select *Assigned* from the Status drop-down menu.
2. Select the Owner assigned to the task from the Assigned to drop-down menu, as shown in the following image.

![Task Assignment Image]

3. Enter the current due date of the task from the calendar provided.

![Calendar Image]

4. Click Save.

Procedure: How to Set Progress in a Task

Note: You can drill into any individual Task from the Tasks panel in Projects, or the end-user Tasks gadget.
From the Tasks tab:

1. Select *In Progress* from the Status drop-down menu.
2. Specify a Start Date using the calendar provided and modify the Currently Due date, if necessary.
3. Set the current progress of the project by dragging the progress bar, as shown in the following image.

4. Click Save.

**Note:** If you switch the status from *In Progress* to *Assigned*, the Start Date will be cleared.

**Procedure:** **How to Add Feedback or Expenditure to a Task**

From the Tasks tab:

1. Click the task for which you want to add feedback or spending.
   
   The Edit Task panel opens.

2. Click the *Feedback & Expenditures* tab.

3. For the Effective Date, click the box and select the date from the calendar that opens.

4. Type any expenditure and task feedback items in the boxes provided, as shown in the following image.

   ![Edit Task Panel](image)

   **Note:** An Owner can only edit or delete their own Effective Date, Feedback, or Expenditure entries.

5. Click Save.
The Info Tab in the Edit Task panel will display the aggregated Spend data in the Task Expenditure field.

**Procedure:** How to Complete a Task

**Note:** You can drill into any individual Task from the Tasks panel in Projects, or the end-user Tasks gadget.

From the Tasks tab:

1. Select *Completed* from the Status drop-down menu.
2. Specify the Completed On date using the calendar provided.
3. Click Save.

**Control Drill Menus for Projects and Tasks**

How to:

- Add a New Drill Menu for a Project
- Make a Content Menu the System Default
- Clear a Specific Metric Menu to the Default

You can control the content visible from the drill for each Project or Project Task in PMF using the Content tab on the Project panel. Any Content managed within PMF can be added to the menus.

There are two menus available. These options control the drill menu that is activated when you click:

- The name of a Project on any Grid or chart.
- The details of a task associated with that project.

**Procedure:** How to Add a New Drill Menu for a Project

By default, all Projects in PMF use the same menu. You do not need to do anything to configure this menu. It is automatically configured whenever a new Project is created in the system.

If you want to configure a menu for a particular Project:

1. In the Author tab, click the Projects panel button.
   - The available projects display.
2. Select the project that you want to use.
   The Edit Project panel opens.

3. Click the Content tab.
   The Content menus configured for that project display, as shown in the following image.
4. If you click the *Link Content* box, you can:

- Add new (link) content to the Project Name or Task Detail menu by selecting the content item that you want to add from the drop-down menu, as shown in the following image.

![Image](image1.png)

- Add new (link) content by entering the name of the item in the box, as shown in the following image.

![Image](image2.png)

- Change the order of menu items by clicking the arrows next to the link name, and dragging the item up or down, as shown in the following image.
Remove (unlink) any content from the Project Name or Task Detail menu for that metric by clicking the *Remove this item* button next to the item, as shown in the following image.

5. Click *Save* once you are done configuring the menu.

The new menu is now configured. Whenever you select the name or values for that project, PMF displays the Content menus that you configured.

**Procedure: How to Make a Content Menu the System Default**

You can quickly design a default menu that all Projects will use. This gives all Projects that do not have specific menus a fallback. The system ships with a default menu configured. Performing the steps in the following procedure will override those settings.

To change the default menu for Project Name or Task Detail drills:

1. In the Author tab, click the *Projects* panel button.

   The available projects display.

2. Select the project that you want to use.

   The Edit Project panel opens.

3. Click the *Content* tab.

   The Content menus configured for that project display,
4. Click Save as default for the menu that you want to make the system default, as shown in the following image.

![Menu Configuration](image)

The menu that you specified is now configured as the default. Whenever you click the name or task for any Project that does not already have a specific menu configured, PMF will display the default Content menu that you configured here.

**Procedure: How to Clear a Specific Metric Menu to the Default**

You can clear any specific metric menu that was previously configured for a Project. When you do this, the Project Name or Task Detail menu of the project will always display the default as currently configured.

1. In the Author tab, click the Projects panel button.
2. Select the project that you want to use.
   
   The Edit Project panel opens.
3. Click the Content tab.
   
   The Content menus configured for that project display,
4. Click Clear to default for the menu that you want to restore to the system default.

Any specific metric menu for the Project is deleted, and the Project will now use the default. Whenever you click the name or task detail items for the project, depending on which menus you cleared, PMF will display the default Content menu that you configured here.

**Processes**

Process tracking enables you to align objectives to core business processes and to link your processes to supporting documentation. You can align any existing process to one or more objectives with the Strategy Map. One measure series is defined and named for each process, and can be input using the New Measure Wizard.

Processes can be linked to operational views including a WebFOCUS view showing project detail, a web-based project or document, BPM systems, or any other source. You have to set up an internal or external process related source as a PMF launch page before you can establish an Operational Report link to a PMF process.
To edit, create, or delete a process, click the **Processes** panel button in the Author tab, and select the desired process.

Alternatively, you can access processes in an existing scorecard from the scorecard tree. To do this, expand the desired Perspectives subfolder, expand the desired Objectives folder, and then expand the specific Objective folder for which you want to add or edit a process. Click **Processes**, and then click the specific project.

The following image shows the Edit Process panel.

![Edit Process Panel](image)

For the fields that prompt you for a date (for example, Start Date), click the date and time icon to supply the information.

The same fields are required for adding a new or updating an existing process. The following table lists and describes the fields in the Edit Process panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Name</td>
<td>The name of the process. The maximum number of characters is 50.</td>
</tr>
<tr>
<td>Description</td>
<td>Process description. The maximum number of characters is 1024.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start date for this process.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Date</td>
<td>End date for this process.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the owner from the list.</td>
</tr>
<tr>
<td>Process Report</td>
<td>Select from the Process Report drop-down menu to establish a link that drills out to an internal (WebFOCUS) or external (web-based) Project, report, or other documentation source. To view the selected Process Report, select the name of the process that you edited from any report in PMF and select <em>Operational Report</em> from the pop-up menu.</td>
</tr>
</tbody>
</table>

**PMF Tabs - Quick Reference for Authors**

**In this section:**
- Author Tab
- Strategy Subtab

The Author and Strategy subtabs provide authors with all the capabilities you need to author PMF applications.

**Author Tab**

**Reference:**

Navigating Through Objectives and Measures Within Scorecards

The Author tab allows staff members that have authoring responsibilities to add, edit, and delete information for scorecards, measures (loaded, user-entered), objectives, risks, projects, and processes. It also provides two wizards to streamline the creation of scorecards and measures.

The left pane of the Author tab contains a drop-down menu at the top for selecting the desired scorecard, and a series of panel buttons below for selecting and modifying components associated with that scorecard.

**Reference:** Navigating Through Objectives and Measures Within Scorecards

Use the following methods to access components in the Author tab:

1. Use the panel buttons in the left pane of the Author tab to select a desired component.
2. Use the Scorecard tree structure that descends through the components of a scorecard. In the case of the CenturyCorp Card scorecard, you can expand the tree structure to navigate through, or select, Perspectives or Themes, and then navigate through, or select, Objectives, which contain Measures, Projects, and Processes you can select.

The following navigational aides will help you in the scorecard tree:

- To expand or collapse portions of a scorecard tree structure, click a plus or minus sign to the left of a folder (or select an open or closed folder icon).
- To access the proper panel to edit or create a component, select an item within the Perspectives, Themes, Objectives, Measures, Projects, or Processes folders.

**Strategy Subtab**

The Strategy subtab allows you to build Strategy Maps, and drag and drop graphics on the map.

For consumers and analysts, the Strategy Map is read-only. For authors, the Strategy Map can be read/write if it has been set up that way by your administrator.
The read-only Strategy Map displays indicators that show the performance of metrics linked to the objectives displayed. The Strategy Map layout shows the relationship between objectives for your operational area of the enterprise. The indicators show an aggregate overall performance of the metrics you own for each of your objectives. The links between objectives for your enterprise represent your enterprise strategy. Larger arrows correspond to more important strategies. The size of the arrow does not affect how it is reported, but is meant as a visual cue only.

For a step-by-step tutorial on using the Strategy Map, see *How to Draw the Strategy Map* on page 203.
This chapter provides instructions for administering a Performance Management Framework application. It describes how to implement a scorecard at a customer site. It is recommended that you have strategic meetings with the customer before you create formal scorecards.

<table>
<thead>
<tr>
<th>Topics:</th>
</tr>
</thead>
<tbody>
<tr>
<td>▪ Getting Started as a PMF Administrator</td>
</tr>
<tr>
<td>▪ Managing Metadata</td>
</tr>
<tr>
<td>▪ Thinking About Users and Security</td>
</tr>
<tr>
<td>▪ Adding, Changing, Deleting, and Importing Users (Owners)</td>
</tr>
<tr>
<td>▪ Understanding Functional and Access Roles</td>
</tr>
<tr>
<td>▪ Working With Scorecard Security</td>
</tr>
<tr>
<td>▪ Working With the New Data Model</td>
</tr>
<tr>
<td>▪ What Are Sources?</td>
</tr>
<tr>
<td>▪ What Are Datapoints?</td>
</tr>
<tr>
<td>▪ Scheduling Loads and Updates</td>
</tr>
<tr>
<td>▪ Setting Measure Access for Users (Owners)</td>
</tr>
<tr>
<td>▪ Specifying Dimensions and Measures</td>
</tr>
<tr>
<td>▪ Creating Units of Measure Conversion Profiles</td>
</tr>
<tr>
<td>▪ Planning Considerations for Loading Dimensions</td>
</tr>
<tr>
<td>▪ Working With a Dimension Load</td>
</tr>
<tr>
<td>▪ Setting Up a Distinct Count Dimension</td>
</tr>
<tr>
<td>▪ Inputting User-Entered Dimensions</td>
</tr>
<tr>
<td>▪ Editing Existing Loaded Dimension Values</td>
</tr>
<tr>
<td>▪ Planning Considerations For Loading Sources</td>
</tr>
<tr>
<td>▪ Working With Measures</td>
</tr>
<tr>
<td>▪ Where to Attach Your Measures</td>
</tr>
<tr>
<td>▪ Loading Legacy Measures</td>
</tr>
<tr>
<td>▪ Excluding a Measure Series From Access Security</td>
</tr>
<tr>
<td>▪ Interpreting the Measure Loader Report</td>
</tr>
<tr>
<td>▪ Scheduling Measure Loads</td>
</tr>
<tr>
<td>▪ Previewing Loadable Sources and Load Measure Data</td>
</tr>
<tr>
<td>▪ Managing Content</td>
</tr>
<tr>
<td>▪ Working with Snapshots</td>
</tr>
<tr>
<td>▪ Administration Views</td>
</tr>
<tr>
<td>▪ Designing Gadgets</td>
</tr>
<tr>
<td>▪ Designing a Dashboard</td>
</tr>
<tr>
<td>▪ Manage Tab - Quick Reference</td>
</tr>
<tr>
<td>▪ Viewing and Editing Default Settings</td>
</tr>
</tbody>
</table>
Getting Started as a PMF Administrator

In this section:
Functions of a PMF Administrator

As an administrator you are responsible for ongoing maintenance of the PMF system and its structures and controls. You will also load dimensions and measures, and set up owners and roles within the organization.

Before you can administer a PMF application, you must do the following:

- Meet the personnel who will author PMF applications.
- Have access to the sources of customer data and its timeliness and dependencies.
- Have access to existing measures and Key Performance Indicators (KPIs).
- Know the RDBMS used.
- Know the security systems used.
- Have access to the personnel who understand the various user groups at the customer site and their respective roles.

Functions of a PMF Administrator

An administrator of a PMF application can do the following:

- Interact with the authors.
- Acquire measures.
- Load dimensions and measures.
- Configure feeds.
- Test loads.
- Interact with users requiring access to the PMF application.
Managing Metadata

PMF stores the data it needs to operate within its own data mart. If you add a type of metadata in this tab it will appear in a drop-down menu within administrative forms.

On the Manage tab, you (the administrator) can manage metadata for the following components:

- **Dimensions.** Enables you to create new dimensions and access the Dimension Loader to load dimensions.
- **Sources.** Enables you to create and modify source data.
- **Datapoints.** Enables you to create and modify the different datapoint types.
- **Measures.** Enables you to create and modify measures metadata, which controls the measure series. Each measure series is a distinct measure that you can link to an objective in a PMF scorecard. You can also load measures with the measure loader.
- **Schedules.** Enables you to schedule load-related activity.
- **Owners.** Enables you to add new system users, make existing users active or inactive, and modify the start tab (Today tab) for each user.
- **Functional Roles.** Enables you to create and modify functional roles to control the level of access to all of the systems in PMF for all users assigned to a functional role. The default roles are Admin w Access Security, Administrator, Analyst, Author, Consumer, and Planner.
- **Scorecard Security.** Enables you to control scorecard user access. You can control which scorecards each user can access, and also determine which users have access to a specific scorecard. Access levels include no access, viewer, editor, and administrator.
- **Access Roles.** Enables you to create and modify access roles to control the level of access to measures and dimensions for all users assigned to an access role.
- **Dashboards.** Enables you to design types of gadgets, create and modify individual gadgets, and add gadgets to report pages. A gadget is usually a small graph or data grid.
- **Content.** Enables you to select the specific content to be displayed on the Today tab for each user. A variety of content can be available in the application.
- **Units of Measure.** Enables you to create and modify units of measure, which determine the types of actual quantities being measured in PMF. Each measure is linked to a unit of measure.
- **Time Ranges.** Enables you to create and modify time ranges, which can be used wherever trending data appears in views throughout PMF.
Settings. Enables you to set system and default settings, such as organization name, corporate logo, style sheet, indicator set, Today date, and more.

About PMF. Displays the version and release dates.

Thinking About Users and Security

PMF is designed to work with your on-site web security system, whether you use Netegrity SiteMinder, EnTrust, LDAP, RACF, or any other security system. As an administrator, you will set up the following:

- **Authentication** to determine which users can access PMF. This requires integration with your on-site web security system to recognize your list of authentic users. You must ensure that the user ID has been entered in the security system files. For example, if you use an LDAP system, ensure that the user ID is valid in that system and that you have specified that they have access to WebFOCUS and PMF.

- **Authorization** to determine which tabs, data, and capabilities users can access within PMF. You can also specify for each user, or groups of users, the level of access permitted in terms of organizational levels. This requires creating owner records (user IDs) and assigning roles that determine the privileges for each user ID or groups of user IDs. User IDs must match those in your on-site web security system, while roles must match those as assigned for use with PMF.

For information on restricting user access to data based on dimension values, see *Setting Measure Access for Users (Owners)* on page 339.
Adding, Changing, Deleting, and Importing Users (Owners)

In this section:
Importing Users (Owners)

How to:
Add a New Owner
Change an Owner Record
Delete an Owner Record

Reference:
Fields in the Owner Panels

You can add individual users who need access to PMF to your system, by adding a new owner record for each user. Owner records can be changed or deleted as needed. You can also import users from the WebFOCUS Managed Reporting/Centralized User Services (MR/CUS) environment directly into PMF as owners.

Procedure: How to Add a New Owner

1. In the Manage tab, click the Owners panel button.
2. Click New.
The New Owner panel opens, as shown in the following image.

![New Owner Panel](image)

3. Specify values for all necessary fields. For more information about these fields, see *Fields in the Owner Panels* on page 276.

4. Click Save when you have finished typing information into the appropriate fields. The tree refreshes to show the new owner.

**Reference: Fields in the Owner Panels**

The following table lists and describes the fields in the New Owner and Edit Owner panels.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner Id</td>
<td>Login ID for the user to enter on the logon page. Read-only in the Edit Owner panel (after a new owner record has been saved).</td>
</tr>
<tr>
<td>First Name</td>
<td>First name for the owner. The maximum number of characters is 20.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last name for the owner. This is the field that appears in the tree by default. The maximum number of characters is 30.</td>
</tr>
<tr>
<td>Owner Email</td>
<td>Used for alerts and other notifications.</td>
</tr>
</tbody>
</table>
How to Change an Owner Record

1. To change an existing owner record, navigate to the Owners tree and click the owner you want to change.

   The Edit Owner panel displays for that owner.

2. Make the changes you want and click Save when you have finished.

   Note that the Last Name and First Name fields appear in the tree. If you edit these fields, click the Refresh content icon to see the updated name in the Owners tree.

How to Delete an Owner Record

1. To delete an existing Owner record, navigate to the Owners tree and click the owner you want to delete.

2. In the Edit Owner panel that opens, click the Delete button. PMF asks you to confirm your deletion.

3. Click OK to confirm it.

Note: If you are using a security system, the owner record will not lock the user out of other web systems you might be using. PMF will have no authorization for the user, and the user will not be able to access PMF data or views.
Importing Users (Owners)

**How to:**

Import Users From MR/CUS to PMF

To simplify coordinating PMF with your WebFOCUS installation, you can import users from the WebFOCUS Managed Reporting/Centralized User Services (MR/CUS) environment directly into PMF as owners. This gives you the ability to import all PMF-flagged users from your LDAP or Active Directory repositories, and easily integrate PMF with your single-source security environments.

PMF can synchronize users between the WebFOCUS MR/CUS repository and the PMF Owners authorization table. If CUT is configured for Realm Driver, this capability enables PMF to import Owners from repositories, such as active directory and LDAP. Synchronizing users analyzes data in your user repository, compares users with PMF domain access to the list of current owners configured in PMF, and enables you to add all users at once, setting up the most necessary parameters for each.

The process of synchronizing users automatically detects the following:

- If a user has been authorized for PMF from any MR/CUS group that is enabled for the Performance Management Framework MRE Domain.
- If a user is already added to the system.
- If a user was added to the system but removed from the MR/CUS access.

**Procedure:** How to Import Users From MR/CUS to PMF

1. Optionally, you can set up new PMF users in the MR/CUS User Administration tool.
   Make sure each new user has been added to a standard PMF Group, such as Consumers, Analysts, or Administrators, or a custom PMF Group that has been granted primary access to the Performance Management Framework MRE Domain.

2. In the Manage tab, click the Owners panel button.
   The Owners panel opens.

3. Click the Sync button.
PMF displays the Synchronize Users panel, as shown in the following image.

<table>
<thead>
<tr>
<th>Category</th>
<th>Group</th>
<th>User ID</th>
<th>User Name</th>
<th>Email</th>
<th>Scorecard</th>
</tr>
</thead>
<tbody>
<tr>
<td>In sync</td>
<td>planner</td>
<td>planner</td>
<td>dev/planner</td>
<td>No Specified Email</td>
<td>CenturyCorp Card</td>
</tr>
<tr>
<td></td>
<td>administrato</td>
<td>pmfadmin</td>
<td>dev/pmfadmin</td>
<td>No Specified Email</td>
<td>CenturyCorp Card</td>
</tr>
<tr>
<td></td>
<td>administrato</td>
<td>admin</td>
<td>Current Administrator</td>
<td>no Specified Email</td>
<td>CenturyCorp Card</td>
</tr>
<tr>
<td></td>
<td>analyst</td>
<td>analyst</td>
<td>dev/analyst</td>
<td>No Specified Email</td>
<td>CenturyCorp Card</td>
</tr>
<tr>
<td></td>
<td>author</td>
<td>author</td>
<td>dev/author</td>
<td>No Specified Email</td>
<td>CenturyCorp Card</td>
</tr>
<tr>
<td></td>
<td>consumer</td>
<td>consumer</td>
<td>dev/consumer</td>
<td>No Specified Email</td>
<td>CenturyCorp Card</td>
</tr>
</tbody>
</table>

The Synchronize Users panel displays the following next to each user in the Owner column:

- **Green plus sign.** User is already a PMF Owner.
- **Check box.** User is enabled as a Managed Reporting user, has access to the Performance Management Framework MRE domain, but needs to be imported into PMF to become a PMF Owner, which is done by selecting the check box next to that user.
- **Red minus Sign.** User is in the Owners table, but needs to have access setup in the Performance Management Framework MRE domain.

**Note:** The Synchronize Users panel can also be used to check the health and status of your basic authorization security in PMF.

4. You can specify a different default Scorecard for each user by selecting the desired scorecard from the Scorecard drop-down menu.

5. Select the check boxes for each user you want to import.

6. For each selected check box, select a value in the Role drop-down menu or use the default role already displayed.

**Note:** By default, PMF uses the current primary Group in the user repository to display the (Functional) Role for each user.

7. Click **Synchronize** to synchronize the two systems.
Understanding Functional and Access Roles

PMF provides you with the flexibility to create, modify, and set access levels for functional roles and access roles. A functional role is a class of user that controls access to systems when performing work in PMF. An access role is created and assigned to a group of users who are granted the same level of access to the measures and dimensions in PMF.

Administrators can edit functional roles to control the system-level functions each type of user is allowed to perform. Users are assigned one of the functional roles that ship with PMF, which are Admin w Access Security, Administrator, Analyst, Author, Consumer, and Planner. You can also add as many new functional roles as are needed for maintenance of your system.

In most organizations, a Business Strategy Committee has the responsibility to assign functional roles. By default, when a user is added to the PMF application, the user is assigned an administrator role. Because an administrator grants user IDs and passwords, you should assign each user an appropriate functional role for their area of responsibility in your organization.

Planning Considerations for Functional Roles

When you determine functional roles, consider the following factors:

- Only a few individuals are granted access as administrators, authors, or planners. This should be based on their responsibilities for the PMF application.

- Executives, managers, and planners are those participants who have budget responsibilities and are helping to define the strategies. Their areas of responsibility within the customer site provide critical feedback for the representation of the strategies and required modifications.

- Before you set up a new role in this panel, you must set up a corresponding group in Managed Reporting using the Managed Reporting Administration Interface. For details about using this interface, see the WebFOCUS Managed Reporting Administrator's Manual.
All others will generally be granted user access, though there might be exceptions based on the particular needs of your installation.

**Working With Functional Roles**

**How to:**
- Create a New Functional Role
- Edit Functional Role Properties
- Delete a Functional Role
- Limit Functional Roles to Enter Only Actual or Target Values

**Reference:**
- Fields in the Functional Role Panels
- Access Levels for Functional Roles
- Gadgets and Dashboard Design Security

Functional roles are assigned to each user in the New Owner and Edit Owner panels, and determine access to the systems throughout PMF.

**Procedure: How to Create a New Functional Role**

Before you set up a new functional role, you must set up a corresponding group in Managed Reporting using the Managed Reporting Administration Interface. For details about using this interface, see the *WebFOCUS Managed Reporting Administrator's Manual*.

1. In the Manage tab, click the *Functional Roles* panel button.
2. Click *New*.
The New Functional Role panel opens, as shown in the following image.

3. In the Role ID field, type a unique identifier for the functional role. The maximum number of characters is eight. This field cannot be edited after the functional role is created.

4. In the Role Name field, type an intuitive name for the role. The maximum number of characters is 20. This name appears in selection lists.

5. Select access levels from the drop-down menus for each of the PMF settings listed in the panel. Choose from the following access level values:
   - Admin
   - Editor
   - No Access
   - Admin (if owner) else Editor
   - Admin (if owner) else Viewer
   - Viewer
For more information about setting access levels, see *Access Levels for Functional Roles* on page 285.

The systems listed in the panel include Scorecard Objects, Security Settings, Dimensions, Measures Loads & Metadata, Gadgets and Dashboard Designs, Tasks, Processes, Projects, System Objects & Settings, Actuals, Targets, Benchmarks, Forecasts, and Stretches. For more information about these fields, see *Fields in the Functional Role Panels* on page 283.

6. Click Save when you have finished selecting appropriate access levels for all settings. The tree refreshes to show the new functional role.

**Reference: Fields in the Functional Role Panels**

The Functional Role panels contain three fields that are manually entered. The Role ID, which is a permanent ID used to track a role (cannot be edited after the role is created), the Role Name, and the Description.

The following table lists and describes the fields you can use to set access levels in the New Functional Role and Edit Functional Role panels.

<table>
<thead>
<tr>
<th>Field</th>
<th>Controls the ability to add/change/delete/view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard objects</td>
<td>Scorecards, Perspectives, Objectives, Objective-to-Measure Linkages, Objective-to-Measure Weights, and Themes.</td>
</tr>
<tr>
<td>Security settings</td>
<td>Access Roles and Owners.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Dimension designs and Dimension loads.</td>
</tr>
<tr>
<td>Sources, Fields &amp; Measures</td>
<td>Source Loads, Field designs &amp; Measure metadata.</td>
</tr>
<tr>
<td>Tasks</td>
<td>Measures Tasks.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Feedback for a Measure.</td>
</tr>
<tr>
<td>Processes</td>
<td>Processes.</td>
</tr>
</tbody>
</table>
### How to Edit Functional Role Properties

1. To edit an existing functional role, navigate to the Functional Roles tree structure and click the role you want to change.

   The Edit Functional Role panel opens for that role.

2. Make the changes you want and click Save when you have finished.

Editing a functional role changes program access for all users currently connected to that role, so make changes carefully. Also, it is possible to remove other functional roles access to change owners. As a result, no users would be able to change program access within PMF. If this happens, contact Customer Support Services.

**Note:** If you rename a functional role, you must update the dashboard for that new role name in the Dashboard View Builder.

### How to Delete a Functional Role

1. To delete an existing functional role, navigate to the Functional Roles tree structure and click the functional role you want to delete.

   The Edit Functional Role panel opens for that role.

2. Click *Delete* and then click *OK* to confirm the deletion.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Controls the ability to add/change/delete/view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects</td>
<td>Projects and Project Measures.</td>
</tr>
<tr>
<td>System objects &amp; settings</td>
<td>PMF System Settings, Time Ranges, Units of Measure, and Content (including links to external web content and WebFOCUS operational reports).</td>
</tr>
<tr>
<td>Data Mart</td>
<td>Snapshots, Audit, and resynch.</td>
</tr>
<tr>
<td>Actuals</td>
<td>Measures Actuals data entry for User-Entered Measures.</td>
</tr>
<tr>
<td>Targets</td>
<td>Measures Targets data entry for User-Entered Measures.</td>
</tr>
<tr>
<td>Benchmarks</td>
<td>Measures Benchmarks data entry for User-Entered Measures.</td>
</tr>
<tr>
<td>Forecasts</td>
<td>Measures Forecasts data entry for User-Entered Measures.</td>
</tr>
<tr>
<td>Stretches</td>
<td>Measures Stretch Targets data entry for User-Entered Measures.</td>
</tr>
</tbody>
</table>
**Caution:** Deleting a functional role deletes program access for all users currently connected to that role, so make changes carefully. Also, it is possible to delete the last functional role that has access to change owners. As a result, no users would be able to change program access within PMF. If this happens, contact Customer Support Services.

**Procedure:** **How to Limit Functional Roles to Enter Only Actual or Target Values**

By default, all functional roles are given Admin access. You can limit users to input only actuals or only targets, by editing the functional role to which they belong using the Edit Functional Role panel.

1. Navigate to the *Functional Roles* tree structure and select the functional role assigned to the users that should have limited access to entering actual or target values. The Edit Functional Role panel opens for that role.

2. To prevent users of this functional role from:
   - Entering Actuals values, select *Viewer* from the Actuals drop-down menu.
   - Entering Targets values, select *Viewer* from the Targets drop-down menu.

3. Click *Save*.

**Reference:** **Access Levels for Functional Roles**

The following table lists and describes the different access levels that can be set for functional roles.

<table>
<thead>
<tr>
<th>Access Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>Allows add/change/delete/view access to object forms, and to any dependent objects, if applicable.</td>
</tr>
<tr>
<td>Editor</td>
<td>Allows change/view access to object forms, and to any dependent objects, if applicable.</td>
</tr>
<tr>
<td>Admin (if owner) else Editor</td>
<td>Access depends on object Ownership. If the Owner is designated as the object Owner, they are given add/change/delete/view access to object forms, and to any dependent objects, if applicable. If the Owner is not designated as the object Owner, they are given change/view access to object forms, and to any dependent objects, if applicable.</td>
</tr>
</tbody>
</table>
Understanding Functional and Access Roles

<table>
<thead>
<tr>
<th>Access Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin (if owner) else</td>
<td>Access depends on object Ownership. If the Owner is designated as the object Owner, they are given add/change/delete/view access to object forms, and to any dependent objects, if applicable.</td>
</tr>
<tr>
<td>Viewer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the Owner is not designated as the object Owner, they are given view-only access to object forms, and to any dependent objects, if applicable.</td>
</tr>
<tr>
<td>Viewer</td>
<td>Allows view-only access to object forms, and to any dependent objects, if applicable.</td>
</tr>
<tr>
<td>No Access</td>
<td>Does not allow the user to view object forms.</td>
</tr>
</tbody>
</table>

**Note:** If a role does not have a corresponding access to the tab in question, it does not make sense to grant read/write access. For example, by default, consumers and analysts have no access to the Manage tab. If you grant them access to Add/Change/Delete Owners, it is meaningless unless you add that tab to their Group View as well.

**Caution:** Deleting a functional role deletes program access for all users currently connected to that role, so make changes carefully. Also, it is possible to delete the last functional role that has access to change owners. As a result, no users would be able to change program access within PMF. If this happens, contact Customer Support Services.

**Reference:** Gadgets and Dashboard Design Security

The following table lists the security settings that are available in PMF for gadgets and dashboards.

<table>
<thead>
<tr>
<th>Security Setting</th>
<th>Authorized to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>❑ Create Public and Private dashboards.</td>
</tr>
<tr>
<td></td>
<td>❑ Delete Public and Private dashboards.</td>
</tr>
<tr>
<td></td>
<td>❑ Edit (Save) Public dashboards.</td>
</tr>
<tr>
<td></td>
<td>❑ Change dashboard parameters.</td>
</tr>
<tr>
<td></td>
<td>❑ Change dashboard viewed.</td>
</tr>
<tr>
<td>Security Setting</td>
<td>Authorized to...</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Editor</td>
<td>- Create Private dashboards ONLY.</td>
</tr>
<tr>
<td></td>
<td>- Delete Private dashboards ONLY.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard parameters.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard viewed.</td>
</tr>
<tr>
<td>Admin (if owner) else Editor</td>
<td>- Create Private dashboards ONLY.</td>
</tr>
<tr>
<td></td>
<td>- Delete Private dashboards ONLY.</td>
</tr>
<tr>
<td></td>
<td>- Edit (Save) Public dashboards, for which you are owner.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard parameters.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard viewed.</td>
</tr>
<tr>
<td>Admin (if owner) else Viewer</td>
<td>- Edit (Save) Public dashboards, for which you are owner.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard parameters.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard viewed.</td>
</tr>
<tr>
<td>Viewer</td>
<td>- Change dashboard parameters.</td>
</tr>
<tr>
<td></td>
<td>- Change dashboard viewed.</td>
</tr>
<tr>
<td>No Access</td>
<td>- Change dashboard parameters.</td>
</tr>
</tbody>
</table>

**Reference:**  **Default Functional Roles in PMF**

Each default functional role in PMF has access to a particular combination of tabs in the PMF dashboard. If you want to change these tabs, you need to use the WebFOCUS Dashboard View Builder. For more information on using the WebFOCUS Dashboard View Builder, see the *WebFOCUS Managed Reporting Administrator’s Manual*. 
The following table lists and describes the default functional roles that are provided with PMF.

<table>
<thead>
<tr>
<th>Role/Group</th>
<th>Function</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin w Access Scry</td>
<td>Allows an Administrator to test Access Security without having to log off and log back on with a different user.</td>
<td>All tabs are available.</td>
</tr>
<tr>
<td>Administrator</td>
<td>Performs and checks every facet of the application. Assigns users to roles, sets up the initial operational data in the application, and enters other application-specific data for each site. Also responsible for ongoing maintenance of the application.</td>
<td>All tabs are available. The only other role with access to Administration is the Planner.</td>
</tr>
<tr>
<td>Author</td>
<td>Sets up the structure of the scorecard, specifies the measures to be used, and links them to the scorecard. This role has the authority to update all fields in the scorecard and all updates are kept historically by date of the entry.</td>
<td>Today, Analytics, Author, Strategy. This is the only role with author and strategy update capabilities.</td>
</tr>
<tr>
<td>Analyst</td>
<td>System users who analyze data, view scorecards, view and comment on their own measures and those of their staff, and perform forecasting functions. Cannot enter values.</td>
<td>Today, Analytics</td>
</tr>
<tr>
<td>Consumer</td>
<td>System users who can display their own views and provide comments on the results of a scorecard. Cannot enter values.</td>
<td>Today</td>
</tr>
<tr>
<td>Planner</td>
<td>Sets up targets for one, many, or all measures in the system.</td>
<td>Today, Analytics, Administration.</td>
</tr>
</tbody>
</table>
Working With Access Roles

**How to:**
- Create Access Roles
- Edit Access Roles

Access roles can be created and assigned to multiple users to set up the exact same level of access to the measures and dimensions in PMF. In the future, if you need to change access to measures and dimensions for that group of users, editing the access role is all that is required.

**Procedure: How to Create Access Roles**

1. In the Manage tab, click the Access Roles panel button.
2. Click New.
   
   The New Access Role panel opens, as shown in the following image.

   ![New Access Role Panel](image)

3. Type a name for the new access role in the Access Role Name field, for example, Consulting.
4. Using the drop-down menus for each dimension, select the measure level at which you want to limit access for the access role.
   
   For each level you select, all users (owners) linked to that access role will only be able to view measures at or below that level. If the access role should be allowed to view all measure data for a dimension, select All in the drop-down menu for that dimension.
5. When you are finished setting measure access for each dimension, click Save to create the new access role.

**Procedure: How to Edit Access Roles**

1. In the Manage tab, click the Access Roles panel button.
2. Click the access role you want to edit in the tree.
The Edit Owner Access panel opens.

3. Using the drop-down menus for each dimension, select the measure level at which you want to limit access for the access role.

4. When you are finished editing the measure access level for each dimension, click Save to save your changes.
Working With Scorecard Security

Scorecard Security enables you to control scorecard user access. You can control which scorecards each user can access, and also determine which users have access to a specific scorecard. Access levels include no access, viewer, editor, and administrator. The following image shows the owners and scorecards to which you can control access when you click the Scorecard Security panel button in the Manage tab.
Scorecard Functional Access

How to:
Change Scorecard Functional Access for a Scorecard
Change Scorecard Functional Access for a User (Owner)

Reference:
Fields in the Edit Scorecard User Access Panel

Scorecard Functional Access is a new Functional Role model that overrides the older default Functional Role behavior for Scorecards and their dependent objects. Dependent objects include perspectives, objectives, objective weights, measure weights, objective linkages to measures, objective linkages to projects, objective linkages to processes, cause and effect linkages, and themes. Depending on how Scorecard Functional Access is configured, it controls user ability to edit dependent objects.

The following are considerations related to Scorecard Functional Access:

- Only Administrators can create scorecards. You cannot grant or remove access to create scorecards from Administrators.
- You cannot hide (set to No Access) a scorecard from the administrator of that scorecard. Scorecard administrators are users with Admin-level access set for scorecard objects in their Functional Role configuration. Scorecard administrators have global access to all scorecards.
- Only a scorecard owner or scorecard administrator can delete a particular scorecard. Users with only Editor-level access set for scorecard objects in their Functional Role configuration cannot delete scorecards.
- If you want to hide (set to No Access) a scorecard from a user, but the scorecard is the default scorecard for the user, you must first change the default scorecard for the user to a different scorecard.
- Depending on how access roles are set up, data access to measures aligned to a scorecard is also controlled by the owner or the scorecard access security setting and the measure row security setting.

Procedure: How to Change Scorecard Functional Access for a Scorecard

1. In the Manage tab, click the Scorecard Security panel button.
   Select the Scorecard for which you want to change Scorecard Functional Access.
   The Edit Scorecard User Access panel opens.
2. For each scorecard whose functional access you want to change, select one of the following:

- **No Access.** Do not allow the user to view or access this scorecard.
- **Viewer.** Allow the user to view the scorecard, the related measure data, and all dependent and linked scorecard objects.
- **Editor.** Allow the user to view the scorecard, the related measure data, and all dependent and linked objects. Also allow the user to add, change, and delete all dependent scorecard objects.

The following image shows the Edit Scorecard User Access panel.

![Edit Scorecard User Access Panel](image)

The No Access setting hides the scorecard from a user. If Administrator or Scorecard Owner is displayed in the Viewer column for a user, scorecard functional access cannot be changed for that user.

3. Click Save to save the changes.

**Procedure: How to Change Scorecard Functional Access for a User (Owner)**

1. In the Manage tab, click the Scorecard Security panel button.
2. Select the user whose Scorecard Functional Access you want to change from the User drop-down menu.

3. Click Apply Filter.
   The Edit Scorecard User Access panel opens.

4. For each Scorecard that you want to change the Scorecard Functional Access for the selected user, select one of the following:
   - No Access. Do not allow the user to view or access this scorecard.
   - Viewer. Allow the user to view the scorecard, the related measure data, and all dependent and linked scorecard objects.
   - Editor. Allow the user to view the scorecard, the related measure data, and all dependent and linked objects. Also allow the user to add, change, and delete all dependent scorecard objects.

   The No Access setting hides the scorecard from the selected user. If Administrator or Scorecard Owner is displayed in the Viewer column for a user, scorecard functional access cannot be changed for that user.

5. Click Save to save the changes.

Reference: **Fields in the Edit Scorecard User Access Panel**

The following table lists and describes the fields you can use to set scorecard functional access in the Edit Scorecard User Access panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Selects the desired scorecard or all scorecards.</td>
</tr>
<tr>
<td>User</td>
<td>Selects the desired user or all users.</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Applies the values selected in the Scorecard and User drop-down menus.</td>
</tr>
<tr>
<td>Sort by Scorecard</td>
<td>When Sort by Scorecard is displayed, all selected and filtered scorecards are listed in alphabetical order. Each user (owner) is listed in the next column.</td>
</tr>
<tr>
<td>Reset (button)</td>
<td>Resets all selections to the default values.</td>
</tr>
<tr>
<td>Save (button)</td>
<td>Saves your changes.</td>
</tr>
</tbody>
</table>
Working With the New Data Model

In this section:

- The Core Paradigm
- Migrating to the New Architecture
- Data Lineage
- Load, Recalculate, and Copy (LRC) Loads

As of PMF 5.3.2, the model where each individual measure needs to be loaded as a separate, schedulable entity is no longer applicable. Instead, PMF now allows you to group (and to schedule loads for) your loadable data by its source.

You can specify how that data should be harvested from individual physical data sources. You can:

- Harvest field values directly, aggregating the values you acquire by dimensionality. You can either aggregate all matching values or filter only particular sets of values.
- Count occurrences of particular flags on one or more fields per record in your source. These counts are automatically kept at the dimensional levels, as indicated on the loadable source.
- Distinctly count occurrences of particular flags on one or more fields per record in your source. These counts are automatically kept at the dimensional levels, as indicated on the loadable source. Additionally, a distinct count is applied on the field you indicate.
- Create custom formulas to describe how data should be harvested, for more complex harvesting techniques.

You can also specify that some datapoints are acquired from end users. Typically, you do this if you do not already have a physical source for this data, but want PMF to become the system of record for the data and to track it as it is captured.

PMF provides user-input features that allow it to capture, update, validate, and store the data in datapoints for use downstream.

When setting up user-entered sources, specify the level of dimensionality common to all datapoints in a single source group. At capture time, end users can input all datapoints at the same time, increasing the speed and convenience for end users.

Once data has been harvested from physical sources or data has been entered by the user, PMF can regularly recalculate any derived datapoints. Recalculation is performed in lineage order. This means that PMF itself determines which derived datapoints have dependencies, and waits to perform recalculation on any datapoint until all of its precursor dependencies have been resolved.
After all datapoints are reloaded, and derived datapoints are fully recalculated, PMF checks for measure dependencies of these datapoints. It then copies the data, as you designed it, to the measures.

**The Core Paradigm**

The new metrics model in PMF allows you to think differently about measure loads than in previous versions of PMF:

- You can now time a single source load to harvest all values needed from any particular external RDBMS system. You no longer have to think about timing multiple separate measure loads to events in external systems. PMF determines the timing for you, harvesting the data at the time you set, and then pushing the data downstream to derivations and then to each dependent measure in the system.

- PMF now knows the lineage of each calculation and the order in which each dependency must be calculated, so you do not have to determine dependency order for calculated fields.

- PMF can now mix user-input data with loadable data. You do not have to create special interim data tables and user interface schemas to accept user input that needs to be combined on measures or sub-calculations (either as separate measure components or as dependent components in complex calculations).

- PMF can now synthesize data at will, using rules that allow you to determine dimensional depth and method of generation. This means that creating demonstrations of new metric models does not require spending time generating data in Excel and figuring out how to load that data into PMF.

- Determining dimensional dependencies is now more automatic. Since dimensional dependencies are attributes of sources and datapoints, just connecting datapoints to a measure automatically determines the dimensions and levels that will be available to that measure.
Migrating to the New Architecture

In this section:
How the Migrator Works
Should I Upgrade Legacy Measures?
How to:
Perform a Migration

PMF allows you to automatically migrate legacy measure load scripts that were created prior to PMF Release 5.3.2 to the new architecture.

How the Migrator Works

If you were a user of PMF prior to release 5.3.2, you used legacy measures and set up loads directly on them. There were no sources or datapoints. Automated Migration enables PMF to automatically migrate all old measure components to use the new architecture.

- The migrator attempts to find common data sources for your measures, examines the dimensional intersections these use, and binds the ones that have common data sources and common dimensional intersections into sources.
- When creating Sources during migration, the migrator names the created sources sequentially. You can rename these sources at any time after the migration completes.
- Naming of datapoints is based on the option you choose:
  - You can choose to have PMF name the datapoints tied to these sequential sources based on the source name.
  - You can choose to name the datapoints after their linked measures.

Note: You can rename the created datapoints at any time after migration is completed.

Should I Upgrade Legacy Measures?

Before upgrading legacy measures, take the following into consideration:

- If you plan to use the new architecture features, immediately migrate your data mart to use the new architecture. The PMF migrator requires that you take an either/or approach. Once you begin creating new-style measures, PMF will not be able to both preserve them and to migrate your legacy measures for you.

- You should always run a snapshot before attempting migration. This will enable you to quickly revert back to using legacy measures and retrying migration with other options if the result is not what you expected.
If you want to continue to use legacy measures unchanged, note that migration to the new architecture is currently an optional step. PMF 8 supports legacy measures, as well as new measures. It is strongly recommended that you upgrade to the new model as the legacy measures are deprecated. The new model will be required in a future release.

Automated migration to the new architecture is not required to upgrade the PMF data mart version. That operation is done when you first start log in to PMF as an administrator after upgrading.

**Procedure: How to Perform a Migration**

Before performing a migration, note the following:

- You should always run a snapshot before attempting migration. This will enable you to quickly revert back to using legacy measures and attempting another migration, with other options, if the results of the initial migration are not what you expected.

- It is recommended that you use migration using the default options and then examine the results. If the results are now what you expected, restore your backup snapshot and perform the migration again after tweaking the options.

- If you were using PMF prior to release 5.3.2, it is not recommended that you add any new sources, datapoints, or measures to PMF until you complete the legacy migration. If there are already existing sources, datapoints, or new measures, the migration operation will quit. You can delete these components before performing the migration using the option available, but this is not advised if you spent a lot of time in the new architecture.

To perform a migration to the new architecture:

1. From the Manage tab, click the Data Mart subtab.
2. Click **Migrate Legacy Measures**. The Migrate Legacy Measures to New panel opens, as shown in the following image.

![Migrate Legacy Measures Panel](image)

The following options are available:

**Retain the Legacy Load Mode**

Enable this option to transfer the deletion option used by the migrated measures into its equivalent default Wipe setting on the sources to be created. This setting is enabled by default.

**Retain Alternate Targets**

If you are using Alternate Targets (for example, Benchmark, Stretch, Budget, and Forecast targets), enable this option to make sure that they are migrated.

If you are not using Alternate Targets, it is recommended that you leave this option disabled. This is the default setting.

**Delete Measures that do not migrate**

If enabled, the migrator will delete any measures that do not migrate. It is recommended that you select this option after doing a test migration and determining that it is safe to do so. This option is disabled by default.

**Note:** Generally, legacy measures that are incomplete will not be migrated, since PMF does not have any way to map these into the new architecture. You can always choose not to delete these, manually set them up as new measures, and then delete the unconverted legacy measures.

---

*Performance Management Framework 299*
Delete any existing Sources and dependent objects

If enabled, the migrator will delete any existing sources and datapoints that were created using the new architecture. This will delete any new sources, datapoints, and measures in your system.

If you have this option disabled, and you have new measures, existing sources and existing datapoints, the migrator will produce an error. This is to prevent the overwriting of any new components. This option is disabled by default.

Base Loadable Datapoint names

The following options are available:

- **on legacy Measure names.** This option names loadable datapoints created in each source using the names of the measures to which the migrator links them.

- **on new Loadable Source names.** This option names loadable datapoints created in each source using the source name, so that the names contain the Master File information.

3. Click **Migrate**.

PMF will perform the migration. This operation can take a few minutes and it is important to wait until it is complete before performing another operation. Once done, a status message will confirm that migration is completed.

4. Once the migration is done, return to the Manage tab and review the results.

Data Lineage

Data lineage refers to the entire path of data through the PMF load architecture.

**Step 1**

For PMF, data lineage starts at the source. Datapoints that are linked to a source are left-side endpoints in the lineage. This means they are harvested directly from:

- Physical database tables or views, or various flat file formats.

- User entry of data, in situations where there is no physical representation of the data.

- Generated data (in the exception where no data exists, and is being created for various demonstration purposes).

**Example 1:** In the case of a manufacturing company, there might be sources defined to harvest data from systems in Warehousing, Production Line, Quality Control, Shipping and Logistics, Supply Chain/Purchasing, Prospect Management, and Wholesale Sales. PMF harvests data as follows:
Warehousing. Average cost of storage per item, per warehouse.

Production Line. Average cost of labor per item, per plant.

Quality Control. Average cost of testing, per item, per plant.

Shipping and Logistics. Cost to ship, per item, per plant, per customer.

Supply Chain/Purchasing. Cost of supply, per item, per plant.

Prospect Management. Average Cost of Customer Acquisition, averaged per item, per customer.

Wholesale Sales. Sale Amount, per item, per customer.

**Step 2**

Lineage then proceeds through each generation of derived datapoints. There is no limit to the number of phases possible.

**Example 2:** Continuing from Example 1, you can derive the following datapoints from those you loaded:

- Total Product Cost = Average cost of storage per item + Average cost of labor per item + Average cost of testing, per item
- Total Sale Cost = Average Cost of Customer Acquisition + Shipping Cost
- Net COGS = Total Product Cost + Total Sale Cost
- Profit = Total Sale – Net COGS
- Margin = Profit/Total Sale (as a %)

These datapoints need to be calculated in the following order:

1. Total Product Cost, Total Sale Cost
2. Net COGS
3. Profit
4. Margin

**Step 3**

Lineage then ends at measures.
Load, Recalculate, and Copy (LRC) Loads

Reference:
Checking the Administrative Log Reports

To load measures, the PMF load architecture puts data through three phases:

1. **Load.** All sources indicated for Load are loaded and data is fed into the datapoints for each source.
   - **Volitional load.** The Load button is clicked on any source. In this case, the only source that will be loaded is the one you indicated for load.
   - **Scheduled direct load.** A source load is scheduled to run at that time.
   - **Scheduled optional cascaded load.** If any of the dimensions that are linked to the source are reloaded, a source load could be forced (cascaded) depending on how the dimension Cascade Load settings are configured.
   - **Scheduled forced cascaded load.** If any of the dimensions that are linked to the source are reorganized, a source load will always be forced (cascaded), regardless of how the dimension Cascade Load settings are configured.

   **Note:** During schedule processing, if more than one source has to be loaded during the scheduled run, all scheduled sources would be loaded before the next step runs. This prevents inefficiently repeating the recalculation.

2. **Recalculate.** PMF looks at all the sources that were reloaded, and analyzes all derived datapoints with dependencies on the sources that were loaded. PMF then analyzes the lineage of all derived datapoints to determine the correct order to recalculate them, respecting their dependencies. Finally, PMF performs the recalculation step, in phases, with the number of phases determined by the generations of lineage of the derived datapoints.

3. **Copy.** PMF analyzes all measures that use the datapoints that were recalculated in Step 2. It then copies the data for the linked datapoints into the measures cube, making the data ready for reporting and dashboard publication.

Reference: **Checking the Administrative Log Reports**

PMF logs all activity that involves load, recalculation, or copy actions. Logged data is stored as peer data in the PMF Data Mart.

PMF captures the following data in its source load logs:
   - Earliest and latest effective dates for the source data.
- What dimensions were processed on the load.
- Status of the load:
  - Running: The load is currently running.
  - Success: The load completed successfully.
  - Error: The load operation completed with an error thrown.
- How many source records were retrieved to process the load.
- How many datapoint records were inserted, updated, and deleted.
- How many dimensional linkage mismatches were processed.
- Gaps in dimensional intersections.
- Datapoint sparsity count (how much of the potential total Cartesian cross product was not loaded).
- LRC load type:
  - Load a source.
  - Load a datapoint.
  - Recalculate.
  - Copy to measure.
- Owner ID under which the load ran.
- Start and end time of the load.
- Messages that were returned from the server during the load.
- Compare mode that was flagged for the load:
  - NO_DATA: There is no incoming/parent data ready to process.
  - NEW: All ready parent data is new (outside the range of the target data), and all parent data is in the lineage for all incoming datapoints for at least one common time period.
  - NEW_W_MISSING: All ready parent data is new (outside the range of the target data), but data is missing for at least one required parent data point in the lineage.
  - POSS_UPD: All incoming ready data falls within the range of current data, but there is no ready data for at least one incoming data point. There is no possibility of new rows being generated.
    - For Copy to Measure, there are possible updates.
For Recalculation, there are also possible updates if there is available data for all other parents (this has not yet been coded).

It is possible that there is some ready data that is new for some parents, but not for all parents. Since we are lacking new data for at least one parent, there can be no new processing.

POSS_UPD_NEW: Similar to POSS_UPD, except that there is ready data for all parents in the lineage, so it is possible that there is some new data.

The most likely scenario for this would be that you source loaded EAST for 2012/01 and then separately source loaded WEST for 2012/01. In order to process the POSS_UPD_NEW mode, you need to split out those incoming or parent rows that match the dimensionality existing/child rows versus those that are new. For those that are new, you have to check for gaps.

MIXED: Similar to NEW, except there is also some ready parent data which overlaps existing data. For incoming data that falls within the range of existing data, it is possible that:

- The data will not be in the current child data, in which case, the data will be New provided that there is already data in all required parents.
  
or

- It may be that the child data already exists, in which case, we can do C2M update processing OR recalcul updates (if there is available data for all other parents).
What Are Sources?

A source allows you map inbound data to PMF elements called datapoints that will become elements in measures, such as Actual, Target, and so on.

There are currently three types of sources available:

- **Loadable Source.** Allows you to map inbound data from physical data tables and views to datapoints, regardless of their format.

- **User-Entered Source.** Allows you to map inbound data from your user input to datapoints, regardless of who is doing the input across your organization.

- **Generated Source.** Allows PMF to automatically create sample data for your models.

**Note:**

- Define dimensional linkages at the source level. These linkages are then inherited by all of the datapoints of a source at once.

- You can quickly edit and change all the individual datapoints on a source using the new source panel.

**Note:** Data values for numbers will be stored in internal floating point format, and can be different than displayed values, depending on the display format you have selected for these values. For example, if you chose to display numbers with less precision (smaller number of decimal places) than is stored, WebFOCUS will reformat the numbers to the level of precision you request.
**Procedure: How to Wipe Source Data**

All loaded data from a loadable, user-entered, or generated source can be wiped out or deleted in a single operation. This is useful when you have loaded data that is invalid. It is a simple way to delete all the data.

1. From the Manage tab, click the **Sources** panel button.
2. Select the source that needs data to be deleted. The Edit Source panel opens.
3. Click the **Wipe Data** button. PMF will ask you to confirm the data purge.
4. Click **OK**.

**Note:** It may take PMF a moment to purge all of the data.

**Reference: Lineage Tab**

You can view the lineage for all datapoints for any loadable, user-entered, or generated source by selecting the **Lineage** tab in the New Source or Edit Source panel. Lineage shows the progress of data through PMF, starting from the external data harvested into datapoints, through any derived datapoints, and finally, all terminal points in measures.
The following image shows an example of the Lineage tab for a loadable source.

The lineage tab automatically displays the entire lineage. You can click the **Collapse All** button to hide the entire lineage.

**Reference: Load History of Sources**

PMF keeps track of each load that is executed for each source in the system, regardless of whether you loaded it manually or the load was called by the scheduler. This data is stored in a special logging section of the PMF data mart.
The History tab on each loadable, user entered, or generated source displays the history of all loads that have been logged, as shown in the following image.

The history of the source shows:

- The dates that the loads ran.
- The count of rows that were retrieved, inserted, updated, and deleted.
- The count of total mismatches that occurred between the source data and the PMF metrics mart. Mismatches are source data rows that do not match to any existing keys for one or more dimensions.
  
  The total count of mismatches for generated sources should always be zero.
- The count of gaps in data continuity, which indicate the sparsity of the data. This does not mean there are errors but, if paired with mismatches, can help you debug any unexpected data discontinuities.
  
  The total count of gaps in data discontinuity for generated sources should always be zero.
- Any messages returned from the load system. If there is an error, the exact error is displayed in the information shown in this tab.
  
  Errors are unlikely for generated sources.
Working With Loadable Sources

**How to:**
- Set Up Loadable Sources and Datapoints
- Update a Loadable Source
- Change the File, Table, or View Used for a Loadable Source

**Reference:**
- Data Harvesting Loadable Sources
- Lineage and Recalculation With Loadable Sources

Loadable sources in PMF:

- Let you harvest data from external data tables, views, flat files, Excel files, and so on. Typically, you would define a loadable source for every single separate and distinct physical data source from which you wanted to acquire metric data. For more information on harvesting data, see Data Harvesting Loadable Sources on page 309.

- Allow immediate loading of data, or you can load data on a schedule.

- Contain one or more loadable datapoints each. A loadable source is a logical grouping of datapoints that all come from the same physical data location.

**Reference:** Data Harvesting Loadable Sources

Data harvesting is the process of taking data from a source and processing it into information that is then loaded into one or more datapoints needed by the PMF source.

**Note:** The result of any data harvesting operation is always numeric.

Typical data harvesting actions are:

- Summarizing aggregated values of an inbound numeric field.

- Summarizing values of an inbound numeric field, but only if certain conditions are true. Otherwise, they are ignored.

- Counting occurrences of a particular set of field conditions (Counting when).

- Distinctly counting occurrences of a particular set of field conditions. Distinct counting is a method to prevent double-counting fixed assets, people, and so on.
Writing a custom load for a datapoint, where the logic is freeform. For example, it is possible to perform custom operations or calculations on the data inbound or implement more complex or nested filters. These use WebFOCUS programming logic, functions, and operations. The PMF source loader allows all the data harvesting methods above.

In PMF, all data harvesting is done across a potential Cartesian cross product of dimensional intersection. Nearly every load involves a fairly high degree of sparsity against this cross product, but in most cases, it also involves creating multiple records that follow a particular pattern against the source data.

In many cases, depending on the degree of granularity of the inbound loadable data from the source, PMF requests the data to be aggregated even when loaded at the lowest level of its dimensionality. This happens when the physical data table or view contains more detailed records that go to a lower logical level than the source requests. Some examples of this are:

- If the physical data of the source is stored at a daily or hourly level, and the source load needs it summarized at a monthly level.
- If there is a location dimension, and the source stores data at the geocode or ZIP code level, and the PMF source wants this data at the city or regional level.

In the examples listed, the PMF loader will be aggregating records from the source inbound during the load process.

**Reference:** Lineage and Recalculation With Loadable Sources

Loadable Sources are primary sources for data in PMF. PMF treats them as first generation in any lineage, along with user-entered datapoints and generated datapoints.

Loadable data is treated as updated on the date of load, but is effective as of the time dimension linkages for the data.

**Procedure:** How to Set Up Loadable Sources and Datapoints

To set up a new Loadable source:

1. In the Manage tab, click the Sources panel button.
2. Click New.
   
   The New Source panel opens.
3. Name your new source and select *Harvested from Data* from the first drop-down menu, as shown in the following image. This option lets PMF know that you want this source to harvest data from an existing table, view, flat file, and so on.

![Image](image.png)

4. Select the metadata file for the existing table from the second drop-down menu. If the file you want to use is not listed, expand the File Picker by selecting *Show More...* from the drop-down menu.

The File Picker allows you to look at all of the available metadata files in your currently configured WebFOCUS app path. The icons to the left of each file name let you explore the contents of the file to make sure that it is the correct one. To select the file to use, click the name once and close the File Picker.

5. Specify the datapoints to be harvested. For each line where you want to add another field from the source, you can do the following:

- To harvest by *summarizing the values of the field*, select the field you want to harvest from the Source field name drop-down menu. You can use the default name assigned to the datapoint, or change the name at anytime.

- To harvest by *summarizing the values of the field only when conditions are matched*, select the field you want to harvest from the Source field name drop-down menu and create filters by clicking the *Filters* button to choose your filters.

- To harvest by *counting*, select *[Count]* from the Source Field Name drop-down menu and specify the conditions to count by clicking the *When* button. You are required to provide a name for the datapoint.

- To harvest by *counting distinctly*, select *[Distinct Count]* from the Source Field Name drop-down menu. Specify the conditions to count by clicking the *When* button, and specify the matching field for distinct counting. You are required to provide a name for the datapoint.

- To create a *custom formula for calculating the field during harvesting*, select *[User Defined]*. Specify filters to be used by clicking the *Filters* button and specify the WebFOCUS code-based formula for harvesting the field by clicking the *Code* button. You are required to provide a name for the datapoint.
Your datapoints should look similar to the following image.

![Image of datapoints](image_url)

**Note:** You can save your work-in-progress at any time. PMF will not be able to actually harvest data into the datapoints that were set up until the needed harvesting details and dimensionality have been specified.

6. Click the *Dimension Links* tab and specify Time, as well as other dimensional linkages, as shown in the following image.

![Image of dimension links](image_url)

**Note:** The fields you select for dimensional linkages must contain values that match up to those you loaded for the dimension keys in the Dimension Loader. PMF will alert you if there is an issue.
7. Once the dimensional linkages are set up, click the Preview tab. The data that is being set up for harvesting can be seen, as shown in the following image.

![Preview Pane Image]

**Note:**

- The Preview pane is very flexible and shows the row values that will be added, changed, or deleted from your source, in separate sections.
- You can resort the contents of the Preview pane by clicking a column heading. The sort toggles between ascending and descending order.
- You can scroll the Preview pane vertically and horizontally, and drag the navigation bar divider to make more room onscreen.
- You can refresh the Preview pane at any time by clicking the Refresh button on the Preview tab.
- You can switch back and forth between the Datapoints, Dimension Links, and Preview tabs to alter the patterns you are using for harvesting, adjust the linkage keys and dimensions that you are linking to, and refresh the preview, as needed.

8. Click Save before concluding your session to ensure that the datapoints and source you have set up are correctly stored in the system. After saving the data, you can click Load to harvest initial data for your new source.

**Procedure: How to Update a Loadable Source**

To update a loadable source:

1. From the Manage tab, click the Sources panel button.
2. Select the source you want to update. The Edit Source panel opens.
3. Make the desired changes. You can rename the datapoints, change their field linkages, format, filters, when conditions, or code. You can also revise dimensional linkages and change Advanced properties of the source.

4. Click Save when you are done making edits. PMF will perform the actions on the source and/or save the changes into each datapoint for the source.

**Procedure:** How to Change the File, Table, or View Used for a Loadable Source

If the name of the Master File or other physical connection information used by a loadable source changes, you can adapt those changes into the source in PMF.

1. From the Manage tab, click the Sources panel button.
2. Select the source you want to edit. The Edit Source panel opens.
3. Select the new Master File for the new data source you want to use from the drop-down menu. PMF will automatically clear the fields from the data source, so you can choose the correct new ones from your new source.
4. Click Save to save your changes.

**Working With User-Entered Sources**

User-entered sources in PMF:

- Let you harvest data from groups of your end users. Typically, you define a user-entered source for every single separate and distinct physical group of inputs from which you acquire metric data among your users.

- Allow updating measures on a recalculation schedule. You can also recalculate during normal daytime processing, if you wish.

- Contain one or more user-entered datapoints. A user-entered source is a logical grouping of datapoints that all come from the same subject matter or groups of users.

User-entered sources let you collect data from groups of end users.
These are typically needed when your measure data is not an actual source in an existing data source, but is entered ad hoc.

User-entered sources let you harvest data from these users and operationalize that data in PMF, without requiring any intermediate files, such as flat files or Excel files.

Apps do not need to be built to collect this data. PMF provides an easy-to-use, lightweight, fast, online, spreadsheet-like user interface, with full validation, that can instantly display within the browser of any end user.

**Procedure: How to Create a User-Entered Source**

1. From the Manage tab, click the Sources panel button.
2. Click New.
   
   The New Source panel opens.
3. Name the source, and from the first drop-down menu, select *Collected from Users*. This lets PMF know that the source will harvest data from the user-entered source.
4. Define each user-entered datapoint for this source by entering a name and format for each datapoint. You can quickly enter this information by pressing the Tab key to move from field to field. You can create multiple user-entered sources, and each user-entered source can represent all the datapoints you would collect from a particular user population.
   
   For example, if you are collecting input from HR staff for HR metrics, you could create a user-entered source called HR Input, and in that source, you could define the datapoints to be collected from that group.
For each datapoint you define, you can also define the numeric validation format. The PMF input facility will enforce that data format during collection, as shown in the following image.

![Image of Sales Targets](image)

**Note:** You can save your work and leave the session at any time. If all the steps are not completed, the Source panel will mark this source as incomplete. End users will not be able to enter data until the source is complete, and incomplete components do not participate in recalculation.

5. Click the *Dimension Links* tab and define the dimensionality to be collected for the user-entered datapoint. Select the dimensions and levels to link for each, as shown in the following image.

![Image of Dimension Links](image)

6. Click Save.
7. Click the Enter Data tab to view the data structure or input data, as shown in the following image.

If data entry is already displayed, click the Refresh button to refresh the contents in the Enter Data tab.

In this tab, PMF displays the rows that are ready to receive data from input and allows you to enter data.

- You can sort the contents of the Enter Data tab by clicking the column headings. The arrow next to the heading tells you the direction of the sort.
- You can click on any row or column to highlight it and get a more detailed view.
- You can resize the columns by dragging its borders in the headings.

Click the small Save button within the Data Entry tab to save the data you entered into the individual datapoints on the Data Entry tab.

**Note:**

- If you leave any open boxes blank, PMF will not create an intersection for them. That intersection will be treated as a NULL, for example, MISSING.
- Zeros entered will be treated as entered data, and an intersection will be created.
- If you blank out an entered number, its intersection will be deleted when you click Save.

**Reference:** **Lineage and Recalculation With User-Entered Sources**

User-entered data differs from standard loaded data in the following ways:

- It is dependent on users supplying their data. If users fail to supply their data, no data will be available for the datapoints, or downstream, to be used in any calculations for derived datapoints, or for copying into measures.
The timing of the data entry is unpredictable. It is therefore difficult to predict when the automatic population of the data should be done.

As a result, you need to schedule recalculation more frequently.

**Note:** User-entered data is treated as updated on the date of entry, and the downstream datapoints and measure copies are treated as loaded on the day they were scheduled to update.

### Updating User-Entered Sources

You can update user-entered sources at any time. PMF adjusts existing user-entered data for the datapoints in a user-entered source as follows:

- Changing the name for any datapoint causes the datapoint to be renamed, with no side effects.
- Adding new datapoints causes them to be added to the source, and to take on the dimensional linkages already configured for that source.
- Changing the format for any datapoint has no effect on the underlying data, because PMF stores all numbers internally in floating-point format. If you change the numeric format to remove or shorten the mantissa (for example, changing the format from D12.2 to D12) when the data is re-displayed for entry, PMF will automatically truncate the mantissa when the data is saved. This might have an effect on values shown for measures on various views and charts in PMF.
- Adding dimensional linkages causes PMF to wipe the data. This is because PMF does not know how to reallocate data that has already been entered.
- If the dimensional level is changed to a lower level for any linked dimension, it causes PMF to wipe the user-entered data for the datapoints. This is because PMF does not know how to reallocate the rolled-up data. The individual dimension-linked values will be lost.
- If the dimensional level is changed to a higher level, PMF attempts to roll the data up. Once the rollup is completed, changing the level back to a lower one will cause PMF to wipe the data, for the same reason as above.
Working With Generated Sources

In this section:
Promoting a Generated Source

How to:
Create a Generated Source
Update a Generated Source

Reference:
Lineage and Recalculation With Generated Sources
Previewing Generated Data

Generated sources in PMF enable you to:

- Indicate to PMF the maximum and minimum values to generate for each datapoint in the source.
- Specify which dimensional intersections should contain the generated data.
- Use different sampling methods to generate data.

Generated sources enable PMF to automatically create sample data for your models. They should be used in the following situations:

- When you need to demonstrate metrics in dashboards, but only have a rough idea what the data should look like.
- When a sponsor can give you more specific guidelines as to the data they want to see, but you do not want to spend time modeling the data in a tool.
- When you are creating a new metrics model, and want to spend your time on it, rather than on the data.

Note: Data that is generated should not be treated as real performance data. PMF cannot distinguish between generated and performance data, so use generated sources only for non-production work.

Procedure: How to Create a Generated Source

1. From the Manage tab, click the Sources panel button.
2. Click New.
   The New Source panel opens.
3. Name the source, and from the first drop-down menu, select *Generated (sample data)*. This indicates to PMF that the source will be generated automatically.

4. Define each datapoint that you want to create. As you enter each datapoint, PMF will set default rules to be used between the generated source and datapoint. You can quickly enter this information by pressing the Tab key to move from field to field.

If you choose to specify the rules that PMF should use to generate data, the following options are available:

**Decimal Format**

Specifies the decimal format of the data generated:

- The first character can be D (Decimal) or I (Integer).
- The next characters are numbers to specify the total length of the field.
- You can indicate a period and number of digits of decimal precision.

Examples of typical decimal formats are: D12.2, I8, D20.6, and I32.

**Method**

Controls how PMF will calculate the sample values:

- **Normal (Bell Curve) Distribution.** PMF generates a range of values that favors the center of the numeric range you type for Lower/Upper Bounds.
- **Uniform Random Distribution.** PMF generates an even distribution of values that favors no point in the numeric range.

**Lower/Upper Bounds**

The lowest and highest number for the range of possible values PMF will generate. The numbers will be formatted using the mask you entered in the Decimal Format field.

**Note:** You can save your work and leave the session at any time. If minimum necessary entries are not set up to generate data, PMF will mark the generated source as Incomplete. Incomplete sources and their datapoints do not participate in recalculation. You need to complete the source to allow its datapoints to participate, or you will not be able to get the data published using measures.

5. Click the *Dimension Links* tab and define the dimensions and levels for which PMF will generate data. This will affect some options in the Rules tab, so perform this step next if you know the dimensions you want to use for generating, as shown in the following image.
**Note:** If you are setting up a trained generated source, you do not have to specify dimension links because they will be inherited from the source.

The following option is available:

**Data Sparsity**

Controls the amount of data PMF generates by letting you focus the data on dimensional choices:

- **None.** Generates a Cartesian cross-product of all possible dimension values.
- **Dimensional Filters.** You can specify filters for the dimension levels for the generated datapoint. To specify the filters, select this option and use the drop-down menus.
- **Train.** You can base the dimension level values along which PMF generates data on another datapoint. This lets you keep a limited amount of data together. You can specify any datapoint to train from a loadable datapoint, user-entered datapoint, derived datapoint, or another generated datapoint.

6. Click Save.

**Procedure: How to Update a Generated Source**

To update a generated source:

1. From the Manage tab, click the Sources panel button.
2. Select the source you want to update. The Edit Source panel opens.

3. Make the desired changes. You can rename or delete datapoints, change the generation method or values for any datapoint, or delete the entire generated source.

   **Note:**
   - Datapoints are included in formulas and linked to measures by reference. Renaming them will percolate through the entire system.
   - Altering the generation method formula or the range values for a generated source automatically flags its data, and any later generations in the lineage for that Generated Source (including child derived datapoints and measure values) for a one-time wipe. If the data is also scheduled for reload, PMF performs that load after wiping the data.

4. Click Save when you are done making edits. PMF will perform the actions on the source and/or save the changes into each datapoint for the source.

**Reference:** Lineage and Recalculation With Generated Sources

Generated sources are primary sources for data in PMF. As such, PMF treat these source types as first generation in any lineage, along with loadable and user-entered datapoints.

**Promoting a Generated Source**

Generated sources are used when you lack real data to prove that your model works, or they are needed for a demonstration. Once you are ready to use a working model with real data, generated sources are no longer necessary to feed your metrics.

To promote the generated source:

- Add it as a loadable source so that its data can be harvested from an existing file, table, or view.
- Add it to a user-entered source, so that the data can be collected from end users.
**Reference:** Previewing Generated Data

You can preview the data that PMF will generate by clicking the *Preview* tab, as shown in the following image.

The Preview tab generally shows rows that are new, or will be updated or deleted.

**Tips:**

- The Preview tab shows data to be handled before any operations occur. It divides this data up into the following sections, based on what will happen to the rows that are displayed:

  - New rows to be created by generation.
  - Rows to be updated by generation.
  - Rows to be deleted by generation (depending on the Wipe Data setting on the Advanced tab).
  - Rows that will be kept, but whose values do not match the new data to be generated (depending on the Wipe Data setting on the Advanced tab).

- Opening the Preview tab will force the navigation bar to close, in order to use as much screen width as possible. You can reopen it by clicking the expand button at the top of the navigation bar.

- You can resort the preview contents in any order by clicking the column headings. Note that the Preview will show data based on the display limit set in the Load settings. To change this value, see *Load Settings* on page 497.
Load Now Panel

**How to:**
Perform a Load Now Operation

The Load Now panel lets you automatically refresh the entire PMF cube from Source data. It runs the following:

- All loads for any Harvested Dimensions
- All Source loads for any Harvested Sources.
- A complete data regeneration cycle for any Generated Sources
- If the Recalculate and Load all option is set on Sources (and this is the default for any Source), each Source reload automatically pushes all data through the lineage to any Derived Datapoints, and copies the calculated data to each Metric in the system.

**Note:** If any Dimensions or Sources are incomplete, the Load Now operation will fail. But this is one way to quickly show you what Dimensions, Sources, Derived Datapoints, or Metrics you still need to complete.

**Procedure:** How to Perform a Load Now Operation

To perform a Load Now operation:

1. From the Manage tab, click the *Data Mart* subtab.
2. Click the *Load Now* panel button. The Load Now panel opens.
3. Click the *Load Now* button.

   A confirmation dialog box opens, as shown in the following image.

   ![Confirmation Dialog Box](image.png)
4. Click Load Now. PMF performs the operation and displays a status log, as shown in the following image.

![Status Log Image]

**Note:** The log is based on polling the status of the Load Now operation over time. If a load operation takes a long time, multiple rows with the same information might be shown in the status log.

### What Are Datapoints?

**In this section:**
- Derived Datapoints
- Loadable Datapoints
- Generated Datapoints
- User Entered Datapoints

**How to:**
- Edit Loadable, Generated, or User Entered Datapoints

A datapoint is similar to a field in a table, but with built-in dimensional linkages. It also has linkages back to sources and forward to measures, which provide a clear lineage from harvest point to presentation.

There are four different types of datapoints in PMF:
What Are Datapoints?

- **Derived datapoint.** A datapoint based on a calculation that uses data from other datapoints and is usually free-standing.

- **Loadable datapoint.** A datapoint that comes from a loadable data source and typically belongs to a loadable source.

- **Generated datapoint.** A datapoint based on data that is generated by an algorithm, and represents sample or demonstration data. This type of datapoint is free-standing.

- **User-entered datapoint.** A datapoint based on data entered by end users and typically belongs to a user-entered source.

**Procedure:** How to Edit Loadable, Generated, or User Entered Datapoints

**Note:** Most of the information for Loadable, Generated, or User-Entered datapoints are read-only. The only thing you can change about them is their name or description.

1. In the Manage tab, click the **Datapoints** panel button.

2. Expand the **Loaded Datapoints**, **Generated Datapoints**, or **User Entered Datapoints** folder and select the datapoint you want to view.

   The Edit Datapoint panel opens.

3. Edit the Name or Description of the loadable datapoint.

4. Click Save.
Derived Datapoints

In this section:
Creating Calculated Measures With Derived Datapoints

How to:
Create a Derived Datapoint
Change Datapoints
Copy Derived Datapoints
Wipe Derived Datapoint Data

Reference:
Previewing Derived Datapoints
Lineage and Recalculation With Derived Datapoints
Derived Datapoint Lineage Tab
Derived Datapoint Load History

Derived datapoints let you create calculations that include dimensional metadata. For example, you can create a series of derived datapoints that perform a series of calculations on Sales performance for your manufacturing company:

- Cost of Supply (by Product, Location and Time)
- Cost of Labor (by Product, Location and Time)
- Cost of Warehousing/Storage (by Product, Location and Time)
- Cost to Ship (by Product, Location and Time)

These datapoints can now be added up to become Total Cost (by Product, Location and Time).

You can then set Total Cost against your Sales (by Product, Location and Time) to calculate Profit.

You can also load precalculated Total Costs and Profit datapoints from an external Source, but there is no guarantee the data will be calculated in the proper order. If you use derived datapoints to calculate the values:

- The data will be calculated in the correct order, by using the generations in the datapoint lineage. PMF will also recognize incomplete data and handle it accordingly.
What Are Datapoints?

- You will be able to deconstruct the calculations performed for all derived datapoints using Lineage Chains.
  
  Lineage Chains are currently available in the Lineage tabs on dimensions, sources, datapoints, and measures panels.

- Derived datapoints allow deep models of recalculation, that let many measures share the same common root calculated values.

- Derived datapoints let you mix and match any data source in one contiguous data mart, and are much easier to set up than ETL jobs. This is because dimensional aggregation logic is included in the calculations, so you do not have to write complex dimensional logic in an ETL tool.

**Procedure: How to Create a Derived Datapoint**

To create a derived datapoint:

1. In the Manage tab, click the *Datapoints* panel button.
2. Click *New*.
   
   The New Datapoint panel opens.
3. Name the new derived datapoint.
4. Drag the datapoints you need for your calculation into the canvas. Each datapoint must be separated by its operation, as shown in the following image.
Calculations can also include constants. To add a constant, drag the Constant object into position on the canvas, and type in the constant value inside the Constant object.

Separate datapoints for WebFOCUS functions are typically created during the source load, since capturing these calculations is done best in the first-generation in the lineage, during harvesting.

For example, if you want to capture counts of a particular condition, rather than trying to save all those attributes somewhere so you can perform the filtering later, you can determine When, that is what filters should be true, for the count. You can then pull that count into a loadable datapoint. Approaching data this way allows you to make calculations in the lineage after this harvesting phase simpler for you to manage.

5. Click Save. If the calculation is not complete, PMF recognizes this, and marks the derived datapoint as Incomplete. Incomplete derived datapoints do not participate in recalculation.

**Procedure: How to Change Datapoints**

To change a derived datapoint:

1. In the Manage tab, click the Datapoints panel button.
2. Select the derived datapoint you want to change. The Edit Datapoint panel opens.
3. Make your desired edits. You can change anything in a derived datapoint, including the name and its formula.

**Note:**

- Datapoints are included in formulas and linked to measures by reference, so renaming them changes their name through the entire system.
- Altering the formula for a derived datapoint automatically flags its data, and any later generations in the lineage for that datapoint, including child derived datapoints and measure values, for a one-time wipe. If the data is also scheduled for reload, PMF performs that load after wiping the data.

**Procedure: How to Copy Derived Datapoints**

You can make an exact copy of any existing derived datapoint. After making the copy, you can immediately alter it as needed. To copy a datapoint:

1. From the Manage tab, click the Datapoints panel button.
2. Select the derived datapoint you want to copy. The Edit Datapoint panel opens.
3. Click Save As. You will be prompted for a new name for the derived datapoint, as shown in the following image.

![Save As dialog box]

4. Click Save. PMF will make an exact copy of the derived datapoint. You can edit and save your changes at any time, and click Save As again if you want to make more copies. This datapoint is what will be loaded for editing.

**Procedure: How to Wipe Derived Datapoint Data**

All loaded data from a derived datapoint can be wiped out or deleted in a single operation, because they are not attached to a source.

**Note:** Wiping data affects downstream datapoints for the datapoint you wipe. Every datapoint downstream is marked as having incomplete components. Incomplete components do not participate in recalculation.

1. From the Manage tab, click the Datapoints panel button.
2. Select the datapoint that needs to be deleted. The Edit Datapoint panel opens.
3. Click the Wipe Data button. PMF will ask you to confirm the data purge.
4. Click OK.

**Note:** It may take PMF a moment to purge all of the data.

**Creating Calculated Measures With Derived Datapoints**

PMF allows you to create an unlimited number of calculations for your measures using special datapoints that store and process calculations, known as derived datapoints. These calculations can be based on one or more existing datapoints, of any kind, including loadable, user-entered, generated, and other derived datapoints. Note the following:

- If you create a derived datapoint that uses data from loadable, user-entered, or generated datapoints, PMF will recalculate the results every time the data for these are changed. The data goes through the lineage, through all of your steps of calculation, until it is copied to any measures linked to your datapoints.
If you create a derived datapoint that uses data from another derived datapoint, PMF knows that the “parent” derived datapoint must be calculated before calculating your new derived datapoint. Logic built into PMF understands that calculations must use generations in the datapoint lineage.

Recalculating a complex lineage chain through possibly hundreds of thousands or millions of row values can be an expensive operation, so you have full control over how much of this calculation is performed during normal processing hours.

**Note:** During scheduled load cycles, since PMF is less used during scheduled load times (usually overnight), recalculation can always go through the entire lineage.

**Reference: Previewing Derived Datapoints**

You can preview the data that PMF will generate by clicking the Preview tab, as shown in the following image.

The Preview tab generally shows rows that are new, or will be updated or deleted.

**Tips:**

- The Preview tab shows data to be handled before any operations occur. It divides this data up into the following sections, based on what will happen to the rows that are displayed:
  - New rows to be created by generation.
  - Rows to be updated by generation.
What Are Datapoints?

- Rows to be deleted by generation (depending on the Wipe Data setting on the Advanced tab).
- Rows that will be kept but whose values do not match the new data to be generated (depending on the Wipe Data setting on the Advanced tab).
- Opening the Preview tab will force the navigation bar to close, in order to use as much screen width as possible. You can reopen it by clicking the expand button at the top of the navigation bar.
- You can resort the preview contents in any order by clicking the column headings. Note that the Preview will show data based on the display limit set in the Load settings. To change this value, see Load Settings on page 497.

Reference: **Lineage and Recalculation With Derived Datapoints**

Derived datapoints can have a complex, multi-part lineage, depending on their relationship to other derived datapoints.

- In the lineage directionality of derived datapoints, the data in derived datapoints always progresses to the left, from first-generation datapoints (loadable, user-entered, and generated) toward measures.
- PMF automatically handles figuring out the generation of each derived datapoint in the lineage, by analyzing the first point in the lineage where a derived datapoint sends its data onward.
Derived Datapoint Lineage Tab

You can view lineage for all datapoints for any derived datapoint. Lineage shows the progress of data through PMF, from the external data harvested into datapoints, through any derived datapoints, and finally all terminal points in Measures. The Lineage tab displays the components in the generated source by default, as shown in the following image.

The lineage tab automatically displays the entire lineage. You can click the **Collapse All** button to hide the entire lineage.

Derived Datapoint Load History

PMF keeps track of each load that is executed for each derived datapoint in the system, regardless of whether you loaded it manually or the load was called by the scheduler. This data is stored in a special logging section of the PMF data mart.

The History tab on each derived datapoint displays the history of all loads that have been logged.

The history of the derived datapoint shows:

- The dates that the loads ran.
- The count of rows that were retrieved, inserted, updated, and deleted.
- The count of total mismatches that occurred between the source data and the PMF metrics mart. Mismatches are source data rows that do not match to any existing keys for one or more dimensions.
The count of gaps in data continuity, which indicate the sparsity of the data. This does not mean there are errors but, if paired with mismatches, can help you debug any unexpected data discontinuities.

Any messages returned from the load system. If there is an error, the exact error is displayed in the information shown in this tab.

**Loadable Datapoints**

Loadable Sources manage Loadable datapoints. You can drill into any datapoint on a Loadable Source to view the specifics about the datapoint, or you can access Loadable datapoints from the separate panel button for them.

**Generated Datapoints**

*In this section:*
- Promoting a Generated Datapoint

*How to:*
- Create a Generated Datapoint

*Reference:*
- Lineage and Recalculation With Generated Datapoints

Generated datapoints enable PMF to create sample data for your models. With generated datapoints, you can:

- Tell PMF the maximum and minimum values to generate.
- Specify which dimensional intersections should contain the generated data.
- Use different sampling methods to generate the data.

Generated datapoints are designed for the following situations:

- When you need to demonstrate metrics in dashboards, but have nothing but a rough idea what the data should look like.
- When a sponsor can give you more specific guidelines as to the data they want to see, but you do not want to spend hours modeling the data in a tool.
- When you are creating a new metrics model, and want to spend your time on it, rather than on the data.
**Important:** Generated data should never be treated as real performance data. PMF 5.3.2 does not yet mark generated data as “unreal,” so use generated datapoints only for non-production work.

**Procedure: How to Create a Generated Datapoint**

To create a generated datapoint:

1. In the Manage tab, click the Datapoints panel button.
2. Click New.
   
   The New Datapoint panel opens.
3. Select Generated from the first drop-down menu.
4. Name the new datapoint.
5. Click the Dimensions tab and specify the dimensions and levels for which PMF will generate data, as shown in the following image.

   ![Generated Datapoint Panel](image)

   Setting dimensions affects some options on the Rules tab, so if you know the dimensions you want to use for generating, set them first.

6. Click the Rules tab and specify the rules PMF should use to generate data. The following options are available:

   **Decimal Format**

   Specifies the decimal format of the data generated:

   - The first character can be D (Decimal) or I (Integer).
   - The next characters are numbers to specify the total length of the field.
You can indicate a period and number of digits of decimal precision. Examples of typical decimal formats are: D12.2, I8, D20.6 and, I32.

**Method**

Controls how PMF will calculate the sample values:

- **Normal (Bell Curve) Distribution.** PMF generates a range of values that favors the center of the numeric range you type in under Lower/Upper Bounds.

- **Uniform Random Distribution.** PMF generates an even distribution of values that favors no point in the numeric range.

**Lower/Upper Bounds**

The lowest and highest number for the range of possible values PMF will generate. The numbers will be formatted using the mask you entered in the Decimal Format field.

**Data Sparsity**

Controls the amount of data PMF generates by letting you focus the data on dimensional choices:

- **None.** Generates a Cartesian cross-product of all possible dimension values.

- **Dimensional Filters.** You can specify filters for the dimension levels for the generated datapoint. To specify the filters, select this option and use the drop-down menus, as shown in the following image.

- **Train.** You can base the dimension level values along which PMF generates data on another datapoint. This lets you keep a limited amount of data together.
You can specify any datapoint to train from a loadable datapoint, user-entered datapoint, derived datapoint, or another generated datapoint.

**Recalculate all Derived Datapoints**

This option should remain enabled, unless you have a very large data mart and want to reserve recalculation for overnight or other offline processing.

**Note:** This option enabled by default. To disable it, see *Load Settings* on page 497.

**Description**

A description of the datapoint.

7. Click Save. If minimum necessary entries are not set up to generate data, PMF will mark the generated datapoint as incomplete. Incomplete components do not participate in recalculation.

**Tips:**

- When generating random data for generated datapoints, PMF will wipe all existing data before regenerating it using your new rules. Generally, with generated datapoints, the Preview tab is useful for new data you are planning to generate into an empty datapoint, or when changing rules. If your rules have not changed, and data is showing up on Preview as 100% added and deleted, you should not regenerate data.

- If you are modeling a new metrics system without having any real data to work from, you will have no data loaded at all into PMF to train from. In this situation, set the Dimensional Filters option on your first generated datapoint, specify the dimensions, and have PMF generate the data. You can then train loading all of your generated datapoints to load based on that one datapoint.

**Reference:** *Lineage and Recalculation With Generated Datapoints*

Generated Datapoints are primary sources for data in PMF. They are treated as first generation in any lineage, along with loadable datapoints and user-entered datapoints.

**Promoting a Generated Datapoint**

Generated datapoints are used when you lack real data to prove that your model works, or they are needed for a demonstration. Once you are ready to use a working model with real data, generated datapoints are no longer necessary to feed your metrics.

To promote the generated datapoint:

- Add it to a loadable source so that its data can be harvested from an existing file, table, or view.

- Add it to a user-entered source, so that the data can be collected from end users.
User Entered Datapoints

In this section:
Lineage and Recalculation with User-Entered Datapoints

A user entered datapoint is based on data entered by the end user and typically belongs to a user entered source.

To create a user entered datapoint, you must first create a user entered source. For more information, see How to Create a User-Entered Source on page 315.

Lineage and Recalculation with User-Entered Datapoints

User-Entered data differs from standard loaded data in the following ways:

- It is dependent on users taking the time to type in their data. If users fail to type in their data, no data will be available for the Datapoints, or downstream to be used in any calculations for Derived Datapoints, or for copying into Measures.

- It comes in at all times of the day, making it difficult to predict when automatic population of the data should be done. As a result, recalculations need to be scheduled more frequently.

Note: User Entered data is treated as updated on the date of entry, and the downstream Datapoints and Measure copies are treated as loaded on the day they were scheduled to update.

Scheduling Loads and Updates

How to:
Schedule Source Loads

PMF allows scheduling loads. Recalculation is performed automatically when data from sources has changed. The recalculation can be made to run during the daytime, whenever you choose, or nightly, on schedule.

Typically, you would schedule only the following:

- Dimension loads and refreshes
- Source loads and refreshes

PMF populates the model. Scheduling no longer requires you to schedule individual measure loads. You need to only schedule source loads, and PMF automatically does the rest.
**Procedure: How to Schedule Source Loads**

To schedule a source load:

1. In the Manage tab, click the Sources panel button.
2. Select the source you want to schedule.
3. Click Schedule.

   The New Schedule panel opens, as shown in the following image.

4. Specify when the schedule should run.
5. Click Save.

**Setting Measure Access for Users (Owners)**

**How to:**

Set Measure Access by Owner
Set Measure Access by Access Role

You can use PMF to select the level of access for each dimension that users are allowed to see their measures.
For each user, you can set up measure access by:

- **Owner.** For individual users who need to have their own customized level of access to measures.

- **Access Role.** For multiple users who require the same level of access to measures. If you have a group of users that perform the same job functions, assigning each to the same access role reduces the time it takes to manage measure access.

You can use either of the two access methods listed above, but these methods are mutually exclusive, so you cannot use both.

**Note:** To set measure access for a specific owner or access role, make sure Row Level Security is enabled (set to Y) in the Edit System Settings panel, which you can access by clicking the **Settings** panel button in the Manage tab. If Row Level Security is not enabled, you cannot set measure access.

**Procedure:** How to Set Measure Access by Owner

To set measure access levels for a specific owner only:

1. In the Manage tab, click the **Owners** panel button and select the desired owner.

   The Edit Owner panel opens. For details, see General Tab - Owners on page 483.

2. Select **User Basis** from the Access Security By drop-down menu, as shown in the following image.
3. Click the Configure Owner Access button. The Edit Access Role panel opens.

4. Using the drop-down menus for each dimension, select the measure level at which you want to limit access for the owner.

   For each level you select, the owner will only be able to view measures at or below that level. If the owner should be allowed to view all measure data for a particular dimension, then select All in the drop-down menu for that dimension.

5. Click Save when you are finished selecting measure access for the owner.

**Procedure: How to Set Measure Access by Access Role**

To assign the level of measure access already set for an existing access role:

1. In the Manage tab, click the Owners panel button and select the desired owner. The Edit Owner panel opens. For details, see General Tab - Owners on page 483.

2. Select Role Basis from the Access Security By drop-down menu.

3. Select an access role to link to this owner from the Access Role drop-down menu.

   The owner is automatically assigned the level of measure access already set for the selected Access Role. For more information about access roles, see Working With Access Roles on page 289.

4. Click Save when you are finished assigning an access role to the owner.

**Specifying Dimensions and Measures**

PMF is primarily designed as a way to measure how organizations are doing against their stated strategy. Strategy means many things in the real world, but when it applies to creating scorecards, it specifically refers to the definition of objectives and the description of how they are linked together.
You can determine how an organization is doing against an objective by setting targets for measures and then grading those measures.

As an administrator, you work closely with scorecard authors to set up the scorecard logic and load measures as defined and approved by the strategy committee in your enterprise.

You can always change anything you set up or load into PMF at a later date. Business processes normally change over time, so you will need to change PMF to reflect external changes.

The sections in this topic describe a methodology to ensure that dimensions and measures support the objectives.

**PMF Objectives**

When you create objectives, remember to make them SMART:

- **S** = Specific
- **M** = Measurable
- **A** = Achievable
- **R** = Results Oriented
- **T** = Time Based

The following table lists and describes in greater detail the principles to follow when creating objectives in PMF.

<table>
<thead>
<tr>
<th>Principle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S = Specific</td>
<td>Objective must be specific and cannot be vague. An example of a bad objective would be <em>Do Better</em> whereas a good objective is <em>Improve Sales</em>. However, you need to define what <em>Sales</em> means.</td>
</tr>
<tr>
<td>M = Measurable</td>
<td>Objective must be measurable. If your objective is to improve sales and there are multiple sales components, such as Sales-Dollars and Sales-Margins, then this objective can be split into two objectives, such as <em>Improve Sales Dollars</em> and <em>Improve Sales Margins</em>.</td>
</tr>
<tr>
<td>A = Achievable</td>
<td>Objective must be controllable. An example of a bad objective is <em>Reduce Loading Dock Time</em> when there is no capture of such time. There must always be data to support the objective. On a personnel performance review, a bad objective would ask the staff to achieve a goal that is not under their control.</td>
</tr>
<tr>
<td>Principle</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>R = Results Oriented</td>
<td>Objective must indicate actions to achieve a goal. In the sales example, consider Improve Sales Margins for Q2 2006 over Q2 2005. This clearly states that there are results that are measurable at the end of the two quarters for comparison.</td>
</tr>
<tr>
<td>T = Time Based</td>
<td>Objective must be time-based. In the sales example, consider Improve Sales Margins for Q2 2006 over Q2 2005 by end of Q2.</td>
</tr>
</tbody>
</table>

By following the SMART principle when working through the statement of an objective, there will be clear objectives. If any of the components are not clearly formalized in the objective, then finding the measures will not be clear.

**PMF Measures**

Measures (or metrics) are the data component of a scorecard. Each measure should clearly belong to at least one objective and you should be able to answer the following questions for each measure:

- How is the measure calculated? Are you already measuring data for this measure?
- Is the data for the measure available? Is the data regularly updated?
- Where are the data files for the measure located, and do you have access to them?

**PMF Dimensions**

**How to:**

Create a New Dimension
Edit a Dimension
Preview a Dimension Load
Rename a Dimension
Delete a Dimension

PMF supports 16 user-configurable dimensions that can go to 16 levels deep, so you can describe complex multi-dimensional structures. There is only one default dimension in PMF, the Time dimension, and multiple Time dimensions are supported.
The following steps are helpful for analyzing your dimensions:

- Ask users to describe how they understand their organization structure. This may relate to their customers, locations, and products.

- Speak to more than one business representative to understand the view of the business. It is important to speak with personnel who know the business.

- Speak with Information Technology (IT) personnel and Database Administrators (DBAs).

- The default Time dimension is built in the data load process by specifying the start and end year values, where the end year is one year ahead of the current year.

- You can create and use an Organization dimension to control data security access across the organization. PMF enables you to filter measures data by specifying for users, or groups of users, the level of data access depending on dimensional values.

- If you create a Customer dimension (which is recommended), consider the following example for a vendor who deals with many clients. Level 1 is the organization or business name and level 2 is the contact name at the customer site.

- Understand how the business is divided geographically.

  Consider a high level break-down of region where there are four regions in the USA and two regions in Canada. From the standpoint of collecting data, decide whether you keep the data in six regions, or two countries with regions as the next level.

- Levels in dimensions must make sense. In a geographical example in the United States, putting State below City is incorrect.

- Consider systems where there are input capable fields for text entries such as states and provinces. These are highly prone to error and it is better to define a set of accepted names for these states and provinces rather than build a list of names from data that could have many inconsistent spellings.

- For fields that have a large number of possible values, but the data only uses a subset, consider populating that dimension with the content of the data.

- Ensure that the dimensions are available. Either they are in an existing data file or they must be input into a flat file or spreadsheet for loading.

At the end of dimension gathering, an agreement must be reached on the types of dimensions, their levels, and the contents at each level. No loading of dimensions should occur prior to the sign-off of the agreement.
**Procedure: How to Create a New Dimension**

The following procedure outlines the steps required when creating a new dimension. For information about editing an existing dimension, see *How to Design a Simple Dimension Load* on page 354.

1. In the Manage tab, click the *Dimensions* panel button.

2. Click *New*.

   The New Dimension panel opens.

   **Note:** You can also click *New* in the Edit Dimension panel to create a new dimension.

3. Enter a name for the dimension in the field box.

4. From the drop-down menu, select one of the following options:
   - *Harvested from Data*. Choose this option to immediately start creating a structure from a preexisting data source.
   - *Collected from Users*. Choose this option if you want to create a structure yourself.

5. Do one of the following:
   - If you chose *Harvested from Data*, enter a *Level Name* and set its properties. As you enter information for each line, a new one opens, as shown in the following image.
If you chose *Entered by Users*, start by creating a structure in the Hierarchy & Data tab by entering Level names, as shown in the following image.

![Image of Hierarchy & Data tab](image)

Click **Save**.

Click the *Edit Dimension Values* tab to set dimension properties for the Levels that were created.

6. Click **Save**.

**Procedure: How to Edit a Dimension**

1. In the Manage tab, click the *Dimensions* panel button.
2. Click the dimension you want to edit in the tree.
   
The Edit Dimension panel opens.
3. Using the drop-down lists for each dimension, make your desired changes and click **Save**.
   
   **Note:** To change the order of the dimension levels, place the mouse over the dimension you wish to move and use the ⬆️ icon to drag the dimension up or down.

**Procedure: How to Preview a Dimension Load**

1. In the Manage tab, click the *Dimensions* panel button.
2. Click the dimension you want to edit in the tree.
   
The Edit Dimension panel opens.
3. Click the Preview tab. The Dimension Load information opens, as shown in the following image.

To refresh the Preview contents, click the Refresh icon that is shown on the Preview tab.

**Procedure: How to Rename a Dimension**

1. In the Manage tab, click the Dimensions panel button.
2. Click the dimension you want to rename in the tree.
   
   The Edit Dimension panel opens.
3. Click the dimension name at the top of the panel tab. The field becomes editable.
4. Enter the new dimension name and click Save. The dimension is automatically renamed throughout PMF.

**Procedure: How to Delete a Dimension**

1. In the Manage tab, click the Dimensions panel button.
2. Click the dimension you want to delete in the tree.
   
   The Edit Dimension panel opens.
3. Click Delete.
A delete confirmation dialog box opens, as shown in the following image.

![Delete Confirmation Dialog](image)

4. Click OK.

When a dimension is deleted, all measures that were linked to it have their dimensional linkage deleted. The measure records are automatically re-summarized, and any orphaned extra records are automatically cleaned up.

**Note:** Re-summarization is a one-time change and cannot be reversed. Once you perform a re-summarization, measure values are now permanently changed. It is strongly recommended that you take a snapshot of your PMF data mart before making this change.

**Reference:** Dimensions Load History

PMF keeps track of each load that is executed for each dimension in the system, regardless of whether you loaded it manually or the load was called by the scheduler. This data is stored in a special logging section of the PMF data mart.

The History tab on each dimension displays the history of all loads that have been logged.

The history of the dimension shows:

- The dates that the loads ran.
- The count of rows that were retrieved, inserted, updated, and deleted.
- The count of total mismatches that occurred between the source data and the PMF metrics mart. Mismatches are source data rows that do not match to any existing keys for one or more dimensions.
- The count of gaps in data continuity, which indicate the sparsity of the data. This does not mean there are errors but, if paired with mismatches, can help you debug any unexpected data discontinuities.
- Any messages returned from the load system. If there is an error, the exact error is displayed in the information shown in this tab.
Creating Units of Measure Conversion Profiles

How to:
Create a Conversion Profile
Assign a Conversion Profile to an Owner

A conversion profile is a group of settings that recalculates measure actuals and targets from one unit of measure to a related unit of measure. Profiles are typically created for international unit conversion, for example, to convert from pounds to kilograms. Administrators can create conversion profiles to enable users to automatically convert their measures and refresh the values displayed in their dashboards and views.

Note: When creating a new conversion profile, make sure you select units of measure that are related. It would not make sense to convert quantities in a unit of measure like euros to those of a unit of measure like incidents.

Procedure: How to Create a Conversion Profile

1. In the Manage tab, click the Units of Measure panel button.
2. In the Units Conversion folder, click a conversion profile.
   The Edit Units Conversion Profile panel opens.
3. Click New.
The New Units Conversion Profile panel opens, as shown in the following image.

4. Type an appropriate name for the conversion profile in the Profile Name field box.

5. For each existing unit of measure that you want to convert in the new profile, select the desired conversion unit of measure in the Convert to Unit drop-down menu to the right of the existing unit listed in the Unit being Converted column.

6. In the Using Formula input area, enter the conversion formula you want PMF to use to convert each of the existing units to the desired conversion units.

In the conversion formula, you can use an opening and closing square bracket to represent the unit being converted as shown in the image below. This allows you to just type [] instead of the actual unit name. The use of complex formulas including parentheses and multiple operations is also supported.

7. Click Save when you have selected a conversion unit and typed a formula for each of the units being converted.

The new conversion profile will be immediately available for end users.
**Procedure: How to Assign a Conversion Profile to an Owner**

You can enable owners to perform measure conversion by selecting a unit of measure conversion profile in the Edit Owner panel. To set a default conversion profile for an owner:

1. Click the Owners panel button in the Manage tab.
2. Select the owner for whom you want to assign a conversion profile.
   
   The Edit Owner panel opens.
3. In the Units Conversion Class drop-down menu, select an existing conversion profile.
   
   You can also select No Conversion to prevent conversions.
4. Click Save after you make your selection.

**Planning Considerations for Loading Dimensions**

As an administrator, you need to design dimensions that will satisfy the needs of all groups across the organization. You should design dimensions so that you can adapt them in the future as necessary.

In PMF, metrics cascade from higher aggregated levels down through levels of responsibilities. They allow employees at all levels to track their own progress to see how their work integrates with the overall enterprise strategy. As you plan what levels of dimensionality you will need, think of levels of responsibility rather than levels of analysis and sketch those levels out. You should do this before you use the tools to design how dimensions are physically loaded in PMF. For details about sketching dimension levels, see *Designing a Simple Dimension Load* on page 354.

Analyze all measures to load and make sure that your dimension structure accounts for the different ways your users will want to slice and dice the data.

Before you can load dimensions, you must answer the following questions:

- What linkages do you need to perform for the measures to be used? It is probably a good idea to examine all the measures to be loaded before beginning the process of creating and loading dimensions.

- How deep should each dimension be? If it is a Time dimension, are you planning on measuring years, quarters, and months, or do you need more granular atomic data?

- What data sources and tables contain values you might use to determine dimensions?

- Do you need to perform any calculations to create the levels in your dimensions?
Working With a Dimension Load

In this section:

- Designing Dimension Loads
- Designing a Simple Dimension Load
- Setting Dimensional Measure Tolerances
- Setting Dimensional Measure-to-Objective Weighting
- Interpreting the Dimension Loader Report
- Running and Scheduling a Dimension Load
- Setting Up the Month Name Display in a Dimension Load
- Designing a Custom Time Dimension Load

The following topics describe dimension related concepts including designing a simple dimension load, interpreting a Dimension Loader report, and running and scheduling a dimension load.

Designing Dimension Loads

Reference:

Sample Data From Source Tables

The Manage tab provides access to the dimensions loaders. These tools are fully integrated into your Administration view. As you load data, you can immediately test new dimensions and measures you have loaded.

Using the loaders, you can do the following:

- Define external data that is retrieved and transformed in PMF.
- Define transformations for the data and create a central view of data to use when loading measures.
- Add FOCUS code to execute MATCH or HOLD commands.

Data loads control all source data used for analysis and aggregation in PMF. When you design loads, you are designing data loads for each measure in the database, and also for the dimensions used to slice and dice the data.
Reference: Sample Data From Source Tables

In the Dimension Loader and Measure Loader, the Sample Data button enables you to view data from any of your source tables. Viewing source table data is useful for determining which fields to use when designing data loads for your measures and dimensions.

To view sample data, select the desired source table data from the Source Table drop-down menu, then click the Sample Data button.

Sample Data is displayed in a new browser window, as shown in the following image.

Tip: To avoid connection errors when designing a load, you can use the Sample Data button to test the selected data source to make sure it has been set up correctly.
Designing a Simple Dimension Load

How to:
Design a Simple Dimension Load

Reference:
Dimension Loader Options

As you load dimensions, ensure that the metrics in PMF show the correct level of responsibility in the hierarchy. The Dimension Loader tools allow you to quickly map the tables and fields that will serve as the source for the dimensions you will need to load.

The Dimension Loader controls the levels for dimensions used throughout PMF. When you first create a new dimension, determine its logical levels. For example, a Customer dimension might include country, region, state, and city.

The mainstreet_century data mart supplied with PMF uses four typical business dimensions: Location, Organization, Product, and Time. All PMF applications must include a Time dimension.

Important: If you have existing measures, and dimensions are loaded or reloaded, changing this information has a ripple effect throughout the system, so make changes carefully. If you change the intended value member or number of levels in any dimension, you will probably need to reload all data for that dimension, as well as reload all measures.

Procedure: How to Design a Simple Dimension Load

Note: If your procedures and metadata are not located in the Mainstreet application, make sure you have added the WebFOCUS application containing them to the WebFOCUS Reporting Server APP PATH setting before you attempt a load operation. You can do this using the Web Console.

The following procedure outlines the steps required when designing a simple dimension load. For information about designing a complex dimension load when customizing the Time dimension, see Designing a Custom Time Dimension Load on page 365.

1. In the Manage tab, click the Dimensions panel button.

2. Click a dimension, for example, Organization.
The Edit Dimension panel opens, as shown in the following image.

![Edit Dimension Panel](image)

**Note:** The Dimension Loader automatically loads and displays the levels defined for the metadata and checks the dimension to make sure it is correctly set up. If anything is wrong, the Load status list displays the error.

3. From the first drop-down menu, select one of the following options:
   - *Harvested from Data.* Choose this option to immediately start creating a structure from a preexisting data source.
   - *Collected from Users.* Choose this option if you want to create a structure yourself.

4. From the second drop-down menu, select a source table or Master File for the dimension.

5. In the Level Name field, type a dimension level name for each dimension you add.
   **Note:** To change the order of the dimension levels, place the mouse over the dimension you wish to move and use the icon to drag the dimension up or down.

6. From the drop-down menu, select *Top, Field, or Define.*
   **Note:** This field is only available if you have selected the *Harvested from Data* option from the first drop-down menu.

7. Do one of the following:
   - If you selected *Top* from the drop-down menu, in the Field box, type the name you want to display as the top-level dimension value (for example, Company-wide or All). You will most likely want to add a new level above all existing levels before using the Top option.
   - If you selected *Define* from the drop-down menu, type the code in the Field box. Code can span multiple lines, and this field can only display one line of code at a time.
To view, and optionally edit, multiple lines of code displayed at the top of the Dimension Loader, click the *Edit* button. Click the *OK* button to save any changes, otherwise click the *Cancel* button.

- If you selected *Field* from the drop-down menu, select a field from the Field drop-down menu.

**Note:** Whenever you make any changes in the Dimension Loader, the changes will not be effective until you save the changes and load the dimension and any associated measures.

**Reference: Dimension Loader Options**

When you design a dimension load, the following options are available in the Dimension Loader.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>This button opens a new Dimension loader.</td>
</tr>
<tr>
<td>Save</td>
<td>This button saves metadata information for this dimension. You must save any changes you make before you can perform a dimension load.</td>
</tr>
<tr>
<td>Load</td>
<td>This button performs the dimension load. Use this to load dimensions after you add new or edit existing information in the Dimension Loader.</td>
</tr>
<tr>
<td>Delete</td>
<td>This button deletes the selected dimension.</td>
</tr>
<tr>
<td>Schedule</td>
<td>This button opens the Dimension Load Schedule panel where you can schedule a one-time or recurring dimension load. For more information, see <em>Running and Scheduling a Dimension Load</em> on page 360.</td>
</tr>
<tr>
<td>Sample Data</td>
<td>This button displays a report in a new browser window, showing sample data for the source table you selected in the Source Table drop-down menu. For more information, see <em>Sample Data From Source Tables</em> on page 353.</td>
</tr>
</tbody>
</table>

**Advanced Tab**

<p>| Description | This button opens a field box in which you can type a description of the dimension load. Click <em>OK</em> to save the description or <em>Cancel</em> to close the field box without saving your changes. |
| Default Level| Select the dimension level that will be automatically displayed for the dimension. The available options are <em>Region</em>, <em>Plant</em>, and <em>Store</em>. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensional Tolerances (check box)</td>
<td>Selecting this check box activates dimensional tolerances for this dimension. This enables you to select a measure and configure tolerances for each dimension level value.</td>
</tr>
<tr>
<td><strong>Note:</strong> This option will only be available if Dimensional Measure Tolerances in the Tolerances settings is enabled. For more information, see <em>How to Set Dimensional Measure Tolerances</em> on page 358.</td>
<td></td>
</tr>
<tr>
<td>Dimensional Weighting (check box)</td>
<td>Selecting this check box activates dimensional measure-to-objective weighting for this dimension. This enables you to select an objective and configure tolerances for each dimension level value.</td>
</tr>
<tr>
<td><strong>Note:</strong> This option will only be available if Dimensional Measure Weights in the Tolerances settings is enabled. For more information, see <em>How to Set Dimensional Measure-to-Objective Weighting</em> on page 359.</td>
<td></td>
</tr>
<tr>
<td>Distinct Count Aggregation (check box)</td>
<td>Enable this option to allow aggregate measure values with distinct Dimension counts for higher-level aggregation.</td>
</tr>
<tr>
<td>If data changes</td>
<td></td>
</tr>
<tr>
<td>Also use surrogate keys (check box)</td>
<td></td>
</tr>
<tr>
<td>Prefix Code</td>
<td>In the field box type FOCUS or SQL code that will run before the dimension is loaded. Click OK to save the code or Cancel to close the field box without saving your changes.</td>
</tr>
<tr>
<td></td>
<td>If the table you are using is DBA protected, you can type the command SET USER = user_DBA_ password before you select the source table. For example, the sample Century Corp data uses the password WEBFOCUS.</td>
</tr>
</tbody>
</table>

**Preview Tab**
### Setting Dimensional Measure Tolerances

**How to:**

Set Dimensional Measure Tolerances

Dimensional measure tolerances enable you to set different measure tolerances for different dimension levels. Setting dimensional measure tolerances controls how threshold and flex values are applied to percent reached values in measure calculations. This functionality enables you to vary targets and the amount of difference from targets for each level in a dimension. By default, PMF uses global measure tolerance settings unless you have set tolerances for specific measures at specific dimension levels.

**Procedure: How to Set Dimensional Measure Tolerances**

1. In the Manage tab, click the *Dimensions* panel button.
2. Select the desired dimension.
   
   The Edit Dimension panel opens.
3. Select the *Advanced* tab.
4. Select the *Dimensional Tolerances* check box to activate dimensional measure tolerances for this dimension.
5. Click Save.
6. Click the *Measures* panel button (in either the Manage or Author tab).
7. Select the desired measure to set tolerances at different dimension levels.
8. Click the *Tolerances* button to open the Dimensional Tolerances panel.
9. Configure tolerances for each desired dimension level.
10. Click Save.

Setting Dimensional Measure-to-Objective Weighting

How to:
Set Dimensional Measure-to-Objective Weighting

Dimensional measure-to-objective weighting enables you to set different weighting values for different dimension levels. Weighting determines the proportional contribution of measures linked to an objective. This functionality enables you to vary the degree each linked measure contributes to an objective at specific dimension levels. By default, PMF uses global dimensional weight settings unless you have set specific objective weighting at specific dimension levels.

Procedure: How to Set Dimensional Measure-to-Objective Weighting

This functionality is only available for new dimensions created in PMF Release 5.

1. In the Manage tab, click the Dimensions panel button.
2. Select the desired dimension.
3. Click the Advanced tab.
4. Select the Dimensional Weighting check box to activate dimensional measure-to-objective weighting for this dimension.
5. Click Save.
6. In the Author tab, click the Objectives panel button.
7. Select the desired objective to set weights at different dimension levels.
8. Click the Adjust Measure Weights button to open the Measure Weights panel.
9. Configure weights for each desired dimension level.
   Use the sliders or type in weighting values. Weights must total exactly 100%.
10. Click Save.

Interpreting the Dimension Loader Report

After you have designed the dimension load, click the Preview tab to open the preview of the Dimension Loader report.

Note: You must select at least a Level 1 field in order to activate the Preview option.
The following is an example of the Dimension Loader report.

The Dimension Loader report displays the hierarchy of dimension values to be loaded. The report compares data to be loaded to what is already loaded so you can tune Dimension loads. The report shows you the changes you will make when you load the new data.

Minus (-) signs appear next to records to indicate that the records will be deleted. Plus (+) signs appear next to records to indicate that the records will be added. If a record does not have a plus or a minus sign, it means that the record already exists for the dimension. You can sort on the signs so that the records appear in ascending or descending order.

After you are finished tuning the dimension load and are satisfied that the data to be loaded is correct, click Save to save the metadata. You cannot perform a new dimension load unless the metadata has been saved. However, you can load an existing dimension load provided no changes have been made since the last time it was run. If changes are made, save the changes first, then load the dimension.

**Running and Scheduling a Dimension Load**

**How to:**

Schedule a Dimension Load

After you have designed, tuned, and saved your dimension load, you can load the data by clicking the Load button in the Dimension Loader. A message appears, informing you that the dimension you loaded is completed (for example, Dimension successfully loaded).

You can automatically run a saved dimension load during specified time intervals using ReportCaster.

**Procedure:** How to Schedule a Dimension Load

1. In the Dimension Loader, click the Schedule button.
For the dimension you selected, for example, Location, the New Schedule panel opens, as shown in the following image.

![New Schedule Panel](image)

**Note:** The New Schedule panel generates Interval, Start Date, and Start Time values based on the values you specified for the load. The schedule is active by default. You can edit these values as needed.

2. Optionally, enter a new Job Description and specify new Interval, Start Date, and Start Time values. You may be prompted for additional information, depending on the interval you select.

3. Click Save to save the new schedule.

For information on editing a saved schedule, see *General Tab - Schedules* on page 483.

**Setting Up the Month Name Display in a Dimension Load**

**How to:**

Set Up Month Name Display in the Time Dimension

You can control how PMF displays the values for months, text, or numeric labeling (for example, Jan... Feb, or January... February, and so on), and the order these components display (for example, 2009/December or December/2009).

Month Names to be displayed are actual data that is stored in the PMF data mart. To set up Month Name display, you can use the Dimension Loader for the Time Dimension.
**Procedure: How to Set Up Month Name Display in the Time Dimension**

1. On the Manage tab, click the *Dimensions* panel button, then click the *Time* Dimension. PMF displays the Edit Dimension panel for Time. The example below shows the typical configuration for Time (using Time AutoGen):

![Edit Dimension Panel for Time](image)

2. In the Month Display drop-down menu, select an option from the table list below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number (default)</td>
<td>Displays the month as (most typically) a two-digit number.</td>
</tr>
<tr>
<td>Abbreviation After Year</td>
<td>Displays the month as a name, using the standard three-character abbreviation for the month (for example, Jan, Feb, Mar, and so on). Position the month name after the Year (for example, 2009/Jan, 2009/Feb, 2009/Mar, and so on). <strong>Note:</strong> If you are using PMF configured for another language other than English, the length of the Abbreviation could vary, or be the same as the full length.</td>
</tr>
<tr>
<td>Abbreviation Before Year</td>
<td>Displays the month as a name, using the standard three-character abbreviation for the month (for example, Jan, Feb, Mar, and so on). Position the month name before the Year (for example, Jan/2009, Feb/2009, Mar/2009, and so on). <strong>Note:</strong> If you are using PMF configured for another language other than English, the length of the Abbreviation could vary, or be the same as the full length.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Full Name After Year</td>
<td>Displays the month as a name using the long version of the name of the month (for example, January, February, March, and so on). Position the month name after the Year (for example, 2009/January, 2009/February, 2009/March, and so on).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are using PMF configured for another language, the length of the Full Name could vary, or be the same as the Abbreviation.</td>
</tr>
<tr>
<td>Full Name Before Year</td>
<td>Displays the month as a name using the long version of the name of the month (for example, January, February, March, and so on). Position the month name before the Year (for example, January/2009, February/2009, March/2009, and so on).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are using PMF configured for another language, the length of the Full Name could vary, or be the same as the Abbreviation.</td>
</tr>
</tbody>
</table>

**Note:** The position you select does not affect how the dates sort in any PMF Views or Gadgets.

3. If you are using an alternate Time Dimension layout (for example, Years/Months/Weeks, Years/Quarters/Months/Weeks), you will see another option called Month Level. For this option, tell PMF the level in the Time Dimension that represents Months, so that PMF can determine where the name or number is to be displayed.

4. Click Save, then click Load to reload your Time Dimension and populate it with display month values as you indicated in the Time Dimension configuration. Once you do this, you will see the Month Name option displayed on all PMF Views and Gadgets.

**Example:**  **Month Names in PMF Views**

After you have configured Month Name display, Month Names display in your PMF Views and Gadgets the way you have configured them, as shown in the following examples. The following examples use the data from the PMF manufacturing demo data mart.
Rolling 5 Periods. The following is an image which displays View drilled to Month level, with the current date set to Feb 2006.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CGOS</td>
<td>21,042</td>
<td>21,044</td>
<td>9,405</td>
<td>9,405</td>
<td>9,405</td>
<td>9,405</td>
</tr>
<tr>
<td>Sales</td>
<td>77</td>
<td>77</td>
<td>77</td>
<td>77</td>
<td>77</td>
<td>77</td>
</tr>
<tr>
<td>Employee</td>
<td>560</td>
<td>560</td>
<td>330</td>
<td>330</td>
<td>330</td>
<td>330</td>
</tr>
<tr>
<td>Item Count</td>
<td>406,000</td>
<td>406,000</td>
<td>406,000</td>
<td>406,000</td>
<td>406,000</td>
<td>406,000</td>
</tr>
</tbody>
</table>

Measure Details. The following is an image which displays the Month Names of the Measure Details drill for 2005/Q1.

<table>
<thead>
<tr>
<th>Month</th>
<th>Actual</th>
<th>Tgt</th>
<th>% of Tgt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan2005</td>
<td>12,746</td>
<td>11,826</td>
<td>104.4%</td>
</tr>
<tr>
<td>Feb2005</td>
<td>43,936</td>
<td>41,548</td>
<td>104.0%</td>
</tr>
<tr>
<td>Mar2005</td>
<td>52,146</td>
<td>48,123</td>
<td>108.3%</td>
</tr>
<tr>
<td>Apr2005</td>
<td>148,852</td>
<td>148,852</td>
<td>100.0%</td>
</tr>
</tbody>
</table>

Key [predictive data]
Scorecard: CenturyCorp Card
Measure: CGOS
Time: Jan05/Q1
Time Range: Rolling 5 Period
Target Field: Target
Designing a Custom Time Dimension Load

**In this section:**
- Creating a Custom Time Dimension From an External Data Source
- Displaying Custom Time Dimension Data
- Accessing Custom Time Dimensions in the Measure Loader

Time dimensions provide time-based views of your data. PMF has default Time dimensions that are available, or you can create custom Time dimensions. The Dimension Loader enables you to specify a custom Time dimension that supports any regular or irregular time period, which can be greater than or less than 12 months. You can specify custom start and end dates for each period, and you can choose between weekly or monthly rollups at the lowest dimension level.

Performance Management Framework 5.1.3 now supports up to five levels of logical Time. This provides you with the ability to create a Time Dimension that goes down to display more detail as needed.

You can specify Time in many more flexible ways. You can split Time at up to six levels. For example, you could create a calendar that specifies weeks, months, quarters, half-years, and years.

Some examples of possible configurations include:

- Year/Quarter/Month/Week
- Year/Period/Week
- Year/Semi-Year/Quarter/Month

To configure PMF to support more Time levels, follow the same directions as you would for Alternate Time Dimensions in the PMF documentation. The Time Dimension Loader will allow you to specify up to five levels. You will need to build and deploy your Calendar file to contain the specific dates that map to your Time Dimension levels.

Time dimensions must be three levels, and can represent the standard Y/Q/M (Year/Quarter/Month) time structure, or any other non-standard time structure.

You can configure any arbitrary custom calendar, regardless of regularity, where you define the three-level Time dimension and the trending time parameters. PMF automatically generates the Time dimension values and adjusts inbound dates for measures to map to the correct fiscal periods you specified. If you are setting the default Today date to use the system clock date, PMF automatically maps the current system date to the correct fiscal time period when you run views.
Examples of custom fiscal calendars include the following:

- A 12-month, 4-quarter July-June calendar in the Y/Q/M structure.
- A 12-month, 3-trimester January-December calendar in the Y/T/M structure.
- A 13-period calendar structured as 13 periods of 4 weeks each per year.

If you select a start month other than January, for example, April, then month 01 of the calendar would be April, month 02 would be May, and so forth. The fiscal year of a custom calendar is the calendar year of fiscal month 12. If April of 2006 is month 01, then April is treated as month 01 of fiscal year 2007, since month 12 is March 2007.

PMF can create almost any arbitrary three-level Time dimension provided that the data is properly defined in an accessible data source. Non-standard Time dimensions can be either regular or irregular. A regular Time dimension always has the same number of lower level entries for each and every upper level entry.

If your year is structured into 13 fiscal periods and every fiscal period always has exactly 4 fiscal weeks, then your data is regular. If you occasionally have a fiscal year with 14 fiscal periods or a fiscal period with 5 fiscal weeks (which can happen in situations where you need to adjust for extra days in the year), then your data is irregular.

PMF can work with both regular and irregular calendars. Irregular calendars require you to set up a custom data source that details how the calendar works.

**Creating a Custom Time Dimension From an External Data Source**

**How to:**
Load a Non-Standard Time Dimension From a Custom Data Source

**Reference:**
Sample Files Containing External Time Data

PMF can create a custom Time dimension from an external data source, provided that the external data source is accessible to the PMF environment and is properly configured. The WebFOCUS adapter must be set up to access the external data source before mapping the dimension.
The external data source can contain regular or irregular time data. PMF determines regularity or irregularity by inspecting the data. If the time data is regular, PMF computes the prior time periods automatically. PMF defines a prior time period as a time period with identical second and third-level values when the year (first level) is one year earlier. If the time data is irregular, you must add prior time period information to the time source. For example, if you have a custom calendar with 53 weeks, PMF cannot determine how to map a 53 week year onto the prior 52 week year, and you must define the prior time period information in the source data. If PMF determines that data is irregular and prior date information is missing, the system issues an error message.

All fields and data values must be the same length, in alpha format. For example, if the source data has single digit low values and double digit high values, the single digit values must have leading zeros to make the values equal in length.

The external data source must be a standard WebFOCUS Master File located in the WebFOCUS application path (APP PATH). The following fields must be defined in the WebFOCUS Master File for both regular and irregular Time dimensions.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME_KEY</td>
<td>Key field used to join to the measures source data.</td>
</tr>
<tr>
<td>TIME_LEVEL01_VALUE</td>
<td>Data value of the first level in the Time dimension hierarchy.</td>
</tr>
<tr>
<td>TIME_LEVEL02_VALUE</td>
<td>Data value of the second level in the Time dimension hierarchy.</td>
</tr>
<tr>
<td>TIME_LEVEL03_VALUE</td>
<td>Data value of the third-level in the Time dimension hierarchy.</td>
</tr>
<tr>
<td>START_DATE</td>
<td>Calendar date of the first day of the time period.</td>
</tr>
<tr>
<td>END_DATE</td>
<td>Calendar date of the last day of the time period.</td>
</tr>
</tbody>
</table>

The following fields must be defined in the WebFOCUS Master File for only irregular Time dimensions.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRIOR_TIME_LEVEL01_VALUE</td>
<td>Data value of the first level of the prior period.</td>
</tr>
<tr>
<td>PRIOR_TIME_LEVEL02_VALUE</td>
<td>Data value of the second level of the prior period.</td>
</tr>
<tr>
<td>PRIOR_TIME_LEVEL03_VALUE</td>
<td>Data value of the third-level of the prior period.</td>
</tr>
</tbody>
</table>
**Reference:** Sample Files Containing External Time Data

The PMF sample data directory includes examples of external time data. The following five (.csv) sample files include Master File definitions and comma-delimited data files: `time_source_reg1`, `time_source_reg2`, `time_source_irreg1`, `time_source_irreg2`, and `time_source_irreg3`.

If you want to use these sample files, you must add the appropriate WebFOCUS FILEDEF statement into your WebFOCUS profile. In addition, you must use the alternate Master File definitions for the source of the measure data (centord) for the sample measures. Examples of the appropriate code to use are contained in the following source files: `centord_reg1`, `centord_reg2`, `centord_irreg1`, `centord_irreg2`, and `centord_irreg3`.

**Procedure:** How to Load a Non-Standard Time Dimension From a Custom Data Source

Once you have correctly set up a non-standard Time dimension data source, perform the following steps to load the time data into the PMF database.

1. From the Manage tab, click Dimensions, and then select the Time dimension to access the standard Time dimension load panel.

2. From the first drop-down menu, select Harvested from Data.

3. From the second drop-down menu, select the Master File containing your custom Time dimension data.
   
   The panel displays the default settings for the custom Time dimension.

4. Click the Sample Data button to verify that your custom time data is correct.

5. From the Key Field drop-down menu, select the key field which links the Time dimension source data to your measures source data.

6. Supply a Level Name for each of the time levels. The default names are Year, Quarter, and Month.
   
   These names are displayed on most standard views.

7. To map each time level to a field in the source data file, confirm that Field is selected from the Source drop-down menu (this is the default), then select `TIME_LEVELnn_VALUE` from the Field/Define Code drop-down menu, where `nn` represents the level number.

8. Click the Preview button to display the data to be loaded. For more information, see *Interpreting the Dimension Loader Report* on page 359.

9. Click the Save button to save the dimension metadata in the database.

10. Click the Load button to load the dimension data into the database.
Displaying Custom Time Dimension Data

For standard Time dimension data in the Y/Q/M (Year/Quarter/Month) format, PMF displays quarterly data in the format yyyyQq, where yyyy is the four digit year, and q is the actual quarter number, for example, 2006Q1. PMF displays monthly data in the format yyyy/mm, where yyyy is the four digit year, and mm is the actual month number, for example, 2006/01. Note that the letter Q in the quarterly data example, and the forward slash in the monthly data example, were assigned using the Abbr. column in the Dimension Loader for the Time dimension.

For non-standard Time dimension data, you can choose alternate abbreviations of up to 5 characters for each level, or you can leave them blank. For standard Y/Q/M time, when you are displaying information at the monthly level, there is no need to display the value of the quarter. Months 01-03 are quarter 1, months 04-06 are quarter 2, and so on. However, in other situations, the value of the second level might not be obvious. For example, if you are using 13 fiscal periods and 52 weeks in the year, it may not be obvious that week 45 is in fiscal period 12. In these situations, you have the option to always display the second level when viewing at the third-level, by selecting the check box in the Req. column for time level 2 in the Dimension Loader for the Time dimension.

If PMF determines that time level 3 has repetitive information and the combination of time level 1 and time level 3 is not unique, then time level 2 is automatically required for all views. In these situations, the Req. check box is activated by default and is not displayed in the Dimension Loader for the Time dimension.

Accessing Custom Time Dimensions in the Measure Loader

After you create a custom calendar, the Dimensions tab of the Measure Loader displays the custom time levels you entered when you specified a custom time source. In most situations, the Measure Loader determines the time values from a custom time source, and PMF automatically calculates the measure date from the Time dimension. In the Field maps tab of the Measure Loader, the Date Mapping drop-down menu displays the correct selection automatically.

Setting Up a Distinct Count Dimension

**How to:**

Set Up Distinct Count Measures

Distinct Count Aggregation for measures allows count-oriented measures to avoid the double-counting problem. This would most typically happen in cases such as:
Flag Type Measures. These represent on/off states for a property, such as how many employees have filed their expense statements? or how many trucks are current on this year’s inspections? They count how many occurrences are true, or in the case of percentages, display the percent of the entire population that are true. Because the same actual flag can appear multiple times across other dimensions, when rolling up on the Time Dimension, if you did not have a distinct count capability, you would unintentionally double-count the same property.

Event Measures. These count events or the presence or absence of people, equipment, and so on. Because the item or person may be there one week or month, and then return, or stay at the same place for an entire period of time, when aggregating at higher levels of time, you would double-count the same property. An example is hospital stays. A single hospital stay can cross time boundaries, so when rolling up on the Time dimension you would only count each stay once for a particular patient. However, if a patient has another hospital stay within a time frame, then that is a new event that has to be counted separately from the first event.

Distinct Count measures use a special dimension that is otherwise hidden from end users. During measure loads, PMF uses the special dimension to differentiate the counted values and ensure no double-counting when summing values that match along that dimension.

Procedure: How to Set Up Distinct Count Measures

The following steps explain how to set up Distinct Count measures.

1. In the Manage tab, click the Dimensions panel button.
2. Click New.
   The New Dimension panel opens.
3. Click the Advanced tab and select the Distinct Count Aggregation check box.
   Note: The Distinct Count setting is non-destructive, so you can disable and re-enable it to see the differences in how measure data is processed.
4. Configure and load at least one dimension to be a Distinct Count differentiator. Click Save and then Load your dimension normally.
   For more information on how to use the Dimension Loader, see the PMF Administration Guide.
**Note:**

- Once you load values into the dimension, these values become the differentiators used to calculate correct counts in Distinct Count processing.

  For example, for the Hospital Event example mentioned previously, you might load all of your patient IDs into this dimension. During Distinct Count processing, PMF would check to see if a patient ID was re-used during any higher level Time aggregation, and prevent that patient from being counted more than once.

- If you set up a dimension to be a Distinct Count differentiator, it is hidden and does not appear in any of the typical locations where you would see a dimension selector.

  For example, you would not see the drop-down of the dimension on the Analysis Designer, the Measure Entry panel, or the drop-downs for Gadget Preferences.

5. Create a Distinct Count measure. To specify that a measure will use Distinct Count Processing, select the **Distinct Processing** check box on the Measure panel. Make sure that you have linked exactly one of your Distinct Count differentiation dimensions to the measure by typing its code letter in the Dimensions text box. Click **Save** once both of these actions are done.
**Note:** Currently, the Distinct Count capability requires you to use Fixed Targets, not loaded. In the previous example, note that Alternate Time Summary is active, and the Time Summary drop-down is set to Most Recent. Since flags can change to on or off during any time period, setting this to Most Recent enables PMF to always display the most current state within the desired Time level.

6. Load the measure normally. PMF will store measure data linked to every available matching row for the Distinct Count differentiator dimension, as well as all other linked dimensions.

**Note:**

- For Additive Aggregated measures, the Actual value is always the Distinct Count of the Distinct Count differentiation dimension for that measure.

- For Ratio and Percentage Aggregated measures, the Actual Denominator is always the Distinct Count of the Distinct Count differentiation dimension for that measure. The Actual Numerator is the Distinct Count of the Distinct Count differentiation dimension for that measure, but only if those measure entries have a numerator > 0.

In the example above, which is a Flag type Distinct Count measure, note the Edit on ACTUAL_NUMERATOR, which points to the proper field and sets the value to 1 if the KPI_5 flag field contains Y.
Tip:

- PMF can handle multiple Distinct Count dimensions. Of course, you must still respect the limit of 16 total dimensions.
- Depending on the number of items in your Distinct Count dimension, you might notice a longer loading time for Distinct Count measures.

Inputting User-Entered Dimensions

How to:

Create a New User-Entered Dimension
Edit Level Values on a User-Entered Dimension

Reference:

Work with Hierarchies

User-entered dimensions enable users to create and use dimensions in PMF before loadable dimension data is available. Similar to user-entered measures, once a user-entered dimension is defined values can be immediately typed directly into PMF for your dimensions.

User-entered dimensions are useful when you need to rapidly prototype new engagements with PMF. Since these values are linked to measures through internal keys, they are not suitable for production environments.

Limitations of User-Entered Dimensions

- It is not possible to link user-entered dimensions to loadable measures, but you can link them to user-entered measures with no issues.
- After loadable dimension data becomes available, you should load your dimension data and reload any linked measures, since keys will now be available to link the two.

   Note: User-entered measures must be re-entered as well.

Procedure: How to Create a New User-Entered Dimension

1. In the Manage tab, click the Dimensions panel button.
2. Click New.
   The New Dimension panel opens.
3. Type a name for the new dimension and select Collected from Users from the drop-down menu, as shown in the following image.

You can create a structure in the Hierarchy & Data tab by entering Level names in the fields provided.

**Procedure:** How to Edit Level Values on a User-Entered Dimension

1. In the Manage tab in PMF, click the Dimensions panel button.

2. Select the dimension you wish to edit.

   The Edit Dimension panel opens.

3. Select Enter Dimension Values.

   Note that each column in the editor corresponds to a level, as defined in the dimension panel. You can type the level values in each text box, as shown in the following image.

**Reference:** Work with Hierarchies

The Enter Dimension Values tab from the Edit Dimension editor allows you to add values to the dimension at any level.
- **To add a level value at a peer level.** Click the button to the left of an existing level value. The editor will create a new level value below the existing one. New peer levels were created under London and East, as shown in the following image.
To remove a level value at a peer level. Click the button to the right of an existing value. The entire hierarchy section of that value will be removed. For example, the following image shows a hierarchy in levels.
Removing the values of UK result in that entire section of hierarchy getting removed, as shown in the following image.
Displaying all logical values. Click Show All to temporarily display all of the level values in the hierarchy, as shown in the following image.
Editing Existing Loaded Dimension Values

**How to:** Change a Loaded Dimension to be User-Entered

Existing loaded dimension values can be edited, which enables you to temporarily change the displayed values for any loaded dimension. This is designed to support demonstrations or prototypes.

**Limitations:**

- This feature should primarily be used when prototyping or demonstrating a PMF system. It is not recommended to be used with a live loaded dimension, since any edits made will be overwritten after a load is performed. This occurs because the source data from which the dimension was loaded will not be changed when you perform these edits.

- Levels and rows cannot be added or removed. This is due to the fact that any measure data that was previously loaded would be deleted since its physical keys get lost.

**Procedure:** How to Change a Loaded Dimension to be User-Entered

1. In the Manage tab in PMF, click the *Dimensions* panel button.
   Select the dimension that you wish to change. The Edit Dimension panel opens.

2. Select *Collected from Users* from the drop-down menu.

3. Click *Save*.

4. Click *OK*.

5. Click the *Enter Dimension Values* tab to edit the level values of the dimensions. For more information on how to do this, see *How to Edit Level Values on a User-Entered Dimension* on page 374.

**Note:** Clicking *Unlock Panel* will turn the dimension into a standard user-entered dimension. Doing so will permanently break any links with existing loaded measures. The dimension will then only be able to link to user-entered measures. Also, any existing user-entered measures might need to be re-entered, depending on the changes that were made.
Planning Considerations For Loading Sources

In this section:
- Creating a Moderately Complex Measure Load
- Working With Standard Aggregation in Measures
- Displaying Data as Current Data
- Working With Ratio and Percent Type Measures

Before creating a new measure, you need to find out:

- What are the source data tables and DBMS for the measure?
- What fields do you need from the tables to perform this load?
- What will be the unit of measure?
- What dimension linkages do you need to consider?
- What temporary fields (if any) will be created, such as sort fields for measures and joined field definitions for defined dimensions.

Critical fields for measures are:

- Target (real field or calculated from real field)
- Actual (real field or calculated from real field)
- Now date (real field or calculated from real field)
- Owner
- Dimensional links
- Scorecard links
- Time (will be linked using the Now date)

Creating a Moderately Complex Measure Load

Note: This will be deprecated in a future release.

If you create a moderately complex measure load, you must change data levels, transform the data, and calculate different sources.

Working With Standard Aggregation in Measures

Note: This will be deprecated in a future release.
When working with measures, you must determine whether to use standard aggregation or percent and ratio type measures. Standard aggregation consists of one field that holds a number.

### Displaying Data as Current Data

The measure data displayed in your PMF views can be “ghosted-in” to display values from a previously loaded period. This functionality enables you to carry previous data values forward into the current period until the actual current data is available. PMF marks the data with a special notation so users can distinguish between actual current data and data carried forward from a past load. This functionality is enabled globally by setting the Previous Period Forward setting to Y (Yes) in the Summarization panel on the Settings menu. To utilize previous period data in your views, you must select the Previous Period Moving Forward option for every measure for which you want to carry previous data values forward.

**Procedure: How to Enable Previous Period Moving Forward for a Measure**

To select the Previous Period Moving Forward option for a measure, perform the following steps:

1. In the Manage or Author tab, navigate to the Measure tree and click the measure that you want to configure.
   - The Edit Measure panel opens.
2. Select the Previous Period Moving Fwd check box.
3. Click Save.

After activating this functionality for a measure, PMF automatically creates the forward moving data for each actual and target every time you load the measure. The data will begin displaying in reports and views immediately after the next measure load for that measure.

### Working With Ratio and Percent Type Measures

If you have ever tried to aggregate percentages or other results of statistical methods, you may have noticed that it is not possible to accurately aggregate percent or other ratio type metrics. For example, if you have percentage results for defects per thousand for Charlotte at 20% and Toronto at 10%, you cannot simply add the percentages together to get an aggregate of 30%. To aggregate ratios or percentages correctly, PMF performs the following steps for you:

1. Separate the numerator and denominator components for each individual measure.
2. Add all numerators together.
3. Add all denominators together.
4. Apply the appropriate calculation method to the aggregated numbers.

**Note:** Percent and ratio type measures use separate numerator and denominator fields to let you store and correctly aggregate measures.

**Working With Measures**

**In this section:**
The Measure Panel
Control Drill Menus for Measures
Measures and Dimensionality

**How to:**
Create a New Measure
Set Measure Controls
Copy Measures
Wipe a Measure
Configure External Aggregation for Each Measure

**Reference:**
Recalculation and Copying Measure Lineage
Measure Lineage Tab
Measure Load History

PMF 5.3.2 provides a completely new way to assemble measures through a new user interface with a new and simpler way to approach measures:

- Measures report just as they did before. The PMF Measure cube is unchanged. Your existing custom reports work the same as in earlier versions of PMF 5.
- The Actual and Target components of measures are now copied directly from datapoints, which are like database fields, but with both rows and dimensions in their structure.
- When linking datapoints, your measures automatically inherit the dimensionality of the summation of all their linked datapoints.
Defining measures is now a quicker and easier process, because you no longer have to define dimensionality. You define dimension links when you make loadable and user-entered sources or when you create derived or generated datapoints.

The Measure Panel

The Measure panel organizes the properties of a measure by common tasks and concepts. It combines all the functions that were formerly on the legacy Measure panel (mostly found on the Info and Controls tab), and the legacy Measure Loader tabs. Everything that was previously on the Dimensions, Field Maps, Filters, and Preview tabs has been changed. The Dimensions, Field maps, and Filters tabs have been removed entirely. This is now done in sources and datapoints, which control dimensionality and how data is harvested when it is loaded, typed in by end users, or generated.

The Link/Unlink Objectives (link objectives to measure) panel was replaced by the Scorecards panel. The Objective Weighting panel is still available as a drill from the Measure panel. You can weigh your measures to objectives and risks using the Objectives panel, depending on if you work top-down or bottom-up.

If any dimensions are configured for dimensional tolerances, you can set them up with the Dimensional Tolerances tab.

Procedure: How to Create a New Measure

To create a new measure:

1. In the Manage tab, click the Measures panel.
2. Click New.

The New Measure panel opens, as shown in the following image.
3. Name your new measure and fill in the fields in the Info tab. The following options are available:

- **Units**
  The unit of measure used for this measure.

- **Owner Id**
  The owner ID currently assigned to the measure. You can reassign the measure to a different owner by selecting it from the drop-down menu.

- **Description**
  An intuitive description of the data loaded into the measure.

- **Measure Formula**
  A technical description of the measure, such as its datapoints, calculation methods, or source fields.

4. Click the *Datapoints* tab to link datapoints to the measure, as shown in the following image.

Manually enter or select datapoints to bring in the datapoints that feed this measure. A datapoint can be specified for the Actual field.

For the Target field, you can:

- Choose a datapoint for any target (Target, Benchmark, Forecast, or Stretch Target).
Define a simple universal numeric target for any target, such as Target, Benchmark, Forecast, or Stretch Target. To do this:

1. Select the Target check box.
2. Select the # check box.
3. Enter the target, as shown in the following image.

5. Click Save.

**Procedure: How to Set Measure Controls**

By default, all measures are ascending, have preset tolerances, and have a default display format. All of these settings can be changed in the Controls tab.

1. In the Manage tab, click Measures.
2. Select the measure you want to change.
   The Edit Measure panel opens.
3. Click the Controls tab, as shown in the following image.

The following options are available:

**Aggregation Method**

A method you can use when aggregating this measure. Choose from Additive, Percentage, Change in Percentage, or Ratio.

**Direction**

Direction to be used to determine how thresholding is performed. The options are:

- Ascending - Higher is better
- Descending - Lower is better
- Range - Should fall within range

For more information about these options, see *Indicator Concepts* on page 228.
**Threshold/Flex Type**

The type of value used in the Threshold/Flex fields. The options are Percent or Units.

**Threshold/Flex**

The first field indicates the value used for the threshold, which determines the outer range when an indicator shows red.

The second field indicates the value used to determine the inner edge of the yellow zone. Setting a flex of 0 indicates that the measure does not allow any deviation from the target.

**Threshold/FlexSlider**

Displays a grid that enables you to graphically adjust the threshold and flex values.

**Display Format**

A WebFOCUS numeric display format valid for the unit of measure. Valid format types are:

- D (floating-point double-precision),
- F (floating-point single-precision),
- I (integer)
- P (packed decimal)

The formats are In, Dn.d, Fn.d, and Pn.d, where n represents the maximum number of digits to display, and .d, an optional decimal point with the number of digits to display after it.

The maximum number you can code before and after the decimal point is 10 for I, 15 for D, 7 for F, and 31 for P. You can also add at the end, in any order:

- M or % to format the number as currency or as a percent
- C to suppress commas

Many other codes can also be used. For more information about numeric display options, see the ACTUAL value options section in the *Describing Data With WebFOCUS Language* manual.

**Access Security**

Enable this option to filter data using access security at the security level of the user.

**Time Summary**

This option varies how measured data is aggregated over time.
Select \textit{Standard} to aggregate using standard Time rules. All of the measure data shown at higher time levels adds up to the total of all data at the lowest loaded level (for linear aggregation) and includes all percent or ratio data over the entire time period (for percent, ratio, and change in percent aggregation). This option is the default.

Select \textit{Average} to show an average value, which calculates a mean average of all the data loaded across the lower Time levels for the duration of the higher level period.

Select \textit{Most Recent} to show the latest values. Only the most recently loaded value of all the data loaded across the lower Time levels for the duration of the higher level period will be shown.

\textbf{Note:} These options will only be available if the Alternate Time Summary setting in the Summarization settings is enabled.

4. Click \textit{Save}.

\textbf{Procedure: How to Copy Measures}

You can make an exact copy of any existing measure. After making the copy, you can immediately alter it as needed. To copy a measure:

1. From the Manage tab, click the \textit{Measures} panel button.
2. Select the measure you want to copy. The Edit Measure panel opens.
3. Click \textit{Save As}. You will be prompted for a new name for the measure, as shown in the following image.

\begin{center}
\includegraphics[width=0.5\textwidth]{save_as.png}
\end{center}

4. Click \textit{Save}. PMF will make an exact copy of the measure. You can edit and save your changes at any time, and click \textit{Save As} again if you want to make more copies. This measure is what will be loaded for editing.
Procedure: How to Wipe a Measure

All loaded data from any loadable source can be wiped out or deleted in a single operation. This is useful when you have loaded data that is invalid. It is a simple way to delete all the data.

1. From the Manage tab, click the Measures panel button.
2. Select the measure that needs data to be deleted. The Edit Measures panel opens.
3. Click the Wipe Data button. PMF will ask you to confirm the data purge.
4. Click OK.

Note: It may take PMF a moment to purge all of the data.

Procedure: How to Configure External Aggregation for Each Measure

To configure external measures to be read into PMF, you must first activate the feature:

1. From the Manage tab, click the Settings panel button.
2. Click Summarization.
3. From the External Aggregation drop-down menu, select Y.
4. Enter the name of the master file for the external DB where you are storing the pre-aggregated data in the External Aggregation MFD box.
5. Click Save.
6. Configure each measure that will use External Aggregation. From the Author or Manage tab, click the Measures panel button.
7. Select a measure.
8. Click the Controls tab.
9. From the Alternate Processing drop-down menu, select External.
10. In the External Dimension links box, enter the letter that represents each dimension to which the external measure data links.

Tip: To get the letter that represents each dimension, click the Dimensions panel button and click the Advanced tab. The dimension letter will be shown next to Dimension Type.
Control Drill Menus for Measures

<table>
<thead>
<tr>
<th>How to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a New Drill Menu for a Metric</td>
</tr>
<tr>
<td>Make a Content Menu the System Default</td>
</tr>
<tr>
<td>Clear a Specific Metric Menu to the Default</td>
</tr>
</tbody>
</table>

You can control the content visible from the drill for each Metric in PMF using the Content tab on the Measure panel. Any Content managed within PMF can be added to the menus.

There are two menus at the Metric level. These options control the drill menu that is activated when you click:

- The name of a Metric on any Grid or chart.
- The data values displayed for a Metric on any Grid or chart.

**Procedure: How to Add a New Drill Menu for a Metric**

By default, all Metrics in PMF use the same menu. You do not need to do anything to configure this menu. It is automatically configured whenever a new Metric is created in the system.

If you want to configure a menu for a particular Metric:

1. Click the Measures panel button.
   The available measures are displayed.

2. Select the measure you want to use.
   The Edit Measure panel opens.

3. Click the Content tab.
The Content menus configured for that metric are displayed, as shown in the following image.
4. If you click the *Link Content* box, you can:

- Add new (link) content to the Measure Name or Measure Value menu by selecting the content item you want to add from the drop-down menu, as shown in the following image.

![Image of measure name menu](image)

- Add new (link) content by entering the name of the item in the box, as shown in the following image.

![Image of text box](image)

- Change the order of menu items by clicking the arrows on the left of the link name, and dragging the item up or down, as shown in the following image.

![Image of menu order change](image)
Remove (unlink) any content from the Measure Name or Measure Value menu for that metric by clicking the *Remove this item* button to the right of that item, as shown in the following image.

5. Click Save once you are done configuring the menu. The new menu is now configured. Whenever you select the name or values for that metric, PMF will display the Content menus you configured.

**Procedure: How to Make a Content Menu the System Default**

You can quickly design a default menu that all Metrics will use. This gives all Metrics that do not have specific menus a fallback. Note that the system ships with a default menu configured. Performing the steps in this task will override those settings.

To change the default menu for Metric Name or Value drills:

1. Click the *Measures* panel button.
   The available measures are displayed.

2. Select the measure you want to use.
   The Edit Measure panel opens.

3. Click the *Content* tab.
   The Content menus configured for that metric are displayed,
4. Click Save as default for the menu you want to make the system default, as shown in the following image.

![Image of Measure Value panel with Save as default and Clear to default buttons]

The menu you specified is now configured as the default. Whenever you click the name or values for any Metric that does not already have a specific menu configured, PMF will display the default Content menu you configured here.

**Procedure:** How to Clear a Specific Metric Menu to the Default

You can clear any specific menu that was previously configured for a Metric. When you do this, the Measure Name or Measure Value menu of the metric will always display the default as currently configured.

1. Click the Measures panel button.
2. Select the measure you want to use.
   
   The Edit Measure panel opens.
3. Click the Content tab.
   
   The Content menus configured for that metric are displayed,
4. Click Clear to default for the menu you want to clear to the system default.

Any specific menu for the Metric is deleted and the Metric will now always use the default. Whenever you click the name or value items for the metric, depending on which menus you cleared, PMF will display the default Content menu you configured here.

**Measures and Dimensionality**

The Dimensions tab has been removed from the Measures panel. In PMF 5.3.2, measures get their dimensionality from the datapoints that are linked. PMF uses dimensions in the most efficient way possible, and with the most flexibility, by always choosing the lowest common level for dimensional linkages.
Prior to PMF 5.3.2, you either had a load or a user entry option for measures. For each measure, you had to separately define dimensionality. Most data marts had very similar dimensionality for all their measures that usually depended on where the data was coming from. This meant a lot of time was spent defining separate dimensional structure for every measure, when actually, most users were simply repeating steps.

As detailed in *The Core Paradigm* on page 296, PMF 5.3.2 gives you the ability to model your measures with consistent dimensionality by figuring out the dimensionality you put into your datapoints. It then uses the most complete (lowest possible) level of aggregation for all the linked-up datapoints, to provide the most detail possible.

**Reference:** Recalculation and Copying Measure Lineage

The datapoints linked to your measures can have a complex, multi-part lineage, depending on their relationship to other derived datapoints and to loadable, user-entered, or in some cases, generated, datapoints.

The PMF design allows any derivations to be calculated in the correct order. The PMF model allows it to discover the generations of data lineage and to navigate in memory backwards and forwards through this lineage. PMF always uses the correct order to calculate the components for your measures. The process of copying the final state of all data is handled automatically once the recalculation of all points in the middle are completed.

**Reference:** Measure Lineage Tab

You can view lineage for the datapoints of any measure. The Lineage tab shows the progress of data through PMF, from the external data harvested into datapoints, through any derived datapoints, and all terminal points in your measure.
Working With Measures

The following image shows an example of the Lineage tab for a measure.

The lineage tab automatically displays the entire lineage. You can click the **Collapse All** button to hide the entire lineage.

**Reference: Measure Load History**

PMF keeps track of each load that is executed for each measure in the system, regardless of whether you loaded it manually or the load was called by the scheduler. This data is stored in a special logging section of the PMF data mart.

The History tab for a measure displays the history of all loads that have been logged.

The history of the measure shows:

- The dates that the loads ran.
- The count of rows that were retrieved, inserted, updated, and deleted.
- The count of total mismatches that occurred between the source data and the PMF metrics mart. Mismatches are source data rows that do not match to any existing keys for one or more dimensions.
The count of gaps in data continuity, which indicate the sparsity of the data. This does not mean there are errors but, if paired with mismatches, can help you debug any unexpected data discontinuities.

Any messages returned from the load system. If there is an error, the exact error is displayed in the information shown in this tab.

Where to Attach Your Measures

In this section:
Matching Scorecard Cascades to Metric Hierarchies

Note: Attaching measures will be deprecated in a future release. Instead, you will attach dimensions to sources and datapoints and PMF will determine measure dimensionality from these linkages.

Measures can help you plan and forecast levels of accountability within your organization. You can attach measure values to any level of dimensionality. You must determine how you want to view achievement and which levels of dimensionality you want to target within the hierarchy.

For example, suppose you are measuring total sales in dollars for your sales staff, and you have a Location dimension set up with the following levels:

- All
- Region (East, West, Central, South, North, Canada)
- Office (various offices in each region)
- Team
- Employee

PMF lets you attach the sales measure to any level on the Location dimension (and any level on the other available dimensions as well). When attaching the measure to the Location dimension, you may want to measure total sales dollars individually, by sales team, by sales office, or by region.

Note: If you are viewing measures at dimensional levels higher than which you attach a measure, they are automatically aggregated in all PMF views. At dimensional levels lower than which you attach measures, the measures do not appear in PMF views since they are not attached at these lower levels.

PMF also supports measure pooling which enables you to create and attach (link) measures to every scorecard, or any combination of scorecards, in your organization.
Matching Scorecard Cascades to Metric Hierarchies

PMF rolls up and drills down to metrics along dimensions. Separately, scorecards have a cascading hierarchy. Any PMF implementation can match the scorecard cascading hierarchy to the metrics dimension hierarchy one-to-one, or use a separate scheme.

A metrics pool is common across all scorecards. It can be as big a pool as you need, with as many metrics as you need. Each of these metrics is hierarchical. The hierarchies go to 16 levels deep, with each level allowing as many individual members as you need. In other scorecard models, profit for the east is a separate metric from profit for the west, so there are several requirements for rolling up values. In the PMF scorecard model, a single profit metric exists while there are details for the east and west, which easily roll up because they are associated with the same metric.

The metrics which a user is permitted to see in the hierarchy depend on the user ID. With PMF you can map each user ID to a level in the metric hierarchy. For example, if you have a hierarchy (dimension) that matches your corporate organization, you can secure sensitive metrics and make metrics specific to users using the organization chart. Individuals in the organization can see the aggregation and detail of the metrics that apply to them, but cannot see the ones that do not apply to them.

Each user has a default scorecard and can see all shared scorecards. On a scorecard, objectives can be links to one or more metrics in the metrics pool. Metrics are associated with a scorecard because they are linked to an objective. You can link zero metrics, one metric, or more than one metric to any objective. If you link more than one metric, you can weigh the share each one has in the overall performance of the objective.

Assume Mr. East is the sales manager for the east coast. He can see sales dollars, profit, COGS, Human Resources (HR) attrition, and salary levels for the east coast. He can also see quality metrics, organization service levels, stock levels, returns, and re-purchases for all the national and international locations. When he looks at his Sales Card, which is cascaded from the Corporate Card, and the card has objectives that link to these metrics, he can see them. For example, there is a Sales Up objective (goal), and it is linked to the sales dollars metric. Mr. East can see the sales dollars metric for the east coast through the Sales Up objective.

Now assume that Mr. West is the sales manager for the west coast. He can see the filtered metrics for the west. He has the same Sales Card as Mr. East. When Mr. West looks at the Sales Up objective on that card, it shows sales dollars for the west. Mr. East and Mr. West are using the same card, but have different access to the metric hierarchy.
This PMF model is illustrated in the diagram that follows.

Why the same card? Because typically cards do not map to people; rather they map to roles in the organization. Our organization has more than one regional sales manager and they all carry out the same strategy. It has many sales people under those managers and they each carry out the same strategy as agreed on by management. Having a separate scorecard for each person is high maintenance. Having shared scorecards reduces the cost of ownership.

PMF is not limited to the model described. Each person can have a separate scorecard. The scorecards will still cascade, and each person can use any of the pooled metrics associated with their cards.

You do not have to use a dimension, such as Organization to organize metrics. You can control access to the up-to-16 metric hierarchies any way you want. However, to match scorecards (which typically cascade by function in the organization) to metrics, use an organization chart type of dimension because it is common between the way you cascade cards and the way you grant access to the hierarchy of metrics.
The PMF model is simple and easy to maintain. For example, suppose you have a franchise business. Every business unit is a shop or store, and all of them have the same business strategy. Only one scorecard is required, and business performance is managed through a pool of identical types of metrics across each store. Each store sees only its part of the metrics pool. If you did not use this model, you would need to maintain and update a separate but identical scorecard for each store, and a separate but identical set of metrics for them, too. If you had thousands of stores, such a system would be very expensive to maintain.

### Loading Legacy Measures

**In this section:**

- Specifying Alternate Targets
- Setting a Basis for Descending Measures
- Running a Measure Load

**How to:**

- Access and Save Measures
- Adjust the Threshold and Flex Values
- Configure Predictive Data
- Design a Simple Measure Load

**Reference:**

- Manage Tab - Measures
- Manage Tab - Measure Loader Fields (All Views)
- Manage Tab - Measure Loader Fields (Dimensions View)
- Manage Tab - Measure Loader Fields (Field Maps View)
- Manage Tab - Measure Loader Fields (Filters View)
- Manage Tab - Measure Loader Options (All Views)

**Note:** Legacy measures will be deprecated in a future release.

The following is an overview of the steps involved in designing a simple measure load.

1. Access the Edit Measures panel. View the metadata and optionally save the measure you will be loading if it does not exist. For detailed information, see *How to Access and Save Measures* on page 401.

2. Click *Measure Loader*. 

3. Select the measure for loading.

4. In the Dimensions pane, specify information in the required fields. You should:
   - Determine the table from which your measures data is derived.
   - Make sure you are properly mapping from the source data to the dimensions.
   - Decide at what level you are going to measure each dimension.

5. In the Field Maps pane, specify information in the required fields. Consider whether you are going to use a custom procedure or map on a field by field basis.

6. In the Filters pane, specify the filters for your measure.
   For detailed information, see How to Design a Simple Measure Load on page 406.

7. Preview the Measure Loader report. For detailed information, see Interpreting the Measure Loader Report on page 420.

8. Save the measure.

**Procedure:** How to Access and Save Measures

**Note:** This will be deprecated in a future release.

The Edit Measure panel controls the measure series, each of which is a distinct measure, and its connected rows of values, which you can optionally link to an objective. The Edit Measure panel is accessible from the Manage tab. To access data in the Edit Measure panel, perform the following steps.

1. In the Manage tab, click the Measures panel button.

2. Select a measures source folder.
3. Select the measure for which you want to view data, for example, Profit. The Edit Measure panel, shown in the following image, displays the data for the Profit.

![Edit Measure Panel](image)

**Note:** To create a new measure, right-click a measure and select New.

4. View the data and change field values as needed. For more information about these fields, see Manage Tab - Measures on page 402.

5. To save an existing prototype measure or a new measure to be loaded, click Save.

**Reference:** Manage Tab - Measures

**Note:** This will be deprecated in a future release.

The following table lists and describes the fields and buttons in the Edit Measure panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure Name</td>
<td>The measure you are editing.</td>
</tr>
<tr>
<td>Units</td>
<td>The unit of measure used for this measure.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>Link/Unlink Objectives... (button)</td>
<td>Displays the Link Measures to Objectives panel, which enables you to link the measure to additional scorecards and objectives. For details on this panel, see <em>How to Link Measures to More Objectives</em> on page 227.</td>
</tr>
</tbody>
</table>
| Measure Type | Type of production measure.  
- Loaded  
- User Entered |
| Aggregation Method | Method you can use when aggregating this measure. Choose from Additive, Percentage, Change in Percentage, or Ratio. For details, see the Aggregation Method table entry in *How to Create a User-Entered Measure With the New Measure Wizard* on page 215. |
| Threshold/Flex Type | The type of value used in the Threshold/Flex fields:  
- Percent  
- Units |
| Threshold/Flex Direction | Direction to be used to determine how thresholding is performed.  
- Ascending (higher is better)  
- Descending (lower is better)  
- Range (should fall within range)  
For more information about these options, see *Indicator Concepts* on page 228. |
<p>| Threshold/Flex | In the first field, the value used for the threshold, which determines the outer range when an indicator shows red. In the second field, the value used to determine the inner edge of the yellow zone. Setting a flex of 0 indicates that the measure does not allow any deviation from the target. |
| Threshold/Flex Slider | Displays a grid that enables you to graphically adjust the threshold and flex values. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Select the type of target you desire.</td>
</tr>
<tr>
<td></td>
<td>- Load from field</td>
</tr>
<tr>
<td></td>
<td>- Use fixed value</td>
</tr>
<tr>
<td></td>
<td>- Aggregate fixed value</td>
</tr>
<tr>
<td></td>
<td>When you select Use fixed value or Aggregate fixed value, the Set Fixed Target Values button appears, which opens the Fixed Target pop-up dialog box where you can select the desired target types and enter a target value for each.</td>
</tr>
<tr>
<td>Owner Id</td>
<td>The owner ID currently assigned to the measure. You can select another owner to reassign the measure to that owner ID.</td>
</tr>
<tr>
<td>Audit Measures (check box)</td>
<td>Select this check box to archive any changes made to the measure in the PMF measures history table, used for reporting purposes.</td>
</tr>
<tr>
<td>Access Security (check box)</td>
<td>When this check box is selected, data is filtered using access security at the user’s security level.</td>
</tr>
<tr>
<td>Display Format</td>
<td>A WebFOCUS numeric display format valid for the unit of measure. Valid format types are D (floating-point double-precision), F (floating-point single-precision), I (integer), and P (packed decimal). The formats are $I^n$, $D^n_o$, $F^n_o$, and $P^n.d$, where $n$ represents the maximum number of digits to display, and $o$, which is optional, and $.d$, which is required, represent the decimal point and the number of digits to display after the decimal point. The maximum number you can code before and after the decimal point is 10 for I, 15 for D, 7 for F, and 31 for P. For more information about numeric display options, see the Describing Data With WebFOCUS Language manual.</td>
</tr>
<tr>
<td>Description</td>
<td>Intuitive description of the data loaded into this measure.</td>
</tr>
<tr>
<td>Measure Report</td>
<td>From the drop-down menu, select an operational or PMF measure view to which users can automatically drill down.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Measure Formula</td>
<td>You can add a text description of the calculation method and source fields that you will use in the load procedure for this measure here. Reports use this field to prompt for actual values displayed for a measure. This field is useful to explain to constituents how a measure was calculated.</td>
</tr>
</tbody>
</table>

**Procedure: How to Adjust the Threshold and Flex Values**

**Note:** This will be deprecated in a future release.

1. On the Edit Measure panel, click the **Threshold/Flex slider** button.

   The next pane shows the current threshold and flex values, and the percentage of the target value reached based on the most current data.

2. Click and drag the graphic for the value you want to change.

   For the ascending measure shown in the following image, to set the threshold value to 15%, drag the Threshold flag to 85% on the percent ruler, stop when the Threshold flag displays 15%, and click the mouse to anchor the flag. A Flex value is set the same way.

   The values displayed on the percent ruler are useful when setting threshold and flex values. For ascending measures, the percent values increase from left to right towards the target. For descending measures, the percent values increase from right to left towards the target. For range measures, the percent values increase towards the target and decrease in either direction away from the target.
3. When you have adjusted the desired values, click Accept to save the specified values and return to the Edit Measures panel.

**Procedure: How to Configure Predictive Data**

**Note:** This will be deprecated in a future release.

1. On the Edit Measures panel, click the Add Predictions button.

   The Configure Predictive Data panel opens, as shown in the following image for the Sales measure series.

![Configure Predictive Data Panel](image)

2. The Search Width drop-down menu provides choices that give approximate wait times for generating a list of predictive forecasting methods. Select:
   - Narrow (15 seconds) for the fastest search.
   - Medium (1 minute) for a longer and more accurate search.
   - Broad (3 minutes) for the longest and most accurate search.

3. Click Get Best Methods to calculate and display the best predictive methods available.

   The Configure Predictive Data window opens displaying a time sampling graph and a selectable list of the top 50 predictive methods.

   You can scroll and select any of the other predictive methods listed in the Accuracy Method columns to display the results of that method in the time sampling graph on the panel. Compare results until you are satisfied with the selected method.

4. Click Save & Generate to save the selected method and PMF will use this forecasting method to calculate predictive data for all views and reports associated with the selected measure.

**Procedure: How to Design a Simple Measure Load**

**Note:** This will be deprecated in a future release.
**Note:** If your procedures and metadata are not located in the Mainstreet application, make sure that you have added the WebFOCUS application containing them to the WebFOCUS Reporting Server APP PATH setting before you attempt a load operation. You can do this using the Web Console.

1. In the Manage tab, click the *Measures* panel button.
2. Select a measures source folder.
3. Select the measure for which you want to load data, for example, *Sales*.
   
   If you do not see the measure you need, you may need to define it in the Edit Measures panel. The properties displayed in all of the read-only fields in this panel can also be changed in the Edit Measures panel. For more detailed information, see *How to Access and Save Measures* on page 401.
   
   The Edit Measure panel opens.
4. Click the *Measure Loader* button.
   
   The Edit Measure Loader opens to the Dimensions view, showing the fields and options available from the Dimensions tab.

![Edit Measure Loader Dimensions View](image)

**Note:** The Edit Measure Loader automatically loads and displays the levels defined for the metadata and checks the measure to make sure it is correctly set up. If anything is wrong, the Load status list displays the error.

5. Specify the key values of the dimension needed to link your loaded measures to its dimensions. You must make sure the field format matches the key field specified when you loaded the dimension.
For more information about the available fields and options, see Manage Tab - Measure Loader Fields (Dimensions View) on page 411, and Manage Tab - Measure Loader Fields (All Views) on page 409.

6. Click the Field Maps tab to view your field mappings, which appear similar to the following.

```
6. | Field Maps tab |
```

7. Specify the Field Maps required for your measure load.

Field maps determine how data from the external table is mapped into the PMF field. The target is the goal amount for the metric. Actual is the value to be evaluated against the target. You can specify a single field in the drop-down menu or type a calculation (using standard WebFOCUS formula syntax) that controls how fields from the source are processed.

For more information, see Manage Tab - Measure Loader Fields (Field Maps View) on page 411, and Manage Tab - Measure Loader Fields (All Views) on page 409.
8. Click the *Filters* tab to view your filters, which appear similar to the following.

9. Specify the Filters required for your measure load.

Filters limit the rows of data to be retrieved during the load. Filters are saved and become part of the load logic.

For more information, see *Manage Tab - Measure Loader Fields (Filters View)* on page 414, and *Manage Tab - Measure Loader Fields (All Views)* on page 409.

**Reference:** *Manage Tab - Measure Loader Fields (All Views)*

**Note:** This will be deprecated in a future release.
The following table lists and describes the fields available for all views in the Measure Loader (Dimensions tab, Field Maps tab, and Filters tab).

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>Select one of the following options from the drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>• Full Refresh. Deletes all existing records and replaces them with the current load data.</td>
</tr>
<tr>
<td></td>
<td>• Add new, replace actual/target. Adds new load data that does not already exist, replaces existing actuals and targets with new values from the load, retains all existing records not in the load data.</td>
</tr>
<tr>
<td></td>
<td>• Add new, increment actual/target. Adds new load data that does not already exist, increments existing actuals and targets with new values from the load, retains all existing records not in the load data. Useful for transaction-based data loaded on a rolling basis.</td>
</tr>
<tr>
<td></td>
<td>• Add new, replace act/targ, delete old. Adds new load data that does not already exist, replaces existing actuals and targets with new values from the load, deletes all existing records not in the load data.</td>
</tr>
<tr>
<td></td>
<td>• Add new, increment act/targ, delete old. Adds new load data that does not already exist, increments existing actuals and targets with new values from the load, deletes all existing records not in the load data. Useful for a trickle-feed approach to loading data.</td>
</tr>
<tr>
<td>On Error</td>
<td>Select one of the following options from the drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>• Nothing loaded if any mismatches. PMF searches for mismatches on dimensions and does not load any data if there are any errors.</td>
</tr>
<tr>
<td></td>
<td>• Bypass errors, load good measures. PMF searches for mismatches on dimensions and does not load any mismatched data.</td>
</tr>
<tr>
<td></td>
<td>• Load everything, including mismatches. PMF searches for mismatches on dimensions and loads all data regardless of whether there are any errors or not.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Allows you to select a source table or Master File for the dimension, or you can use this to select sample data you want to view.</td>
</tr>
</tbody>
</table>
Limit display

Type in a number of records. This does not affect loading, only the display of sample data. It improves performance of the Load Wizard. You can leave it at the default (100 records) unless you need to see a deeper data range.

**Reference:** Manage Tab - Measure Loader Fields (Dimensions View)

**Note:** This will be deprecated in a future release.

The following table lists and describes fields that are specific to the Dimensions view in the Measure Loader.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case sensitive compare</td>
<td>This option is checked by default. When this option is checked, if there is a mismatch on the dimensionality, it will be flagged as an error in the Measure Loader report. When this option is not checked, PMF uppercases everything before comparing the dimensionality.</td>
</tr>
<tr>
<td>Dimension</td>
<td>Lists the type of dimension.</td>
</tr>
<tr>
<td>Aggregation at Level</td>
<td>Lets you select the appropriate level of aggregation for the associated dimension.</td>
</tr>
<tr>
<td>Join from Key Field</td>
<td>Joins a key field from the measures source table with the associated dimension source table. If there is a field in the measures source table with the same name as the key field in the dimension source table, PMF automatically selects that field as the Join from Key Field. If this is not the correct join field, use this Join from Key Field drop-down menu to select another field. This option is only available if the Separate table option is selected from the Table Type drop-down menu in the Dimension Loader.</td>
</tr>
</tbody>
</table>

**Reference:** Manage Tab - Measure Loader Fields (Field Maps View)

**Note:** This will be deprecated in a future release.
The following table lists and describes the fields in the Field Maps view in the Measure Loader.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Procedure</td>
<td>Available only if Custom coding is selected as the Source Type. Select a procedure from the drop-down menu. This is the procedure that contains the defined fields you can use when you load the measure from the source data. The define procedure contains fields mapped to the ACTUAL, TARGET, and THRESHOLD series fields, as well as any component fields used in calculating these values, and any JOINs necessary to perform the calculations.</td>
</tr>
<tr>
<td>Date Mapping</td>
<td>If Field Mapping is selected as the Source Type, select one of the following Time dimensions from the drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- Measure Dt determines Time Dim</td>
</tr>
<tr>
<td></td>
<td>- Source data Contains Time Dim</td>
</tr>
</tbody>
</table>
If Field Mapping is selected as the Source Type, the following data metrics are displayed:

- **ACTUAL.** This is the value to be evaluated against the target.
- **BENCHMARK.** This is the value to be evaluated against the benchmark.
- **FORECAST.** This is the value to be evaluated against the forecast.
- **STRETCH.** This is the value to be evaluated against the stretch target.
- **TARGET.** This is the value of the goal for the related measure.

If *Measure Dt determines Time Dim* is selected as the Date Mapping option, the following date metric is also displayed:

- **MEASURE_DATE.** This is the date when a measure value is effective. The measure date can be used independently from the Time dimension, or it can be used to determine the Time dimension.

If you selected any of the discrete date options beginning with Time Dim, the following date metrics are displayed instead of MEASURE_DATE:

- **YEAR.** This is the year attribute of the date when a measure value is effective.
- **MONTH.** This is the month attribute of the date when a measure value is effective.

### Table: Measure Field Name

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure Field Name</td>
<td>If Field Mapping is selected as the Source Type, the following data metrics are displayed:</td>
</tr>
<tr>
<td></td>
<td>- <strong>ACTUAL.</strong> This is the value to be evaluated against the target.</td>
</tr>
<tr>
<td></td>
<td>- <strong>BENCHMARK.</strong> This is the value to be evaluated against the benchmark.</td>
</tr>
<tr>
<td></td>
<td>- <strong>FORECAST.</strong> This is the value to be evaluated against the forecast.</td>
</tr>
<tr>
<td></td>
<td>- <strong>STRETCH.</strong> This is the value to be evaluated against the stretch target.</td>
</tr>
<tr>
<td></td>
<td>- <strong>TARGET.</strong> This is the value of the goal for the related measure.</td>
</tr>
<tr>
<td>Source</td>
<td>Select one of the following from the drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Field.</strong> Activates the Field/Field Mapping Code drop-down menu where you will select a field.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Code.</strong> Displays an Edit button next to the Field/Field Mapping Code field where you will enter, and optionally edit, a filter code statement.</td>
</tr>
</tbody>
</table>
Field/Field Mapping Code

Description:

- Allows you to do one of the following:
  - If Field is selected in the Source drop-down menu, select a field from this Field/Field Mapping Code drop-down menu.
  - If Code is selected in the Source drop-down menu, enter code here. Field mapping code can span multiple lines, and this field can only display one line of code at a time.

To view, and optionally edit, multiple lines of code displayed at the top of the Measure Loader, click the Edit button. Click the OK button to save any changes, otherwise click the Cancel button.

Reference: Manage Tab - Measure Loader Fields (Filters View)

Note: This will be deprecated in a future release.

The following table lists and describes the fields and option buttons in the Filters view in the Measure Loader.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Filter Below</td>
<td>This button adds an additional filter level field below the filter currently selected with the option button to the left of the Filter Name.</td>
</tr>
<tr>
<td>Add Filter Above</td>
<td>This button adds an additional filter level field above the filter currently selected with the option button to the left of the Filter Name.</td>
</tr>
<tr>
<td>Drop Filter</td>
<td>This button deletes the filter level field currently selected with the option button to the left of the Filter Name.</td>
</tr>
<tr>
<td>Move Level Up</td>
<td>This button moves the filter level field currently selected up one level. Use the option button to the left of the Filter Name to select a filter to move.</td>
</tr>
<tr>
<td>Move Level Down</td>
<td>This button moves the filter level field currently selected down one level. Use the option button to the left of the Filter Name to select a filter to move.</td>
</tr>
<tr>
<td>Filter Name</td>
<td>Name for the filter. You can type a maximum of 50 characters.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Source      | Select one of the following from the drop-down menu:  
  - *Field*. Activates the Field/Field Mapping Code drop-down menu where you will select a field.  
  - *Code*. Displays an Edit button next to the Field/Field Mapping Code field where you will enter, and optionally edit, a filter code statement.                                                                                                                                                                                   |
| Field/Filter Code | Enables you to do one of the following:  
  - If you select *Field* in the Source drop-down menu, select a field from this Field/Filter Code drop-down menu.  
  - If you select *Code* in the Source drop-down menu, enter code here. Field mapping code can span multiple lines, and this field can only display one line of code at a time.  
    To view, and optionally edit, multiple lines of code displayed at the top of the Measure Loader, click the *Edit* button. Click the *OK* button to save any changes, otherwise click the *Cancel* button.                                                                                                     |
| Operator    | Select one of the following comparisons from the drop-down menu:  
  - *EQ* (equals)  
  - *NE* (does not equal)  
  - *LE* (less than or equal to)  
  - *LT* (less than)  
  - *GE* (greater than or equal to)  
  - *GT* (greater than)  
  - *LIKE*  
  - *NOT LIKE*                                                                                                                                                                                                                                        |
| Value       | Type a value in the field in single quotes (for example, '2001').                                                                                                                                                                                                                   |

**Reference:** Manage Tab - Measure Loader Options (All Views)

**Note:** This will be deprecated in a future release.
The following table lists and describes the option buttons available for all views in the Measure Loader (Dimensions tab, Field Maps tab, and Filters tab).

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix Code</td>
<td>This button opens a field box in which you can type FOCUS or SQL code that will run before the measure is loaded. Click OK to save the code or Cancel to close the field box without saving your changes. If the table you are using is DBA protected, you can type the command SET USER = user_DBA_ password before you select the source table. For example, the sample Century Corp data uses the password WEBFOCUS.</td>
</tr>
<tr>
<td>Formula</td>
<td>This button opens a field box in which you can enter a formula for the measure load. Click OK to save the formula or Cancel to close the field box without saving your changes.</td>
</tr>
<tr>
<td>Preview</td>
<td>This button runs and displays the Measure Loader report in the Data for tab of the Measure Loader. This report shows you how the load will be performed. For more information, see Interpreting the Measure Loader Report on page 420.</td>
</tr>
<tr>
<td>Save</td>
<td>This button saves metadata information for a measure.</td>
</tr>
<tr>
<td>Load</td>
<td>This button performs the measure load. Use this after you enter the appropriate information and make the proper selections in all of the required fields of the Dimensions, Field Maps, and Filters tabs. For more information, see Running a Measure Load on page 418.</td>
</tr>
<tr>
<td>Schedule</td>
<td>This button opens the measure load schedule panel, where you can schedule a one-time or recurring measure load. For more information, see Scheduling a Measure Load on page 419.</td>
</tr>
<tr>
<td>Sample Data</td>
<td>This button displays a report in a new browser window, showing sample data for the source table you selected in the Source Table drop-down menu. For more information, see Sample Data From Source Tables on page 353.</td>
</tr>
</tbody>
</table>

**Specifying Alternate Targets**

PMF enables you to specify multiple targets for comparison to your measure actuals. By default, you can use the alternate target types of Forecasts, Stretch Targets, and Benchmarks, which enable you to interface PMF with industry-standard benchmarking systems. This capability is extensible so you can define your own custom alternate target types.
With alternate target types, you can switch the compared target used on any PMF view by changing the Default Target Field on the Systems panel on the Settings menu, which you can access by clicking the Settings panel button in the Manage tab. You can also design analysis reports to show multiple indicators comparing multiple instances of alternate targets to your measure actuals.

Alternate targets are attached directly to your measures and can be loaded or entered by users. If you are working with a measure that is loaded from external data, the Measure Loader automatically detects the alternate targets defined in your system. The Field Maps tab in the Measure Loader automatically displays the alternate target fields so you can define how they will be loaded. For more information about the Measure Loader, see *How to Design a Simple Measure Load* on page 406.

To see an example of a report created with alternate targets, see *Running the Metrics Vertical Sort View* on page 92.

For more information about user-entered measures, see *Working with User-Entered Measures* on page 214.

For more information about alternate targets, see Forecasts, Stretch Targets, and Benchmarks in *Manage Tab - Measure Loader Fields (Field Maps View)* on page 411.

### Setting a Basis for Descending Measures

**How to:**

Configure Descending Measure Basis

PMF allows you to specify how Percent Reached should be calculated for descending measures with targets set at zero, or where misleading negative Percentages Reached values are shown.

**Note:** In previous versions of PMF, if there was a descending measure configured and that measure had a target of zero, or if the Actual of the descending measure was very far from the Target in the wrong direction, PMF would automatically calculate Percent Reached as 0% or display a very high negative Percent Reached.

Basis controls where you would have zero Percent Reached. The basis is the point you would exceed with your descending measure greater than which your Percent Reached would start moving into the negative. Any Actuals that were greater would show a negative Percent Reached, while any that were less will show a positive Percent Reached. Setting the Basis gives you control over how Percent Reached is calculated so you can see more reasonable Percent Reached values.

**Procedure:** How to Configure Descending Measure Basis

To configure the Basis for a descending measure:
1. In the Manage (or Author) tab, click the Measures panel button. Select the measure you wish to change.

The Edit Measure panel opens.

2. Select Use Basis Value from the Calculating % Reached drop-down menu. The panel expands and shows the Basis Value field box, as shown in the following image.

```
| Threshold/Flex Direction:       | Descending - Lower is better |
| Calculating % Reached:          | Use Basis Value              |
| Basis Value:                   | 12                           |
```

**Tip:** The Basis can be set by analyzing the extend of your Actuals. For example, if your Target is set to zero, the median of your Actual values is 12, and the extent is 30, you could choose 12 as it is the most typical, or median value. You could also do a Pareto analysis and decide that 80% of your measures should have positive Percent Reached values. Suppose a Pareto analysis indicates that 80% of your Actual value spread fell under 18. You could set the Basis to 18 so that any Actual values approaching upward to 18 were scaled down from 100% and any values exceeding it would be negative. If you never want to see a negative Percent Reached, you would set the Basis to the extent of your values. Any Actual values that are precisely at the Basis will show zero Percent Reached.

3. Click Save to save the changes.

**Running a Measure Load**

**In this section:**

Scheduling a Measure Load

**Note:** This will be deprecated in a future release.

After you have designed, tuned, and saved your measure load, you can load the data by clicking the Load button in the Measure Loader. A message appears, informing you that the measure you loaded is completed (for example, Successfully loaded (“Sales”)).
Scheduling a Measure Load

**How to:**
Schedule a Measure Load

You can automatically run a saved measure load during specified time intervals using ReportCaster.

**Procedure:** How to Schedule a Measure Load

1. In the Measure, click the **Schedule** button.
   The New Schedule panel opens.

   ![New Schedule Panel]

   **Note:** The New Schedule panel generates Interval, Start Date, and Start Time values based on the values you specified for the load. You can edit these values as needed.

2. You can change the Interval, Start Date, and Start Time values. You may be prompted for additional information, depending on the interval you select.

3. Optionally, enter a new Job description and then click **Save** to schedule the measure load.

For information on editing a saved schedule, see *General Tab - Schedules* on page 483.

Excluding a Measure Series From Access Security

**How to:**
Exclude a Measure Series From Access Security

**Note:** Excluding a measure series from access security will be deprecated in a future release.
Access security automatically applies to all measure series in the PMF system unless you exclude the series. To exclude a measure series from access security, see the following procedure.

Access security for ad hoc measure series created by the Scorecard Wizard or Measures Wizard is disabled when the series is created.

**Procedure:** How to Exclude a Measure Series From Access Security

1. Display the Edit Measures panel for the measure series to which security is applied.
2. Deselect the Access Security check box.
3. Click Save.

For more information on the Edit Measures panel, see How to Access and Save Measures on page 401.

**Interpreting the Measure Loader Report**

**Note:** This will be deprecated in a future release.

After you have designed the load for a measure (for example, Sales), click Preview to open the Data for: Sales window in which you can preview the Measure Loader report.

**Note:** You must select a Filter field for the first filter level in order to activate this option.

The following is an example of a Measure Loader report.
The Measure Loader report displays the hierarchy of dimension values to be loaded. The report compares data to be loaded to what is already loaded so you can tune measure loads. The report shows you the changes you will make when you load the new data.

Minus (-) signs appear next to records to indicate that the records will be deleted. Plus (+) signs appear next to records to indicate that the records will be added. If a record does not have a plus or a minus sign, it means that the record already exists for the measure. You can sort on the signs so that the records appear in ascending or descending order.

After you are finished tuning the measure load and are satisfied that the data to be loaded is correct, click Save to save the metadata. You cannot perform a new measure load unless the metadata has been saved. However, you can load an existing measure load provided no changes have been made since the last time it was run. If changes are made, save the load and then run it.

### Scheduling Measure Loads

In PMF 5.3.1 and earlier, you scheduled loads for each dimension and each measure, which resulted in a lot of scheduling and coordination. You had to know the data sources for each individual measure and make sure the external data from which you were loading was ready at the time each measure was scheduled. This meant you had to keep track of all these external sources, and when they got refreshed, make sure your measures always had the most recent data.

As of PMF 5.3.2, you do not need to schedule measure loads if you are using the new measure data acquisition model. The model controls scheduling in a manner that is closer to the point from which data is harvested. Measures are linked from sources, to datapoints, through the recalculation model. PMF keeps track of when data is refreshed. Schedules are only created to specify the times at which your external sources are refreshed. PMF does the rest automatically.

Currently, both the old and new models are supported. As PMF 5.3.2 moves through its hotfix cycle, legacy measures will be converted to new measures. At that point, legacy schedules will no longer be appropriate, and will return an error and schedules will need to be recreated.
Previewing Loadable Sources and Load Measure Data

To preview a load, click the Preview tab. If a Preview is already displayed, click the Refresh button to refresh the preview, as shown in the following image.

The Preview tab is a speculative function, since a load or measure action has not yet been performed. You can use this tab to determine what would happen if one of these actions were initiated.

In the Preview tab, PMF displays data rows that will be added, updated, or deleted to either the loadable datapoints in the source or the measure. Each loadable datapoint specified in the loadable source is displayed as a column, while the dimensional intersections to be loaded are displayed as headings on the rows.

PMF splits the information for loadable data that will be new, updated, and deleted into separate sections of the Preview tab. While using the Preview tab:

- You can sort the contents of each column by clicking the column headings. The arrow next to the column heading tells you the direct of the sort.
- You can click a row or column to highlight it for closer examination.
- You can resize the columns of the Preview by dragging the column borders in the headings.

If you see unexpected results for any loadable datapoint in the source, double-check the settings you configured on the Managed Datapoints and Dimension Links tabs.
Managing Content

In this section:
Creating a Custom Category
Mapping Parameters to an Operational Report

How to:
Add Content by Linking to a WebFOCUS Procedure
Add Content by Linking to a Website
Add Existing Content to Analytics Tab Categories
Add an Operational Report as Content
Link Content to Scorecards
Convert a Saved View Into a Today Page

Content management enables you to create pointers to the following:

- PMF views.
- WebFOCUS procedures that can be used in the PMF viewing panels (Today and Analysis).
- Web-available content.

PMF has several predefined categories for administrator-distributed content, including Administration, Analysis, Audit, CPM/BPM Practice, History, Measures Detail, Objective, Perspective, Projects & Processes, Saved, and Today. You can categorize content to control where it appears on the Analytics tab for an administrator, or on the Document List of the Action gadget for a user.

You can also create up to 10 custom categories for the content that you manage.

Parameter sets saved from the Analysis Designer are also stored as content under the Saved category. Content contains references to stored procedure names and, for Saved views, stores blocks of parameters and controls how PMF distributes and manages these views.

When creating access to content, make sure to click the Preview button. If the content pointed to is valid, PMF launches that content in a new window. This is a good way to test the content before making it available to administrators in the Analytics tab or users in the Document List.

For details about the fields and options available in the New Content and Edit Content panels, see General Tab - Content on page 487.
**Procedure:** How to Add Content by Linking to a WebFOCUS Procedure

1. In the Manage tab, click the **Content** panel button.
2. Click **New**.
   
The New Content panel opens, as shown in the following image.

3. In the Name field, type the name of the content you wish to create.
4. Select **WebFOCUS Procedure** from the Content Type drop-down menu.
5. From the Content drop-down menu, select the name of the WebFOCUS procedure for the view that you want to add.
6. Select the check box for each category from which the procedure can be accessed.

   On the Analytics tab, an administrator will see the category in the Type drop-down menu. When the administrator clicks that category, the description that you specified for the procedure will be displayed in the View drop-down menu.
A user accesses the content of a selected category through the Document List of the Action gadget.

7. Optionally, create one or more custom categories from which administrators and users can access the WebFOCUS procedure. To create a custom category:
   a. Left-click a User Type field, type a name for the custom category, and press Enter.
   b. Select the check box next to the new custom category to associate the content with it.

   For more information and an example of a selected custom category, see Creating a Custom Category on page 430.

8. Make any other changes in the New Content panel as needed.
   For more information about the fields in the New Content panel, see General Tab - Content on page 487.

9. Click Save to save the specified access to the content.

**Procedure:** How to Add Content by Linking to a Website

1. In the Manage tab, click the Content panel button.

2. Click New.
   The New Content panel opens.

3. Select Web Site from the Content Type drop-down menu.

4. In the URL field, type the exact URL to the web content that you want to add.
   **Note:** The URL field is named Parameters before you select the Web Page check box.

5. Type a name for the web content in the Name field.

6. Select the check box for each category from which the web content can be accessed.
   On the Analytics tab, an administrator will see the category in the Type drop-down menu. When the administrator clicks that category, the description of the web content that you specified in this procedure will be displayed in the View drop-down menu.
   A user accesses the content of a selected category through the Document List of the Action gadget.

7. Optionally, create one or more custom categories from which administrators and users can access the web content. To create a custom category:
   a. Left-click a User Type field, type a name for the custom category, and press Enter.
b. Select the check box next to the new custom category to associate the content with it.

For more information and an example of a selected custom category, see *Creating a Custom Category* on page 430.

8. Make any other changes in the New Content panel as needed.

For more information about the fields in the New Content panel, see *General Tab - Content* on page 487.

9. Click Save to save the specified access to the content.

**Procedure: How to Add Existing Content to Analytics Tab Categories**

You can add existing content to categories on the Analytics tab.

1. In the Manage tab, click the *Content* panel button.

2. Navigate to the Content tree, expand the desired folder, and select the content that you want to add to categories on the Analytics tab.

   The Edit Content panel opens.

3. Select one or more of the following check boxes for the categories from which the content can be accessed.

   - Administration
   - Analysis
   - Audit
   - CPM/BPM Practice
   - History
   - Measures Detail
   - Objective
   - Perspective
   - Projects & Processes
   - Saved
   - Today

4. Optionally, create one or more custom categories from which administrators and users can access the content. To create a new custom category:
Left-click a User Type field, type a name for the custom category, and press Enter.

Select the check box next to the new custom category to associate the content with it.

For more information and an example of a selected custom category, see Creating a Custom Category on page 430.

5. Click Save to save the specified access to the content.

To verify, navigate to the Type drop-down menu on the Analytics tab, and click one of the categories that you selected previously on the Edit Content panel. The content that you added in this procedure appears in the View drop-down menu. Repeat for each selected category.

**Procedure: How to Add an Operational Report as Content**

You can add an operational report as content and link it to any measure, objective, project, or process defined in PMF. Doing this makes the operational report available through the Operational Report option when you click the measure, objective, project, or process in any PMF view.

1. You must first link the desired operational report to one or more categories shown in the following list. To do this, see How to Add Existing Content to Analytics Tab Categories on page 426.
   - Measures Detail. To link the operational report to a measure.
   - Objective. To link the operational report to an objective.
   - Projects & Processes. To link the operational report to a project or process.

2. Navigate to the Author tab and click the Measures, Objectives, Projects, or Processes panel button.

3. Select the desired measure, objective, project, or process.


5. Click Save to save the specified access to the content.

To verify, click the desired measure, objective, project, or process in any PMF view and select the Operational Report option. The operational report that you specified in this procedure is displayed in a new window.
**Procedure: How to Link Content to Scorecards**

You can link any content, including Reports and Dashboards, to specific Scorecards. This allows the content to only be displayed when that Scorecard is selected to be displayed.

When you create new content, such as creating a Dashboard or linking a WebFOCUS report, it is automatically linked to all Scorecards. When you create a Scorecard, how content is linked to it depends on how it was created. For example:

- If you create a top-level Scorecard, with no parents, the new Scorecard is automatically linked to all Content in the system.
- If you create a child-level Scorecard, with a parent, the new Scorecard is automatically linked to the same content as its parents.

To link content to a Scorecard:

1. In the Manage tab, click the **Content** panel button.
2. Navigate to the Content tree, expand the desired folder, and select the content that you want to link to a Scorecard.
   
   The Edit Content panel opens.
3. Select the Scorecards that you want linked to this content. Deselect any Scorecard that you do not want linked to this content.
4. Click **Save**.

**Procedure: How to Convert a Saved View Into a Today Page**

1. In the Analytics tab, select **Analysis** in the Type drop-down menu.
2. Select **Analysis Designer** in the View drop-down menu.
3. Click **Run**.
The following image shows the Analysis Designer.

4. Specify parameter values and optionally run the view to display the results.

5. Type a Report Name for the view and click Save to save the view and its specified parameter values as content.

6. Navigate to the Manage tab and click the Content panel button.

7. Navigate to the Content tree, expand the desired folder, and select the content that you saved.
   
   The Edit Content panel opens.

8. Select the Today check box.

   Edit the other fields and options as needed. For more information about the fields in the Edit Content panel, see General Tab - Content on page 487.

9. Click Save.

   The content is now available as a Today page and can be assigned to specific users.
Creating a Custom Category

**How to:**
Create a Custom Category

You can create up to 10 custom categories for the content that you manage. Administrators can see the custom categories and their associated content on the Analytics tab. Users can see the custom categories and the content on their Dashboard in the Document List, which is accessed through the Action gadget.

**Procedure: How to Create a Custom Category**

In this procedure, you will create a custom category and associate content with it, using the New Content panel.

You can also create a custom category using the Edit Content panel. For instructions, see *How to Add Existing Content to Analytics Tab Categories* on page 426.

1. In the Manage tab, click the Content panel button.

2. Click New.

   The New Content panel opens. The User Type fields enable you to create custom categories for the content that you manage.

3. Left-click a User Type field, type a name for the custom category, and select the Save icon next to the field.

4. Click the check box next to the new custom category to associate content with it.

5. In the applicable fields, supply the information for the content that will be associated with the custom category.

6. If applicable, select the check box for each additional category from which users can access the content.

7. Make any other changes to the New Content panel as needed.

   For more information about the fields on the New Content panel, see *General Tab - Content* on page 487.

8. Click Save to save the specified access to the content.

   As an administrator, you can see the custom category in the Type drop-down menu, and the associated content in the View drop-down menu, on the Analytics tab.
Mapping Parameters to an Operational Report

You can drill to any WebFOCUS operational report from a PMF view by mapping PMF parameters.

PMF automatically passes the following information from drill-down contexts:

<table>
<thead>
<tr>
<th>Property</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard Name</td>
<td>&amp;SCORECARD_NAME</td>
</tr>
<tr>
<td>Scorecard ID</td>
<td>&amp;SCORECARD</td>
</tr>
<tr>
<td>Perspective Name</td>
<td>&amp;PERSPECTIVE_NAME</td>
</tr>
<tr>
<td>Perspective ID</td>
<td>&amp;PERSPECTIVE</td>
</tr>
<tr>
<td>Measure Name</td>
<td>&amp;MEASURE_NAME</td>
</tr>
<tr>
<td>Measure ID</td>
<td>&amp;MEASURE_SERIES</td>
</tr>
<tr>
<td>Dimensional values</td>
<td>&amp;[dimension name]_LEVEL[level #]_VALUE</td>
</tr>
</tbody>
</table>

To use these parameters in your operational reports, you may need to map the parameters passed from PMF to the parameters used in your report.

For example, suppose you have an operational report that displays outage data for all regions and warehouses, and you would like to drill out to this report from a PMF view and pass the region and warehouse information to select the proper filters in the operational report. You already have WHERE clauses embedded in the operational report to filter by the REGION and WAREHOUSE fields in your operational data. The operational report is already set up to receive the &REGN parameter for the region and the &WHOUSE parameter for the warehouse.

In PMF, you already store information about your warehouse locations in a location dimension, which has Region as Level 1 and Warehouse as Level 2. You select a PMF view and drill to a particular warehouse location. Next, you click a measure and select the Operational Report option. You want PMF to filter the designated operational report for just the warehouse displayed in the current PMF view.

You need to edit your operational report using WebFOCUS code, Developer Studio, or a GUI, such as Power Painter. Start by adding -DEFAULT commands at the top of the report as follows:

```
-DEFAULT &LOCATION_LEVEL01_VALUE = ' ';
-DEFAULT &LOCATION_LEVEL02_VALUE = ' ';
```
Next, add a utility program and parameters to the top of the report to allow it to receive the parameter values from PMF as follows:

-SET &DIM_NAME = 'LOCATION';
-SET &DIM_VALUE = &LOCATION;
-INCLUDE gadg_dim_parms

The first -SET command provides the dimension name for the utility program to use for outbound parameters. The second -SET passes a fully qualified internal dimension filter value to the utility program.

Finish by mapping the fields to your variables as follows:

-SET &REGN = IF &LOCATION_LEVEL01_VALUE NE ' ' THEN TRUNCATE(&LOCATION_LEVEL01_VALUE);
-SET &WHOUSE = IF &LOCATION_LEVEL02_VALUE NE ' ' THEN TRUNCATE(&LOCATION_LEVEL02_VALUE);

Note: The WebFOCUS TRUNCATE function is used in the preceding code to remove the trailing spaces that are automatically added to all parameters being passed out of PMF.

The following is an example of an operational report that was mapped to PMF parameters, saved as content, and made available in the Analytics tab.

Note: You can use the logic described in this topic to pass parameters from the PMF gadget layer to an operational report. As a result, you can place the operational report on a PMF dashboard as a gadget. For more information, see Turning a WebFOCUS Report Into a Gadget on page 467.
Working with Snapshots

PMF includes a snapshot and restore feature. Taking a snapshot serializes the entire content of the PMF data mart to a set of files in a folder located on your server file system. These files can then be restored to another data mart on any platform or RDBMS that PMF supports.

A Snapshot or Template captures an entire PMF Data Mart. This includes all Scorecards and their components, all pooled Metrics, all Content links, any saved content references (including Analysis Designer views), Gadgets, and any Dashboards you have designed.

You can use Snapshots to:

- Make a copy of your PMF data mart for use in another installed copy of PMF.
- Transfer the PMF data mart from the source RDBMS to the target when moving your RDBMS system from one to another.
- Preserve temporary or permanent work while you work on something else.

Snapshot Manager lets you more easily work with Snapshots, and automates many functions that used to require manual work. You no longer have to manually copy and move Snapshots from one location to another by accessing the various server file systems. With Snapshot Manager, you can easily move a Snapshot from one PMF environment to another.

**Note:** If you are moving Snapshots from one environment to another, note the following:

- Both the source environment and the target environments need to have a fully-working copy of PMF installed.
- If the versions of PMF between environments do not match, newer copies of PMF can restore older Snapshots, but older ones cannot see newer-versioned Snapshots.
Common Tasks in Snapshot Manager

How to:
Take a Snapshot
Restore a Snapshot
Download a Snapshot
Upload a Snapshot

To access the Snapshot Manager, click the Manage tab and then click the Data Mart subtab. Then, click Manage Snapshots.

The Manage Snapshots panel opens, as shown in the following image.

From the Snapshot Manager, you can:

- **Take a Snapshot.** Copies all content from the PMF Data Mart into a portable file, which can be restored on any PMF environment.

- **Restore a Snapshot.** Replaces all content in the current PMF Data Mart with the exact state of the Snapshot when it was taken.

- **Restore a Template.** Replaces all content in the current PMF Data Mart with the exact state of a distributed Solution Template from IB or another vendor.

- **Upload a Snapshot.** Lets you move a Snapshot in compressed (ZIP) format stored in a file-accessible location to a new PMF environment.
- **Download a Snapshot.** Lets you obtain a Snapshot file in compressed (ZIP) format from a PMF environment and copy it to a folder on a file-accessible machine, from which it can be uploaded in the future.

- **Merge a Snapshot.** Lets you incorporate the exact state of a Snapshot into your existing PMF Data Mart, allowing you to add objects from multiple Snapshots together. This feature is in Beta.

**Procedure: How to Take a Snapshot**

When you Take a Snapshot, all content from the PMF Data Mart is copied into a portable file, which can later be Restored to any PMF environment (including the same one).

To take a snapshot:

1. From the Manage Snapshot pane, Click *Take Snapshot*.
   
The Take Snapshot dialog box opens.

2. Enter a name for the snapshot, or select the text box if you want to use and overwrite a previous snapshot, as shown in the following image.

   ![Take Snapshot Dialog](image)

**Tips:**

- As you type, if a previous and similar name was used, the dialog will display a list of matches, and you can click one of these matches if you want to replace it.

- Only alphanumeric characters are accepted since this will become a folder and file name. Any spaces or special characters will be edited out.

3. Click *Take*. The Snapshot Manager creates the snapshot. Once it is complete, it will appear in the list on the User Snapshots tab.
**Procedure: How to Restore a Snapshot**

When you restore a Snapshot, all content in the current PMF Data Mart is replaced with the exact state of the Snapshot you select, at the time it was taken. Restoring Snapshots let you preserve the exact state of PMF, including all models, data and content. Snapshots are good for:

- PMF Data Mart backups.
- Situations where you want to experiment or create new models and want to be able to preserve them.
- Moving a PMF Data Mart to a new PMF environment.

To restore a snapshot:

1. From the Manage Snapshot pane, click the Restore button next to the snapshot you want to restore, as shown in the following image.

The Restore Snapshot dialog box opens, as shown in the following image.

2. Click Restore. Snapshot Manager will restore the snapshot and notify you when the process is complete.

   **Note:** Depending on the size of the metrics warehouse in the snapshot, a restore can take some time.

3. Refresh the browser once the process is complete.
**Procedure: How to Download a Snapshot**

You can download a Snapshot to your browser Downloads folder. This lets you upload it to another compatible PMF environment, where it can be restored at will.

To download a snapshot:

1. From the Manage Snapshot pane, click the Download button next to the snapshot you want to download, as shown in the following image.

   ![Download Button](image)

   Snapshot Manager compresses the Snapshot to a single ZIP file, and downloads it to your browser Downloads folder.

   You can now upload the Snapshot to another PMF environment, either now or at a future time.

   **Note:** If you periodically clean up your browser Downloads folder, and accidentally delete the Snapshot ZIP file, return to the PMF environment with the Snapshot you want, and download it again.

**Procedure: How to Upload a Snapshot**

You can upload a Snapshot from your browser Downloads folder to any compatible PMF environment. Any uploaded Snapshots are stored in the PMF environment, and can be Restored at any future time.

To upload a snapshot:

1. From the Manage Snapshot pane, click the Upload a Snapshot button.

   The Upload Snapshot dialog box opens, as shown in the following image.

   ![Upload Snapshot Dialog](image)

2. Click Choose File to select the file to be uploaded.
Working with Snapshots

Your browser Downloads folder opens.

3. Click the compressed (ZIP) PMF Snapshot you want to upload and click Open.

   **Note:** The dialog box varies depending on your local operating system.

4. The file name is shown in the Upload Snapshot dialog box. Click *Upload*.

Snapshot Manager uploads the file to the PMF environment. The snapshot then appears in the Users Snapshots tab, where you can restore it at will. For more information on restoring snapshots, see *How to Restore a Snapshot* on page 436.

Working with Templates

**How to:**

- Restore a Template

PMF ships with a set of pre-defined Templates that represent complete PMF Data Marts for various vertical and horizontal business cases, which you can restore to your PMF environment. You can restore these Templates at any time.

**Note:**

- When you restore a Template, you will wipe out any existing content in the currently-configured PMF Data Mart. If you want to preserve anything in your PMF environment, make sure to take a Snapshot so it can be restored again.

- The list of available Templates can increase from release to release, so your list might have more items than is shown in these examples.

**Procedure:** How to Restore a Template

To restore a template:

1. From the Manage Snapshots pane, click the *Templates* tab.
A list of available templates is displayed, as shown in the following image.

2. Find the template you want to restore, and click the Restore button next to it. The Restore Snapshot dialog box opens.

3. Click Restore. Snapshot Manager will restore the template and notify you when the process is complete.

   **Note:** Depending on the size of the metrics warehouse in the template, a restore can take some time.

4. Refresh the browser once the process is complete.
Administration Views

In this section:
Description of the Administration Views
How to:
Run an Administration View

The following topics describe the administration views available in the Analytics tab. Administration views provide general documentation on the internal system capabilities of PMF. Those who maintain the PMF system can run them to query and display all components in the data mart. Administration views will help you when you perform compliance analysis of the PMF system or diagnostic functions against the data mart.

Sorting options allow you to select and arrange the content as desired. You can also save the parameters for a request for future use.

Procedure: How to Run an Administration View
To run an administration view:

1. Log on as a user or administrator.
2. In the Analytics tab, select Administration from the Type drop-down menu. The available views are displayed in the drop-down menu.
3. To display the options for a view, select it from the drop-down menu and click Run.
4. Enter the content options as prompted.
5. Select the output option: Browser, PDF, or Excel.

The Reset button returns all options to their default value.
The following sample panel shows the default content and output options for the Dimension Data view.

6. Click *Run* to run the view with the chosen content and output options.
Description of the Administration Views

In this section:

- Dimension Data
- Dimension Data Level Breakout
- Dimensions Load
- Dimensions Metadata
- Launch Pages
- Load Analysis
- Load History
- Loads: To Do?
- Measures Load
- Measures Metadata
- Metrics Load Requirements
- Owner Information
- Scorecard
- Theme Information
- Units of Measure Information

This topic lists each administration view and describes its content.
Dimension Data

The Dimension Data view displays, in sorted order, actual data values for the levels in a selected dimension or all dimensions.

For example, the following CenturyCorp Card PDF view includes data for the dimension levels in the Product dimension.

![Dimension Data Table]

<table>
<thead>
<tr>
<th>Region</th>
<th>Plant</th>
<th>Store</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAST</td>
<td>BOS</td>
<td>792</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>793</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>794</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>795</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>796</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>797</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>798</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>799</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>800</td>
</tr>
<tr>
<td></td>
<td>BOS</td>
<td>801</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>802</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>803</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>804</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>805</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>806</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>807</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>808</td>
</tr>
<tr>
<td>MIDWEST</td>
<td>STL</td>
<td>809</td>
</tr>
<tr>
<td>SOUTH</td>
<td>DAL</td>
<td>810</td>
</tr>
<tr>
<td>SOUTH</td>
<td>DAL</td>
<td>811</td>
</tr>
<tr>
<td>SOUTH</td>
<td>DAL</td>
<td>812</td>
</tr>
<tr>
<td>SOUTH</td>
<td>DAL</td>
<td>813</td>
</tr>
<tr>
<td>SOUTH</td>
<td>DAL</td>
<td>814</td>
</tr>
</tbody>
</table>
**Dimension Data Level Breakout**

The Dimension Data Level Breakout view displays, in sorted order, actual data values for a selected dimension or all dimensions, broken out level by level to show all linkable keys in the system.

For example, you can run a CenturyCorp Card PDF view that includes data for the three dimension levels in the Product dimension. The following images show the data broken out for each dimension level on three pages.

![Dimension Data - Level Breakout](image1)

**Dimensions Load**

The Dimensions Load view displays data that controls how a dimension is loaded, as stored in the PMF data mart. You can select a single dimension or all dimensions.
It includes information, such as the name, type, and key of the dimension source table and the server on which it resides. It also includes the dimension source prefix code, the dimension levels, and their names and type, and if applicable, the DEFINE source code for a dimension level.

The following is a sample PDF Dimensions Load view for the Product dimension. It applies to the CenturyCorp Card.

**Dimensions Metadata**

The Dimensions Metadata view displays control information in the PMF data mart for a selected dimension or all dimensions.

It includes information, such as the setting of the Time dimension flag (Yes or No), the levels in the dimension, and the abbreviation of a dimension level name if applicable. The Y or N value in the Display For Lower column determines which levels of the Time dimension are displayed.

The following is a sample PDF Dimensions Metadata view for the Location dimension. It applies to the CenturyCorp Card.
Launch Pages

The Launch Pages view is a view of WebFOCUS reports, other reports, and websites linked from PMF. It displays information about a selected type of view in PMF, or about all types. Examples of types include Today, saved, analysis, perspective, objective, measure, audit, and administration.

It includes information, such as the name of the launch page associated with each available view, and the parameters that are passed if applicable.

The following is sample PDF output on the administration views for the CenturyCorp Card.

<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>a_5_line</td>
<td>Measures - Rolling 5 Periods (Obsolete)</td>
<td>Analysis, Perspective, Objective, Measure</td>
<td></td>
</tr>
<tr>
<td>a_layout</td>
<td>Stop Light (Obsolete)</td>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>todmeas</td>
<td>Measures - Previous vs. Current (Obsolete)</td>
<td>Analysis, Perspective, Objective, Measure</td>
<td></td>
</tr>
<tr>
<td>pmr_form</td>
<td>Analyst Designer</td>
<td>Analysis, Perspective, Objective, Measure</td>
<td></td>
</tr>
<tr>
<td>pmr_matrix</td>
<td>Scorecard Matrix</td>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>turnoverl</td>
<td>HR Staff Turnover</td>
<td>Objective, Measure, Analysis</td>
<td></td>
</tr>
<tr>
<td>pmr_booklet</td>
<td>HR Booklet</td>
<td>Today, Analysis</td>
<td></td>
</tr>
<tr>
<td>qao_form</td>
<td>Quality Output</td>
<td>Analysis, Perspective, Objective, Measure, Today, Analyse</td>
<td></td>
</tr>
<tr>
<td>mst_rst_form</td>
<td>Measures History</td>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>pmr_pwi_impact01</td>
<td>Project Impact</td>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>pmr_pwi_summary01</td>
<td>Project Summary</td>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>pmr_pwi_summary01</td>
<td>Process Summary</td>
<td>Analysis</td>
<td></td>
</tr>
<tr>
<td>strategy</td>
<td>Strategy Map</td>
<td>Today, Analysis</td>
<td></td>
</tr>
<tr>
<td>correlate</td>
<td>Correlation</td>
<td>Analysis, Objective, Measure, Today, Analyse</td>
<td></td>
</tr>
<tr>
<td>admin_rst_owner</td>
<td>Owner Information</td>
<td>Administration, Analysis</td>
<td></td>
</tr>
<tr>
<td>admin_rst_unit</td>
<td>Units of Measure Information</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
<tr>
<td>admin_rst_launch</td>
<td>Launch Pages</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
<tr>
<td>admin_rst_mees</td>
<td>Measures Metadata</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
<tr>
<td>admin_rst_mea_load</td>
<td>Measures Load</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
<tr>
<td>admin_rst_dim_meta</td>
<td>Dimensions Metadata</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
<tr>
<td>admin_rst_dim_load</td>
<td>Dimensions Load</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
<tr>
<td>admin_rst_scorecard</td>
<td>Scorecard Report</td>
<td>Administration, AdminStr</td>
<td></td>
</tr>
</tbody>
</table>

Load Analysis

Load Analysis shows the current data path capability, for example, can it be loaded, recalculated or copied, of sources, generated and derived datapoints, and measures.
The following example shows the Load Analysis report for all measures.

![Load Analysis](image)

**Load History**

The Load History view shows a detailed log, sorted by date, of all data done in PMF. It also shows a log status for each item.

**Loads: To Do?**

The Loads: To Do view shows which dimensions, sources, generated and derived datapoints, and measures have been loaded to date, and which have not. This is useful as a checklist of data processing that needs to be done.

The following example shows the Loads: To Do report for all dimensions.

![Loads: To Do](image)
**Measures Load**

The Measures Load view displays data that controls how measures are loaded, as stored in the PMF data mart. It includes calculations that PMF performs to define the actuals and targets of your metrics information. You can display data about a selected measure or about all measures.

In the Measures Load Report Options panel, you select the values for the content. In the following example, the measure is Ship, the Objective is Shipping costs down 5 Pct, the Perspective is All, and the Scorecard is CenturyCorp Card.

The view displays load information about the requested measure, including the name and type of the measure source table and the server on which it resides, the setting of the measure load error flag and store history flag, the measure load prefix code, the dimension order and dimension names, and mapping and filtering information.

**Measures Metadata**

The Measures Metadata view displays control information in the PMF data mart for a selected measure or all measures.
It includes information, such as the measure aggregation type (linear, percent, ratio, or change of percent), the setting for the fix target flag, and the threshold flex direction and type.

The following is a sample PDF Measures Metadata view for the Defects measure for the Improve Product Quality objective, for the Internal Process perspective. It applies to the CenturyCorp Card.

![Measures Metadata Table](image)

### Metrics Load Requirements

The Metrics Load Requirements view displays load requirements for the selected metric, including table name, source, and datapoint.

The following example shows the Metrics Load Requirement for four measures.

![Metrics Load Requirements Table](image)

### Owner Information

The Owner Information view displays information about PMF owners and their user preferences. Owners are sorted by Owner ID, Group Name, Name, Scorecard, or Owner Status. Information that might compromise security is not shown.
The following is the first page of a sample PDF Owner Information view for the CenturyCorp Card, sorted by Owner ID.

An owner information view includes the following columns:

- **Owner Id.** The ID of the owner.
- **Group.** The name of the group with which the owner is associated.
- **Name.** The name of the owner.
- **Status.** The letter A means the owner is active.
- **Scorecard.** The name of the scorecard.
- **Launch Page.** The name of the view shown on the Today page by default.
- **Email.** The email address of the owner.
- **Flags.** Managed Reporting access flags.

### Scorecard

The Scorecard view is a summary of the scorecard information in the PMF data mart, showing perspectives and objectives, with drill downs. It includes information about a selected perspective, or all perspectives, optionally sorted by objective weight or perspective weight. It applies to a selected scorecard or to all scorecards.
The following is a sample PDF Scorecard view for the Financial perspective, sorted by objective weight. It applies to the CenturyCorp Card.

**Theme Information**

Theme Information lists the themes in your strategies and displays the color key, the creation date and time, and the description.

The following is a sample of Theme Information.

**Units of Measure Information**

Units of Measure Information is a catalog of the units of measure defined in the PMF data mart. It displays information about the units of measure set up by the administrator for use in PMF. A unit of measure controls the format of the data displayed.

The view includes information, such as the name of the unit of measure, the default display format, the symbol, the unit ID, and a description.
You can sort units of measure information by Unit Name or Unit Symbol. The following partial view is sorted by Unit Name.

<table>
<thead>
<tr>
<th>Name</th>
<th>Default Display Format</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acres</td>
<td>D12</td>
<td>ac.</td>
<td>24 Acres</td>
</tr>
<tr>
<td>Barrels</td>
<td>D12</td>
<td>bls.</td>
<td>36 Barrels</td>
</tr>
<tr>
<td>Calls</td>
<td>D12</td>
<td>calls</td>
<td>46 Calls</td>
</tr>
<tr>
<td>Centimeters</td>
<td>D12</td>
<td>cm.</td>
<td>57</td>
</tr>
<tr>
<td>Claims</td>
<td>D12</td>
<td>cls.</td>
<td>6 Claims</td>
</tr>
<tr>
<td>Containers</td>
<td>D12</td>
<td>cnts.</td>
<td>31 Containers</td>
</tr>
<tr>
<td>Count</td>
<td>D12</td>
<td>Cnt</td>
<td>51 Counts of people, places, or things</td>
</tr>
<tr>
<td>Cubic Centimeters</td>
<td>D12</td>
<td>cc</td>
<td>65</td>
</tr>
<tr>
<td>Cubic Feet</td>
<td>D12</td>
<td>cu ft.</td>
<td>63</td>
</tr>
<tr>
<td>Cubic Inches</td>
<td>D12</td>
<td>cu in.</td>
<td>62</td>
</tr>
<tr>
<td>Cubic Meters</td>
<td>D12</td>
<td>cu m.</td>
<td>66</td>
</tr>
<tr>
<td>Cubic Yards</td>
<td>D12</td>
<td>cu yds</td>
<td>64</td>
</tr>
<tr>
<td>Cups</td>
<td>D12</td>
<td>c.</td>
<td>37 Cups</td>
</tr>
<tr>
<td>Customers</td>
<td>D12</td>
<td>Cust</td>
<td>52 Counts of Customers</td>
</tr>
<tr>
<td>Days</td>
<td>D12</td>
<td>Days</td>
<td>50 Used for measuring duration of events and aging processes</td>
</tr>
</tbody>
</table>
Designing Gadgets

**In this section:**
Designing a Gadget Procedure
Creating a Gadget
Creating Gadgets With WebFOCUS InfoAssist
Creating Gadgets Using an Analysis Designer Template
Saving Managed Reporting Content as a Gadget
Adding Various Content Types as Gadgets
Custom Parameters for Gadgets
Broadcast Capability for All Grid Gadgets
Turning a WebFOCUS Report Into a Gadget

**Reference:**
Designing a Gadget Procedure
Gadget Display Fields
Gadget Grouping
Gadget Filtering

Gadgets are mini-graphs and data grids that display multiple metrics and can be placed together to create complex dashboard pages. Each gadget is designed to perform a specific type of business analysis, such as zoom or compare analysis. You can configure a gadget to display specific data for specific users, and PMF stores user preferences and applies them to each page. Users can select and save various parameters determined by the gadget author to personalize the gadgets on their pages at runtime.

To utilize gadgets in your PMF dashboard pages, you can select from the gadgets already available in PMF or create your own gadgets. When you create a new gadget, you also have to create a gadget. Overviews of all aspects of gadget design and implementation are provided in the sections that follow. For information about the forms used to design gadgets in PMF, see *General Tab - Dashboards* on page 484.

**Designing a Gadget Procedure**

To design a new gadget, you must first create a gadget procedure, which is usually a WebFOCUS reporting or graph procedure that reports on data from the PMF data mart. (Gadgets can also be designed to extract and report on data from other sources.) All gadget procedures must have a name that begins with a *gadget_* prefix.
When using a new or existing WebFOCUS report or graph procedure for a gadget, you can utilize standard WebFOCUS parameter names. There are three types of parameters gadgets can process: display fields, groupings, and filters.

**Reference: Gadget Display Fields**

Display fields, similar to PRINT or SUM fields in a WebFOCUS request, determine the data fields displayed in the gadget using parameters that indicate whether to display or hide these fields, or to use these fields as data feeds for a graph.

Each display field has the following three possible settings:

- **Not used.** The field is not available to be displayed in the gadget.
- **Optional.** The field, or the result of the field, can be displayed in the gadget if the user chooses to display it.
- **Required.** The field, or the result of the field, must be displayed in the gadget.

The display fields you can choose to include in a gadget are listed and described in the following table:

<table>
<thead>
<tr>
<th>Display Field</th>
<th>What it Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>Actual measure value (raw data).</td>
</tr>
<tr>
<td>Target</td>
<td>Target measure value (raw data).</td>
</tr>
<tr>
<td>Pct_Reached</td>
<td>Percent reached for actual/target measures.</td>
</tr>
<tr>
<td>Pct_Used</td>
<td>Cumulative percent spent for project budget measures.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Cumulative percent completed for project schedule measures.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Dashboard symbol that indicates the status of a measure, objective, or perspective. For:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Measures.</strong> Shows the Pct_Reached to be within or outside set tolerances.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Objectives.</strong> Shows the cumulative, weighted Pct_Reached for all linked measures to be within or outside set tolerances.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Perspectives.</strong> Shows the cumulative, weighted Pct_Reached for all linked measures and objectives to be within or outside set tolerances.</td>
</tr>
</tbody>
</table>

454 Information Builders
<table>
<thead>
<tr>
<th>Display Field</th>
<th>What it Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator + Actual</td>
<td>Combines the actual value with the indicator.</td>
</tr>
<tr>
<td>Indicator + Target</td>
<td>Combines the target value with the indicator.</td>
</tr>
<tr>
<td>Indicator + Pct_Reached</td>
<td>Combines the percent reached value with the indicator.</td>
</tr>
<tr>
<td>Indicator + Pct_Used</td>
<td>Combines the actual measure value with the indicator.</td>
</tr>
<tr>
<td>Indicator + Actual + Pct_Reached</td>
<td>Combines the actual and percent reached values with the indicator.</td>
</tr>
<tr>
<td>Indicator + Target + Pct_Reached</td>
<td>Combines the target and percent reached values with the indicator.</td>
</tr>
<tr>
<td>High-Mid-Low: raw count totals</td>
<td>Shows a raw count of the total number of measures in High (Green), Mid (Yellow), and Low (Red) status for the selected grouping and filtering.</td>
</tr>
<tr>
<td>High-Mid-Low: percentages of totals</td>
<td>Shows a percentage of the total number of measures in High (Green), Mid (Yellow), and Low (Red) status for the selected grouping and filtering.</td>
</tr>
</tbody>
</table>

**Reference:** **Gadget Grouping**

Grouping involves both sorting and aggregating data values. Selected detail values are sorted using the classifications built into the group, then aggregated at the level implied by the sort.

Many sort groupings are affected by other groupings selected above them. For example, if you select to group by perspective first, and then by objective, the resulting gadget shows measure level details, the measure results are grouped first by perspective and then by objectives within each perspective, and the aggregations occur at the objective level. For each gadget, you can select up to three groupings.

Each grouping has the following two possible settings:

- **Optional.** The gadget can use the grouping, and the gadget instance can include a default value for the grouping.

- **Required.** The gadget must use the grouping, and a value must be specified for the grouping. Note that the default setting from the gadget instance is used, and users can optionally change the default.
The groupings you can choose to include in a gadget are listed and described in the following table:

<table>
<thead>
<tr>
<th>Grouping Method</th>
<th>What it Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perspectives</td>
<td>Sorts results alphabetically by perspective name and aggregates field values at that level.</td>
</tr>
<tr>
<td>Objectives</td>
<td>Sorts results alphabetically by objective name and aggregates field values at that level.</td>
</tr>
<tr>
<td>Measures</td>
<td>Sorts results alphabetically by measure name and aggregates field values at that level.</td>
</tr>
<tr>
<td>User Specified Dimension</td>
<td>Sorts results alphabetically by level values within the dimension specified by the user and aggregates field values at that level. User specified dimension drill-downs are continuous by level, using a second drill-down on an individual value within a dimension to show data at the next dimension level.</td>
</tr>
<tr>
<td>Time</td>
<td>Sorts results alphabetically by level values within the time dimension and aggregates field values at that level. Time dimension drill-downs are continuous by level, using a second drill-down on an individual value within a time dimension to show data at the next time level, down to the lowest level.</td>
</tr>
</tbody>
</table>

**Reference: Gadget Filtering**

Gadget filters limit the displayed results to the values a user selects. For example, if a user specified the financial perspective as a filter, the results displayed would be limited to only the details linked to the financial perspective. For each gadget, you can specify up to five different filtering methods.

Each filter has the following two possible settings:

- **Optional.** The gadget can use the filter, and the gadget instance can include a default value for the filter.

- **Required.** The gadget must use the filter, and a value must be specified for the filter. Note that the default setting from the gadget instance is used, and users can optionally change the default.
The filters you can choose to include in a gadget are listed and described in the following table:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Limits the Output to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>The default scorecard for the gadget. Enables users to select a default scorecard to display in the gadget. If not selected, the default selection is the default scorecard of the user.</td>
</tr>
<tr>
<td>Perspective</td>
<td>The default perspective for the gadget. Enables users to select a default perspective to display in the gadget. If not selected, the default selection is the PMF default perspective.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires selection of the Scorecard filter.</td>
</tr>
<tr>
<td>Objective</td>
<td>The default objective for the gadget. Enables users to select a default objective to display in the gadget.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires selection of the Scorecard filter.</td>
</tr>
<tr>
<td>Measure Series</td>
<td>The default measure series for the gadget. Enables users to select a default measure series to display in the gadget.</td>
</tr>
<tr>
<td>User Specified Dimension</td>
<td>The default level value for the gadget, for a selected dimension. Enables users to select a default dimension to display in the gadget.</td>
</tr>
<tr>
<td>Time</td>
<td>The default point in the time dimension for the gadget. Enables users to select a default time dimension value to display in the gadget.</td>
</tr>
<tr>
<td>Red and Yellow Indicators only</td>
<td>Only retrieve and display measure values, objectives, or perspectives, where the result is a very low or moderately low (red or yellow) condition. This filter blocks out any measure values with a high (green) condition.</td>
</tr>
<tr>
<td>Red indicators only</td>
<td>Only retrieve and display measure values, objectives, or perspectives, where the result is a very low (red) condition. This filter blocks out any measure values with a high (green) or moderately low (yellow) condition.</td>
</tr>
</tbody>
</table>
Creating a Gadget

For PMF to call a procedure and store parameters locally for a gadget, you must first create a gadget. The gadget enables PMF to manage the gadget. A gadget defines the input parameters for the gadget and controls how the parameters are saved for each user. The class also controls the parameters that each instance of the gadget can store and recall.

Procedure: How to Create a Gadget

Before creating a gadget, add all new gadget procedures to the WebFOCUS pmfgadgets application folder.

1. In the Manage tab in PMF, click the Dashboards panel button.

2. Click New Gadget.

PMF displays the New Gadget Designer panel. The following image shows the panel, with sample values in the fields.

3. In the Name field, enter a descriptive name for the new gadget.

4. From the Content Type drop-down menu, click the option that applies to the gadget. For details on the choices, see Adding Various Content Types as Gadgets on page 462.

5. From the Content Display drop-down menu, click the option that applies to the gadget.
For example, if the Content Type is PMF gadget focexec, the Content Display drop-down menu contains the names of all FOCEXECs that begin with gadget_ and are in the WebFOCUS pmfgadgets application folder.

6. From the Scorecard filters drop-down menu, click one of the following options.

- **Use Current Scorecard**, to apply the scorecard that is currently associated with this gadget.
- **Scorecard not used**, to suppress the use of any scorecard with this gadget.

7. In the Width and Height fields, type the values, in pixels, that determine the placement of the gadget.

For a graph that is coded according to the standard gadget specification, the width and height that you type here is dynamically passed to the gadget at run time to determine the actual width and height of the output of the graph.

8. From the Preview image drop-down menu, click the name of the .png file that supplies the preview image for the gadget.

The preview image appears on the Catalog chevron in Dashboard Designer. If you do not supply a preview image of your own, you can use the default preview image, preview_na.png.

9. Select the **Receive Broadcasts** or **Enable Moonbeam** check boxes to enable these features for the new gadget.

10. In the Description field, optionally type a brief description of the gadget.

11. From the available Display, Groupings, and Filters fields, select the applicable options for the new gadget.

12. Click **Save** when you have finished creating the gadget.

PMF displays a message saying the new gadget has been added. The Gadget Definitions navigation tree on the left is refreshed to display the new gadget.

**Creating Gadgets With WebFOCUS InfoAssist**

WebFOCUS InfoAssist can be used to develop new operational gadgets that display information from your operational data sources. A new property defines your custom-developed content as a PMF gadget, and allows you to optionally prompt to filter your content using PMF dimensions. For more information on how to use this, see the *WebFOCUS InfoAssist User’s Manual*. 
**Creating Gadgets Using an Analysis Designer Template**

**How to:**

Build a New Gadget From an Existing PMF Template

PMF allows you to use existing Analysis Designer templates to create Gadgets. These Gadgets can display grids with indicators that show PMF metrics, strategic objectives, or themes dimensionally. Each data item in the grid contains drill downs to other related PMF content, and provides the same feedback, alerting, and task capabilities as pre-built content in PMF.

**Procedure:**  **How to Build a New Gadget From an Existing PMF Template**

1. In the Manage tab, click the *Dashboards* panel button.
2. Click *New Gadget*.
   
The New Gadget Designer panel opens.
3. Enter a name for the gadget.
4. Select *PMF Gadget focexec* from the Content Type drop-down menu.
5. Select one of the nine standard Analysis Designer templates from the Content Display drop-down menu. The templates are:

<table>
<thead>
<tr>
<th>Template</th>
<th>Content Display value to choose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metrics Across Dimension</td>
<td>pmf_rpt_tmplt_meas_vert</td>
</tr>
<tr>
<td>Metrics Crosstab</td>
<td>pmf_rpt_tmplt_meas_acrdim</td>
</tr>
<tr>
<td>Metrics Vertical Sort</td>
<td>pmf_rpt_tmplt_meas_crsstab</td>
</tr>
<tr>
<td>Objectives Vertical Sort</td>
<td>pmf_rpt_tmplt_obj_vert</td>
</tr>
<tr>
<td>Objectives Across Dimension</td>
<td>pmf_rpt_tmplt_obj_acrdim</td>
</tr>
<tr>
<td>Objectives Crosstab</td>
<td>pmf_rpt_tmplt_obj_crsstab</td>
</tr>
</tbody>
</table>
6. Use the Display, Grouping, and Filters fields to set up your Gadget properties.
   - The selections you make in the Display area will control what object data the Gadget will display. The object can be Metric(s), Objective(s), or Theme(s) depending on the template that was selected.
   - The selections you make in the Filters and Grouping areas will control what filters and groupings the Gadget will expect to collect. These will be automatically configured when the Gadget is dropped onto a Dashboard design.
   - When you select a Grouping, the sort direction arrows control whether the grouping is applied as a Horizontal or Vertical sort. The Across Dimension templates require at least a horizontal sort to be defined.

7. Click Preview. PMF will run the Gadget and display a preview. The auto-selection routine will be run and defaults for the display will be chosen based on the data available for the currently selected Scorecard.
   - **Note:** If you are working with your own data mart and Scorecard, and that Scorecard does not have loaded measure data yet, PMF will display an error message.

8. Click Save. The Gadget can now be used on the Dashboard.
   - **Note:** This procedure can also be done by selecting New Gadget from the Dashboard Designer Catalog.

**Saving Managed Reporting Content as a Gadget**

**How to:**

Save Managed Reporting Content as a Gadget From Within PMF

Gadgets can be defined based on standard reports in your Managed Reporting repository. This can be done from within PMF or from within the WebFOCUS MR environment, which is typically from within BID.

- **Note:** MR Save as Gadget integration in WebFOCUS BID requires WebFOCUS 7.7.1 or higher.
**Procedure: How to Save Managed Reporting Content as a Gadget From Within PMF**

Saving Managed Reporting content as a gadget will make it available from within PMF to use on features, such as Dashboards. MR content can be given parameters from PMF, such as dimensional filters or sorts, and can optionally receive Broadcasts on a PMF Dashboard.

1. In the Manage tab, click the *Dashboards* panel button.
2. Click *New Gadget*.
   
   The New Gadget Designer panel opens.

3. Enter information for the gadget name and its other properties. For more information on these properties, see *Creating a Gadget* on page 458.

   **Note:** If you want to pass parameters to the MR Standard Report, make sure you have added code to your report to enable it to receive PMF parameters. For more information, see *Mapping Parameters to an Operational Report* on page 431.

4. From the Content Type drop-down menu, select *MR Report*. A MR Domain drop-down menu will become available, which lists all of the MR Domains.

5. Select the MR Domain where your Standard Report is stored. PMF will list the Standard Reports that are stored in that MR Domain in the Content Display drop-down menu.

6. Select the MR Standard Report that will become the gadget. Click *Save*.

**Adding Various Content Types as Gadgets**

The PMF Dashboard capability allows you to directly add several types of content as gadgets. These types include:

- Web applications (for example, Google, Wiki, or other web widgets)
- Adobe® Flex® SWF objects

  **Note:** These are deprecated.

- General WebFOCUS FOEXEC content
When creating a gadget, or editing a gadget, you can select the content type from a drop-down menu on the New Gadget Designer panel or the Edit Gadget Designer panel, as shown in the following image.

<table>
<thead>
<tr>
<th>Content Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMF Gadget focexec</td>
<td>Default. Allows you to select from any FOCEXEC in your environment with gadget_ as the starting characters in the name. Typically, these are PMF gadgets. Since most of the shipped FOCEXEC gadgets are already registered in PMF, you would typically need to use this option only if you have created a custom gadget and want to register it with the system.</td>
</tr>
<tr>
<td>Adobe Flex control</td>
<td>Allows you to select from any SWF file that you have installed in any application in your application path. PMF does not search the mainstreet, pmfdata, or pmf[rdms] app folders. <strong>Tip:</strong> If WebFOCUS is installed in a split-tier configuration, the SWF files must be installed in the same app folder on both the WebFOCUS Client and WebFOCUS server machines.</td>
</tr>
<tr>
<td>WebFOCUS report</td>
<td>Allows you to select from any FOCEXEC in your environment. Typically, you would select this option to gadgetize any existing WebFOCUS report. This allows you to pass standard PMF parameters to the report. For more information on how to receive and use those parameters, see <em>Mapping Parameters to an Operational Report</em> on page 431.</td>
</tr>
<tr>
<td>MR report</td>
<td>Allows you to integrate Managed Reporting content into PMF. Typically, you would select this option to gadgetize an existing WebFOCUS Managed Reporting report. This capability allows you to pass standard PMF parameters to the report. For more information on how to receive and use those parameters, see <em>Mapping Parameters to an Operational Report</em> on page 431.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Web Page</td>
<td>Allows you to specify any external web application that you want to include as a gadget. You can type the entire URL for the application, including any parameters, in the URL field.</td>
</tr>
</tbody>
</table>

Once you have specified the type of gadget that you are registering, you can configure the passing of parameters, as appropriate to the gadget, as detailed in *Designing Gadgets* on page 453.

### Custom Parameters for Gadgets

**How to:**

Set Up a Custom Parameter for a Gadget

WebFOCUS parameters can be passed to your Gadgets, allowing you to configure components for inclusion from any external system without needing to code a procedure. This essentially causes PMF to pass the WebFOCUS amper variables to any Gadget, every time that Gadget is added to a Dashboard.

**Procedure:** **How to Set Up a Custom Parameter for a Gadget**

1. In the Manage tab, click the Dashboards panel button.
2. Expand the *Gadget Definitions* folder.
3. To set the custom parameters, choose the Gadget from the list.
   
   The Edit Gadget Designer panel opens.
4. Click the *Custom Parameters* button.

   The Custom Parameter panel opens, as shown in the following image.
5. Enter a parameter name in the Name column, and its value in the Value column. Each time you add a new entry, the panel adds another row for another entry. You can enter as many parameters as you need.

6. Click OK to save the parameters.

**Tip:** To see the parameters that have been set for a Gadget, hover over the Custom Parameters button, as shown in the following image.

---

**Broadcast Capability for All Grid Gadgets**

**How to:**

Add the Broadcast Property to a Gadget

Any standard Grid Gadget in PMF is fully broadcast-capable within any PMF Dashboard. As you drill on any of the Grid Gadgets in PMF, Dimensional and Object parameters can automatically be sent to the rest of the Dashboard, so a drill down on any Grid can also automatically drill on all the Chart Gadgets on your Dashboards.

Drill broadcasting on Grid Gadgets works in the following ways:

- Drilling on a data cell showing Value, Pct Reached, and so on, broadcasts all of the specifics of that intersection (dimension/measure or objective).
- Drilling on a vertical or across sort broadcasts the dimensional specifics.
- Drilling on an object name broadcasts the object name.

**Note:** Enabling broadcasting on any Grid Gadget requires adding a single custom parameter to the Gadgets you want to have this ability.

**Procedure:** How to Add the Broadcast Property to a Gadget

From the Manage tab:

1. Click the **Dashboards** panel button.
2. Select the Grid Gadget you want to edit from the Gadget Definitions folder.
The Edit Gadget Designer panel opens, as shown in the following image.

3. Click Custom Parameters. The Custom Parameters panel opens.
4. In the Name field, enter GRID_BROADCAST. Set the Value to Y.
5. Click OK.
6. Select the Reset Dashboard Defaults and the Remove User Preferences check boxes.
7. Click Save. PMF saves the changes to the Gadget and overwrites all instances where the Gadget is used on Dashboards, while adding the new parameter.

Once the parameter has been added, the Gadget will be able to Broadcast Object and Dimensional information to any Dashboard. To make sure other Gadgets “listen” to the Broadcast, you need to configure Broadcast for the Dashboard. For more information on setting up Broadcast, see Setting Up Broadcast on a Dashboard on page 147.
Turning a WebFOCUS Report Into a Gadget

You can turn any WebFOCUS report into a gadget. Once you do that, you can place the content of the report on a dashboard that you design.

You can also configure metric and dimensional parameters (preferences) in order to pass them from a PMF dashboard to a WebFOCUS report. You can then use those parameters in sorting, filtering, and other content display activities. When you turn a WebFOCUS report into a gadget, you must identify which parameters need to be passed from the dashboard to the report.

You must also make sure that the report can detect, receive, and process those parameters. For more information on how to modify a report to handle parameters, see Mapping Parameters to an Operational Report on page 431.

Procedure: How to Turn a WebFOCUS Report Into a Gadget

1. In the Manage tab in PMF, click the Dashboards panel button.
2. Click New Gadget.
   The New Gadget Designer panel opens.
3. In the Name field, type a name for your new gadget.
   Tip: You might want to use the default title of the WebFOCUS report.
4. From the Content Type drop-down menu, click WebFOCUS report.
5. From the Content Display drop-down menu, click the name of the WebFOCUS report (the FOCEXEC) that you want to turn into a gadget.
6. From the Groupings and Filters drop-down menus, supply values for the parameters that you would like PMF to pass to the WebFOCUS report.
7. Click Save to save the WebFOCUS report as a gadget.

Once you have created a gadget from a WebFOCUS report, you can drop the gadget onto any dashboard. From the dashboard, you can set default preferences for the new gadget for use in the selection and display of data.
The new gadget can also participate in Broadcast, as any other gadget can. For an example that shows how to create a gadget from a WebFOCUS report and work with it on a dashboard, see the following example.

**Example:** Turning the WebFOCUS Outages Report Into a Gadget

This example uses a WebFOCUS report named process_orders_outages. The report requires one parameter, a value for the Location dimension.

The report is supplied with your product software.

This example has four parts.

- Create the gadget.
- Add the gadget to a dashboard and set preferences. You will use Dashboard Designer for this task. For full information on Dashboard Designer, see *Designing a Dashboard* on page 478.
- Configure the gadget for Broadcast. For full information on Broadcast, see *What is Broadcast?* on page 147 and *Setting Up Broadcast on a Dashboard* on page 147.
- Preview the live dashboard.

**Create the Gadget**

1. In the Manage tab, click the **Dashboards** panel button.
2. Click **New Gadget**.

   The New Gadget Designer panel opens.

3. In the Name field, type **Outages in Ordering Process**.

   Outages in Ordering Process is the default title of the WebFOCUS report.

4. From the Content Type drop-down menu, click **WebFOCUS report**.
5. From the Content Display drop-down menu, click **process_orders_outages**. That is the name of the WebFOCUS report (the FOCEXEC) that you want to turn into a gadget.
6. Select **User Specified Dimension** from the Select a filter drop-down menu under Filters. Keep the associated default value, Required, for this filter.
7. Click **Save** to save the WebFOCUS report as a gadget.

**Add the Gadget to a Dashboard and Set Preferences**

In this procedure, you will add the new gadget to a dashboard and set preferences for it. To implement Broadcast using the new gadget, you will add a second gadget to the dashboard. The second gadget, Utility - Dimension Tree, enables you to select a data value for Location. The selected value is broadcast to the first gadget and reflected in the report.
1. In the Manage tab in PMF, click the Dashboards panel button.

2. Click New.

The Dashboard Designer opens.

3. Click the Properties chevron on the right.

4. In the Dashboard Name field, type WebFOCUS Outages as the name of the new dashboard.

5. In the Description field, type This sample dashboard displays the Outages in Ordering Process report, which participates in Broadcast.

The following image shows the Properties chevron, with supplied values in the Dashboard Name and Description fields.

6. Click the Properties chevron to close it.

7. Click the Catalog chevron to display a list of registered gadgets.

8. Use the scroll bar directly to the right of the Catalog chevron to locate your new gadget, Outages in Ordering Process.

In the following image, the Outages in Ordering Process gadget is the first one in the partial list that is displayed.
**Tip:** In the Catalog, a default preview is used if you do not provide a preview of your own. The following image shows the default preview for the Outages in Ordering Process gadget. For instructions on providing your own preview, see the *Performance Management Framework Developer Guide*.

9. Drag and drop the *Outages in Ordering Process* gadget onto the design canvas.

10. Move the cursor inside the title bar of the gadget. Using the move symbol, position the gadget in the upper left corner of the dashboard.

11. To save the work that you have done so far on the dashboard, click Save on the ribbon.

12. Click anywhere inside the gadget to re-display its title bar.

13. To confirm the default preferences for the gadget, click the *Preferences* button on the title bar.

14. Under Filters on the Preferences panel, confirm that *Location* is selected in the field on the left.

15. Confirm that *EAST* is selected in the Dtl field.

16. On the Preferences panel, click Save.
17. On the Catalog chevron, use the scroll bar to locate the gadget named *Utility - Dimension Tree*, and drag and drop that gadget onto the design canvas.

18. Using the move symbol in the title bar, position the gadget in the upper right corner of the dashboard. You can close the Catalog chevron.

19. To save the work that you have done so far on the dashboard, click *Save* on the ribbon. Your dashboard will look similar to the one in the following image.

20. Click anywhere inside the Utility - Dimension Tree gadget to re-display its title bar.

21. To set the default references for the Utility - Dimension Tree gadget, click the *Preferences* button on the title bar.

22. Under Filters on the Preferences panel, confirm that *Location* is selected in the field on the left.

23. From the Dtl drop-down menu on the right, click *Select a Filter*. With this setting, the Utility - Dimension Tree gadget will display all possible values from which the user can choose at run time.

24. On the Preferences panel, click *Save*.

**Configure the Gadget for Broadcast**

1. With your two gadgets positioned on the dashboard, click the *Broadcast* chevron.

2. Since you want to broadcast the value of a dimension (Location), click *Dimensions only* from the Broadcast drop-down menu.

3. With the Broadcast chevron still open, click the *Outages in Ordering Process* gadget on the design canvas.

   The gadget is highlighted to indicate that it participates in Broadcast.
Do not highlight the Utility - Dimension Tree gadget for Broadcast. That utility gadget is designed to work correctly with the report.

4. Click Set on the Broadcast chevron to close the chevron and save the Broadcast properties.

The following image shows the Broadcast chevron with the specified property, Dimensions only. On the design canvas, the Outages in Ordering Process gadget is highlighted.

5. On the ribbon, click Save to save the dashboard.

**Preview the Live Dashboard**

1. On the ribbon, click Live.
2. In the Dimensions tree, expand the **Location** node, as shown in the following image.

![Dimensions tree expanded](image)

3. In the Dimensions tree, click the **MIDWEST** node to select it.

   The Outages in Order Processing report is automatically refreshed. PMF replaces the data values for the **EAST** (the default setting) with the data values for the **MIDWEST** (the Broadcast setting).

   In the following image, MIDWEST was selected in the Dimensions tree, and is reflected in the report.

![Outages in Ordering Process](image)
**Exporting a Gadget**

**How to:**

Export a Gadget

You can export an information gadget to a standardized file. This capability enables you to:

- Share a gadget with other PMF sites.
- Develop a gadget with third-party software and share that gadget with other PMF sites.
- Treat a gadget as a component that you can import and register on any WebFOCUS server that is running PMF. For more information on registering a gadget, see *Registering a Gadget* on page 476.

**Procedure: How to Export a Gadget**

Before you export a Gadget, make sure to test it and ensure that it is working properly in your environment. If the Gadget uses a FOCEXEC, you should note any executable dependencies for the FOCEXEC other than the main FOCEXEC so that you can copy these files manually into the new environment to make sure the Gadget works after it is registered in a new environment. Likewise, if the Gadget is a custom developed applet or SWF, make sure any non-SWF dependencies for these programs are likewise noted so that you can make sure the Gadget works after it is registered in a new environment.

1. In the Manage tab in PMF, click the **Dashboards** panel button.

2. In the navigation tree on the left, expand the **Gadget Definitions** folder to locate the name of the gadget that you want to export.

3. Click the name of the gadget.
   
   The Edit Gadget Designer panel opens.

4. If required, modify any field values on the panel. The values reflect the properties that will be saved with the exported file.

   For details on the fields on the Edit Gadget Designer panel, see *Creating a Gadget* on page 458. For details on the type of content that you can export, see *Adding Various Content Types as Gadgets* on page 462.

5. Click **Export** when you have supplied all the values as desired.
6. Supply the information needed to create the Export file, as shown in the following image.

![Export file creation interface]

7. Complete the fields on the Export panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gadget creation date</td>
<td>Date the Gadget was originally created.</td>
</tr>
<tr>
<td>Gadget revision version</td>
<td>Version number for the gadget. Type a number in the field.</td>
</tr>
<tr>
<td>Gadget revision date</td>
<td>Date on which the gadget was last revised. Type a date, or accept the system-supplied date, which is the current date.</td>
</tr>
<tr>
<td>Gadget author name</td>
<td>ID of the creator of the gadget. Click a value from the drop-down menu, or accept the default value. The default value is the ID of the person who was logged on to PMF when the gadget was created.</td>
</tr>
<tr>
<td>Minimum supported PMX version</td>
<td>Earliest PMF version that supports the content type for the gadget. Type a version number, or accept the system-supplied number.</td>
</tr>
</tbody>
</table>
**Designing Gadgets**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview image</td>
<td>Name of the .png file that supplies the preview image for the gadget. The preview image appears on the Catalog chevron in Dashboard Designer. Click the name of the .png file from the drop-down menu. PMF displays the selected preview image below the field. Preview images for Gadgets are stored in the [approot]\pmfgadgets\thumbs folder. If you do not see an appropriate Preview image for your gadget in this folder, you should create one using an image capture program. Gadget Preview files should be in PNG format, with a recommended size of no larger than 160px x 160px. If you do not want to create a new Gadget Preview file, you can use the default preview file name, preview_na.png, for a generic Preview.</td>
</tr>
</tbody>
</table>

8. After you have supplied the values on the panel, click *Export*. You are returned to the Edit Gadget Designer panel.

Gadget Export files have a .GDG file extension, contain no spaces or non-alphanumeric characters in the name, are generally all lowercase, and are placed in the [approot]\pmfgadgets\pmf_import_export folder on your server. After you export a Gadget to a file, you can move a copy of the export file to your PC by clicking the link in the confirmation message. You can later download the file by navigating to the approot for your server and looking in the [approot]\pmfgadgets\pmf_import_export folder on your server.

**Registering a Gadget**

**How to:**

Register a Gadget

You can register a gadget on any WebFOCUS server that is running PMF. With this capability, you can add third-party gadgets to a PMF dashboard without the need for additional PMF development work. For example, you can add an iGoogle™ gadget (a personalized Google page) or Yahoo gadget to a dashboard, or your own web 2.0 mini-application.
As part of the registration process, you will import the file that contains the gadget. Before you can import a Gadget, you must copy the .GDG file to the \[approot]\pmfgadgets\pmf_import_export folder on your WebFOCUS server. This can be a .GDG file you exported previously and are migrating to a new server, or a .GDG file you obtained from Information Builders or another developer.

A registered gadget appears in the list of gadgets on the Catalog chevron in Dashboard Designer.

**Procedure: How to Register a Gadget**

When you Register a HTML5 or FOCEXEC-based Gadget, the main executable file is automatically binary-copied from the export (.GDG) file into the \[approot]\pmfgadgets folder on your server. Note that web type Gadgets are only URIs pointing to an executable resource on a web server. No files need to be copied for this type of Gadget.

1. In the Manage tab in PMF, click the **Dashboards** panel button.
2. Click **New Gadget**.
   
   The New Gadget Designer panel opens.
3. Click **Register**.
   
   PMF displays the properties and the Preview graphic for the Gadget export file you selected.
4. Complete the fields on the Register panel, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gadget Import File</td>
<td>Select a Gadget to Register.</td>
</tr>
<tr>
<td>If file or definition exists</td>
<td>From the drop-down menu, click the action that you want PMF to take if the gadget has already been registered. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>❑ Replace it with this one</td>
</tr>
<tr>
<td></td>
<td>❑ Add it as a new one anyway</td>
</tr>
<tr>
<td></td>
<td>❑ Cancel registration</td>
</tr>
</tbody>
</table>

5. Once your Gadget has been registered, the Gadget Editor panel displays all the properties for the Gadget. The registered gadget appears in the list of gadgets on the Catalog chevron in Dashboard Designer.

**Important:** Since HTML5-based Gadgets are web-deployed, if you are running WebFOCUS in a two-tier environment, after Registering a HTML5 Gadget, you should make sure to copy the resulting SWF file from the [approot]\pmfgadgets folder on your WebFOCUS server machine to the [approot]\pmfgadgets folder on your WebFOCUS client machine.

**Designing a Dashboard**

**In this section:**

Designing a Dashboard for Mobile Content

A dashboard combines one or more gadgets placed together on a single interface that users can access as a PMF dashboard page.

The PMF design-time dashboard interface is called Dashboard Designer. Dashboard Designer enables you to add gadgets to a design canvas and preview them in run-time mode, to create a presentation-ready page for your users. For more information on how to use the Dashboard Designer, see *Dashboard Designer* on page 129.

If you enable Broadcast for a dashboard, run-time changes that a user makes to one gadget on the dashboard are applied to multiple gadgets on the dashboard. As an administrator, you can add a gadget to, or remove a gadget from, a Broadcast group with a few clicks of your mouse. For more information on Broadcast, see *What is Broadcast?* on page 147.
The following image shows a sample dashboard in Dashboard Designer.

Designing a Dashboard for Mobile Content

PMF automatically adapts any content designed for a PC-based browser system to work on any iOS device. No extra steps need to be taken when designing a dashboard.

Manage Tab - Quick Reference

In this section:
Manage Tab Components

The Manage tab gives you the ability to administer the PMF application.
Manage Tab Components

Reference:
- General Tab - Dimensions
- General Tab - Measures
- General Tab - Schedules
- General Tab - Owners
- General Tab - Functional Roles
- General Tab - Scorecard Security
- General Tab - Access Roles
- General Tab - Dashboards
- General Tab - Content
- General Tab - Units of Measure
- General Tab - Time Ranges
- General Tab - Settings
- General Tab - About PMF
- Data Mart Tab - Load Now
- Data Mart Tab - Manage Snapshot

The Manage tab provides components that Administrators can access to manage dimensions, sources, fields, measures, schedules, owners, functional roles, scorecard security, access roles, dashboards (gadgets), content, units of measure, time ranges, and system settings.
The following image shows the Manage tab.

On the Manage tab, you (the administrator) can manage metadata for the following components:

- **Dimensions.** Enables you to create new dimensions and access the Dimension Loader to load dimensions.

- **Measures.** Enables you to create and modify measures metadata, which controls the measure series. Each measure series is a distinct measure that you can link to an objective in a PMF scorecard. You can also load measures with the measure loader.

- **Schedules.** Enables you to schedule load-related activity.
 Owners. Enables you to add new system users, make existing users active or inactive, and modify the start tab (Today tab) for each user.

Functional Roles. Enables you to create and modify functional roles to control the level of access to all of the systems in PMF for all users assigned to a functional role. The default roles in PMF are Admin w Access Security, Administrator, Analyst, Author, Consumer, and Planner.

Scorecard Security. Enables you to control scorecard user access. You can control which scorecards each user can access, and also determine which users have access to a specific scorecard. Access levels include no access, viewer, editor, and administrator.

Access Roles. Enables you to create and modify access roles to control the level of access to measures and dimensions for all users assigned to an access role.

Dashboards. Enables you to design types of gadgets (classes), create and modify individual gadgets, and add gadgets to dashboard pages. A gadget is usually a small graph or data grid.

Content. Enables you to select the specific content to be displayed on the Today tab for each user. A variety of content can be available in the application. This component also enables you to create up to 10 custom categories for the content that you manage.

Units of Measure. Enables you to create and modify units of measure, which determine the types of actual quantities being measured in PMF. Each measure is linked to a unit of measure.

Time Ranges. Enables you to create and modify time ranges, which can be used wherever trending data appears in views throughout PMF.

Settings. Enables you to set system and default settings, such as organization name, corporate logo, style sheet, indicator set, Today date, and more.

About PMF. Displays the version and release dates.

Reference: General Tab - Dimensions

The Dimensions panel button provides access to the dimensions and measures loaders. These tools are fully integrated into your Administration view. Unlike most systems, in which the creation of the underlying data used for analysis is performed using a separate tool, the loaders enable you to perform data loads right in the context of the framework. After a load is complete, you can immediately switch to a data-bearing view and test the new measures you have loaded right in the system.

For details on the Dimension Loader, see Designing a Simple Dimension Load on page 354.
**Reference: General Tab - Measures**

The Measures panel button provides access to all aspects of working with measures. You can access the Edit Measures panel. The Edit Measures panel controls the measure and its connected rows of values, which you can optionally link to an objective. For details on the fields and buttons in the Edit Measures panel, see *How to Access and Save Measures* on page 401.

You can also access the Measure Loader panel. The Measure Loader panel enables you to load data for a selected measure by specifying the dimension key values, field maps, and filters. For details on the Measure Loader, see *How to Design a Simple Measure Load* on page 406.

**Reference: General Tab - Schedules**

The Edit Schedule panel enables you to edit or delete a saved schedule for a dimension or measure load. Schedules are created during the load process. For details on creating a schedule for a dimension load, see *Running and Scheduling a Dimension Load* on page 360. For details on creating a schedule for a measure load, see *Scheduling a Measure Load* on page 419.

To access the Edit Schedule panel, click the Schedules panel button and select a dimension or measure load schedule in the navigation tree.

You can change the job description and interval at which to run the load. You are prompted for information that applies to the selected interval. For example, you are prompted for the days of the month if you select a monthly interval.

Enter the value for time in 24-hour notation. For example, to schedule a load at 8:00 a.m., enter 0800.

**Reference: General Tab - Owners**

The Edit Owner panel enables you to edit the properties assigned to an owner. Owners are constituents who use PMF. They are known as owners because they own the responsibilities for measure records, projects, processes, objectives, and scorecards.

Note that each owner ID tends to exactly match a login ID used in the system. You cannot have an owner ID without a matching login ID because that user ID could never be validated for basic access to the PMF system.

The Owners record contains an optional password field. This field is designed to allow the Owners table to double as a basic authentication table in cases where the customer does not have an external security system. For example, the standard PMF demo uses the Owners table for this purpose.

To edit the properties assigned to an owner, click Owners in the Manage tab and expand the tree structure. Click the desired owner name to open the Edit Owner panel.
The same fields used to create an owner in the New Owner panel are used to edit owner properties in the Edit Owner panel. The only exception is the Owner ID field, which cannot be updated when editing the rest of the fields in the panel. For details on the fields in the New Owner and Edit Owner forms, see *Fields in the Owner Panels* on page 276.

**Reference: General Tab - Functional Roles**

The Edit Functional Role panel enables you to control the system-level functions each type of user is allowed to perform. As administrator, you can change the access allowed for the default roles that ship with PMF. You can also add and personalize as many roles as necessary for system maintenance.

For more information on setting access levels for functional roles, see *Access Levels for Functional Roles* on page 285. For details on creating a new functional role, see *How to Create a New Functional Role* on page 281.

**Reference: General Tab - Scorecard Security**

Provides access to the Edit Scorecard User Access forms, which enable you to control scorecard user access. You can control which scorecards each user can access, and also determine which users have access to a specific scorecard. Access levels include no access, viewer, editor, and administrator.

**Reference: General Tab - Access Roles**

The Edit Owner Access panel provides a way to control measure access for a group of owners linked to an access role by enabling you to set the level of dimension values that each owner can access.

From the drop-down menus for each dimension, select the level of access for the selected access role. The owners linked to this access role will only be able to see measures at or below the dimension level you set.

For details on setting measure access for access roles, see *How to Set Measure Access by Access Role* on page 341.

**Reference: General Tab - Dashboards**

There are two types of panels used to design and implement gadgets in your views and pages.

- The Gadget Designer panel enables you to create a class of gadgets, which is required before you can create a gadget within that class. A class points to a WebFOCUS gadget procedure and lets you define its properties. The Gadget Designer panel is also used to edit existing gadgets.
The Dashboard Designer panel enables you to add gadget instances to a view or other type of page.

The following tables lists and describes the fields used in the Edit Gadget Designer panel:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the gadget.</td>
</tr>
<tr>
<td>Scorecard filters</td>
<td>Specify whether the current scorecard filters should be used.</td>
</tr>
<tr>
<td>Width</td>
<td>Set the number of pixels in width for this gadget.</td>
</tr>
<tr>
<td>Height</td>
<td>Set the number of pixels in height for this gadget.</td>
</tr>
<tr>
<td>Preview image</td>
<td>The preview image of the gadget.</td>
</tr>
<tr>
<td>Enable Broadcasts</td>
<td>Select to enable the broadcast feature.</td>
</tr>
<tr>
<td>Enable Moonbeam</td>
<td>Select to enable the moonbeam feature.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Select which type of content will be added as the gadget.</td>
</tr>
<tr>
<td>Content Display</td>
<td>Select which type of content will be displayed.</td>
</tr>
<tr>
<td>Aggregation at Level</td>
<td>Select the appropriate level of the dimension at which data will be aggregated.</td>
</tr>
<tr>
<td>Reset Dashboard defaults</td>
<td>Select to reset Dashboard default values.</td>
</tr>
<tr>
<td>Remove user preferences</td>
<td>Select to remove user preferences for the gadget.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the gadget.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display</td>
<td>Select from the following Display elements to include in the gadget being created. (Use the drop-down menu next to each element to select Not Used, Optional, or Required.)</td>
</tr>
<tr>
<td></td>
<td>- Actual</td>
</tr>
<tr>
<td></td>
<td>- Target</td>
</tr>
<tr>
<td></td>
<td>- Pct_Reached</td>
</tr>
<tr>
<td></td>
<td>- Pct_Used</td>
</tr>
<tr>
<td></td>
<td>- Indicator</td>
</tr>
<tr>
<td></td>
<td>- Indicator + Actual</td>
</tr>
<tr>
<td></td>
<td>- Indicator + Target</td>
</tr>
<tr>
<td></td>
<td>- Indicator + Pct_Reached</td>
</tr>
<tr>
<td></td>
<td>- Indicator + Pct_Used</td>
</tr>
<tr>
<td></td>
<td>- Indicator + Actual + Pct_Reached</td>
</tr>
<tr>
<td></td>
<td>- Indicator + Target + Pct_Reached</td>
</tr>
<tr>
<td></td>
<td>- Hi-Mid-Low: raw count totals</td>
</tr>
<tr>
<td></td>
<td>- Hi-Mid-Low: percentages of totals</td>
</tr>
<tr>
<td>Groupings</td>
<td>Select up to three Groupings elements to include in the gadget being created. (Use the drop-down menu next to each element to select Required or Optional.)</td>
</tr>
<tr>
<td></td>
<td>- - Select a grouping - - (select one of the following)</td>
</tr>
<tr>
<td></td>
<td>- Perspectives</td>
</tr>
<tr>
<td></td>
<td>- Objectives</td>
</tr>
<tr>
<td></td>
<td>- Measures</td>
</tr>
<tr>
<td></td>
<td>- User Specified Dimension</td>
</tr>
<tr>
<td></td>
<td>- Time</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filters</td>
<td>Select up to three Filters elements to include in the gadget being created. (Use the drop-down menu next to each element to select Required or Optional.)</td>
</tr>
<tr>
<td></td>
<td>- Select a filter - - (select one of the following)</td>
</tr>
<tr>
<td></td>
<td>- Perspective</td>
</tr>
<tr>
<td></td>
<td>- Objective</td>
</tr>
<tr>
<td></td>
<td>- Measure Series</td>
</tr>
<tr>
<td></td>
<td>- User Specified Dimension</td>
</tr>
<tr>
<td></td>
<td>- Time Ranges</td>
</tr>
<tr>
<td></td>
<td>- Time</td>
</tr>
<tr>
<td></td>
<td>- Scorecard</td>
</tr>
<tr>
<td></td>
<td>- Red and Yellow indicators only</td>
</tr>
<tr>
<td></td>
<td>- Red indicators only</td>
</tr>
</tbody>
</table>

**Reference: General Tab - Content**

The New Content and Edit Content panels enable you to create content and edit existing content. Content is a default reference to any WebFOCUS procedure that displays automatically when users log on to PMF. PMF content management lets you link PMF measures, objectives, projects, and processes to WebFOCUS operational reports and webpages. PMF ships with default content. You can configure additional content by clicking the Content panel button in the Manage tab.

The New Content and Edit Content panels also enable you to create up to 10 custom categories for the content that you manage.

To create content, click the Content panel button and then click New. To edit existing content, click the Content panel button, expand all the folders in the tree structure, and select the desired content that you want to edit. The Edit Content panel opens. For more information on creating and editing content, see Managing Content on page 423.
To create a custom category on the Edit Content panel, select a *User Type* field, and rename it to reflect the nature of the new category. For more information on creating a custom category, see *Creating a Custom Category* on page 430.

The following table lists and describes the fields in both the Edit Content and New Content panels.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Contains the name of the WebFOCUS procedure that runs as content. The content must be placed in the Managed Report default repository used by PMF in order to run it. The maximum number of characters is 12.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the optional Web Page check box is selected, this field becomes unavailable and displays URL.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Select the content type that will be created. When you select <em>Web Site</em>, enter a website URL in the field which is labeled URL (normally labeled Parameters).</td>
</tr>
<tr>
<td>Application</td>
<td>Select the application that this content will use. This option is only available when WebFOCUS Procedure is the Content Type.</td>
</tr>
<tr>
<td>Content</td>
<td>Select the WebFOCUS procedure for the view that you want to add. This option is only available when WebFOCUS Procedure is the Content Type.</td>
</tr>
<tr>
<td>User Type (check boxes)</td>
<td>Enables you to create up to 10 custom categories for the content that you manage. Left-click a <em>User Type</em> field and supply a category name of your choice.</td>
</tr>
<tr>
<td>Owner</td>
<td>The user who has responsibility for this content.</td>
</tr>
<tr>
<td>Parameters (or URL)</td>
<td>Optional. When you select the <em>Web Page</em> check box, enter a URL in this field, which is renamed URL.</td>
</tr>
<tr>
<td>Scorecards</td>
<td>Enables you to select what Scorecards will show the selected content.</td>
</tr>
<tr>
<td>Escape (button)</td>
<td>When using the optional Parameters field, use this to convert parameters so they can be submitted in machine code format as part of a URL.</td>
</tr>
</tbody>
</table>
When using the optional Parameters field, use this to submit the parameters in readable text.

Opens the content in a new window where you can preview it.

If you select the Email Certified check box, the content will be embedded in the body of an email (rather than included as an attachment) when you schedule the view.

**Reference: General Tab - Units of Measure**

The Edit Unit of Measure panel enables you to control the format of data displayed in PMF. There are many default measures included in PMF. You can customize the standard display format of any unit of measure to modify how that measure is displayed in the detail views in which it appears.

To edit units of measure, click Units of Measure in the left pane, and expand the tree structure. Click a unit of measure and the Edit Unit of Measure panel opens.

The same fields in the Edit Unit of Measure panel are required for input as for updating. The following table lists and describes fields in the Edit Unit of Measure panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit name</td>
<td>Type a name for the unit of measure. The maximum number of characters is 20.</td>
</tr>
<tr>
<td>Default format</td>
<td>A WebFOCUS numeric display format valid for the unit of measure. Valid format types are D (floating-point double-precision), F (floating-point single-precision), I (integer), and P (packed decimal). The formats are \textit{In}, \textit{Dn.o}, \textit{Fn.o}, and \textit{Pn.d}, where \textit{n} represents the maximum number of digits to display, and \textit{o}, which is optional, and \textit{.d}, which is required, represent the decimal point and the number of digits to display after the decimal point. The maximum number you can code before and after the decimal point is 10 for I, 15 for D, 7 for F, and 31 for P. For more information about numeric display options, see the \textit{Describing Data With WebFOCUS Language} manual.</td>
</tr>
<tr>
<td>Common symbol</td>
<td>Type characters for the symbol used to represent the unit of measure. The maximum number of characters is 6.</td>
</tr>
</tbody>
</table>
**Place symbol**

The location of the symbol. Select one of the following:

- Place at end of value.
- Place at front of value.

**Description**

Type a description or rationale for the unit of measure. The maximum number of characters is 100.

---

**Reference:** **General Tab - Time Ranges**

The Edit Time Range panel enables you to create new custom time ranges or edit existing time ranges. After you edit or create a time range, it can be used as a trending value throughout all PMF views, wherever measures or objectives are trended.

The following table lists and describes the fields in both the New Time Range and Edit Time Range forms.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The long, descriptive name of the time range, for example, Last 13 months. The maximum number of characters is 50.</td>
</tr>
<tr>
<td><strong>Abbreviation</strong></td>
<td>The short, abbreviated name of the time range, for example, 13M. The maximum number of characters is 10.</td>
</tr>
<tr>
<td><strong>Start and End are:</strong></td>
<td>Select between the following two values using the drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Time segment endpoints.</strong> All time values between the Start and End of the Range.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Two discrete points.</strong> Two discrete values (for example, Prior and Current).</td>
</tr>
</tbody>
</table>
For the following start types, select:

- **No Start Range** if there is no start date for this time range.
- **Relative** if the time range starts on a date relative to the current time period as specified on the Edit System Settings panel. Use the Start Value field to enter a positive or negative number to start the time range that number of units in the future or past, depending on the unit of time specified as the Start Level (Month, Quarter, or Year). For example, if you enter -10 in the Start Value field, and select Month for the Start Level, the time range starts 10 months prior to the current time period. If you use the default of 0, the time range is the current time period.
- **Previous** if the time range starts on a date relative to the previous month, quarter, or year, which you set with the Start Level field.
- **Prior** if the time range starts on a date relative to the prior month, quarter, or year, which you set with the Start Level field. Note that prior time values are in the previous calendar year. For example, if the current month is July 2006, the prior month is July 2005.
- **Fixed** if the trend starts on a specific time period (for example, 2006Q1).
**End Type**

For the following end types, select:

- **No End Range** if there is no end date for this time range.
- **Relative** if the time range ends on a date relative to the current time period as specified on the Edit System Settings panel. Use the End Value field to enter a positive or negative number to end the time range that number of units in the future or past, depending on the unit of time specified as the End Level (Month, Quarter, or Year). For example, if you enter -10 in the End Value field, and select Month for the End Level, the time range ends 10 months from the current time period. If you use the default of 0, the time range is the current time period.
- **Previous** if the time range ends on a date relative to the previous month, quarter, or year, which you set with the End Level field.
- **Prior** if the time range ends on a date relative to the prior month, quarter, or year, which you set with the End Level field.

**Note:** Prior time values are in the previous calendar year. For example, if the current quarter is Q3 2006, the prior quarter is Q2 2005.

- **Fixed** if the trend ends on a specific time period.

**Start Time Level**

Select **Current Level, Year, Quarter, or Month** from the drop-down menu. This level specifies the start of the time range. If you select **Current Level**, the time range will use the Current Time Level value from the Edit System Settings panel.

**End Time Level**

Select **Current Level, Year, Quarter, or Month** from the drop-down menu. This level specifies the end of the time range. If you select **Current Level**, the time range will use the Current Time Level value from the Edit System Settings panel.

**Start Value**

If you selected **Relative** in the Start Type field, enter a positive or negative number to start the time range that number of units in the future or past depending on the unit of time specified in the Start Level field.

If you selected **Fixed** in the Start Type field, select the desired time period to start the time range using the Start Value drop-down menu.
If you selected *Relative* in the End Type field, enter a positive or negative number to end the time range that number of units in the future or past depending on the unit of time specified in the End Level field.

If you selected *Fixed* in the End Type field, select the desired time period to end the time range using the End Value drop-down menu.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Value</td>
<td>If you selected <em>Relative</em> in the End Type field, enter a positive or negative number to end the time range that number of units in the future or past depending on the unit of time specified in the End Level field. If you selected <em>Fixed</em> in the End Type field, select the desired time period to end the time range using the End Value drop-down menu.</td>
</tr>
<tr>
<td>Show this Time Range</td>
<td>If selected, the time range will be shown and available for use wherever trending data appears in views throughout PMF. Hidden time ranges are shown in the Time Ranges (hidden) tree.</td>
</tr>
</tbody>
</table>

**Important:** If you have a custom Time dimension, you may need to make adjustments to the following time periods, which are standard in PMF, to conform to the structure of your custom Time dimension: Last 13 months or weeks, Last 25 months or weeks, Last 5 periods, and Last 9 periods.

The adjustments may involve altering these time ranges or deleting them and creating new time ranges.

Otherwise, the default time ranges in PMF, which are based on the standard 12-month, 4-quarter Gregorian calendar, will not produce realistic results after your new Time dimension is loaded.

For more information on custom Time dimensions, see *Designing a Custom Time Dimension Load* on page 365.

**Reference:** *General Tab - Settings*

The *Settings* panel button enables you to view and edit any of the default PMF settings. The settings are categorized into Debugging, Integration, Look, Security, Summarization, System, Tolerances, and UI. For more information, see *Viewing and Editing Default Settings* on page 495.
**Reference:** General Tab - About PMF

The About Performance Management Framework (PMF) panel displays the product version number, database date, build date, release date, and copyright.

![About Performance Management Framework (PMF)](image)

**Reference:** Data Mart Tab - Load Now

The Load Now panel lets you automatically refresh the entire PMF cube from Source data. For more information, see *Load Now Panel* on page 324.

**Reference:** Data Mart Tab - Manage Snapshot

The Manage Snapshot panel allows you to work with PMF snapshots. For more information, see *Working with Snapshots* on page 433.
Viewing and Editing Default Settings

In this section:
- Debugging Settings
- Integration Settings
- Load Settings
- Look Settings
- PMF Labs Settings
- Project Settings
- Security Settings
- Summarization Settings
- System Settings
- UI Settings
- Changing Language Display

You can view and edit all default settings in PMF by clicking Settings in the Manage tab to open the Settings menu, as shown in the following image.
Debugging Settings

The Debugging panel is shown in the following image. After you make changes on the panel, click Save to save your changes.

The following table lists and describes the default PMF settings you can view and change on the Debugging panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>AJAX debugging</td>
<td>Indicates whether the system should display the AJAX execution code before submitting the request. The default is OFF.</td>
</tr>
<tr>
<td></td>
<td>- <strong>OFF</strong>. Hides the trace window and shuts off debugging.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ON</strong>. Shows fatal errors and standard AJAX and JavaScript flows.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ALL</strong>. Shows detailed AJAX and JavaScript program flows.</td>
</tr>
<tr>
<td>Application RDBMS SQL Tracing</td>
<td>Select <strong>OFF</strong> or <strong>ON</strong> to indicate whether WebFOCUS SQL Tracing should be active. The default is OFF.</td>
</tr>
<tr>
<td>Application Tracing</td>
<td>Select <strong>ON</strong> or <strong>ALL</strong> to debug PMF by turning WebFOCUS ECHOing on. ON displays FOCUS code for the last processing step. ALL displays FOCUS code for all processing and is not recommended. The default is OFF.</td>
</tr>
<tr>
<td>Minify for Speed</td>
<td>Enable this feature to run compacted components for faster network performance.</td>
</tr>
</tbody>
</table>
Integration Settings

The Integration panel is shown in the following image. After you make changes on the panel, click Save to save your changes.

The following table lists and describes the default PMF setting you can view and change on the Integration panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportCaster schedule ID</td>
<td>Provide the WebFOCUS server user ID that is passed to ReportCaster for scheduled runs.</td>
</tr>
<tr>
<td>iWay Service Manager</td>
<td>Provide the URL for the iWay Service Manager Console.</td>
</tr>
</tbody>
</table>

Load Settings

The Load panel is shown in the following image. After you make changes on the panel, click Save to save your changes.
The following table lists and describes the default PMF settings you can view and change on the Load panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>If Source Data is Keyed Higher</td>
<td>Controls how PMF handles lower dimension level source data on load. Select E to display an error and stop the source load or W to complete the load and ignore the lower level data. The default value is E.</td>
</tr>
<tr>
<td>If Source Data is Keyed Lower</td>
<td>Controls how PMF handles higher dimension level source data on load. Select E to display an error and stop the source load or W to complete the load and ignore the higher level data. The default value is E.</td>
</tr>
<tr>
<td>Preview display size</td>
<td>The maximum number of lines to show in the Preview tab for Sources, Datapoints, Dimensions, and Measures.</td>
</tr>
<tr>
<td>Recalculate on manual load?</td>
<td>Controls if PMF should, by default, set all datapoints and measures to be recalculated when you click Load (or Generate) on a source, datapoint, dimension or measure during a session. This sets up the default when you create new objects. This setting can be overridden on many objects.</td>
</tr>
<tr>
<td>Recalculate on user entry?</td>
<td>Controls if PMF should, by default, set all datapoints and measures to be recalculated when a user enters data into a user-entered source. This sets up the default when you create new objects. This setting can be overridden on individual user-entered sources.</td>
</tr>
<tr>
<td>Use Database Load Utility?</td>
<td>Enables bulk loading.</td>
</tr>
<tr>
<td>Zero on missing components</td>
<td>Select Y to set values to zero for measure components missing at an intersection. This setting is the default. Select N to reject rows with missing components and allow them to be null.</td>
</tr>
<tr>
<td></td>
<td>For example, if the actual of a measure is connected to a datapoint for which there is data, but its target data is missing, 0 will be inserted instead of not loading that intersection for the measure. If this is set to N, any missing components at an intersection cause all components to not be loaded.</td>
</tr>
</tbody>
</table>
Look Settings

The Look panel is shown in the following image. After you make changes on the panel, click Save to save your changes.

The Colors and Styles tab allows you to generate a color swatch for PMF, WebFOCUS content, and the WebFOCUS BI Portal, that give a consistent style to match the official style of your organization, or your group preferences.
The following table lists and describes the default PMF swatch settings you can view and change in the Colors and Styles tab on the Look panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a swatch</td>
<td>Select one of the following default swatches for all PMF views.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 01</strong>: Uses 10 point Sans-Serif font to provide good readability and compatibility with the ISO shapes, ISO signs, 3-D, and Few indicator sets.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 02</strong>: Uses 8 point Sans-Serif font to provide much denser information on-screen (with slightly less readability) and is compatible with the Glass indicator set.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 03</strong>: White, silver, black. Uses Set 01 specifications.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 04</strong>: Black (Hitech). Uses Set 02 specifications.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 05</strong>: Blue (Hitech). Uses Set 02 specifications.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 06</strong>: Orange (Hitech). Uses Set 02 specifications.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 07</strong>: Corporate blue. Uses Set 02 specifications.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 08</strong>: Sporty 3D Blue. The default is Set 08.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 09</strong>: Sporty Red &amp; Black.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 10</strong>: Rainbow Hip.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 11</strong>: Rainbow Floral.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 12</strong>: Cool Ranch.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set 13</strong>: Clarity.</td>
</tr>
<tr>
<td>Background colors</td>
<td>Refers to the HTML backgrounds in PMF, such as those for panels, grids, and dashboards.</td>
</tr>
<tr>
<td>Foreground colors</td>
<td>Refers to the colors of text and borders in PMF.</td>
</tr>
</tbody>
</table>
The following table lists and describes the default PMF settings you can view and change in the Advanced tab on the Look panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Palette</td>
<td>Select one of the following default color palettes for charts.</td>
</tr>
<tr>
<td></td>
<td>☐ RYG_PASTELS to use a red-yellow-green pastel color scheme to describe performance on charts. The default is RYG_PASTELS.</td>
</tr>
<tr>
<td></td>
<td>☐ BLUES_GREYS to use gradations of blues to describe performance on charts.</td>
</tr>
<tr>
<td></td>
<td>☐ TANS_BROWNS to use gradations of tans to describe performance on charts.</td>
</tr>
<tr>
<td></td>
<td>☐ GREEN_N_TAN to use gradations of greens to describe performance on charts.</td>
</tr>
<tr>
<td>Data Font</td>
<td>Type the name of the default font style you want used in all views and grids.</td>
</tr>
<tr>
<td></td>
<td>The default is ARIAL. If you specify a font and want to ensure the font is used for WebFOCUS PDF output, the font must be defined on the WebFOCUS Server in the PDF.FMP file.</td>
</tr>
<tr>
<td>Heading Font</td>
<td>Type the name of the default font style for headings in all reports. The default is ARIAL.</td>
</tr>
<tr>
<td>Line Chart Rounding effect</td>
<td>Select Y to make lines on line charts rounded,</td>
</tr>
<tr>
<td>Line Chart Thickness</td>
<td>Select the thickness of on line charts. The available options are 1 (thin), 2 (medium), and 3 (thick).</td>
</tr>
<tr>
<td>Organization Name</td>
<td>Provide the name of your company, organization, or enterprise (for display on some reports).</td>
</tr>
<tr>
<td>Style Sheet</td>
<td>Select the WebFOCUS stylesheet that will be used for all standard system reports.</td>
</tr>
<tr>
<td>Use Chart Gradients</td>
<td>Select Y to use gradient colors on chart objects. Select N to flatten chart objects and not use gradients.</td>
</tr>
<tr>
<td>Setting</td>
<td>What To Set It To</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indicator Set</td>
<td>Select one of the following indicator sets to display in views and grids in PMF.</td>
</tr>
<tr>
<td></td>
<td>- Set one (ISO shapes)</td>
</tr>
<tr>
<td></td>
<td>- Set two (ISO signs)</td>
</tr>
<tr>
<td></td>
<td>- Set three (3-D)</td>
</tr>
<tr>
<td></td>
<td>- Set four (Few - no Green)</td>
</tr>
<tr>
<td></td>
<td>- Set five (Glass - no Green)</td>
</tr>
<tr>
<td></td>
<td>- Set six (Glass)</td>
</tr>
<tr>
<td></td>
<td>- Set seven (Huebgen)</td>
</tr>
<tr>
<td></td>
<td>- Set eight (O’Grady)</td>
</tr>
<tr>
<td></td>
<td>- Set nine (EuroGlass)</td>
</tr>
<tr>
<td></td>
<td>- Set ten (New Blue)</td>
</tr>
</tbody>
</table>

Using the same number elements will give you all of the essential designs, but you can also mix and match them to get a number of combinations.

**PMF Labs Settings**

The PMF Labs panel is shown in the following image. After you make changes on the panel, click Save to save your changes.

**Note:** This option is only seen if you enable the PMF Labs feature in System settings.
The following table lists and describes the default PMF settings you can view and change on the PMF Labs panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze Source data on Load?</td>
<td>Specify if an analysis of the source data will be run during source load.</td>
</tr>
<tr>
<td>High performance begins</td>
<td>Set the time for scheduled or batch jobs to stop running when online entry and reporting starts.</td>
</tr>
<tr>
<td>Overnight maintenance begins</td>
<td>The time for when scheduled loads can begin.</td>
</tr>
<tr>
<td>Weekend maintenance</td>
<td>Set if weekend maintenance should occur. Options are:</td>
</tr>
<tr>
<td></td>
<td>S - Saturdays only</td>
</tr>
<tr>
<td></td>
<td>U - Sundays only</td>
</tr>
<tr>
<td></td>
<td>B - Both Saturdays and Sundays</td>
</tr>
<tr>
<td></td>
<td>O - Off</td>
</tr>
</tbody>
</table>

**Project Settings**

The Project panel is shown in the following image. After you make changes on the panel, click Save to save your changes.
The following table lists and describes the default PMF setting you can view and change on the Project panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Dimensional linkages</td>
<td>Select whether to enable the ability to link Projects to up to two dimensions. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>❑ Y (Yes)</td>
</tr>
<tr>
<td></td>
<td>❑ N (No). The default is N (No).</td>
</tr>
<tr>
<td></td>
<td>If you select Y, the following options are available:</td>
</tr>
<tr>
<td></td>
<td>❑ Project Dimension 1. Choose a specific Dimension for the first Project Dimension. Available Dimensions are listed, excluding Time and Project).</td>
</tr>
<tr>
<td></td>
<td>❑ Project Dimension Level 1. Choose a Dimension level for the first Project Dimension.</td>
</tr>
<tr>
<td></td>
<td>❑ Project Dimension 2. Choose a specific Dimension for the second Project Dimension. Available Dimensions are listed, excluding Time and Project).</td>
</tr>
<tr>
<td></td>
<td>❑ Project Dimension Level 2. Choose a Dimension level for the second Project Dimension.</td>
</tr>
</tbody>
</table>

**Security Settings**

The Security panel is shown in the following image. After you make changes on the panel, click Save to save your changes.

![Security Settings Panel](edit_system_settings_security.png)
The following table lists and describes the default PMF settings you can view and change on the Security panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Security</td>
<td>Select the level of security. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>☐ O (Off)</td>
</tr>
<tr>
<td></td>
<td>☐ G (Global). The default is G (Global).</td>
</tr>
<tr>
<td></td>
<td>☐ S (Scorecard)</td>
</tr>
</tbody>
</table>

**Summarization Settings**

The Summarization panel is shown in the following image. After you make changes on the panel, click Save to save your changes.
The following table lists and describes the default PMF settings you can view and change on the Summarization panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Aggregation</td>
<td>Select whether to allow aggregate measure values using external tables with pre-populated rollup values. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>Y (Yes)</td>
</tr>
<tr>
<td></td>
<td>N (No). The default is N (No).</td>
</tr>
<tr>
<td>External Aggregation MFD</td>
<td>Type the name of the Master File to use for external aggregation.</td>
</tr>
<tr>
<td>Measure Detail Sorting</td>
<td>Select whether to sort measure detail from the report context or the measure dimension order. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>R to pick up sorting from the report context. The default is R.</td>
</tr>
<tr>
<td></td>
<td>M to enforce the measure dimension order for sorting.</td>
</tr>
<tr>
<td>Multi-Level Dimension Display</td>
<td>Select whether to display data at lower levels of non-Time Dimensions than what is measured. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>Y (Yes). The default is Y.</td>
</tr>
<tr>
<td></td>
<td>N (No).</td>
</tr>
<tr>
<td>Multi-Level Time Display</td>
<td>Select whether to display data at lower levels of Time than what is measured. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>Y (Yes). The default is Y.</td>
</tr>
<tr>
<td></td>
<td>N (No).</td>
</tr>
<tr>
<td>Previous Period Forward</td>
<td>Select whether previous measure data should be carried over into the current period until actual data becomes available. PMF marks carried over data to distinguish from actual data. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>Y (Yes)</td>
</tr>
<tr>
<td></td>
<td>N (No). The default is N (No).</td>
</tr>
<tr>
<td>Setting</td>
<td>What To Set It To</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rebalance weights for no data?</td>
<td>Select Y to rebalance weights to compensate for measure series with no data. The default is Y.</td>
</tr>
<tr>
<td>Default Dimension</td>
<td>Select the default dimension to be displayed in views. Choose a Dimension to use.</td>
</tr>
<tr>
<td>Default Dimension Level</td>
<td>Select the default dimension level for standard system reports. The available options are 1-Region, 2-Plant, and 3-Store.</td>
</tr>
<tr>
<td>Default Time Level</td>
<td>Select one of the following default time levels for displaying data when the time level is not specified.</td>
</tr>
<tr>
<td></td>
<td>- Year</td>
</tr>
<tr>
<td></td>
<td>- Quarter. The default is Quarter.</td>
</tr>
<tr>
<td></td>
<td>- Month</td>
</tr>
</tbody>
</table>
System Settings

The System panel is shown in the following image. After you make changes on the panel, click Save to save your changes.

The following table lists and describes the default PMF settings you can view and change on the System panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ajax Timeout (seconds)</td>
<td>The amount of time (in seconds) PMF should wait for http server requests.</td>
</tr>
<tr>
<td>Days to Allow Revisions</td>
<td>The amount of days PMF will allow newer Feedback and Project information to be updated. The default value is 20 days.</td>
</tr>
<tr>
<td>Hide Old-Style Measures</td>
<td>Hides legacy measures from appearing in the Measure trees on the Author and Manage tabs.</td>
</tr>
<tr>
<td>PMF APP PATH</td>
<td>Enter the WebFOCUS Application Path used by PMF.</td>
</tr>
<tr>
<td>Setting</td>
<td>What To Set It To</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Turn On PMF Labs Features | Displays new and unsupported features from the PMF laboratory.  
**Note:** Enabling this feature is not recommended for production environments. |
| Default Target Field    | Select the default target field to be displayed in views. Choose one of the following:  
- **Benchmark.** A comparative average or median value for a business sector for displaying measures in reports.  
- **Forecast.** A predictive alternate target or an estimate of future performance for displaying measures in reports.  
- **Stretch Target.** An alternate target field for displaying measures in reports.  
- **Target.** The default target field for displaying measures in reports. The default is Target.  
**Note:** You might see additional target fields, or different ones, depending on how your administrator has configured PMF at your site. |
### Setting | What To Set It To
---|---
Today Date | Select the now date shown for all PMF views. Choose one of the following options from the drop-down menu:

- **Use system clock date.** PMF uses the clock time and date on the server where your PMF application is running.

- **Set to fixed time.** PMF overrides the now date with the date you select from the drop-down menu below. This setting freezes PMF in time and does not allow PMF to slide as time elapses. This capability is best used for demonstrations of PMF when working with historical data and is not recommended for use in any other situation.

- **Use custom procedure.** You can modify a supplied procedure that calculates a custom date if the system clock date and fixed time options are not suited to your needs. Edit the procedure `pmf_set_date.fex`, which is located in your apps\mainstreet directory. Create three WebFOCUS Dialogue Manager variables: &TLVL01_CUR, &TLVL02_CUR, and &TLVL03_CUR.

For example, the following code sets the current default time period to the previous calendar month:

```plaintext
-SET &CURRENT_DATE_INTERNAL_FORMAT = DATECVT(&YYMD, 'I8YYMD', 'YYMD');
-SET &PREV_MONTH_INTERNAL_FORMAT = DATEADD(&CURRENT_DATE_INTERNAL_FORMAT, 'M', -1);
-SET &PREV_MONTH_DATE = DATECVT(&PREV_MONTH_INTERNAL_FORMAT, 'YYMD', 'A8YYMD');
-SET &TLVL01_CUR = EDIT(&PREV_MONTH_DATE, '9999');
-SET &TLVL03_CUR = EDIT(&PREV_MONTH_DATE, '$$$$99');
-SET &TLVL02_CUR = DECODE &TLVL03_CUR ('01' '1' '02' '1' '03' '3' '04' '2' '05' '5' '06' '6' '07' '7' '08' '8' '09' '9' ELSE '4');
```
UI Settings

The UI panel is shown in the following image. After you make changes on the panel, click Save.

The following table lists and describes the default PMF settings you can view and change on the UI panel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic cancel</td>
<td>Specify how many seconds PMF should wait before auto-cancelling actions, such as a click on the dashboard, and drills. The default value is 5 seconds.</td>
</tr>
<tr>
<td>Display Budgets for Projects</td>
<td>Select Y to track project expenditures.</td>
</tr>
</tbody>
</table>
Viewing and Editing Default Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>What To Set It To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Language</td>
<td>Select the default language for panels and reports. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- ar (Arabic)</td>
</tr>
<tr>
<td></td>
<td>- br (Brazilian Portuguese)</td>
</tr>
<tr>
<td></td>
<td>- ca (Catalan)</td>
</tr>
<tr>
<td></td>
<td>- de (German)</td>
</tr>
<tr>
<td></td>
<td>- en (English)</td>
</tr>
<tr>
<td></td>
<td>- es (Spanish)</td>
</tr>
<tr>
<td></td>
<td>- fr (French)</td>
</tr>
<tr>
<td></td>
<td>- he (Hebrew)</td>
</tr>
<tr>
<td></td>
<td>- it (Italian)</td>
</tr>
<tr>
<td></td>
<td>- ja (Japanese)</td>
</tr>
<tr>
<td></td>
<td>- nl (Dutch)</td>
</tr>
<tr>
<td></td>
<td>- zh (Chinese)</td>
</tr>
<tr>
<td>Object Display Type</td>
<td>Select to display all objects or only the objects owned by the user who is viewing the Author tab. Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- A (All objects). The default is A (All objects).</td>
</tr>
<tr>
<td></td>
<td>- U (Only user-owned objects)</td>
</tr>
<tr>
<td>Pop Up Window Handling</td>
<td>Select NEW or SAME to determine whether views open in a new window or the same window. The default is NEW.</td>
</tr>
<tr>
<td>Weighting Decimals</td>
<td>Select the number of significant decimal places to use for weighting. Choose 0, 1, or 2 decimal places. The default is 1.</td>
</tr>
</tbody>
</table>
Changing Language Display

**How to:**
Change Language Display

PMF has the ability to support English, Brazilian Portuguese, Catalan, Chinese, Dutch, French, German, Hebrew, Italian, Japanese, and Spanish for its user interface. You can switch PMF to display the user interface (panels, trees) and all report column titles and headings in any of these languages. There can be only one primary language configured for PMF at this time.

If you change the user interface to display a language other than English, PMF runs a process to automatically change some internal data depending on the selected language. This data includes shipped versions of units of measure, content, dashboards, gadgets, time ranges, system settings, and functional roles.

The internal information that is not automatically translated when the primary language is changed includes scorecard data, dimension data, user-entered data, and static components, such as Business Intelligence Dashboard (BID) tab titles and shipped documentation. You should select your desired language at installation time, otherwise you have to manually change BID tab titles when you change the PMF language. For documentation, you have to download and install non-English documentation for PMF.

The primary language is stored as a setting in the PMF primary data mart. It is possible to connect the application to a data mart and have PMF automatically adopt the language configured there after an automatic metadata resync is performed (as long as the language configured is one PMF supports).

If you want user interfaces and data display to be appropriate for the language you select, you should change the primary language of your WebFOCUS environment. The WebFOCUS primary language controls BID menus, WebFOCUS tools available from BID menus, and right-click menus in the PMF trees. For more information about changing the primary language for WebFOCUS, see the *WebFOCUS Security and Administration* manual, and the *WebFOCUS and ReportCaster Installation and Configuration* manual for your platform.

Before changing the Display Language setting on the UI Settings panel, do the following:

- Change the WebFOCUS server code page to display the correct character set for the target language.
- Verify that you have installed the appropriate language pack and that your user logons are configured to display the WebFOCUS user interface in the desired target language.
- You may have to change some server defaults, for example, CDN, to make the display of currency correct for the target language.
Procedure: How to Change Language Display

To change the PMF language display, perform the following steps:

1. Log on to PMF as an Administrator.
2. Click the Manage tab.
3. Click the Settings panel button.
   - The Settings menu displays.
4. On the UI panel, select one of the following two-character language codes from the Display Language drop-down menu.
   - en - English
   - ar - Arabic
   - br - Brazilian Portuguese
   - ca - Catalan
   - de - German
   - es - Spanish
   - fr - French
   - he - Hebrew
   - it - Italian
   - ja - Japanese
   - nl - Dutch
   - zh - Chinese
5. Click Save to save the changes.
   - PMF automatically changes the internal language code and display items. You must log off PMF and then log on again to see the changes.
This appendix contains topics that provide tips and troubleshooting techniques for PMF Administrators and Authors. Topics specially designed for only Administrators, or only Authors, are marked as such.

### Topics:
- Displaying Static Tabs With Dynamic Dashboards
- Administrators: Dashboard Design Tips
- Administrators: Hiding Content From Users
- Administrators: Automated Upgrades
- Administrators: Styling the Look and Feel of PMF
- Authors: Creating a Scorecard
- Troubleshooting Measure Data Issues
- Troubleshooting and Debugging Aids
Displaying Static Tabs With Dynamic Dashboards

**How to:**
Create a Static Tab With a Dynamic Dashboard

Multiple dashboards can be displayed in a single portal session and each dashboard can contain gadgets that are personalized for the owner (user). You can also create fixed dashboards that the owner cannot personalize.

**Procedure:** How to Create a Static Tab With a Dynamic Dashboard

1. Run a query against the GADGET_PAGES table and locate the number stored as the GADGET_PAGE_ID for the dynamic dashboard you want to launch.
   
   If you are a developer, you can use the WebFOCUS Server Console to run a query against your PMF data mart.

2. Log on to the MRE applet.


4. Save the Standard Report with an appropriate name (for example, Operational Dashboard static launcher), then close the report.

5. Open the report with the Editor and add the following lines of code:

   ```
   -MRNOEDIT -SET &PAGE_ID=nn;
   -MRNOEDIT -INCLUDE GADGET_PAGE_SHELL
   ```

   where

   `nn`

   Is the specific GADGET_PAGE_ID of the dashboard you want to launch.

   
   You cannot test the functionality of the report until it is launched from inside the PMF environment.

7. Log off MRE.

8. Log on to the Business Intelligence Dashboard View Builder.

9. Create and assign a name to a new page for the group view that will become the new static tab.

11. Save the new page and the group view.

12. Log off from the Business Intelligence Dashboard View Builder.

13. Log on to PMF as a user for the group view.

   Users can save their preferences for the new dashboard, but they cannot switch preferences to point to a different dashboard.

   **Important:** Do not replace the PMF Today page with the new static tab page in the group view. This would cause serious errors and make the PMF application inoperable. The Today page must run additional application logic, point to the Today Page bounce report, and be the first page that users view.

**Administrators: Dashboard Design Tips**

When designing a dashboard, use the following guidelines:

- **Provide enough space for gadgets.** Configure and position your gadgets to provide enough space to display properly in the dashboard.

- **Avoid scroll bars.** The best designed dashboards show all of the important information without requiring the use of scroll bars. If scrolling is required, place the most important information and indicators in the most significant locations of the dashboard, either close to the top left corner or near the center of the dashboard.

- **Design for different screen resolutions.** The PMF Dashboard Designer enables you to design for any target screen resolution, but cannot automatically reconfigure and deploy your dashboard design to a lower resolution screen. Make sure you know the target resolutions your consumers will be using, and design alternate versions of the dashboards as needed.

- **Mix contexts so users can see everything.** Where possible, avoid requiring users to switch flags or options to see all of the data that is important to them. PMF enables you to configure each dashboard by owner, scorecard, or gadget, so you can point different gadgets to different contexts and avoid making users perform unnecessary clicks.

- **Appropriate metrics.** PMF can automatically detect and display valid metrics for each dashboard and scorecard. However, because PMF cannot select the most appropriate metric to display for a scorecard, you should set up appropriate default metrics for each scorecard.
Administrators: Hiding Content From Users

In this section:
Analytics Tab

There are times when you need to hide specific content from all users. For example:

- You may want to hide a particular dashboard, scorecard, or the Analysis Designer if it displays sensitive information.
- You may be in the middle of designing a new dashboard and do not want anyone to see it while it is a work-in-progress.

The Edit Content Access panel enables you to restrict all users from accessing specific views and dashboards. For a selected content (launch) page, deselect all view categories to hide the content from all users. For more information about using the Edit Content Access panel, see How to Add Existing Content to Analytics Tab Categories on page 426.

Analytics Tab

You can easily limit the views your users see and hide content so that they are not presented to your users at will.

The Analytics tab displays a list of categories for PMF views and linked Content (for example, web or operational reports). If a category is empty (for example, there are no Content items for that category, probably because items have been removed from that category), PMF will not display the category.

Tip: Because of this change, if you save your first report in Analysis Designer, you will need to refresh the Analytics tab to display the Saved Reports category.

Administrators: Automated Upgrades

How to:
Upgrade the Data Mart Automatically

PMF enables you to implement automated upgrades if an existing PMF installation is found. When you run the PMF installer and enter the license code, the installer determines if upgrading is an option. If the upgrade options is selected, the PMF installer:

- Upgrades the PMF application seamlessly.
- Does not alter any existing Business Intelligence Dashboard group views or any MRE users or groups.
Creates the pmf_install.csv file in the pmfdata application folder. This file contains the release number for the current application version of PMF.

Creates migration scripts, which can be run automatically to upgrade the PMF data mart.

**Note:** After the installer completes, the data mart is still set to the previous release.

**Procedure:** How to Upgrade the Data Mart Automatically

1. Start PMF after upgrading.

   The PMF internal synchronization code (pmf_internal_check_and_rpt) compares the release number in the a_defaults.fex and pmf_install.csv files.

   If the release numbers are the same, processing continues. However, if the release numbers are not the same, there is a problem with the installation and processing stops with an error condition.

2. PMF checks the internal SYSTEM_SETTINGS table in the PMF data mart.

   If the data mart has the same release level as the PMF application, processing continues. However, if the data mart has a higher release level, there is a problem with the installation and processing stops with an error condition.

3. If the data mart is at a lower release level than PMF, you are prompted to upgrade the data mart.

   **Note:** A warning message is displayed recommending that you back up your database before upgrading.

4. Click Resynch.

   The PMF automatic synchronizer runs all DDLs needed to upgrade from the previous release to the new release. This process works between point releases or major releases.

   **Note:** After you manually upgrade the data mart to the Release 5 level or higher, PMF will be able to process all future data mart upgrades (migrations) automatically.

**Administrators: Styling the Look and Feel of PMF**

**In this section:**

PMF Swatching System

PMF supports a central style sheet model for all aspects of views, reports, and the application User Interface. Using the Look panel, you can use global settings to allow all views, gadgets, and charts to be formatted as you desire. The global settings allow you to select:
A consistent color scheme across all charts and chart gadgets. This allows for user-created chart coloration.

A global style sheet default that formats views and grid gadgets. This allows for easier user-created styling.

An override font for all reports.

PMF includes chart and graph styles that allow you to automatically select a look for every chart and graph in the system (all content that maps to a WebFOCUS graph from PMF content). All charts in the system are written to allow template styling. You can also define custom charting color schemes using the Look panel.

A section of the Look settings control the look and style of the user interface through different indicators, HTML style sheets, graph palettes, and WebFOCUS StyleSheet settings.

You can create new skins to follow any corporate standards without adversely affecting the operation of PMF.

**Note:** For more information on the default settings you can view and change on the Look panel, see *Look Settings* on page 499.
PMF Swatching System

**How to:**

Use the Swatching System to Change the PMF Look
Disable or Enable Chart Gradients

The PMF style swatching system allows you to generate a color swatch for PMF, WebFOCUS content, and the WebFOCUS BI Portal, that give a consistent style to match the official style of your organization or your group preferences.

The swatch file can come from using the WebFOCUS Branding portal, or you can design your own styling in a few moments with the PMF dynamic styling panel. Once you have a style designed, you can apply it across an entire PMF tenant in seconds. PMF picks up the new style and applies it across the entire system.

**Note:**

- If you are in a multi-tenant or cloud version of PMF, the color look for PMF is tenant-specific. You can easily move the styling from tenant to tenant, since it is controlled by a compact text file.

- The PMF legacy look management system that uses manually-configured CSS files and FOCUS style sheets is deprecated. In PMF Release 8, all 11 standard style sheets that shipped with PMF have equivalent swatches that you can use.

**Procedure:** How to Use the Swatching System to Change the PMF Look

To change the look of PMF, using the swatching system:

1. In the Manage tab, click the Settings panel button.
2. Click the Look panel button.

   The Look settings panel opens.

3. You can either set the new colors directly in the Background and Foreground colors fields, or select a swatch (LESS) file from the Choose a swatch drop-down menu.

   The Look settings panel has the following options:

   - **Choose a swatch drop-down menu:**
     - **Template swatches.** Swatches that ship with PMF. You can click Save As and rename the swatch, but you cannot override their settings without changing the file name.
- **Tenant swatches.** Swatches that you or another user with administrator privileges created for use in PMF. Clicking Save or Save As will save the swatch file to the local area for your tenant.

- **Background colors.** Refer to HTML backgrounds, such as those for panels, grids, and dashboards.

- **Foreground colors.** Refer to text and borders.

4. Click *Preview* once you have finished making your selections.

   - A confirmation box opens.
   
   You can save the current state of the swatch as you are editing it by clicking *Save*. You can save the current settings under a new name by clicking *Save As*.

5. **Click *Apply*** to apply the swatch and reformat the PMF colors. If you want to cancel the operation, click *Revert*.

   **Note:**

   - After applying a new swatch to PMF, you should refresh the portal pages to remove the old style sheets and display the new colors.
   
   - If you created a tenant swatch, its LESS file is automatically included in any snapshots.

For more information on the swatching system, see *Look Settings* on page 499.

**Procedure: How to Disable or Enable Chart Gradients**

You can control whether PMF applies a color gradient to charts. Disabling the gradients allows you to apply a flat look to charts.

To disable or enable chart gradients:

1. In the Manage tab, click the *Settings* panel button.

2. Click the *Look* panel button.

   The Look settings panel opens.

3. Click the *Advanced* tab.
4. From the drop-down menu, select:
   - Y. Enable gradients on charts.
   - N. Disable gradients on charts.

5. Click *Save Advanced*.

Authors: Creating a Scorecard

There are several ways to create Scorecards in PMF. Choose one of the following methods depending on your needs:

- **Create a new scorecard.** If you are starting from scratch and want to create a prototype of a new scorecard quickly, you can use the PMF Scorecard Wizard to create a new scorecard in minutes. The Scorecard Wizard takes you through all of the steps required to create a scorecard, from selecting the strategic objectives and perspectives, to creating commonly-selected metrics including entry formulas for each strategic objective. After you complete creating a scorecard with the Scorecard Wizard, you only need to draw the Strategy Map and type some sample values for the metrics. PMF does the rest.

  To open the New Scorecard Wizard, click **Scorecards** in the left pane of the Author tab, and select the **Wizard** button.

- **Copy an existing scorecard.** If you are trying to copy an existing scorecard, the PMF cascade function enables you to do this quickly and easily. When you save the scorecard, PMF copies all aspects of the scorecard including the Strategy Map and metric linkages. The Strategy Map includes cause and effect linkages, project and process links, and themes. The metric linkages includes all corresponding weights.

  To open the New Scorecard panel and access the cascade function, click **Scorecards** in the left pane of the Author tab, and select the **New** button. Provide the new scorecard with a name, select the scorecard you want to copy from the Parent Scorecard drop-down list, select the **Cascade Scorecard** check box, and click **Save** to complete the cascading operation.

  After the scorecard cascading is complete, you can change the parent child relationship of the scorecard you created, which effectively removes the cascade and disconnects the parent and child scorecards from each other. You can also change other aspects of the scorecard including the objectives, perspectives, metrics, projects, processes, and cause and effect linkages.

Troubleshooting Measure Data Issues

If you ever run a PMF view or gadget and do not see the expected data, here is a list of potential issues to investigate to confirm that you have taken all of the steps necessary to publish your measure data:
Is the measure linked to any objectives on the scorecard you are displaying?

Click the Measure panel in the Manage or Author tabs and click the Link/Unlink to Objectives button to make sure the measure has been linked to the Scorecard.

Have you weighted the measure so its data contributes to the objective?

Click the Measure panel in the Manage or Author tabs and click the Link/Unlink to Objectives button to make sure the measure has a positive weight assigned to it for the objective on the scorecard.

Have you loaded data for the measure?

Check the Measure Loader Preview screen to confirm that there is data loaded.

Was the data loaded to include data for the currently set Time period from which you are reporting?

Check the Time period on the view. If your view does not display a Time breakout, check the attribute history in the footing to see what period is being used. If you still cannot determine the issue, check the PMF current time setting in the Settings panel on the Manage tab.

Troubleshooting and Debugging Aids

How to:

Use Application Tracing

Because all software applications occasionally have issues, PMF includes built-in utilities that allow you or your administrator to troubleshoot and resolve potential issues.

Procedure: How to Use Application Tracing

If you receive an error that you do not understand, you can enable Application Tracing, then re-run the request that generated the error. If you are proficient in WebFOCUS, you can examine the trace yourself to determine the cause of the issue. If you are not proficient in WebFOCUS, you can forward the trace to either your local support representative or your Information Builders support specialist.

To activate Application Tracing:

1. In the Manage tab, click the Settings panel button.
   The Settings menu opens.

2. On the Debugging panel, select one of the following values from the Application Tracing drop-down list.
- **OFF.** Disables tracing, which is the default value.
- **ON.** Trace WebFOCUS code without showing a full trace of the Dialogue Manager pre-processing code. This is the most typical setting for tracing.
- **ALL.** Trace WebFOCUS code and show all steps in the Dialogue Manager pre-processing code. This generates the most detailed trace.

3. Click Save.

If you selected ON or ALL, tracing is now active. You can re-run any process that has an error message, and select **Source** from the View menu in your Browser to display the underlying HTML source code containing the error trace. Traces are present at the bottom of the HTML file, after the closing `</HTML>` tag.

**Note:** Turning on tracing can slightly lower PMF performance speed because more HTML is downloaded to the browser. It is recommended that you turn off tracing after you resolve the issue you are investigating.
access roles 280, 289, 484
  creating 289
  editing 289
  understanding 289
access security 241, 505
  system settings 505
accessing views 33, 41
Active Technologies Reports 95
  creating 95
actual values 228
Actual vs. Target Relationship view 84
administration views 440, 442
  running 440
administrators 22, 271, 272, 280, 479, 480
  functions 272
  getting started 272
  Manage tab 480
  quick reference 479
aggregating measures 381
AJAX debugging 496
  system settings 496
Alert Wizard 115
alerts 112, 113, 114, 115, 120
  adding comments 114
  changing 114
  creating 115, 120
  editing 114
  managing 112
  modifying 113
  options 113
  reassigning 114
  viewing 113
Aligned Projects view 79
alternate targets 90, 92, 416, 509
  benchmarks 90, 92, 416, 509
  forecasts 90, 92, 416, 509
  specifying 416
  stretch targets 90, 92, 416, 509
  system settings 509
Analysis Designer 89, 95, 423, 460
  automatic trend dates 95
  creating Active Technologies Reports 95
  creating gadgets 460
analysts 23, 280
Analytics tab 41
application tracing 496, 524
  system settings 496
applying time animation 151
arrow indicators 34
atomic measures 42
authenticating users 274
Author tab 267
  accessing components 267
  authorizing users 274
authors 22, 169, 171, 172, 267, 280
  Author tab 267
  getting started 171
  quick reference 267
  scorecard building 172
automatic trend dates 95

B

basis value 239
benchmarks 509
cascading scorecards 184, 185, 398
creating 185
  matching to metric hierarchies 398
Cascading Style Sheets 203
Causes & Effects view 68
chart color palettes 501
system settings 501
charting styles 501
commenting in PMF 240
compound objectives 68, 193
  editing 193
consequences 68, 196, 199
  creating 199
  editing 196, 199
consumers 23, 280
content 423, 424, 425, 426, 427, 428, 487, 518
  categories 426
  editing 487
  hiding 518
  linking to measures 427
  linking to objectives 427
  linking to processes 427
  linking to projects 427
  linking to scorecards 428
  operational reports 427
  WebFOCUS procedure 424
  webpages 425
content management 423
correlating metrics and objectives 55
Correlation view 55, 57, 58, 60
  example 58, 60
  running 57
custom categories 430
custom parameters 464
dashboards 30, 31, 32, 101, 128, 129, 136,
  141, 143, 453, 478, 479, 484, 517
  adding guidelines 136
  changing graph gadget preferences 32
  changing the display 30
  changing user preferences 30, 31
  Dashboard Designer 129
designing 478, 517
gadgets 30
mobile content 479
resetting user preferences 141
data access security 241
  owner-based 241
  scorecard-specific 241
data font 501
system settings 501
data indicators 34
data lineage 300
data mart
  upgrading automatically 519
datapoints 325, 327, 329, 330, 334
  change 329
  copy 329
  derived 325, 327
  generated 334
  loadable 325, 334
  user entered 325
  wipe 330
debugging 496, 524
  settings 496
default roles 280
default system settings 496, 497, 500, 501, 505,
  506, 507, 509, 510, 512
  access security 505
  AJAX debugging 496
  application tracing 496
  chart color palettes 501
  data font 501
default time level 507
dimension 507
default system settings (continued)
  display language 512
  external aggregation 506
  external aggregation MFD 506
  heading font 501
  iWay Service Manager 497
  measure detail sorting 506
  multi-level dimension display 506
  multi-level time display 506
  object display type 512
  organization name 501
  pop-up window handling 512
  previous period forward 506
  rebalance weights for no data 507
  style sheet 500
  target field 509
  today date 510
  weighting decimals 512

default time level 507
  system settings 507
derived datapoints 325, 327, 328, 330, 332
  calculate measures 330
  create 328
  lineage 332
design and rollout process 25
designing dashboards 517
developers 24

Dimension Data Level Breakout view 444

Dimension Data view 443

Dimension Loader 353, 354, 356, 359, 482
  designing loads 354
  options 356
  report 359
  viewing sample data 353
  creating custom time dimension 366
  creating new 345
  deleting 347
  designing custom time dimensions 365

dimensions (continued)
  designing loads 352, 354, 356
  editing 346
  editing loaded values 379
  interpreting reports 359
  loading 351
  loading data 352, 354, 360
  loading non-standard time dimensions 368
  measure tolerances 358
  previewing 346
  renaming 347
  scheduling a load 360
  specifying 341
  system settings 507
  understanding 344

Dimensions Load view 444
Dimensions Metadata view 445
display language 512
  system settings 512
displaying measure instances 223
documenting in PMF 240

draggable guidelines 136
drawing the Strategy Map 203
drill-down menus 35
drill-down options 39, 40, 41
  measure 40
  objective 39
  perspectives 39
  process 41
  project 40
dynamic dashboards 516
  displaying static tabs 516

E

Edit Content Access panel 426, 487
Edit Dashboard Designer form 484
Edit Functional Role form 484
Edit Gadget Designer form 484
Edit Measure form 402
Edit Owner Access form 484
Edit Owner form 483
Edit Process form 265
Edit Project form 253
Edit Schedule form 483
Edit Scorecard form 178
Edit Time Range form 490
Edit Unit of Measure form 489
end users 27
environment settings in PMF 495, 496
Executive Booklet view 49
Executive Briefing Booklet PDF view 50
Executive Briefing Booklet PowerPoint view 50
exporting gadgets 474
external aggregation 506
external aggregation MFD 506

fonts (continued)
  default styles for headings 501
  specify for PDF output 501
  specify for report headings 501
forecasts 509
functional access to scorecards 178
functional roles 280, 281, 283, 284, 285, 287, 292, 484
  access levels 285
  changing properties 284
  creating 281
  default 287
  deleting 284
  fields 283
  limiting access to 285
  planning considerations 280
  scorecard functional access 292
  understanding 281

G
gadgets 128, 135, 139, 140, 141, 142, 143, 154, 453, 454, 455, 456, 458, 459, 460, 461, 464, 474, 476, 478, 484
  adding 140
  Analysis Designer templates 460
  available catalog 154
  creating classes 458
  creating dashboard designs 478
  custom parameters 464
  customizing 142
  designing 453, 484
  display fields 454
  displaying 143
  exporting 474
  filtering 456
  grouping 455
  indicators 454
  Managed Reporting 461
  moving 139
  registering 141, 476
  resizing 143

feedback 102, 103, 105
  adding 103
  blogging 102
  deleting 105
  editing 105
  entering 102
feedback icon 34
fixed targets 217, 404
flex values 228, 405
fonts 500, 501
  default style sheets 500
  default styles for data 501
gadgets (continued)
searching 135
using InfoAssist 459
utilizing 128
generated datapoint 325, 334, 335, 337
create 335
lineage 337
promoting 337
ginsu slicer 167
global font style 501
graph color palettes 501
system settings 501
graph gadgets 30

H

harvest 295, 309
loadable source 309
heading font 501
system settings 501
Hi-Mid-Low percents of total 96
Hi-Mid-Low raw counts 96
hiding content 518
Histogram Predictive view 71
history tab 307
hyperlinks in views 35

I

Impact of Projects on Objectives view 78
implementing PMF 170
indicators 34, 228, 230, 232
ascending 230
customizing 228
descending 230
designing a range 232
flex 232
indicators (continued)
grading systems 228
threshold 232
using stop lights 34
installation 518
automating upgrades 518
upgrading 518
installers 24
integration settings 497
introduction to PMF 20, 28
iWay Service Manager 497
system settings 497

L

language display 513, 514
changing 514
in Business Intelligence Dashboard 513
in PMF 513
Last 5 Periods view 47
launch pages 101
Launch Pages view 446
lineage 300, 306, 310, 317, 332, 337
derived datapoints 332
generated datapoint 337
lineage tab 306
sources 310
user entered source 317
linking processes to objectives 211
linking projects to objectives 211
Load now panel 324, 494
load schedules 483
loadable datapoint 325, 326, 334
edit 326
loadable source 305, 309, 310, 313, 321
data harvesting 309
new 310
update 313, 321
loaded measures 213
loading data 351, 354, 356, 359, 360, 380, 400, 407, 410, 411, 412, 414, 416, 418, 419
creating complex measure load 380
designing a dimension load 354
designing a measure load 400, 407
Dimension Loader options 356
Dimension Loader report 359
Measure Loader field maps 412
Measure Loader fields 411
Measure Loader filters 414
Measure Loader options 410, 416
planning considerations 351
planning to load measures 380
running a dimension load 360
running a measure load 418
scheduling a dimension load 360
scheduling a measure load 419
loading dimensions 351
loading measures 380
loads 302, 338
scheduling 338
locking guidelines 137
log report 302
logging on to PMF 28
look settings 497, 499, 502

M

Manage tab (continued)
owners 483
PMF Settings 493
schedules 483
scorecard security 484
time ranges 490
units of measure 489
managing content 423
measure access 339, 340, 341
by access role 339, 341
by owner 339, 340
Measure Breakout view 75
measure conversion profiles 349, 351
assigning 351
creating 349
Measure Detail Data view 74
measure detail sorting 506
system settings 506
measure drill-down options 40
Measure Loader 353, 407, 410, 411, 412, 414, 416, 418, 420, 483
Dimensions view 411
Field Maps view 412
Filters view 414
interpreting reports 420
options 416
report 420
viewing sample data 353
Measure Properties view 85
measure tasks 121, 122, 124
creating 122
editing 124
measure tolerances 358
setting dimensional 358
measure-to-objective weighting 359
setting dimensional 359
measures 42, 72, 102, 103, 105, 126, 175, 213, 214, 215, 221, 222, 223, 227, 233, 234, 239, 240, 248, 267, 339, 340, 341, 343, 352, 381, 382, 383, 385, 388, 389, 394, 395, 397, 400, 401,
measures (continued)  
   402, 405, 407, 410, 411, 412, 414, 416, 418, 419, 420, 421, 483, 489, 523  
   accessing 401  
   adding 213  
   adding feedback 103  
   aggregating ratios and percentages 381  
   attaching to dimensions 397  
   author options 175  
   controls 385  
   copy 388  
   creating 383  
   creating user-entered 215  
   descending 239  
   designing loads 352, 400  
   dimensionality 394  
   drilling to atomic levels 42  
   editing 213, 402, 483  
   editing user-entered 222  
   entering actual values 215  
   entering feedback 102, 105  
   entering formulas 221  
   entering target values 215  
   excluding from row-level security 420  
   field maps when loading data 412  
   filters when loading data 414  
   flex values 405  
   inputting user-entered 126  
   interpreting Measure Loader report 420  
   lineage 395  
   linking 227, 248  
   linking to objectives 227, 248  
   loaded 213  
   loading data 400, 407, 418  
   loading dimensions 411  
   loading production measures 223  
   Measure Loader options 410  
   navigating 267  
   options when loading data 416  
   overriding 240  
   panel 383  
   percent type 381  
   prototyping 213  
   ratio type 381  

measures (continued)  
   saving 401  
   scheduling 421  
   scheduling a load 419  
   setting access by access role 341  
   setting access by owner 340  
   setting access level 339  
   setting properties 402  
   specifying 341  
   threshold values 405  
   troubleshooting data issues 523  
   understanding 343, 397  
   units of measure 489  
   unlinking from objectives 248  
   user-entered 213, 214, 221, 222  
   using standard aggregation 381  
   using the Measure Wizard 215  
   views 72  
   weighting across objectives 233, 234  
   wiping 389  

Measures Compare to Previous view 73  
Measures Load view 448  
Measures Metadata view 448  
metadata management 273  
Metrics Across Dimension view 89, 90  
Metrics Crosstab view 89, 94  
metrics pool 398  
Metrics Vertical Sort view 89, 92  
mission statement 186  
mobile device 167, 168  
ginsu slicer 167  
zoom 168  
mobile favorites 167  
moving gadgets 139  
moving guidelines 137  
multi-level dimension display 506  
   system settings 506
multi-level time display 506
  system settings 506

N
New Content Access panel 425, 487
New Measure Wizard 214, 215

O
object display type 512
  system settings 512
objective drill-down options 39
Objective Properties view 86
objectives 66, 175, 178, 190, 235, 244, 246, 267, 342
  adjusting weights for scorecards 178
  author options 175
  creating 190
  editing 190, 244, 246
  for scorecards 244, 246
  navigating 267
  views 66
  weighting across a strategy 235
Objectives Compare to Previous view 66, 67
Objectives Performance view 53
Objectives Previous vs. Current view 66
Objectives Summary view 52
objects 186, 203
  creating 186
  deleting 203
Operational Report view 76
operational reports 427, 431, 467
  mapping parameters 431
organization name 501
  system settings 501
overriding measures 240
Owner Information view 449
owners 275, 276, 277, 278, 483
  adding 275
  changing 275, 277
  deleting 275, 277
  fields when creating 276
  importing 275, 278

P
percent measure type 381
Percent Reached Histogram view 82
Performance Trend view 83
Performance Trend with Predictions view 71
Perspective Properties view 86
perspectives 39, 187, 243
  creating 187
  drill-down options 39
  editing 187, 243
  for scorecards 243
planners 280
PMF information 494
PMF Labs 509
PMF settings 493, 496
pop-up windows 512
  system settings 512
predictive analysis views 70
predictive data 406
  configuring 406
prerequisites 170
previous period forward 506
  system settings 506
previous period moving forward 381
Previous vs. Current view 46
Prior vs. Current view 46
process drill-down options 41
Process Properties view 88
processes 80, 175, 211, 265
   author options 175
   creating 265
   editing 265
   linking to objectives 211
   views 80
Processes Objectives view 81
Processes view 55
production measures 213
Project Detail view 79
project drill-down options 40
project icon 34
Project Impact view 78
Project Properties view 87
projects 77, 175, 211, 251, 253, 257
   author options 175
   create 257
   creating 253
   editing 253
   linking to objectives 211
   views 77
Projects Objectives view 77
Projects view 54
properties 85
   views 85

R
ranking metrics 98
ranking objectives 98
ratio measure type 381
read-only Strategy Map 42
rebalance weights for no data 507
   system settings 507
red metric icon 34
registering gadgets 141, 476
Related Properties view 88
removing guidelines 137
ReportCaster 112, 419
   scheduling a load 419
   scheduling alerts 112
risk objects 186, 203
risks 68
roles 22, 23, 24, 280
   administrators 22
   analysts 23
   authors 22
   consumers 23
   developers 24
   installers 24
   shared 23
Rolling 5 Periods view 47
row-level security 420
   excluding a measure series 420
   running a saved view 101

S
saving a view 101
schedules 483
   scheduling
      source loads 339
   scheduling loads 338
   scheduling views 105, 106, 107
      canceling 107
      updating 107
schemas 173
Scorecard Aligned Processes by Objective view 80
Index

Scorecard Aligned Projects by Objective view 79
Scorecard Dimensional Breakout view 64
scorecard functional access 292, 294
editing by owner 294
editing by scorecard 292
Scorecard Matrix view 62
Scorecard Objectives Summary view 52
Scorecard Processes view 55, 81
Scorecard Projects view 54, 77
Scorecard Quadrants view 63
Scorecard User Access form 294
Scorecard view 450
Scorecard Wizard 180, 181
scorecarding 174
bottom up process 174
top down process 174
scorecards 62, 172, 174, 175, 176, 178, 180,
181, 184, 185, 241, 242, 243, 244,
246, 250, 291, 398, 484, 523
access security 178
adjust objective weights 178
author options 175
cascading 184, 185
configure functional access 178
copying 523
creating 178, 185, 523
creating by cascading 180
creating with Scorecard Wizard 180
data access security 241
deleting 178
editing 178
matching to metric hierarchies 398
navigating the scorecard tree 176
objectives 244, 246
options 242
perspectives 243
security 291, 484
selecting 178
themes 250

scorecards (continued)
tree 176
using the Scorecard Wizard 181
views 62
Scorecards Overview view 65
security 274, 420, 504
row-level 420
settings 504
setting up a PMF application 25
settings 495, 496, 497, 499, 502, 504, 505,
508, 511
changing default system 495
debugging 496
integration 497
look 497, 499, 502
security 504
summarization 505
systems 508
UI 511
shared roles 23, 173
Show Measures view 73
Show Objectives view 67
snap grid control 139
snapshot 433
sources 305, 306, 309, 310, 314, 339
lineage 310
lineage tab 306
loadable 305, 309
scheduling 339
user entered 305, 314
wipe 306
stop light images 34
Strategy Map 42, 203, 205, 208, 211, 268
adding themes 208
adjusting height 205
copying 42
drawing 203
linking processes to objectives 211
linking projects to objectives 211
moving perspectives 205
strategy objects 186, 203
Strategy Relationships view 51, 68
Strategy tab 268
stretch targets 509
style sheet 500
   system settings 500
styling control 500
summarization settings 505
swatching system 499
system settings 495, 496, 497, 500, 501, 505, 506, 507, 508, 509, 510, 512
access security 505
AJAX debugging 496
Ajax timeout 508
application tracing 496
chart color palettes 501
data font 501
default dimension 507
default target field 509
default time level 507
display language 512
external aggregation 506
external aggregation MFD 506
heading font 501
iWay Service Manager 497
measure detail sorting 506
multi-level dimension display 506
multi-level time display 506
object display type 512
organization name 501
PMF APP PATH 508
PMF labs 509
pop-up window handling 512
previous period forward 506
rebalance weights for no data 507
style sheet 500
today date 510
weighting decimals 512

T
taking a snapshot 433
target screen resolution 138
target values 228
targets 509
tasks 257, 258, 259, 261
   assign 258
   complete 261
   progress 259
Theme Information view 451
themes 208, 250
   editing 208, 250
Strategy Map 208
threshold values 228, 405
time animation 147, 151
time dimensions 365, 366, 368, 369
   accessing in Measure Loader 369
   creating from external source 366
   customizing 369
   customizing a load 365
   customizing data 369
   displaying data 369
   non-standard 368
time ranges 490
today date 510
   system settings 510
Today page 30, 31, 32, 101, 423, 424, 428
   changing graph gadget preferences 32
   changing user preferences 30, 31
   creating access to content 423, 424
   creating from a saved view 428
   customizing 30, 101
   launch page 101
Today tab 101
tracing 524
troubleshooting 515, 523, 524
   application tracing 524
troubleshooting (continued)
measure data issues 523
turning WebFOCUS reports into gadgets 467

U

Ul settings 511
units of measure 349
Units of Measure Information view 451
unlinking measures 248
upgrading an installation 518
upgrading the data mart 519
user entered source 305, 314, 315, 317, 318, 319
   lineage 317
   new 315, 319
   updating 318
user preferences 30
user-entered dimensions 373
user-entered measures 126, 213, 214, 215, 221, 222
   inputting 126
users 27, 274, 275, 276, 277, 278, 483
   adding 275
   authenticating 274
   authorizing 274
   changing 275, 277
   deleting 275, 277
   fields when creating 276
   importing 275, 278

V

viewing a measure task 125
views 33, 41, 42, 46, 47, 49, 50, 51, 52, 53, 54, 55, 62, 63, 64, 65, 66, 67, 68, 70, 71, 72, 73, 74, 75, 76, 77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 90, 92, 94, 101, 105, 106, 440, 443, 444, 445, 446, 448, 449, 450, 451
   accessing 33, 41
   Actual vs. Target Relationship 84
   administration 440
   Aligned Projects 79
   Causes & Effects 68
   Correlation 55
   Dimension Data 443
   Dimension Data Level Breakout 444
   Dimensions Load 444
   Dimensions Metadata 445
   editing 101
   Executive Booklet 49
   Executive Briefing Booklet PDF 50
   Executive Briefing Booklet PowerPoint 50
   Histogram Predictive 71
   Impact of Projects on Objectives 78
   Last 5 Periods 47
   Launch Pages 446
   Measure Breakout 75
   Measure Detail Data 74
   Measure Properties 85
   measures 72
   Measures Compare to Previous 73
   Measures Load 448
   Measures Metadata 448
   Metrics Across Dimension 90
   Metrics Crosstab 94
   Metrics Vertical Sort 92
   Objective Properties 86
   objectives 66
   Objectives Compare to Previous 66, 67
   Objectives Performance 53
   Objectives Previous vs. Current 66
   Objectives Summary 52
   Operational 76
   Owner Information 449
   Percent Reached Histogram 82
   Performance Trend 83
   Performance Trend with Predictions 71
   performance trending 81
   Perspective Properties 86
views (continued)
Predictive Analysis 70
Previous vs. Current 46
Prior vs. Current 46
Process Properties 88
processes 55, 80
Processes Objectives view 81
Project Detail 79
Project Impact 78
Project Properties 87
projects 54, 77
Projects Objectives view 77
properties 85
Related Properties 88
Rolling 5 Periods 47
running 101
saving 101
scheduling 105, 106
Scorecard 450
Scorecard Aligned Processes by Objective 80
Scorecard Aligned Projects by Objective 79
Scorecard Dimensional Breakout 64
Scorecard Matrix 62
Scorecard Objectives Summary 52
Scorecard Processes 55, 81
views (continued)
Scorecard Projects 54, 77
Scorecard Quadrants 63
scorecards 62
Scorecards Overview 65
Show Measures 73
Show Objectives 67
Strategy Map 42
Strategy Relationships 51, 68
Theme Information 451
Units of Measure Information 451

W

WebFOCUS components 21
WebFOCUS reports 467
weighting 228, 233, 234, 235
   measures across objectives 233, 234
   objectives across a strategy 235
weighting decimals 512
   system settings 512
wipe
datapoints 330
sources 306
Reader Comments

In an ongoing effort to produce effective documentation, the Technical Content Management staff at Information Builders welcomes any opinion you can offer regarding this manual.

Please share your suggestions for improving this publication and alert us to corrections. Identify specific pages where applicable. You can contact us through the following methods:

**Mail:**
Technical Content Management
Information Builders, Inc.
Two Penn Plaza
New York, NY 10121-2898

**Fax:**
(212) 967-0460

**Email:**
books_info@ibi.com

**Website**
http://documentation.informationbuilders.com/connections.asp

Name: _____________________________________________________________

Company: __________________________________________________________

Address: __________________________________________________________

Telephone: ___________________________ Date: _________________________

Email: _____________________________________________________________

Comments:

